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Safety Guidelines

This manual contains notices intended to ensure personal safety, as well as to protect the products and

connected equipment against damage. These notices are highlighted by the symbols shown below and

graded according to severity by the following texts:

! Danger
indicates that death, severe personal injury or substantial property damage will result if proper
precautions are not taken.

! Warning
indicates that death, severe personal injury or substantial property damage can result if proper
precautions are not taken.

! Caution
indicates that minor personal injury can result if proper precautions are not taken.

Caution
indicates that property damage can result if proper precautions are not taken.

Notice
draws your attention to particularly important information on the product, handling the product, or to a
particular part of the documentation.

Qualified Personnel

Only qualified personnel should be allowed to install and work on this equipment. Qualified persons are

defined as persons who are authorized to commission, to ground and to tag circuits, equipment, and

systems in accordance with established safety practices and standards.

Correct Usage

Note the following:

! Warning
This device and its components may only be used for the applications described in the catalog or the

technical description, and only in connection with devices or components from other manufacturers

which have been approved or recommended by Siemens.

This product can only function correctly and safely if it is transported, stored, set up, and installed
correctly, and operated and maintained as recommended.

Trademarks

SIMATIC®, SIMATIC HMI® and SIMATIC NET® are registered trademarks of SIEMENS AG.

Third parties using for their own purposes any other names in this document which refer to trademarks might

infringe upon the rights of the trademark owners.
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Preface

Overview

"SIMATIC PCS 7 Tips and Tricks" Manual

The "SIMATIC PCS 7 Tips and Tricks" manual is a supplement to Getting Started
and to the Configuration Manual. This manual is a compilation of the "Frequently
Asked Questions" (FAQs) on PCS 7 from the Internet. The FAQs provide you with
specific help on various topics and areas of interest based on "hands on"
experience. You should use this manual as a reference work.

Audience

The "SIMATIC PCS 7 Tips and Tricks" manual is intended for people involved in
configuration, commissioning, and service. Basic experience of handling PCS 7 as
described in Getting Started and in the Configuration Manual is assumed.

Validity

This manual is valid for the software on the CD "Process Control System PCS 7
Engineering Toolset V5.1".

Overview of the General Manuals on PCS 7

The PCS 7 Getting Started manual provides you with an overview of the
fundamental steps involved in creating a project. It includes  the "COLOR_GS"
project in a form that will allow you to complete the project in approximately eight
hours.

In the  PCS 7 Configuration Manual, the individual steps required during
configuration are explained based on the "COLOR_PH" sample plant and you are
shown how to structure the process control of a plant from a technological point of
view in various phases. You are provided with an overview of the various views
(component view and plant view), the individual phases of configuration ranging
from structuring projects, creating models, creating an OS, configuring user data
for the OS and transferring the PLC-OS connection data. The configuration manual
is intended to provide you with a comprehensive overview of the steps involved in
configuring a plant. Detailed explanations of the contents and functions in dialog
boxes have been deliberately left out. For more detailed information in this case,
please refer to the documentation or the online help of the particular application.
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This manual, SIMATIC PCS 7 Tips and Tricks provides you with a collection of
FAQs relevant to PCS 7 from the Internet arranged logically in chapters based on
the normal steps involved in configuration.

Getting Started, Configuration Manual and Projects

Getting Started consists of a manual explaining the steps required to create the
COLOR_GS project. Getting Started and the finished project COLOR_GS are
supplied on the CD "Process Control System PCS 7 Engineering Toolset V5.1".

The configuration manual explains the steps necessary to create the COLOR_PH
project. The Configuration Manual and the finished project COLOR_PH are
supplied on the CD "Process Control System PCS 7 Engineering Toolset V5.1".

You can run these projects on an existing SIMATIC station. It may be necessary to
adapt your hardware components.

The CD "Process Control System PCS 7 - Electronic Manuals" also includes
Getting Started and the Configuration Manual along with the Tips and Tricks
manual. You can read and print the manuals using the Acrobat Reader.

The contents of the electronic manuals are largely identical to those in the online
help . Due to technical reasons, there may be minor differences between the online
help and the electronic manuals. If there are discrepancies, the information in the
online help can be considered more up to date.

The "PCS 7 Getting Started" and "PCS 7 Configuration Manual" are on the PCS 7
installation CD (Process Control System PCS 7 Engineering Toolset V5.1) in
"Manuals\English\" in the files "PCS 7 Getting Started.pdf" and "PCS 7
Configuration Manual.pdf".

Further Support

If you have questions about the use of the software described here, and you
cannot find the answers in the electronic manuals or in the online help, please
contact your Siemens representative in your local Siemens office.

To familiarize you with the Process Control System PCS 7, we offer a range of
courses. Please contact your regional training center or the central training center.

http://www.ad.siemens.de/training

You will find information on the SIMATIC PCS 7 Process Control System on the
SIMATIC Web site "Industrial Automation Systems" at the following address:

http://www.ad.siemens.de/simatic-pcs7

If you require support from Customer Support, you can call the central hotline:
+49-911-895-7000
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References to other FAQs

In the answers to the questions in this manual "SIMATIC PCS 7 Tips and Tricks",
you will occasionally find references to the Entry IDs of other FAQs. To locate
these FAQs on the Internet, follow the steps outlined below:

1. Go to the following address on the Internet:

http://www.ad.siemens.de/csinfo

2. Select the Click here button.

3. Enter the required Entry ID in the "Display entry (Entry ID)" field and confirm
with Enter or click the Go To button.

FAQs

You can display the FAQs selected in this manual and other FAQs on the Internet
as follows:

1. Select the following address

http://www.ad.siemens.de/csinfo

2. Click the Product Support button

3. Select the topic you require, for example, "SIMATIC PCS 7"
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Customer Support, Technical Support
Open round the clock, worldwide:

Johnson City

Nuremberg

Singapore

SIMATIC Hotline

Worldwide (Nuremberg)
Technical Support

Worldwide (Nuremberg)
Technical Support

(FreeContact)

Local time: Mo.-Fr. 7:00 to 17:00

Phone: +49 (180) 5050 222

Fax: +49 (180) 5050 223

E-mail: techsupport@
ad.siemens.de

GMT: +1:00

(charged, only with
SIMATIC Card)
Local time: Mo.-Fr. 0:00 to 24:00

Phone: +49 (911) 895-7777

Fax: +49 (911) 895-7001
GMT: +01:00

Europe / Africa (Nuremberg)
Authorization

America (Johnson City)
Technical Support and
Authorization

Asia / Australia (Singapore)

Technical Support and
Authorization

Local time: Mo.-Fr. 7:00 to 17:00

Phone: +49 (911) 895-7200

Fax: +49 (911) 895-7201

E-mail: authorization@
nbgm.siemens.de

GMT: +1:00

Local time: Mo.-Fr. 8:00 to 19:00

Phone: +1 423 461-2522

Fax: +1 423 461-2289

E-mail: simatic.hotline@
sea.siemens.com

GMT: -5:00

Local time: Mo.-Fr. 8:30 to 17:30

Phone: +65 740-7000

Fax: +65 740-7001

E-mail: simatic.hotline@
sae.siemens.com.sg

GMT: +8:00

English and German are spoken on all hotlines. On the authorization hotline, French, Italian and Spanish are also
spoken.
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SIMATIC Customer Support Online Services
The SIMATIC Customer Support team provides you with comprehensive additional
information on SIMATIC products in its online services:

• You can obtain general current information:

- On the Internet at http://www.ad.siemens.de/simatic

• Current Product Information leaflets and downloads which you may find useful
for your product are available:

- On the Internet at http://www.ad.siemens.de/simatic-cs

- Via the Bulletin Board System (BBS) in Nuremberg (SIMATIC Customer
Support Mailbox)   number +49 (911) 895-7100.

To access the mailbox, use a modem with V.34
(28.8 Kbps) capability whose parameters you should set as follows: 8, N, 1,
ANSI, or dial in using ISDN (x.75, 64 Kbps).

• You can find your local contact for Automation & Drives in our contacts
database:

- On the Internet at http://www3.ad.siemens.de/partner/search.asp
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1 Basics

1.1 Basics

1.1.1 Implementing a Standard PCs with PCS 7 V4.02

Entry ID: 1870314 - Date: 02/17/2000

QUESTION:
Can I implement any standard PC from Siemens or another manufacturer for
PCS 7 or PCS 7 Compact Engineering?

ANSWER:
A complete package of PCS 7 includes all the hardware components required plus
the preinstalled software. This are tested hardware and software combinations.

If you do not go for a ready-configured complete package of PCS 7, then you
should know that you will be responsible for any compatibility problems and that
in this case there is no free support.

This applies especially for the PCS 7 Compact Engineering System which is
configured as a Siemens Industrial RI45 PC with slot PLC as a PCS 7 complete
package.

Requirements:

• Implementation of the PC as ES:
In the case of an ES system you need an MPI card to be able to configure an
initial communication between PC and AS. Furthermore you need the complete
PCS 7 software package with all the engineering licenses.

• Implementation of the PC as OS:
For an OS station you simply need the OS software with WinCC Runtime
license.

• The communications card is either a CP1413 for Industrial Ethernet or a
CP5412 for PROFIBUS/MPI.

The current order numbers for hardware and software are to be found in the PCS 7
catalog.
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1.1.2 Diagnostics option in the case of problems connecting with DP

Entry ID: 1017239 - Date: 10/07/1999

QUESTION:
How can I analyze/diagnose faults in the distributed I/O?

ANSWER:
You are working with PCS 7 and a PLC. The PLC is connected to the I/O via the
distributed I/O of the ET200-M. When you install or start up the distributed I/O, it
might happen that no connection is set up between the PLC and the distributed
I/O. To find out the reason for this there is a bus monitor for PROFIBUS (MLFB:
6ES7651-1BA01-0AX0 Engineering St., PROFIBUS, D) that you can download
from a Customer Support page (FAQ number 338386). The bus monitor can
analyze the data traffic in PROFIBUS networks. But this tool can only run under
Windows95 and not under Windows NT.

Since this is a freeware product, it cannot be said when this bus monitor will also
be available for Windows NT.

Now, in order to be able to use the bus monitor for PCS 7, you only need a PC/PG
with Windows 95 and bus monitor installed that is connected to the PROFIBUS.
This procedure is in fact best because the bus monitor can then register the data
independent of the load of the actual PCS 7 computer. This thus prevents
corruption of the bus runtimes (essentially important for the analysis).

The analyzer/amprolyzer is incorporated as a download under FAQ number
338386.

1.1.3 EMC of S7 components

Entry ID: 376160 - Date: 06/06/2000

QUESTION:
Are there guidelines for assembling S7 components with regard to EMC?

ANSWER:
Yes there is a manual:
In the installation manual "Assembling S7-400 and M7-400" (with the drawing
number C79000-G7000-C424-01), Appendix A deals with the topic of EMC. This
manual is available on the Internet pages of Customer Support. The manual is
available under Entry ID 1117849.
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1.1.4 Data communication cycle with S7-400

Entry ID: 39638 - Date: 11/22/1999

QUESTION:
In which cycle is there data communication between S7-400 stations?

ANSWER:
Data communication between 2 CPUs is configured using Send/Receive
connections. The data communication cycle depends on the call frequency of the
functions. The performance of each individual CPU is important here.

1.1.5 WinCC messages: "PLC fault synchronous" and "PLC fault
asynchronous"

Entry ID: 673584 - Date: 03/13/2000

QUESTION:
What is the meaning of the WinCC messages "PLC fault synchronous" and "PLC
fault asynchronous"?

ANSWER:
The messages "PLC fault synchronous" and "PLC fault asynchronous" are
triggered when a synchronous or asynchronous fault is triggered in the PLC.

These can be the following:

AS errors, synchronous:
OB 121: Programming error
OB 122: I/O access error

AS errors, asynchronous:
OB 80: Time error (e.g. exceeding cycle time)
OB 81: Power supply error (e.g. battery error)
OB 82: Diagnostics interrupt (e.g. defective fuse on a signal module)
OB 83: Remove/plug interrupt
OB 84: CPU hardware error (e.g. interface error)
OB 85: Program runtime error
OB 86: Subrack failure
OB 87: Communications error

You can delimit these faults by proceeding as follows:
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1. Read out the diagnostics buffer of the CPU.
(Select CPU in the SIMATIC Manager, right click Target System to open the
Module Properties, select the Diagnostics Buffer tab).

2. Evaluate the local variables of the fault OBs.
Double-click the relevant OB in the block container. With a small STL program
transfer the contents of the required local variables into a marker byte or a data
block that you have created beforehand. The relevant commands are as
follows, for example:

L #OB80_EV_CLASS

T MB80

or

L #OB80_FLT_ID

T DB1.DBB0

3. Finally, you must load the modified OB or data block into the PLC.

If you can’t clear the cause of the fault message, you have the option of
suppressing the message in WinCC Runtime. For this refer to the FAQ "Inhibit
messages in Runtime", Entry ID: 264704.

1.1.6 Message suppression of the PCS 7 blocks CTRL_PID /
MEAS_MON for AH,WH,WL,AL

Entry ID: 735185 - Date: 02/02/1999

QUESTION:
Why is there only partial functioning of message suppression of the blocks
CTRL_PID / MEAS_MON for AH,WH,WL,AL?

ANSWER:
When message suppression is activated via the faceplate, there are no more
interrupts displayed in WinCC, but the associated S7 block still continues to output
an interrupt bit via its block output. It is not possible when suppressing messages
of the blocks CTRL_PID and MEAS_MON to also block output of warnings or
interrupts at the block output. Otherwise in the S7 program you wouldn’t have a
chance to react to interrupts and warnings that arrive but which are not forwarded
to WinCC. If you block all the interrupts and warnings through the MSG_LOCK
input, this is displayed at the QMSG_SUP output. In this way you also have the
option of reacting to it even in the S7 program.
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1.1.7 Reduce runtime of error OBs (SUBNET block) in PCS 7 version
V4.xx

Entry ID: 836501 - Date: 09/01/2000

QUESTION:
What can the SUBNET block be used for?

ANSWER:
The SUBNET blocks works identically in versions V5.x and V4.x. Configuration in
version V5 has been enormously simplified.

With the SUBNET block you can significantly reduce the runtime of error OBs. If,
for example, a rack in the distributed I/O fails, the operating system of the AS calls
the OB86 (rack failure). For each call of the OB86 the complete OB86 is
processed. All the driver blocks are processed one after the other.
Depending on the number of drivers, this takes up a great deal of processing time
on the AS.

The SUBNET block has the following effect:
If there is a failure, the OB86 is called by the operating system of the AS. The
SUBNET block determines from the start information of the error OB the address of
the rack that has caused the error. It is now possible not to process all those driver
blocks that have a different address to this error address. This means that only
those driver blocks of the modules are called that are slotted in the same rack as
the module and which have caused the calling of the OB86. You achieve this by
sorting the driver blocks in the CFC in run groups according to their addresses and
by interconnecting the run groups with the outputs of the SUBNET block. Through
this interconnection the SUBNET block can specifically activate individual groups.
The other run groups are just not processed.

Example:
An AS has 5 ET200M racks. An error occurs in the rack with address 3.

Reaction without SUBNET block:
The error OB for all driver blocks of the rack concerned is called by the AS
operating system and is processed completely.

Reaction with SUBNET block:
The error OB for all driver blocks of the rack concerned is called by the AS
operating system. Only the driver blocks of the modules of Rack 3 are processed.
The reduces the processing time. The execution time of the error OB is drastically
reduced by the SUBNET block.

Configuring in PCS7 V4.x:

1. Manually enter run groups for each rack in the OBs 82, 83 and 86. In each run
group the driver blocks of the rack are to be called.

2. For each DP segment you must insert a SUBNET block in the CFC.

3. Interconnect the "SUBN1_ID" input with the associated SUBNET number of
the segment.

4. The "Subn1Typ" parameter receives "0" if the DP segment of the integrated
interface of the CPU is interconnected. Otherwise it receives "1".
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5. Interconnect the EN_Rx outputs with the run group in question ("CFC > right-
click > Connection to the group"). The value x stands for the PROFIBUS
address of the ET200M.

6. In the error OBs 82, 83 and 86 always call the SUBNET block before the
associated run groups of its DP segment.

Configuring in PCS7 V5.x:

In this version you don’t have to worry about configuring, because this is done
automatically be the Driver wizard.

In the PCS7 Configuration Manual, which is installed with PCS7 V5.01, see section
1.6 "Connecting to the I/Os". This section deals with the basics of the driver
concept of version V5.x.

1.2 Installation

1.2.1 Abort when installing PCS 7 V4.02

Entry ID: 1965150 - Date: 03/13/2000

QUESTION:
The installation of PCS 7 V4.02 aborts with the following error "End of File found".
What can be done about this?

ANSWER:

1. Check whether drive C:\ has enough free memory.

2. Find the INSTDUMP.TMP file and delete it before doing a new installation. This
file contains status information on the installation when WinNT has to be shut
down and started up. Normally the file is deleted automatically upon successful
installation.

1.2.2 When starting the PCS 7 Setup issue of error message "Setup
Runtime Error 5; invalid procedure call"

Entry ID: 1658691 - Date: 12/16/1999

QUESTION:
When starting the PCS 7 Setup why do I get the error message: " Setup Runtime
Error 5; invalid procedure call"?

ANSWER:
If you have terminated Setup once previously with an error, then not all the
temporary files are removed.

Remedy:

1. Find the "INSTDUMP.TMP" file on drive C:\.

2. Delete this file.

3. Now you can start the Setup again without error message.
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1.2.3 Deinstalling PCS 7

Entry ID: 1086918 - Date: 01/28/2000

QUESTION:
What should I watch out for when deinstalling PCS 7?

ANSWER:
You should note the following points when deinstalling PCS 7:

1. Make sure of the following:
- You project data under the directories Siemens/Step7/... and
Siemens/WinCC/.. (if available).
- Your supplementary GSD file (find all the GSD files on your computer and
save these in a protected location).
- Your own WinCC C scripts under Siemens/WinCC/aplib/*.fct (if available).

2. Deinstall any SIMATIC components already installed via Settings > Control
Panel > Software.

3. Delete all the SIMATIC components in the SIEMENS directory (with Explorer).

4. Start menu > Run, enter regedit.

5. Find the code:
HKEY_CURRENT_USER\SOFTWARE

6. In this path delete all the paths for the SIMATIC components deleted under
point 2.

7. Find the code:
HKEY_LOCAL_MACHINE\SOFTWARE

8. In this path delete all the paths for the SIMATIC components deleted under
point 2.

9. Delete all the S7*.* files in the Windows directory.

10. Then you must reinstall the components that do not belong to PCS 7
(e.g. ProTool)

Notice

Basically, no warranty can be given for direct changes in the registry database,
because this is entirely the responsibility of the user. In any case it is
recommended to make a backup of the registry before proceeding as described
below. Furthermore, these settings are computer-specific. This means that when
copying the project to another computer, the settings have to be made again.
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2 Project planning

2.1 Basics

2.1.1 Free block numbers for user blocks

Entry ID: 2772014 - Date: 08/02/2000

QUESTION:
Which number ranges are not occupied by system blocks?

ANSWER:

If you generate a new block type (e.g. compile CFC charts as block type or
compiling a SCL source), then you must assign an FB number for your block. Parts
of the number range from 1 to 499 are reserved for standard blocks (PCS 7
libraries, etc.). In order to avoid overlapping, use FB numbers greater than or
equal to 500 for your blocks.

An FB number can be changed easily even if there are already instances for the
block concerned. Proceed as follows:

1. Select the block folder of your S7 program

2. In the block folder change the number of the FB by right-clicking the block and
selecting Properties from the pop-up menu.

3. Change the FB number in the "Name" field.

4. Select the S7 program and open the symbol table.

5. Adapt the symbolic name to the new block number. Save and close the symbol
table.

6. You can update open CFC charts by pressing the "F5" key.
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2.1.2 Determining the current local data requirement in the CPU

Entry ID: 2718726 - Date: 08/14/2000

QUESTION:
How can I determine the current local data requirement of my CPU?

ANSWER:
For the priority classes 1 to 29 you can define the amount of local data (stack for
temporary data). You can edit the local data in the application Configure
hardware. Select the associated station and select the menu command Edit >
Properties and the Memory tab or double-click the CPU and select the Memory
tab. You can increase the number of bytes to the maximum amount of local data
for each individual CPU type.

The CPU 414-2 makes available to you 8 Kbytes of local data, the CPU 416-2 >
16 Kbytes and the CPU 417-4 > 32 Kbytes.

If you are already at this limit with your local data requirements, then you can
"distribute" the local data from priority classes not used in the user program to
other priority classes. In this way you can obtain more local data for the individual
priority classes.

Make sure that the value you specify is divisible by 2. Values from 2 to 18 are
not permissible.

The following table shows you the default assignment of the local data per priority
class in a CPU 416 and a CPU 417.
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Note

OB 121 and OB 122 have the same priority class as the block interrupted by a
programming error or I/O access error. A default assignment to a specific priority
class is thus not possible.

Determining local data requirements

For the optimum setting of the local data requirement of your CPU it is necessary
that you generate the reference data of your current project. Using the reference
data you can have an output of the maximum amount of local data required for
each priority level.

Generating reference data

Proceed as follows:

1. Open a CFC plan of the CPU for which you want to determine the local data.

2. Select the dialog box for generating executable codes (Chart > Compile >
Charts as program).

3. In this dialog box press the button Customer Compiler (SCL).

4. In the "Customize Compiler (SCL)" dialog box you must select Generate
reference data. This ensures that the reference data is generated
automatically when compiling (note: compilation time is longer because of this).
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5. Close the "Customer Compiler (SCL)" dialog box with OK and start compiling
the charts by pressing the OK button in the Compile dialog box once you have
set the scope of the compilation ("Entire program" or "Changes only").

After compilation of the data without error message you can go on to the next item.

Displaying reference data

Proceed as follows:

1. Switch to the SIMATIC Manager and select the block folder of the CPU whose
reference data you have generated.

2. Press the Display button in the pull-down menu Options > Reference data. In
the "Displaying reference data" dialog box that opens, select that the reference
data be updated and press the Yes button.

3. Depending on the setting of the SIMATIC Manager another dialog box opens
with the message that the data is displayed filtered. Close this dialog box with
OK.

4. In the Customize dialog box that now opens you select Program structure
and press the OK button.
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5. The Processing Program Structure window opens in which you see a
processing status display.

You obtain a tree structure which tells you the maximum amount of local data
needed for each OB. All the blocks marked with a cross are not incorporated into
any block, they are not called and therefore require no local data.
If required, you can enter the data into the object properties of the CPU.

Sample
Observe the following local data that has been determined using reference data:
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In the example, for the OB 32 (priority 9) there is a requirement of 214 bytes plus
244 bytes for the possible call of the OBs 121 and 122. In the Properties of the
CPU therefore, there must be at least 458 bytes of local data reserved.

2.1.3 Relationship between computer name and database server name
V4.0x

Entry ID: 2727253 - Date: 11/03/2000

QUESTION:
What should I watch out for when assigning the computer name?

ANSWER:
The data of an Operator Station is held in a Sybase database. The server name of
the Sybase database server (in the case of a multi-user system) is derived from the
computer name. There must not be any blanks in the computer name. . The
computer name must begin with a letter. Now the server name can be up to 15
characters long and contains "_N" as characters 14 and 15. If the computer name
already has 15 or more characters, those over 15 are truncated. For this reason
the computer name should not be longer than 13 characters.

Example:
The following names been assigned for 3 computers of a working group:
SIMATIC_PCS7_510, SIMATIC_PCS7_520, SIMATIC_PCS7_530
which generate the following server names (no longer unambiguous):
SIMATIC_PCS7__N, SIMATIC_PCS7__N, SIMATIC_PCS7__N
In the example above the database server cannot be started. Therefore you can no
longer create any technological hierarchy, for example.

You enter the computer name under
Start (Windows NT taskbar) > Settings > System Control > Network >
Identification > Computer_name > Change.
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2.1.4 Modules in the central rack

Entry ID: 264662 - Date: 11/30/1998

QUESTION:
Can I access a module in the central rack?

ANSWER:
You have various options for accessing modules in the central rack:

• In version V4.02 and higher of the base block there are driver blocks for
various modules in the central rack. Consult the online help of any driver block
(’Overview of the Driver Blocks’) to find out for which modules there are drivers.

• In the symbol table you can assign symbolic names for the inputs and outputs
in the central rack. You can then interconnect them in the CFC. In addition you
can interconnect the inputs and outputs absolutely in the CFC (with the
'Connect to Operand…' function).

• You can write the data of the module in the STEP 7 program to a data block
and then access these data blocks in the CFC. Example:

FC 1

U E 0.0

= DB5.DBX0.0

• You call the FC 1 in an OB. After the OB call the status of the input is 0.0 in the
first data word of the DB 5 can be used further in the CFC.

2.2 Message Configuration

2.2.1 Predefining operating message texts

Entry ID: 2847377 - Date: 08/14/2000

QUESTION:
How can you predefine the operating message texts?

ANSWER:
If the operator operates an input of a block (e.g. manual/automatic switching of a
controller), then on the Operator Station there is output of an operating message
with the operator text defined in the block instance. These operator texts are
predefined in English, but you can change them. There are two distinct cases:

• Change the operator text for all instances (copies) of the block type.

• Change the operator text for individual instances.

Once the texts have been changed and the AS/OS connection data transferred,
the changed operator texts are available on the Operator Station.

If you wish to switch languages during the Runtime of the Operator Station, then
you must translate the transferred operator texts into the desired language
beforehand in the text library of the Operator Station (Windows Control Center).
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Uniform texts for all instances

Proceed as follows:

1. In the SIMATIC Manager open the Block Folder in the required S7 program.

2. Open the appropriate block type with a double-click
(e.g. the FB 61 "CTRL_PID").

3. Close the "The block is protected" message with OK.

4. In the top part of the monitor you see the inputs and outputs of the block.

5. Click the red flag of the parameter whose operator texts you wish to change
(e.g. AUT_ON_OP).

6. Change the operator texts in the attributes "S7_string_0" and "S7_string_1"
according to your requirements (max. 16 characters) and close "Properties –
Parameters" with OK.

7. Store the changes in the block (File > Store) and close the block (File >
Close).

8. If the message "The block has been created in a different programming
language…" appears, acknowledge with OK.

If you now place the new instances of this block type in the CFC, these instances
will already contain the changed texts.

If instances of this block type are already in charts of this S7 program, then you are
asked if you want to import the changed block into the data storage of this S7
program. If you agree, then all existing instances are updated with the new texts if
you haven't yet made any changes to the operator texts.

If you have already changed the operator texts individually in specific existing
instances, then these changes are retained and are not overwritten by the changed
texts of the block type.

Individual texts for individual instances

You enter individual operator texts directly on the parameter concerned.
Proceed as follows:

1. In the CFC chart open the Properties of the block by double-clicking it.

2. Select the Connections tab.

3. Select the required parameter.

4. Enter the operator texts in columns "Text 0" and "Text 1".
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2.2.2 Message configuring in the EngineeringStation

Entry ID: 2862776 - Date: 10/16/2000

QUESTION:
How can message texts/message classes be processed so that they can be
applied as defaults in the instances?

ANSWER:
You can do this using Message Configuration to create and edit event-driven
messages with assigned texts. Message Configuration is divided into two parts:

• Definition of message classes

• Definition of message texts

You create the message classes in the Special Object Properties of a block.
Proceed as follows:

1. Open the block container in your S7 program.

2. Select the block whose message classes you want to change (e.g. the
CTRL_PID block).

3. Select the menu command Edit > Special Object Properties > Message...

4. In the dialog that opens you can change the message classes and enter
default message texts. In the CFC each newly created instance of this block
will have these texts by default. You can change these message texts in an
instance at a later date as long as you have not activated the "Locked"
checkbox after the message text.

When you change the message class or message texts, you must reimport the
block concerned into the CFC in order for the changes to become effective. This
also applies for locking message classes and message texts.

Notice

Note here that a change of message class does not affect the existing instances
even after import. You can only disable the change lock and change each
individual instance in the CFC.

Proceed as follows

1. Open any CFC chart.

2. Select the menu command Options > Block types.

3. In the left window select the block to be imported.

4. Press the "-->" button.

5. Acknowledge the Import New Version dialog with OK.
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Notice

If you change the message classes of the standard PCS 7 blocks (e.g. CTRL
PID), then the block algorithm no longer matches the message. Group messages
can therefore not be displayed or only displayed incorrectly on the OS. Therefore
only change the message classes of your user blocks or the message classes of
the MESSAGE block.

You can change one or more message texts simultaneously in CFC blocks:

• Edit message texts individually.
In the CFC in the message dialog for all the submessages used.

• Edit several message texts simultaneously.
In the Technological View of the SIMATIC Manager, in the Options > Charts >
Edit messages dialog or
in the Import-Export wizard in the Options > Import-Export Wizard > Import
dialog.

For editing the message texts in the CFC you double-click the block header to
open the dialog box Properties - Block. In the bottom part of the General tab you
see the field Special Object Properties with the Message... button. Click
Message... to open a new dialog box.
Alternatively, for the selected block, you can trigger the "Messages..." function
with the "Special Object Properties" function in the submenu of the "Edit" menu.

In the case of blocks from a library of any version up to and including V4.x, a dialog
opens for the standard configuration. In the case of blocks from the library version
V5.0 or higher, the dialog for the PCS 7 Message Configuration opens.

Adding auxiliary values:
If you add a block with message action to the CFC chart, messages are created
automatically. This block has the message structure defined by the message type
with the default attributes and message texts, i.e. even without any further
configuring, when an event occurs, the corresponding messages are sent by the
PLC. Auxiliary values can be given to the message signals. These permit dynamic
values to be entered in the message texts.

Example of an auxiliary value:
@1%6d@
Meaning: the value of the auxiliary value 1 is to be displayed as a decimal number
with a maximum of 6 places (see Entry ID: !1926599!).

Comments on message editing:
In WinCC the PLC message numbers are assigned their own numbers. If you need
a reference list of the assigned numbers for diagnostics, it can be found in the
message part of the transfer log.
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2.2.3 Message classes in PCS 7 and their acknowledgability

Entry ID: 2847472 - Date: 08/14/2000

QUESTION:
Which message classes are there in PCS 7 and which are acknowledgable?

ANSWER:
In the following is an overview of the PCS 7 message classes

Process messages:
The process messages are divided into different subclasses:

 Message class  Display on the monitor  Meaning

Alarm at top,
at bottom

AH, AL Alarm High, Low

Warning at top,
at bottom

WH, WL Warning High, Low

Tolerance at top,
at bottom

TH, TL Tolerance High, Low

Process message PM Process Message (with mandatory acknowledgment)

Process message PM Process Message (without mandatory acknowledgment)
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Control system messages
The control system messages are again divided into different subclasses:

 Message class  Display on the monitor  Meaning

Fault in control system S System

Fault in the field F Field

Preventive maintenance M Maintenance

Operating messages
The operating messages are divided into subclasses:

 Message class  Display on the monitor  Meaning

Operator request OR Operator Request

Operating message as
operating protocol

OM Operating Message

Note

Configuring the message classes and message displays is done automatically
using the Alarm Logging wizard for SIMATIC PCS 7.

Acknowledgability of message classes
The following table shows the acknowledgability of the message classes for
SIMATIC PCS 7:

 Message class  Message type  Acknowledgment

Alarm AH, AL Arrived, blinks

Warning WH, WL Arrived, blinks

Tolerance TH, TL No acknowledgment, doesn’t blink

AS control system messages S, F Arrived, blinks

OS control system messages
(internal OS LTM, Batch
flexible LTM)

S Arrived, blinks,
gone without state

Preventive maintenance M Arrived, blinks

Process message PM Arrived, blinks

Process message PM No acknowledgment, doesn’t blink

Operator request OR No acknowledgment, doesn’t blink

Operating message OM No acknowledgment, doesn’t blink,
gone without state
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3 Creating a Project

3.1 Basics

3.1.1 Illegal characters in PCS 7 V5.0 and V 4.x

Entry ID: 2123719 - Date: 04/19/2000

QUESTION:
Which characters are permitted in PCS 7 V5.0 and V4.x?

ANSWER:
The following special characters may not be used in PCS 7 V5.0 and V4.x:

 PCS 7 version  AS Engineering  OS Engineering  Object Engine

PCS 7 V 4.02 . % / \ " * ? : < > . % \ ´ blank Not relevant

PCS 7 V 5.0 + SP1 . % / \ " . % \ ´ blank * ? : / \ * ? :

Notice

Note that in AS Engineering the * is permitted as character, but in OS Engineering
it counts as a special character.

In PCS 7, during the AS/OS transfer, the special characters are replaced according
to the chart below:

 AS-OS Engineering
Version 4.x

 Character used  Replaced by

Illegal characters in
names

. % \ ´ blank $

AS-ES separators \ _

 AS-OS Engineering
Version 5.x

 Character used  Replaced by

Illegal characters in
names

. % \ ´ blank * ? : $

AS-ES separators \ / (because of OE)
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3.1.2 Creating global data blocks for the OS

Entry ID: 2727413 - Date: 07/26/2000

QUESTION:
How should I create a data block so that the OS can access it?

ANSWER:
Data blocks (DBs) are blocks that are used by the code blocks (FB/FC/OB) of your
user program to store values. In contrast to the temporary data of the code block,
the data in the data block is not deleted upon completion of the processing of the
code block or when the DB is closed. The possible size of a data block depends on
the CPU.

Global data blocks are blocks which can be accessed by all the code blocks of
the S7 user program. Each FB, FC or OB can read or write the data in these data
blocks. By default the global blocks are not transferred into the OS. By adding the
system attribute "S7_m_c" to the Properties, the elements of a global DB are
transferred the next time into the data list of the OS. Proceed as follows:

1. Create a new DB and select it or select an existing DB in the block folder with
a left-click.

2. Add the attribute "S7_m_c" to the system attributes of the block (right-click >
Properties > System attributes) and set the value to true.

3. Open the block by double-clicking in the block folder.

4. Click the element names that you wish to transfer and open the Properties
(right-click).

5. Add the attribute "S7_m_c" and set the value to true.

6. Close the block.

7. Select the block again by clicking in the block folder.

8. Open the Special Properties (Edit > Special Properties > Operation and
Monitoring).

9. Select the Operation and Monitoring box.

10. Close Special Properties.



Creating a Project

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 3-3

3.1.3 Determining defective station in the case of I/O access failure

Entry ID: 1032718 - Date: 09/20/1999

QUESTION:
How can I determine from which rack an I/O access failure comes in order to
prevent the OB122 (I/O access failure) from being called unnecessarily?

ANSWER:
If you access the I/O directly in your program, without using the PCS 7 driver
blocks, you get the problem when the I/O fails that the OB122 (I/O access failure)
is called for each access. This overloads the CPU. If the I/O fails, you should
determine the station affected and inhibit I/O access.

The OB86 contains the start information required for this. You can read out this
information using the SFC6 (RD_SINFO).

The function block attached below evaluates the SFC6 (RD_SINFO) accordingly.
You must incorporate the block in OB86 and in OB100. You must not call the
block in a cyclic OB.

If you call the attached FB (FUNCTION.pdf) in the OB100, in the source code you
must manually set the desired variable presettings for the rack failures when
starting up the CPU. It is best to set all the variables so that the entire I/O can be
accessed. In the case of an I/O failure, this variable is reset.

If the OB86 (rack failure) is called, it is determined whether a rack has failed or
returned. The outputs QRACKF (failure) and QRACKOK (rack return) are set
accordingly to 1. The output SUBN_ID specifies the number of the subnetwork, the
output RACK_NO the PROFIBUS address of the failed station. The values are
available always only for one call of the function block.

For more information on evaluating refer to the on-line Help of the SFC6
(RD_SINFO) and the OB86.

In the proposed evaluation you must define a variable for each station
monitored. This variable is then set to 1 when the station fails. It is set to 0 again
when the station returns. Depending on this variable, access to the I/O must be
inhibited, to prevent the OB122 from being called. You also have the option of
defining a Boolean output in the block, which is set according to the status.

You must copy the SFC6 (RD_SINFO) into the block container before compiling
the SCL codes.

FUNCTION.pdf (4 KB)
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3.1.4 Configuring CPUs and CPs not listed in the HW Config

Entry ID: 1529424 - Date: 06/05/2000

QUESTION:
Which CPU / CP do I have to configure in the HW Config if the CPU / CP is not yet
listed in the HW Config?

ANSWER:
Generally for configuring you always take the CP of the next version down.
Below the data on CP configuring under V4.02:

 Description  Order number  To be configured

CP 443-1 ISO 6GK7 443-1BX00-0XE0 6GK7 443-1BX00-0XE0

CP 443-1 ISO 6GK7 443-1BX01-0XE0 6GK7 443-1BX00-0XE0

CP 443-1 TCP 6GK7 443-1EX00-0XE0 6GK7 443-1EX00-0XE0

CP 443-1 TCP 6GK7 443-1EX01-0XE0 6GK7 443-1EX00-0XE0

CP 443-1 ISO 6GK7 443-1EX02-0XE0 6GK7 443-1BX00-0XE0

and TCP 6GK7 443-1EX02-0XE0 6GK7 443-1EX00-0XE0

CP 443-1 ISO 6GK7 443-1EX10-0XE0 6GK7 443-1BX00-0XE0

and TCP 6GK7 443-1EX10-0XE0 6GK7 443-1EX00-0XE0

CP 443-5 Basic 6GK7 443-5FX00-0XE0 6GK7 443-5FX00-0XE0

CP 443-5 Basic 6GK7 443-5FX01-0XE0 6GK7 443-5FX00-0XE0

CP 443-5 Extended 6GK7 443-5DX00-0XE0 6GK7 443-5DX00-0XE0

CP 443-5 Extended 6GK7 443-5DX01-0XE0 6GK7 443-5DX01-0XE0

CP 443-5 Extended 6GK7 443-5DX02-0XE0 6GK7 443-5DX01-0XE0

You must also configure the next version down for the CPUs if the current CPU is
not (yet) in the hardware catalog.

 Description  Order number  To be configured

CPU 414-3 6ES7 414-3XJ00-0AB0 6ES7 414-2XJ01-0AB0

CPU 416-2 6ES7 416-2XK02-0AB0 6ES7 416-2XK01-0AB0

CPU 416-3 6ES7 416-3XL00-0AB0 6ES7 416-2XL01-0AB0

CPU 417-4 6ES7 417-4XL00-0AB0 6ES7-416-2XL01-0AB0
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3.1.5 Menu item "Set PG/PC interface" missing in the SIMATIC
Manager

Entry ID: 2043586 - Date: 04/18/2000

QUESTION:
Why is the menu item "Set PG/PC interface" missing under "Tools" in the
SIMATIC Manager?

ANSWER:
In PCS 7 version V4.x and higher there is the menu item "Set PG/PC interface"
under "Tools" in the SIMATIC Manager.
You have opened the SIMATIC Manager and the menu item "Set PG/PC interface"
is missing under "Tools". One possible cause is that you have deinstalled the
SIMATIC NET software. During deinstallation an entry in the Registry is deleted. In
order to get the menu item to appear again, you must insert the code again.
Proceed as follows to do this:

1. Start menu > Run, enter regedit.

2. Find the code:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\App
Paths\S7EPATSX.EXE

3. The value "Standard" must be set on "C:\Windows\System32\s7epatsx.exe"

4. The value PATH must be on "C:\Siemens\Step7\S7bin;C:\Siemens\Common".

5. Delete the *.DAT files in the directory <DRIVE>:\Siemens\Step7\S7Bin

6. Restart the SIMATIC Manager.

7. The entry "Set PG/PC interface" is now available.

Notice

In general, no warranty can be given for direct changes in the registry database,
because this is entirely the responsibility of the user. In any case it is
recommended to make a backup of the registry before proceeding as described
below. Furthermore, these settings are computer-specific. This means that when
copying the project to another computer, the settings have to be made again.
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3.1.6 Menu item ’Language for Display’ doesn’t work in the SIMATIC
Manager

Entry ID: 501348 - Date: 01/28/2000

QUESTION:
In the SIMATIC Manager the menu Tools > Language for Display ... can no
longer be opened. What should I do?

ANSWER:
Close the SIMATIC Manager. In the project path find the TextSync file
(...\"Projectname"\TextSync) and delete it. Now you should be able to open the
menu Tools > Language for Display ....

3.1.7 Error when copying an AS in the SIMATIC Manager

Entry ID: 1965493 - Date: 03/13/2000

QUESTION:
When copying ASs in the SIMATIC Manager I get the following error message
"Could not find a free message number area", error number: 295:5605 . What can
be done about this?

ANSWER:
The message number areas are not automatically released if, for example, you
have deleted an AS in a project. So when you frequently copy ASs a new/higher
area is always created and thus at some time or other the end of area is reached.
You can avoid this problem as follows.

1. Using the project wizard create a new project for each AS and then copy the
ASs into them accordingly.

2. Then copy the ASs individually into a new overall project. Here you reassign
the message number area.
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3.2 Project Handling

3.2.1 Back up project data

Entry ID: 2741660 - Date: 09/01/2000

QUESTION:
When should I do a data backup?

ANSWER:
For the security of your data it is absolutely necessary to make a backup at regular
intervals. During configuring you should make a backup of your project at least
twice a day.

Use the archiving tool "PKZIP" (version V2.5 or higher) supplied on the PCS 7 CD.

Setting the archiving program
You set the archiving program to be used in the SIMATIC Manager. Proceed as
follows:

1. Select the menu command Options > Settings.

2. Select the Archive tab.

3. In the "Preferred archiving program" window set the "PKZip 2.50 (*.zip)"
program.

4. Press the Configure button.

5. Press the Browse button and select pkzip25.exe program.

6. If necessary, set the Archive directory and the Options according to
requirements.

7. Close the dialog box with OK.

Archiving a project
You do the archiving in the SIMATIC Manager using the menu command File >
Archive. Before starting to archive, make sure that all applications that access the
project (e.g. CFC, SFC, SCL compiler etc.) are closed and that the project is closed
in the SIMATIC Manager.

Give the archiving file a name that indicates as far as possible the archiving date
and the name of the project (e.g. "yearmonthdayprojectname"; 000412name). If the
archiving program does not support certain names, change them as necessary in
the Windows NT Explorer.

In order to achieve a high degree of data security, keep at least the last four most
recent versions of your project in your archiving directory (e.g. Backup_Projects)
and, if possible, use different data media (2nd hard disk, ZIP drive, MOD etc.).
Remember, a virus attack could delete your hard disk or at least badly damage
your data. With multi-user configurations you can also backup your data on the
clients. It is very unlikely that several disks on different PCs will all fail at the same
time.
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Notice

Since the GSD files are not stored in the project directory, they are not backed up
when you do the backup as described above.
The data from Batchflexible is also in the Siemens directory and should therefore
be backed up separately.

3.2.2 Reorganization of the project

Entry ID: 2742424 - Date: 08/01/2000

QUESTION:
Does a project on the ES have to be "serviced"?

ANSWER:
You should reorganize the data storage of the project or the library at regular
intervals. For this select the menu command File > Reorganize.

Reorganization removes the gaps created by deleting, i.e. the memory requirement
of the project/library data is reduced. The function optimizes the data storage for
the project or library just as a program for defragmenting a hard disk optimizes the
data storage on the hard disk.

Duration of the reorganization:
The duration of the reorganization depends on the data movements required and
can take a long time. The function is therefore not executed automatically (e.g.
when a project is closed), but has to be started by the user, whenever you wish to
reorganize the project or library.

Requirements:
Projects and libraries can only be reorganized when no objects from them are
being processed by other applications and are therefore blocked.

Note

To check the S7 data storage as such, in the SIMATIC Manager you select the
menu File > Save as. In the dialog box that opens activate the checkbox for With
reorganization (slow) and give your project a new name.
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3.2.3 Copying CFC plans into other Ass for PCS 7 versions earlier than
V5.0

Entry ID: 1922887 - Date: 04/12/2000

QUESTION:
What should I watch out for when in the components view I want to copy or move
CFC charts from one PLC to another?

ANSWER:
If you want to copy or move CFC charts from one PLC to another, then please
proceed as follows:

1. Copy the symbol tables from the source to the target station.
Warning:
Any existing symbol table in the target station will be overwritten.

2. Copy all blocks whose author is not "ES_MAP" from the block container of the
source station into the block container of the target container.

3. Create a CFC chart in the target station and open it.

4. In the CFC editor via "Options > Block types..." import all blocks into the CFC.
If necessary you will have to adapt areas blocked for the CFC via "Tools >
Settings for compiling".

5. Delete the CFC charted you have created.

6. Then you can copy the CFC charts by drag-and-drop into the target station.

7. If the charts to be moved are integrated in the Technological Hierarchy, then
the charts with the same name are double in the source hierarchy folders.
Mark these charts in the source hierarchy folders concerned and then cut them
out ("Mark charts > Right-click > Cut").

8. Then re-insert these charts into the target hierarchy folder in the Technological
Hierarchy ("Open target hierarchy folder > Right-click > Insert").
Note:
With this procedure only those cross-chart connections whose partners were
not copied in step 6 are lost.

9. If you want to move the charts, then delete the original charts in the charts
afterwards in the charts folder of the source station.

Notice

It is sufficient to enter in the symbol table of the target station just those symbol
names that are used by the CFC charts to be copied (blocks and global
operands). The same applies for the blocks and their import.
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3.2.4 Copying of PCS 7 projects

Entry ID: 2281913 - Date: 05/22/2000

QUESTION:
How can I copy PCS 7 projects to other computers?

ANSWER:
In the case of multi-user configurations of PCS 7 systems it is often necessary to
copy the projects to other computers. You have several options for this. The
requirement is the both computers are in the same network.

1.0 Copying the OS project:
If only the OS project (WinCC project) is to be copied onto another computer, you
must use the Project Duplicator.
The Project Duplicator can be started via the menu sequence START > Simatic >
WinCC > Project Duplicator.
In the Project Duplicator, in the "Select source object to be duplicated" field you
must first enter with complete path name the "<<WinCC project file>>.mcp" of
the OS project to be copied. The file can also be found and selected via the button
[...].
Then as target you must enter the target path in the Copy duplicated project for
redundancy partner to field. The target path can also be found and selected via
the button [...].
Now select the Duplicate button to start the copying process.

2.0 Copying the complete PCS 7 project using SIMATIC Manager:
If the complete PCS 7 project is to be copied, you must use the SIMATIC Manager.
Open the PCS 7 project in the SIMATIC Manager and in the File menu execute the
Save as function.
Another dialog box opens in which you can choose whether or not the project is to
be reorganized when it is saved. You set the name and save location in the next
dialog.

Note

Without reorganization (fast): the complete file tree from the project directory
onwards is copied and stored without checking. Files for possibly defective objects
are not recognized and are therefore copied too.
With reorganization (slow): the project is copied and stored whereby the project
is checked and reorganized. If an object cannot be copied and stored (e.g. if an
options package is missing or if the data of the object is defective), then an
appropriate message is output. It is always best to use the "Save with
reorganization" option to ensure early recognition of faults in your project
database.
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3.2.5 Data backup of individual automation systems

Entry ID: 2768825 - Date: 08/02/2000

QUESTION:
How can I back up individual automation systems?

ANSWER:
For data backup of individual systems you create a new project in the "SIMATIC
Manager". Then in the Component View copy the AS from the source project into
the new project.
For this right-click the AS in the source project and select "Copy".

Now, in your newly created project you right-click in the right side of the "SIMATIC
MANAGER" and select "Paste".

All the components belonging to the AS are automatically copied too The complete
AS is located in your new project.

There are other ways of copying your AS. Arrange the two projects next to each
other in the SIMATIC MANAGER and then drag and drop the AS from the source
project into the target project.

Now you save the new project to create a backup of the desired automation
system.

Notice
Zip your project (pkzip or winzip etc.) before exporting it onto a CD for data
backup, otherwise all the files and directories will be write-protected. You would
then have to remove all the write-protected attributes before you can use such a
project again.

Proceed as follows to remove all write-protected attributes:

1. Copy your project into the directory of your choice.

2. With "Start > Programs" open the "Input prompt" window.

3. Now switch to your project directory.

4. Here you enter "attrib -r /s".
The attribute [-r] defines that the write-protection will be removed. The attribute
[/s] defines that all files in the working directory and in all the subordinate
directories will be processed.

5. Close the "Input prompt" by entering "exit".
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3.3 Blocks Handling

3.3.1 Adapting blocks and libraries to the customer profile

Entry ID: 2687195 - Date: 07/21/2000

QUESTION:
Can I adapt the blocks of the PCS 7 library to a special customer profile?

ANSWER:
Before starting a project in which you wish to implement blocks from a PCS 7
library, you can adapt the library to your requirements or to a specific customer
profile.

Procedure for adapting the library:

1. In the SIMATIC Manager open the PCS 7 library to be copied and save it
under another name (standard path: Siemens\STEP 7\S7libs).

2. The copied library is then located in the SIMATIC Manager ready for editing.

3. Change the system attributes (see below) of the blocks according to your
requirements.

4. Now you can implement the changed blocks in your STEP 7 project. Create a
new library in this way for each change of tasks in other projects.

Note

You can also create a new library in the SIMATIC Manager using the menu
command File > New > Library copy into it blocks from various libraries
(File > Open > Library; copy blocks using Drag&Drop) and change the attributes.

Examples of changed system attributes:

1. Visibility in the CFC (S7_visible)

2. Operating texts for binary values (S7_string_0, S7_string_1)

3. Texts for analog values (S7_unit, S7_shortcut)

4. Switchability in the CFC (S7_link, e.g. for GAIN, TN, TV with controller) etc.

You must not change the attributes for messages (S7_server, S7_a_type).

If you set the attribute S7_m_c = ’false’ for the PCS 7 blocks, then under certain
circumstances the functionality of the associated image blocks in the OS might be
restricted.
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Proceed as follows to change the system attributes:

1. Double-click the block type to be changed in the "Blocks" folder of the S7
program.

2. Acknowledge the message The block is protected.

3. In the upper part of the block you see the parameters of the block. Here you
can click the parameters to be changed and under Properties (Edit >
Properties) you can define new system attributes and change those already
there.

The description of the system attributes can be found in the online Help of the
CFC.

3.3.2 Changing the operating behavior of the PCS 7 with blocks from
the standard library

Entry ID: 2687217 - Date: 07/21/2000

QUESTION:
Is there a possibility of changing the operating behavior of a PCS 7 block?

ANSWER:
Yes, you have the possibility of influencing the operating behavior. See below:

• Limited operating behavior
The blocks of the PCS 7 libraries use the operator control block OP_A_LIM
(FB 46) to operate analog values (REAL type). The operating behavior is
limited. This means that if a value greater than the upper/lower limit is
operated, then the OP_A_LIM limits the value to the upper/lower limit.

• User-specific operating behavior
If you require a specific operating behavior, then you must replace the
OP_A_LIM with another block with the required behavior. This block must have
the same interface structure (I/O strip) as the OP_A_LIM. It must be named
FB 46 and have an earlier date of creation than the technological block in
which you want to use it. In order to achieve this, you must set the PC date
back temporarily before you compile the new block. The procedure is
necessary to rule out any time stamp conflicts in the CFC, because the CFC
compiler compares the date of creation of both blocks and if there is a conflict,
aborts compilation of the plans with a fault message.
After compilation, you will find the new operating behavior in all the blocks that
had previously implemented the OP_A_LIM.

• Rejection operating behavior
You get a rejection operating behavior with the operator control block
OP_A_RJC (FB47) if you transfer it into your project as FB 46.
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3.3.3 System attributes for blocks and parameters

Entry ID: 2936808 - Date: 01.09.2000

QUESTION:
How can I assign special PCS 7 properties to self-written blocks?

ANSWER:
Using system attributes you have the option of influencing the PCS 7 properties.

System attributes of the blocks:
You can assign system attributes to the blocks. You incorporate these attributes
immediately after the statement for the beginning of the block.

For example, the setting "S7_m_c : =..." determines the default reaction of the
instances of a block type with reference to the HMI behavior.
If the value is set to "true", then all the instances have the HMI behavior specified
by the "System attributes of the Parameters".
If the value is set to "false", the HMI behavior of all instances is disabled by
default. The user can specify the behavior individually for each instance.

Example:

FUNCTION_BLOCK FB576
TITLE = ‘AND link’
{ S7_m_c : = ‘true’ }
//
//Block comment
//
VERSION : ‘1.0’
:
END_FUNCTION_BLOCK

System attributes of the parameters:

You can also assign system attributes, e.g. for configuring messages and
connections, to the input, output and in-out parameters. You assign the system
attributes for parameters in the input, output and in-out parameter declaration
blocks. A designator may have up to 24 characters.

Example:
Each parameter that is to be operator-controllable and observable in WinCC must
have the attribute "S7_m_c := true". In the example the inputs "E1" and the input
"E3" are to be operator-controllable and observable in WinCC:

// Block parameter
VAR_INPUT
// Input parameters
E1 { S7_m_c:=‘true’ } : BOOL:=1;
E2 : BOOL:=1;
E3 { S7_m_c:=‘true’ } : BOOL:=1;
:
END_FUNCTION_BLOCK
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Notice

The possible attributes and their descriptions can be found in the online Help of
the SIMATIC Manager under "Help > Help Topics > Attributes for Blocks and
Parameters > System Attributes".
You insert blocks from changed system libraries (e.g. after a version change) into
an existing project. Before inserting, make sure that you change the attributes of
the blocks back to suit your wishes.
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3.4 Redundancy

3.4.1 Creating and Downloading a Redundant OS Within a Project in
PCS 7 Versions Higher than 4.02

Entry ID: 00003- Date: 07.08.2000

QUESTION:
How do I create a redundant project on the ES and download the OS part of the
project to the OS?

ANSWER:
The description below explains the steps required to create a project and then
download the relevant part of the project to the OS.

Create a SIMATIC PC station for the OS server 1-1 (master server) in the SIMATIC
Manager and a SIMATIC station for the OS server 1-2 (standby server). A
SIMATIC PC station consists of a WinCC application and a communications
module (for example, CP 1613). Multi-clients are an exception since they do not
require a CP in the SIMATIC PC station (as an option, you can also create a
project with redundant operator stations using the "New Project Assistant"
(SIMATIC Manager > File > New Project Wizard)). When creating the SIMATIC PC
stations use the following HMI applications:

• WinCC Application (name in the SIMATIC PC station: WinCC Application) for a
single workstation system or the master server in a multiple work system
project.

• WinCC Application red. OS (name in the SIMATIC PC station: WinCC
Application (stby)) for the standby server in the multiple workstation project.

• WinCC Application Multi-Client (name in the SIMATIC PC station: WinCC
Application MC) for the multi-clients in the project.
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1. Open the object properties of the OS and set the path to the OS server 1-1
(master server) in the "Target OS and Standby OS" tab in "Path to Target OS
Computer". For "Standby OS" select the redundant OS (OS server 1-2,
standby server). Close the Object Properties.

The name of the redundant OS is automatically changed to "Master OS
Name_STBY".

2. Open the object properties of OS_Stby and set the path to the OS server 1-2
(standby server) in the "Target OS and Master OS" tab in "Path to Target OS
Computer". The OS server 1-2 (master server) has already been entered in
"Master OS". Close the Object Properties.
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3. Create the connections required for a redundant OS in NetPro. For more
information read the FAQ with entry ID 00004 "Configuring a Redundant
Connection".

4. Transfer the PLC-OS connection data.

5. Configure the "Redundancy" application in the WinCC Explorer of the master
OS.

6. If you are using a multi-client project: Create the packages for the multi-clients
on the master OS in the WinCC Explorer in "Serverdata", enter the physical
computer name of the master OS in the properties of the package and, if
necessary, change the symbolic computer name.

7. If you are using a multi-client project: Download the packages in the WinCC
Explorer on the multi-clients in "Serverdata" and set the standard server and
the preferred server.

8. Select the master OS in the SIMATIC PC station in the SIMATIC Manager and
select "PLC > Download".

9. Select the standby OS in the SIMATIC PC station in the SIMATIC Manager
and select "PLC > Download".

10. If you are using a multi-client project: Select each multi-client individually in the
SIMATIC Manager and select PLC > Download.
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3.4.2 Configuring a redundant connection in PCS 7 Versionen higher
than 4.02

Entry ID: 2855188- Date: 13.07.2000

QUESTION:
How do I configure a redundant connection to an AS400-H?

ANSWER:
Specific points must be observed when configuring a redundant connection from
an Operator Station to an AS400-H. The following instructions are for configuring
the configuration shown.

 

Note
If you are using a CP1413-H(256K), the BIOS of the PC might have to be changed. The
reason for this is 256-Kbyte transfer buffer of the CP. Proceed as follows:

1. When starting up the PC, call the Setup of the BIOS (e.g. with F2).

2. Switch to "Advanced" settings and there to "Advanced System Configuration".

3. Set "ISA Memory Gap" to "Extended" and quit the "Advanced System Configuration".

4. In "Advanced" settings call the "PCI Configuration".

5. Call the "PCI/PnP ISA IRQ Resource Exclusion" and reserve the interrupt for the
CP1413 (recommended: Interrupt 10).

6. Save and quit the BIOS setup.

The menu designations might vary from PC to PC.
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Configuring:

PG/PC interface:

1. Install the CP driver both on your OS and on the ES. Depending on your CP
you must install either CP1413-H (256K) or CP1613 (Fast Ind. Ethernet) or
CP5412H (PROFIBUS). For this use you can also refer to the online Help for
the "PG/PC interface".

2. In the "PG/PC interface" set an unused, unique address for your CPxxxx on
your bus.

3. Close "PG/PC interface".

Configuring the ES station:
In the rest of this description it will be presumed that you have already configured
the SIMATIC H station completely in the Hardware Configuration (rack, PS, CPU,
CP etc.). In the configuration make sure you have unique addresses on the
Ethernet and PROFIBUS.

1. In the SIMATIC Manager start the network configuration (NetPro).

2. Add a "SIMATIC PC Station" (stations) from the "Selection of network
objects" catalog. This SIMATIC PC station represents the ES station. The
station is created in the network view.

3. Save the configuration with "Save Network".

4. Right-click the newly created station and select "Open Object". The "HW
Config" opens and the SIMATIC PC station is displayed.

5. In the hardware catalog open the SIMATIC PC station (click "+"). If the
hardware catalog cannot be seen, then you must select the menu "View
Catalog" beforehand.

6. In the hardware catalog in the SIMATIC station, open the "CP" folder and
drag&drop the desired CP (e.g. CP 1613) to a free slot in the SIMATIC PC
station (e.g. slot 1).

7. In the "Properties - Ethernet interface CP 1613" dialog that opens select the
desired address (user address of the OS on the Ethernet or Fast Ethernet) and
select a subnetwork or create on if necessary.

8. Quit the Properties of the CP with the "OK" button.
The CP appears in the SIMATIC PC station.

9. In the hardware catalog in the SIMATIC station, open the "HMI" folder and
drag&drop the "WinCC Application" to a free slot in the SIMATIC PC station
(e.g. slot 2).
The WinCC application is displayed in the SIMATIC PC station. The
configuration of the station is thus completed.

10. Save the station via "Save Station" and terminate the hardware configuration
with "Exit Station".

Through the entries you have made the SIMATIC PC station is now already
connected with the Ethernet or Fast Ethernet.
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Defining the memory location:

1. Right-click the SIMATIC PC station in NetPro and in the pop-up menu select
"Properties".

2. Select the "Configuration" tab and note the memory location of the
configuration file. This configuration file contains the connection data of the ES
station. Since you will need this information in a later configuration step, give
the configuration file an unambiguous name that you can easily identify (e.g.
ES.xdb).

3. Now save and compile your network configuration via the menu sequence
"Save and compile network".

4. Terminate network configuring with NetPro.
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Configuring the connections:

1. Open "NetPro" and click the "WinCC Application" box in the SIMATIC PC
station.
The connection table of the WinCC application opens in the lower part of the
monitor.

2. Double-click a line in the connection table.

3. Create a high-availability connection between your SIMATIC H station and the
application.

 

4. You have the option of adapting the name of the new connection to the project.
Click the checkbox "Display Properties Dialog" and click the "OK" button.

5. In the window that opens enter under "Local ID" the name
"PC_Station_ES_AS1". From the name you can tell that a connection has
been made between the ES and the AS1. A connections between the ES and
other ASs you can then name, for example, PC_Station_ES_AS2 and so on.
When transferring the AS/OS connection data you will find the name to
connection to be specified under this name.

6. Close the dialog boxes with "OK".

You have completed configuring the high-availability connection between the
ES and the SIMATIC 400-H station. With it you can start the Runtime software
of the Operator Station on the ES and operate and monitor the AS400-H. But
the project also has an Operator Station. For this Operator Station you need
another PC station with the associated *.xdb file. With the information of the
other *.xdb file you can set up the high-availability connection from the
Operator Station to the SIMATIC 400-H station.
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Configuring the OS station:

1. Create the SIMATIC PC station for the OS by repeating the steps Configuring
the ES station, Defining the memory location and Configuring the
connections. In doing so you enter the information as shown in the following
figures in the corresponding boxes.

 

2. Once you have also created a new connection here, you have to select the
checkmark "Display Properties Dialog" to adapt the connection. Press "OK"
and a window opens in which you specify the name "PC_Station_OS_AS1"
under "Local ID".
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3. Note the memory location and the name of the configuration file (here
OS1.xdb). You need this information in a later configuration step.

4. Save and compile your network configuration via "Save and compile
network".

5. Load your network configuration into the CPU with "Target System Load
Marked Stations".

6. Start the transfer of the AS/OS connection data via "SIMATIC Manager
Options Transfer AS/OS connection data".

7. In step 3(7) you assign the S7 program of the SIMATIC station to an OS.

The data of the Operator Station are kept only once on the ES. For this reason
assign the S7 program only to the OS(1) via drag&drop. In a later configuration
step the OS data is transferred to the OS with the "Project Duplicator".
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8. Press the "Next" button.

9. In step 4(7) click the second OS in the left window. You are only going to
transfer into the Operator Station of the ES.
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10. Click the "Connection" button and specify the connection "PC_Station_ES"
(subnetwork type: Named Connections).

 

11. Close "Select Network Connection " with "OK".

12. Execute the next steps in the transfer dialog and transfer the AS/OS
connection data.

When transferring, among other things, the xdb file belonging to the specified
connection (here ES.xdb) is copied into the path of the OS project
(default: "Siemens/STEP7/S7proj/projektname/Wincproj/OS(1)") and renamed
OS(1).xdb (OS project name and xdb file name are always identical).

13. Open the OS from the Component View of the SIMATIC Manager.

The transferred "S7 Program" appears in the variables list of the associated
OS. In the properties of this "S7 Program" are the "Application Name" and
"Connection Name" that you have configured.
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14. The redundant connection between the ES and the SIMATIC station is thus
installed and you can start the Runtime software of the Operator Station on the
ES.

Copying the data onto the OS:

1. To copy the data you open the Project Duplicator "Start SIMATIC WinCC
ProjectDuplicator".

2. In the Project Duplicator you select the source project (default: "Siemens/STEP
7 /S7proj/projektname/Wincproj/OS(1)") and specify the target directory for
copying.

3. Press the "Duplicate" button.

The project is copied onto the partner server. But here it is the xdb file of the
ES that is copied. This file contains the connection parameters of the ED but
on those of the OS. After duplicating the project on the Operator Station,
therefore, you must save and rename the xdb file belonging to the Operator
Station in the right path.

4. Copy the xdb file of the Operator Station (here OS1.xdb) and paste this file into
the project path of the Operator Station (default: OS(1)).

5. Delete the xdb file of the OS (default: OS(1).xdb) and assign the name of the
deleted file to the xdb file you have copied (OS1.xdb).

(here: OS(1).xdb).
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6. Start the PG/PC interface on the Operator Station via "Start > Settings >
Control Panel > Set PG/PC interface".

7. Open the "STEP 7 Configuration" tab.

8. In the "Name of configuration file" box check the path and file name entered
there match those of the xdb file you copied and renamed.

The redundant connection between the OS and the SIMATIC station is installed
and you can start the Runtime software of the Operator Station on the OS.



Process Control System PCS 7, Tips and Tricks
A5E00080064-01 4-1

4 Configuring Hardware

4.1 Basics

4.1.1 Station diagnostics of a SIMATIC Station

Entry ID: 2687356 - Date: 07/21/2000

QUESTION:
How can I read out the current module status of a SIMATIC Station?

ANSWER:
You have the option of reading out the current status of the modules of a
configured station. For this there is a tool available for speedy troubleshooting.

Requirement:
A connection between automation system and PC/PG. Proceed as follows:

1. In the SIMATIC Manager select the S7 program in a CPU.

2. Select the menu command Target system > Module status

3. In the dialog that opens select the Diagnostic buffer tab.
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Displayed in brief form in the Event window are the messages of the events that
have occurred. If you click an event in this window, then a detailed description of
the event is displayed in the bottom window. If you then click Help on Event you
will obtain further instructions as to how to evaluate the event or how to clear a
fault.

4.1.2 Storing user program permanently on FEPROM memory card

Entry ID: 2699017 - Date: 07/24/2000

QUESTION:
Can a user program be stored permanently on a memory card (load memory)?

ANSWER:
If you want to store a user program permanently (even if the battery fails), then use
an FEPROM memory card as load memory of the CPU.

For accessing FEPROM memory cards in the Engineering System you need the
corresponding FEPROM driver. EPROM driver and Flash File System are offered
as options upon installation of the base package of STEP 7. You can only delete
FEPROM memory cards on the Engineering System. In the case of memory cards
for S7 target systems you can only delete the whole memory card, i.e. all blocks. It
is not possible to load changes from the ES. If you use a PC, you need an external
prommer in addition to store on FEPROM memory cards.
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Implementation:
You only use FEPROM memory cards when the user program no longer changes
or only very seldom changes and you want to store the data permanently. The
stored user program remains on an FEPROM memory card even if you remove the
card from one AS and slot it into another AS.

Notice

Note, however, that there are programs that change the user structure on the load
memory without loading. For example, the application "Route Control" is used in
breweries. This application changes the length of data blocks in the load memory.
If you use FEPROM memory cards here, then the program can no longer function.

4.1.3 Moving DP slaves to a different master system

Entry ID: 2717635 - Date: 07/24/2000

QUESTION:
How is a DP slave moved from one CPU to another?

ANSWER:
When processing a project it is sometimes necessary to move a DP slave (e.g. an
ET 200M) from one master system of a CPU (e.g. built-in DP interface of the CPU)
to another master system of the same CPU (e.g. DP interface of a CP 443-5
Extended). Proceed as follows:

1. Open the hardware configuration.

2. Select the DP slave to be moved.

3. Select the menu command Edit > Copy.

4. Select the master system to which the DP slave is to be moved (click dash).

5. Select the menu command Edit> Paste.

6. The DP slave is moved to the master system selected.

7. Select the DP slave in the original master system and select the menu
command Edit > Delete.

Now you have moved the DP slave to another master system. Depending on the
requirements, you must now adapt the address of the DP slave and, in the case of
an ET 200M, the input and output addresses of the modules used in it. The
copying moves these addresses to unused areas.
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4.1.4 Operating state "STOP" when cycle monitoring time is exceeded

Entry ID: 2847489- Date: 08/14/2000

QUESTION:
Does an S7 CPU go into STOP because of a cycle overload?

ANSWER:
When configuring the hardware you can set a cycle monitoring time (ms) in the
CPU properties (double-click CPU in the Hardware Configuration.

Make sure that the cycle monitoring time is always greater than the maximum
cycle time of the current user program. If the cycle monitoring time is exceeded,
the CPU goes into the operating state "STOP". However, you have the possibility in
an OB 80 of reacting once to this ("retrigger") and thus prevent the "STOP" state of
the CPU. If the cycle time is exceeded a second time, then the CPU inevitably goes
into "STOP". Without the OB80 the CPU goes immediately into the "STOP" state.

Possible causes for exceeding the cycle monitoring time:

• The quantified project scope is too great

• Too many blocks are being processed too quickly

• Additional communications processes that take a long time

• Bundling of alarm events

• Error in the CPU program

With the minimum cycle time you define for OB 1 the time intervals in which
the CPU program is called. If the cycle time is shorter than the minimum cycle
time specified, then the CPU processes the OB90 (background task) until the
minimum cycle time is reached.

4.1.5 Quantified project scope of the communications instances for
PCS 7 automation systems

Entry ID: 2446042 - Date: 10/17/2000

QUESTION:
How many communication instances (CFBs) can I use in PCS 7 automation
systems (AS)?

ANSWER:
CFB means " communication function block". For each CPU of an automation
system there is a quantified project scope of communication function blocks. You
can retrieve this quantified project scope from the table. An ID is assigned for each
CFB in order to open a communications channel over it. If you exceed the possible
number of CFBs, then you can no longer load the user program into the AS and
you get the following message:
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Possible remedies:

• Reduce the number of CFBs used to the permissible number of the CPU
implemented.

• Use a larger CPU that supports the quantified project scope required.

Quantified project scopes of selected PCS 7 CPUs

 CPU type  MLFB number  Max. number of
simultaneous CFB
blocks (default)

 Maximun number of
simultaneous archive
Ids (AR_SEND)

 CPU 414-2 6ES7414-2XJ00-0AB0 300* 16

 CPU 414-2 6ES7414-2XJ01-0AB0 300* 16

 CPU 414-3 6ES7414-3XJ00-0AB0 600 (300) 16

 CPU 416-2 6ES7416-2XK00-0AB0 600* 32

 CPU 416-2 6ES7416-2XK01-0AB0 600* 32

 CPU 416-2 6ES7416-2XK02-0AB0 1800 (600) 32

 CPU 416-2 6ES7416-2XL00-0AB0 600* 32

 CPU 416-2 6ES7416-2XL01-0AB0 600* 32

 CPU 416-3 6ES7416-3XL00-0AB0 1800 (600) 32

 CPU 417-4 6ES7417-4XL00-0AB0 Settable up to a max. of
10000; Default:  (1200)

64

 (* cannot be changed)
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The following blocks belong to the CFBs:

• USEND , URCV

• BSEND , BRCV

• AR_SEND

• GET , PUT

• PRINT

• START , STOP , RESUME

• STATUS , USTATUS

• ALARM , NOTIFY , ALARM_8 , ALARM_8P

4.1.6 Modules missing the HW Config

Entry ID: 643369 - Date: 11/09/1998

QUESTION:
Why can I see all the modules in HW Config although they all must be there?

ANSWER:
If modules that should normally be there are missing in the module catalog of the
HW Config, then you must delete all the files of the type "*.dat" from the path
"C:\SIEMENS\Step7\S7met". Just to be on the safe side copy these files
somewhere else beforehand. Then reboot the computer. The "*.dat" files are now
newly created.

If everything is OK, then you can delete the backup copies of the "*.dat" files.

4.1.7 CPU diagnostics includes smudge characters instead of cleartext

Entry ID: 770478 - Date: 03/24/2000

QUESTION:
What should I do if the CPU diagnostics is displayed in smudge characters instead
of cleartext?

ANSWER:
It might be that some of the database services have not been correctly started or
installed.
Check the following settings:

1. Call the Task Manager. The "S7wmedax.exe" file must be started under
Processes in the Task Manager.
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2. In the Registry the following entry must be set to 1:
HKEY_CURRENT_USER/Software/Siemens/Step7/SQLANY/DBADMIN:
AutoStart Event Database = 0x00000001(1)
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3. In the Control Panel open the item ODBC Data Sources,
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and check whether "sybtab" is entered in the list.

4.1.8 HW Config cannot be started after incorporating a GSD file
(versions <4.02)

Entry ID: 790821 - Date: 04/09/1999

QUESTION:
I have incorporated GSD files of another manufacturer into a project. Why do I get
an error message when I open HW Config?

ANSWER:
You have opened the hardware configuration from an ES on which it wasn’t
originally configured. In addition, you have incorporated GSD files from another
manufacturer, and have probably not copied them onto the other ES (in
S7Data/GSD). This results in the error message "Cannot start HW Config".

If you open the hardware configuration from a project in which GSD files from
another manufacturer are incorporated and these are not under "S7DATA/GSD",
you get the following error message (STEP7 V3.2 / V4.01):

HW Config
Opening of station has failed
OK/Details/Help
HW Config
Details
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The GSD file (type file):
C:/Siemens/STEP/S7DATA/GSD/Mchspdp.gsd
could not be found.

This refers to the missing GSD file. As a remedy you copy the GSD file(s) of the
other manufacturer onto all stations that process the project. In version V4.02 and
higher GSD files are contained in the project data. Thus the procedure described
above doesn’t apply.

4.1.9 STOP through the priority class run system

Entry ID: 906270 - Date: 06/30/1999

QUESTION:
What is the meaning of the message ’STOP through the priority class run system’,
event ID 16#4541 in the diagnostics buffer?

ANSWER:
This entry is made if in the CPU you call the OB 80 (time error OB) twice in one
cycle because the cycle time was exceeded. Proceed as follows to avoid a STOP
of the CPU:

• Increase the cycle monitoring time in the HW Config (CPU Properties,
"Cycle/Clock marker" tab).

• Check whether the processing time of the time interrupt OB in your CPU is
at the limit. If, for example, the program is for the main part in the OB 35, which
is called every 100ms, then its processing time must be significantly under this
value. If the processing time is too close to the call time, the additional call of
an error OB (e.g. I/O failure) can lead to exceeding of the cycle time. The
processing time of the OB can be determined with the TIME_BEG and
TIME_END blocks. Add these blocks to the beginning and end of the
organization block to be checked. You can reduce the processing time of an
OB by incorporating run groups with reductions and phase shifts, or call
blocks in other OBs.

• If a CPU STOP upon failure of I/O, the SUBNET block can help you. The
SUBNET block ensures that when an error OB is called (e.g. OB 86, rack
failure), only those driver blocks are processed which reported the error. This
reduces the processing time required.
See also the FAQ with Entry ID 836501.



Configuring Hardware

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 4-11

4.2 Redundant AS

4.2.1 Configuring redundant power supply modules in an S7-400

Entry ID: 1945522 - Date: 03/08/2000

QUESTION:
How can I insert two redundant power supply modules into the subrack of an S7-
400 station?

ANSWER:
You want to insert two redundant power supply modules into the subrack of an S7-
400 station. For configuring you use the HW Config tool from the SIMATIC
Manager. The requirement here is that you have installed STEP7 V5.0 with SP3.

You haven’t installed SP3?
In the SIMATIC Customer Support, under the Entry ID. 1663971, there is a
download with which you can install SP3.

Notice

Power supply modules that you can use redundantly can be slotted twice in a
subrack. You can recognize these modules by the "About" text in the "Hardware
Catalog" window. Observe the following rules here:

• It is only possible to slot redundant power supply modules in the subracks
designed for this.

• Redundant power supply modules can only be operated with the CPUs
designed for this. Unsuitable CPUs (e.g. older releases) are rejected during
configuring.

• The two redundant power supply modules must be slotted directly next to each
other as of slot 1. No gaps are permitted.

• You can not have mixed operation of redundant and non-redundant power
supply modules.

Procedure:

1. In the SIMATIC Manager open your S7-400 station and start HW Config by
double-clicking the Hardware icon. If the "Hardware Catalog" window does not
open, select the menu command View > Catalog.

2. Select an appropriate subrack in the "Hardware Catalog" window under
"Rack-400". Here you must select a subrack that supports redundant
configurations. You can tell this from the "About" text.

3. Drag&drop the selected component into the station window.

4. In the "Hardware Catalog" window, under "PS-400" you select an appropriate
redundant power supply module.

5. Drag&drop the selected component to Slot 1 in the station window.
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6. In the "Hardware Catalog" window, under "PS-400" select a second redundant
power supply module.

7. Drag&drop the selected component to the next free slot in the station window.

4.2.2 Changing the rack number of sync modules

Entry ID: 738129 - Date: 02/03/1999

QUESTION:
What should I watch out for when changing the rack number of sync modules?

ANSWER:
If you remove the sync module, change the rack number setting and remount the
module, then you must do a manual overall reset. If you do not do this, the CPU
retains the old value after changing the rack number until a manual overall reset is
done.

4.2.3 Configuring the second CPU 417-4H

Entry ID: 747243 - Date: 02/08/1999

QUESTION:
Why can’t I insert a second H CPU in my station?

ANSWER:
You have created a new H station. You can set up several racks, but the
CPU 417-4H only allows you to slot in Rack 0. If you attempt to configure an H
CPU in another rack, you get the following message:

"The module can only be slotted in rack 0."

Solution:
To insert a station you must select Insert > Station > H System, and not "Insert >
Station > SIMATIC 400 Station".

4.2.4 No switching to Redundant mode with running PG function for
test and start-up

Entry ID: 747268 - Date: 02/08/1999

QUESTION:
My H-CPU is in Solo mode, why can’t I switch to Redundant mode?

ANSWER:
The H system is in Solo mode and at the same time a PG function for test and
start-up is running (e.g. Block Status, Variable Status, Forcing, Var Control, Set
Stop Point …).

Remedy:
You can only switch your H system into Redundant mode once all the PG functions
for test and start-up are switched off.
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4.2.5 Prompt to make overall reset after power ON with no battery
back-up

Entry ID: 747475 - Date: 02/08/1999

QUESTION:
Why does my CPU 417-4H remain in the "Overall reset" state after a power ON
with no battery back-up?

ANSWER:
The CPU 417-4H is in Self-test mode. This self-test automatically triggered by a
power ON with no battery back-up runs a memory test. Depending on the
configuration of the memory this can take several minutes (about 8 seconds per
Mbyte of memory). You cannot set up a connection to the CPU during this time,
either.

Remedy:
Install a back-up battery.

4.3 Automation System

4.3.1 Memory concept for the S7-400

Entry ID: 1027086 - Date: 06/27/2000

QUESTION:
What should I watch out for with respect to memory in the case of an S7-400?
What are the limits?

ANSWER:

Loading memory and main memory
With respect to the S7-400 memory, you must distinguish between the loading
memory and the main memory.

• Transfer into the load memory all the blocks from the block container of the
CPU in your project storage. This includes all blocks of the CPU in full length
including the description of the parameter interface. An example here is a DB.
Alongside the actual data there is also storage in the load memory of
information on the definition of the formats of the individual bits of data.
The CPU then searches in these blocks in the load memory for those parts that
it really needs for the program run (commands and data).

• The data (e.g. of a DB relevant for the program run) comes into the main
memory (data memory), the information on the parameter interface and data
formats remains in the load memory. You can thus use any PG to access the
controller and see, for example, how the DBs and their data formats have been
created.

• The program parts (e.g. the statements in an FC) also come into the main
memory (code memory), the description of the parameter interface remains in
the load memory. You can thus use any PG to access the controller and see,
for example, how the FCs and their parameters have been created.
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• With some CPUs in S7-400 a difference is made between main memory for
data (data memory) and main memory for statements (code memory), other
CPUs use a common main memory for both. You can see this in the
information about how your CPU memory allocation.

• All S7-400 CPUs have an internal RAM load memory. If it is not large enough
or if a non-volatile memory is required, then you can slot a RAM or FEPROM
card.

Size of the program and data blocks
The limit is defined by the size of the main memory and is thus fixed. You
cannot extend the main memory (except CPU 417), so it is the most important
criterion of the CPU. Under STEP7, you can find out the size of the main memory
and the loading memory for existing projects. You do this in "Program" by clicking
Blocks > right-clicking Object Properties and then selecting Special.

! Warning

You can only update a FEPROM card by completely retransferring the program.
For start-up therefore it is best to use a RAM card, because of the option of
reloading individual blocks.

Prospect:
Considering the present capacity of the main memory, MCs, e.g. 16MB, are not
very useful, because the main memory would never be sufficient. For later versions
of STEP7 (dates unfortunately not yet fixed) it is planned to have the comments
and symbols stored completely in the loading memory, and then greater loading
memory capacities will be required.

4.3.2 Higher memory requirement when the CPU is in RUN mode

Entry ID: 1435651 - Date: 11/18/1999

QUESTION:
Why is more main memory occupied when the CPU is in RUN?

ANSWER:
The user program is loaded into a overall reset CPU in the STOP state. The
amount of main memory of the CPU used corresponds exactly to that which is also
displayed off-line. If you switch the CPU to RUN, more main memory is occupied.

Cause:
Additional memory must be allocated during runtime for the accompanying
message values of the Alarm_8p block. This happens in the OB 100 start-up.
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4.3.3 Memory requirement of the process image (code memory/ data
memory)

Entry ID: 2147032 - Date: 04/27/2000

QUESTION:
Which memory does the process image occupy (PAE / PAA)?

ANSWER:
With S7-400 CPUs with configurable size of process image, You need 12 bytes in
the code memory per byte of the process image. You do not occupy any data
memory.
In the case of all other CPUs the memory is reserved on the system side for the
process image and does not occupy any user memory.

4.3.4 Using the 3rd and 4th interfaces of the CPU 417-4

Entry ID: 910273 - Date: 07/01/1999

QUESTION:
Do the 3rd and 4th interfaces of the CPU 417-4 offer the same functionality as the
integrated interface?

ANSWER:
Yes, the other interfaces behave identically to the integrated interfaces. You
configure the additional interfaces in the same way as an integrated DP interface.

4.3.5 Maximum possible number of DP phases with S7 400

Entry ID: 947094 - Date: 07/07/1999

QUESTION:
How many DP phases can be set up via CPU and CP modules?

ANSWER:
You can set up as many DP phases as there are interfaces available to all the
CPUs. Take the following into account when planning your installation:

• Maximum 4 x CPU 417-4 modules, with 4 DP interfaces, means 16 DP
phases.

• In addition, in the central rack you can slot other CP 443-5 Extended modules
(6GK7 443-5DX02- ... firmware V2.0.0 and higher). This configuration can then
operate 23 DP phases (16 phases CPU + 7 phases CP).

Note the quantified project scope of the CPU concerned

• Specially with the CPU 417-4 you can address maximum 2 Kbytes I/O with the
integrated MPI-DP interface.

• The DP interfaces (available and slottable) can process 8 Kbytes I/O
addresses.

• The address area administered by CPs is also 8 Kbytes I/O
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• The complete address area of the CPU 417-4 is however always restricted to
16 Kbytes I/O peripherals.

4.3.6 Battery error with the S7-400: OB81 is not called

Entry ID: 997694 - Date: 08/11/1999

QUESTION:
Why isn’t the OB81 called although the battery is empty or has been taken out?

ANSWER:
You are using an S7-400. You have taken out the battery or it is empty, but the
OB81 is not called.

Background:
In the S7-400 the OB81 is called in the case of battery failure only if the battery
check is activated with the BATT.INDIC switch. If you want to change the battery,
it is best to set the BATT.INDIC switch purposely to OFF, in order to suppress
the calling of an OB81 in this case.
The event "At least one backup battery of central controller is empty" (16#21,
BATTF) is only active when one of the batteries fails (in the case of redundant
backup batteries). Now, if the other battery fails too, the event does not occur
again. Only a complete failure of the backup batteries leads to OB81 with the event
"Backup power supply of central controller empty/removed" (16#22, BAF).
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5 Configuring Networks

5.1 Basics

5.1.1 Connection of PROFIBUS PA devices

Entry ID: 39675 - Date: 05/15/1997

QUESTION:
How are the PROFIBUS PA devices connected?

ANSWER:
With a PA link module or a PA coupler mounted in the switchroom. 8 to 10 PA field
devices can be connected per module or coupler.

5.1.2 COM Port in PCS 7 can no longer be addressed

Entry ID: 776180 - Date: 03/24/1999

QUESTION:
After installing PCS 7, a COM port can no longer be addressed. What should I do?

ANSWER:
With WinCC you can configure a serial link that is set up when you install WinCC.
In this case a COM port is reserved or occupied, even if there is at the moment no
current serial WinCC link established. You should, therefore, only install this serial
link with WinCC when you actually need it. You can subsequently deinstall it, in
which case the occupied COM port is again released for other applications.

Proceed as follows:

1. In the Windows NT Control Panel you must start the Software tool and double-
click the entry SIMATIC WinCC Windows Control Center V4.02 in the Install/
Uninstall tab of the Add/ Remove Programs Properties dialog box.
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2. Now the WinCC Setup program starts and the "Uninstall/ Add" dialog box
opens. In this dialog box you must click the first button Do you want to
remove parts of WinCC or add them to the installation?.



Configuring Networks

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 5-3

3. The "Select Components" dialog box opens.
In this dialog box you must click the component Communication.

! Warning

Do not select the check box, that will select all the Communication options. Just
click the text "Communication". On the right All the currently installed components
for WinCC are then listed on the right. If the check box of the "AS511-NT" option is
checked, then WinCC has occupied a serial COM port.

4. Now you must clear the check box and complete the Setup by pressing the
Next button.
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5. Finally, you should reboot the computer. In this way you deinstall the
"AS511-NT" option and the serial COM port is once again free for other
applications.

5.1.3 Installing the 3COM card after PCS 7

Entry ID: 997755 - Date: 08/11/1999

QUESTION:
Why can’t the 3COM card be retro-installed?

ANSWER:
If you want to use a 3COM card in conjunction with PCS 7, then you must install it
on your computer before PCS 7. If PCS 7 is already installed on the computer
concerned, then you must deinstall it before you can install the 3COM card.
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5.2 FMS

5.2.1 Maximum message length with FMS link

Entry ID: 1936508 - Date: 02/25/2000

QUESTION:
How many bytes of data can I transfer with an FMS link?

ANSWER:
With an FMS link from WinCC to a controller you can transfer a maximum of 233
bytes in one message. You should bear this in mind in particular when using
arrays or structures.

5.2.2 Restrictions of the FMS channel

Entry ID: 2361825 - Date: 06/06/2000

QUESTION:
Which restrictions should I watch out for when implementing the FMS channel in
WinCC?

ANSWER:
If you implement the WinCC FMS channel, then you must note the following
restrictions:

• You cannot write any bits/ bytes. The procedure for accessing a bit is
described in Entry ID 1021365.

• WinCC is always the active communication partner. No active read/write jobs
can be sent out by the controller.

• Implementation in conjunction with an S5 controller:
The "octet string" must be set in the NCM diagnostics. The settings "Visible
String" and "Binary String" give no results.
(There is only one "S7 String" available for the S7.)

• Implementation in conjunction with an S7 controller:
It is not possible to access the FMS variables via names. The variables can
only be addressed via indices.
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5.3 OML

5.3.1 Configuring the PROFIBUS bus parameters with STEP7 using
OLMs version V3

Entry ID: 1995199 - Date: 03/14/2000

QUESTION:
How should I adapt the PROFIBUS bus parameters with STEP7 using OLMs
version V3?

ANSWER:
You have to adapt the PROFIBUS bus parameters accordingly using OLMs
(Optical Link Modules) version V3. The reasons for this are message delays
through cables and network components, as well as monitoring mechanisms in
the network components. When programming the PROFIBUS network parameters,
therefore, you must adapt the slot time to the reach of the network, its topology
and the data rate. If you configure the slot time with a value that is too low, this can
lead to error functions and error displays on the OLM (the system LED blinks red/
green).

Here you must distinguish between two types of network topology:

Line or star structure

The number of OLMs implemented and the total length of the fiber-optic cables are
entered in the appropriate mask in STEP7. Then the required slot time is calculated
and adjusted where necessary.
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Redundant optical ring

You must calculate the necessary slot time yourself and manually correct it in the
bus parameter settings in STEP7.

Required steps for configuring:

1. Configure the PROFIBUS users as usual with HW Config (in the SIMATIC
Manager) or NETPRO.

2. Configure the PROFIBUS network as usual:
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3. Calculate the slot time using the following formula:

Slot time = a + (b * fiber-optic cable length) + (c * number of OLMs)
where:

• "Slot time" is the monitoring time in bit times.

• "Fiber-optic cable length" is the total length of all the fiber-optic cables
(segment lengths) in the network. The length is given in kilometers.

• "Number of OLMs" is the number of the PROFIBUS OLMs in the network

The factors a, b and c depend on the transmission rate and on the bus profile
selected. They are listed in the following table.

Pure DP mode (DP bus profile):

 Data rate  a  B  c

12 Mbit/s 1651 240.000 28

6 Mbit/s 951 120.000 24

3 Mbit/s 551 60.000 24

1.5 Mbit/s 351 30.000 24

500 Kbit/s 251 10.000 24

187.5 Kbit/s 171 3.750 24

93.75 Kbit/s 171 1.875 24

45.45 Kbit/s 851 0.909 24

19.2 Kbit/s 171 0.384 24

9.6 Kbit/s 171 0.192 24
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Combined DP/FMS mode (Universal bus profile):

 Data rate  a  B  c

12 Mbit/s 1651 240.000 28

6 Mbit/s 951 120.000 24

3 Mbit/s 551 60.000 24

1.5 Mbit/s 2011 30.000 24

500 Kbit/s 771 10.000 24

187.5 Kbit/s 771 3.750 24

93.75 Kbit/s 451 1.875 24

45.45 Kbit/s 851 0.909 24

19.2 Kbit/s 181 0.384 24

9.6 Kbit/s 171 0.192 24

In case of doubt always select the greater slot time.

The following holds for both profiles:
With OLM/G11-1300 and with OLM/G12-1300 minimum slot times according to
the table below must be kept to with data rates of 12 Mbit/s, 6 Mbit/s, 3 Mbit/s and
1.5 Mbit/s.

 Data rate  Minimum slot time

1.5 Mbit/s 530 tbit

3 Mbit/s 1000 tbit

6 Mbit/s 2000 tbit

12 Mbit/s 3800 tbit

When configuring the slot time, use the minimum slot time if the calculated slot time
is less than the minimum slot time.

Notice

the slot time calculation only takes into account the fiber-optic cable network and
the connections of bus users to the OLMs over an RS 485 bus segment of a
length of maximum 20m. Longer RS 485 bus segments must be calculated in
addition by adding them to the fiber-optic cable length.
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Example:

The slot time for the above example is calculated as follows:
Total fiber-optic cable length = 500m + 2750m + 4250m + 1000m + 1500m =
10000m =10km
Number of OLMs = 5
OLM type: OLM-G12

Values from the DP bus profile table and the baud rate of 1.5 Mbit/s:
a = 351
b = 30.000
c = 24

These values give the following:
Slot time = 351 + (30.000 x 10) + (24 x 5) = 771

A minimum slot time greater than the calculated time does not have to be taken
into account, because no OLM G12-1300 has been implemented.

4. After calculation you must set the bus profile in STEP7 to User-defined:
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5. You must adapt the following parameters:

• Set the slot time according to the calculation under point 3 (in the example:
771 tbits).

• Set the Retry Limit to at least 3.

• Set Min TSDR to at least 11.
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You must then recalculate the bus parameters (button: Recalculate).

6. Check the HSA (Highest Station Address)

Finally you must check whether the HSA is at greater by at least one than the total
number of all the PROFIBUS users in the network. If not, you must adjust the
parameter accordingly.
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5.4 CP Industrial Ethernet

5.4.1 Connecting Industrial Ethernet communications processors with
an Industrial Ethernet OSM/V1 (optical switch module)

Entry ID: 1002445 - Date: 06/05/2000

QUESTION:
What should I watch out for when connecting Industrial Ethernet CPs with an
Industrial Ethernet OSM?

ANSWER:
An Industrial Ethernet OSM has 4 ITP ports and 2 fiber-optic ports. Here, all
Industrial Ethernet CPs can be connected via the ITP ports (Industrial Twisted Pair)
of the OSM. Make sure that the operating mode of the ITP ports is set to half
duplex, because at the moment, all the CPs except for CP 1613 support this
operating mode only. This holds both for the PC modules and AS modules.

! Notice

Pay attention to the special features when connecting CPs via the AUI interfaces.
An AUI interface on its own does not support Twisted Pair. However, for proper
functioning, it is decisive whether the individual modules on the AUI interface each
have an ITP transceiver. For example, you can connect the widely-used PC
module CP1413 with an ITP cable to an OSM, but no electrical connection will be
set up.

Important
The CP 1413 has no integrated ITP transceiver.

For a link between OSM and CP1413 there must be an additional TPTR plug-in
transceiver (MLFB: 6GK1100-0BA00) mounted on the CP 1413. This does the
conversion from AUI to Twisted Pair.

The following modules can be connected without a TPTR:

• CP 1430 xxx

• CP 343-1 xxx

• CP 443-1 xxx

• CP 1401

• CP 1411

• CP 1511

• CP 1613
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The following modules cannot be connected without a TPTR:

• CP 1473 MAP

• CP 143

• CP 1413

You must not use a crossed cable to connect the two devices, because the ITP
interface of the OSM/V1 is a terminal interface. Information about the crossed
cable (crossing of send and receive line) is given in the FAQ with entry ID 771421.

5.4.2 Possible block transfer sizes with SEND/RECEIVE

Entry ID: 187029 - Date: 03/17/1999

QUESTION:
What are the block sizes you can transfer with a job with the different connection
types for SEND/RECEIVE?

ANSWER:

SEND/RECEIVE can be implemented via the following connection types:

• ISO transport connection

• ISO-on-TCP connection

• UDP connection

Here the block transfer sizes depend on the block used and the connection type.
The following blocks are available for data transfer:

• FC 5 (AG_SEND)
FC 6 (AG_RECV)
Transfer of data up to 240 bytes

• FC 50 (AG_LSEND)
FC 60 (AG_LRECV)
Transfer of data up to 8192 bytes

The following data blocks can be transferred via the following connection types:

 Connection  Block size

ISO transport connection (1 ... 8192) bytes

ISO-on-TCP connection (1 ... 8192) bytes

UDP connection (1 ... 2048) bytes
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5.4.3 Link between the OSM V2 and the Industrial Ethernet CPs 343-1
and 443-1

Entry ID: 1936979 - Date: 02/25/2000

QUESTION:
What should I watch out for with the link between the OSM_V2 and an Industrial
Ethernet CP, and where might there be problems?

ANSWER:
OSM_V2 (Optical Switch Module) and the Industrial Ethernet CPs all have the
functionalities Autonegotiation and Autosensing.

"Autosensing" is the capability of automatically recognizing the data
transmission rate. The module can determine whether the signals are being
transmitted at a rate of 10 Mbit/s (Ethernet) or 100 Mbit/s (Fast Ethernet).

"Autonegotiation" is the capability of negotiating a transmission medium. The
data transmission rate here is negotiated in conjunction with the transmission
method.

For the transmission method there are 2 options:

• Half duplex:
The data exchange can be bidirectional. On one transmission link between 2
components data transport is only possible in one direction at any one time.
If, for example, a message is sent from A to B, the user B can only send to
user A when user A has terminated his Send process.

• Full duplex:
The data exchange can be bidirectional. On one transmission link between 2
components both users can send independently of each other.
A message can be sent simultaneously from A to B and vice versa. There is a
separate pair of lines for each sending direction.

The OSMs with the MLFB numbers 6GK1105-2AA00 (OSM ITP62) and 6GK1105-
2AC00 (OSM ITP62-LD long distance) support the following operating modes:

• 10 Mbit/s (Half duplex)

• 10 Mbit/s (Full duplex)

• 100 Mbit/s (Half duplex)

• 100 Mbit/s (Full duplex)

The module CP 343-1 (6GK7 343-1EX10-0XE0) and the module CP 443-1 (6GK7
443-1EX10-0XE0) support the following operating modes:

• 10 Mbit/s (Half duplex)

• 10 Mbit/s (Full duplex)

• 100 Mbit/s (Half duplex)

Principles of the mechanism for negotiating the operating mode:
If a CP is connected to an OSM_V2, the Autonegotiation mechanism is triggered
in the start-up phase of the CP. Here the CP first attempts to negotiate the fastest
and most effective operating mode. In this case it is the operating mode
"100 Mbit/s (Half duplex)". This negotiation is done through the exchange of
hardware link pulses.
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Since the OSM_V2 supports the proposed operating mode, it will accept it. The
OSM_V2 will then operate the appropriate port and the CP the appropriate
interface with the operating mode "100 Mbit/s (Half duplex)". The communication
can now be operated without a problem until there is a power failure or the network
structure is reconfigured. In such cases there usually follows rewiring, restarting of
the modules and thus a new autonegotiation mechanism.

Possible problem case:
The behavior described above always works on the same principle. This means
that both communications partners should always agree on the operating mode
"100 Mbit/s Half duplex".

There is however a special case which should be noted:
If one of the CPs 343-1 or 443-1 is to linked with an OSM_V2, it might happen that
the components agree upon the operating mode "10 Mbit/s (Half duplex)". This is
the minimum possible operating mode.

Explanation:
The operating mode is set when one of the CPs starts up (e.g. after a brief power
failure). Another requirement is that the OSM_V2 doesn’t start at all or only after a
delay. In this case the CP attempts to negotiate the operating mode using the link
pulse. But the OSM_V2 is not ready and therefore doesn’t respond. The
consequence is that the CP sets its LAN controller to the default operating mode of
"10 Mbit/s Half duplex".

Now when the OSM_V2 starts up and also attempts to negotiate the operating
mode, it is set to this operating mode by the CP’s LAN controller that is already set.
The communication continues to function perfectly, but with the less efficient
minimum operating mode of "10 Mbit/s (Half duplex)".

Conclusion:
If the LAN controller of the CP is set to a transmission rate after start-up, the setting
cannot be changed without restarting the module.

Remedy:
You must make sure that the OSM_V2 is already in operation before one of the
CPs starts up.
When this is ensured, the operating mode can be negotiated to "100 Mbit/s (Half
duplex)" as desired.

Modules affected:

• CP 343-1 (6GK7 343-1EX10-0XE0)
Firmware release: V1.0

• CP 443-1 (6GK7 443-1EX10-0XE0)
Firmware release: V1.0

Note

If the firmware is updated in the course of troubleshooting, this behavior is
changed so that in the case described above the required maximum operating
mode is negotiated in the same manner.
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5.4.4 Replacing S7-400 CPU keeping the CP data and subsequent
loading of the CPU via Industrial Ethernet CP in PCS 7 version
V4.xx

Entry ID: 1972934 - Date: 03/13/2000

QUESTION:
How can I replace the S7-400 CPU so that the Industrial Ethernet CP keeps its
data in order to load the new CPU via the CP?

ANSWER:
If you want to replace the CPU and then load the new one via Industrial Ethernet
CP, you must make sure that the parameters of the CP are stored on the CP.
Modules must be replaced only when the AS is in a deenergized state. Check the
battery back-up beforehand.

Procedure:

1. To ensure that the CP keeps its parameters when replacing the CPU, you must
make the following settings in the CP Properties:
In the HW Config select the Industrial Ethernet (I.E.) CP and then Edit >
Properties. In the Options tab under "Replace module without PG" deactivate
the option Save configuration data in the CPU.

With CPs that do not support this functionality the CP parameters are saved on the
CP as a system default.
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2. Compile the changes with Station > Save and compile.

3. Load the changes made into the CPU via Target system > Load in module.

4. Behind the cover of the power supply module is a switch with 3 positions
(BAT1 OFF BAT2). Set this switch to BAT2. Observe the LEDs BATF; BAT1
and BAT2. If, when you switch to BAT2, one or more of the LEDs starts to light,
then replace the buffer batteries. Then check the battery function again.

5. Switch off the power.

6. Replace the CPU (incl. MEMORY CARD)

7. Switch the power on again.

8. The CP should start up again.

9. The CPU now requests an internal overall reset and after that it is ready for
operation.

10. Now you can reload the CPU via Ethernet.

5.4.5 Consistency system data block (SDB 1xxx Type 3118) with the
CPs 443-1xxx and 343-1xxx for PCS 7 version V5.x

Entry ID: 770487 - Date: 03/17/1999

QUESTION:
What is the consistency system data block and what is its function?

ANSWER:
The system data block only exists with CPs that support the "Module replacement
without PG" function. Here, with STEP7 V5.0 and higher, the SDB is also only
generated if the relevant function is activated when configuring.
The function of each SDB is unambiguously defined by marking a type. The
corresponding number is organized by STEP7 and can change when the system
data is generated. The consistency SDB has the type 3118. This is always the
same and only available once for each CP.

In the case of module replacement without PG, the SDBs are stored in the CPU
after the hardware configuration has been loaded. The CPU then distributes the
blocks to the relevant CPs. These SDBs also include the consistency SDB.
Entered in this consistency SDB are all the valid SDBs for the CP with the
appropriate time stamp in each case. If, after reloading the CPU, you again
transfer SDBs to the CP, the CP only accepts those SDBs that are entered in the
consistency SDB. If the CP receives an SDB with a time stamp that matches one
that is already stored, then it doesn’t accept it, because it is already there.
Furthermore, an unknown SDB that is sent to the CP by mistake is rejected and not
put into sequence.

The consistency SDB prevents inconsistencies and avoids error functions.



Configuring Networks

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 5-19

5.4.6 Operating modes Simplex, Half Duplex and Full Duplex in the
communications world and with SIMATIC NET

Entry ID: 771582 - Date: 03/22/1999

QUESTION:
What are the operating modes Simplex, Half Duplex and Full Duplex, and what do
the SIMATIC NET modules use?

ANSWER:
In the communications world a rough distinction is made between the three above-
mentioned operating modes.

• Simplex mode
In the Simplex mode the information flows in one single direction. The
information flow is unidirectional. One station is always the sender and the
partner station is always the recipient. Examples of this are radio and
televisions.

• Half Duplex mode
In the Half Duplex mode the information can flow in both directions
(bidirectional). This however can only be done in one direction or the other at
a time and not simultaneously. Each partner can send and receive. When
one partner is sending, the second must remain in receive mode and vice
versa. Technically, each station has send and receive equipment (transmitter
and receiver that form the transceiver). Transmitter and receiver cannot be
operated at the same time.

• Full Duplex mode
In the Full Duplex mode the information can also flow in both directions. But in
this case each station can send and receive simultaneously. The transmitter
and receiver can be operated at the same time and independently of each
other. Generally, separate physical transfer media are used, i.e. one line is
used exclusively for sending and another exclusively for receiving.

The SIMATIC NET communications processors use the Half Duplex mode. This
is the default operating mode.
The OSMs (OSM = optical switch module) operate in Full Duplex mode on the 100
Mbit/s fiber optic backbone network.
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5.4.7 Autosensing and autonegotiation in the Fast Ethernet technology

Entry ID: 816064 - Date: 04/26/1999

QUESTION:
What is to be understood by the terms "Autosensing" and "Autonegotiation" that
are always used in conjunction with the Fast Ethernet technology?

ANSWER:
Terms:

• Autosensing:
Autosensing describes the property of network components to interpret an
incoming transfer signal automatically. Here, the device determines itself
whether the signal has a data rate of 10 Mbit/s or 100 Mbit/s. It is therefore not
necessary to make any explicit sittings as to whether the device is to be
operated with Fast Ethernet or Standard Ethernet.

• Autonegotiation:
Autonegotiation designates the configuration protocol for Fast Ethernet. It
makes it possible for the devices concerned to negotiate the transfer conditions
before the transfer of a data packages. Here, both the transfer rate 10 / 100
Mbit/s and the transfer type are negotiated. The available transfer types are
Half Duplex and Full Duplex.

If you want to guarantee a specific transfer type, you can also deactivate the
"Autonegotiation". In this way Ethernet components with different properties can
communicate with each other.

Older devices that do not support Autonegotiation (Industrial Ethernet OLM) can
also communicate with the Fast Ethernet components.

5.4.8 Installation of the CP1413 under Windows NT

Entry ID: 830817 - Date: 04/26/1999

QUESTION:
What should I watch out for when installing a CP1413 under Windows NT?

ANSWER:
The following procedure is best for installing the CP1413 under Windows NT:

1. Before building in a plug-in card for an ISA slot, you must first check the free
resources of your computer.
For this you should call the Windows NT diagnostics (Start > Programs >
Management(General) > Windows NT diagnostics). Compare the values
here for IRQ, I/O Port and Memory with the possible values of the CP1413
(Installation Instructions). Note the free areas of the system that the CP1413
can also use.
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2. Now you can build in the card and install it as PG/PC interface.
(Start > Settings > Control Panel > Setting the PG/PC interface)
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3. The values determined but not yet assigned should now be entered here. After
entering the values you can close the dialog boxes and select the access path
(PCS 7 Standard: S7ONLINE (STEP7) --> CP1413). You then get the following
message:

4. Acknowledge with OK. If the restart is successful, you can then communicate
using this access path.

5. If you get an error message during the restart or other warnings from the
operating systems, there are several other options for clearing the cause.
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6. Acknowledge with OK. Now perform a cold restart of the computer. Then you
must check the entry of the CP1413 card in the Resources, i.e. the
appropriately set values of the CP1413 must be seen to be entered (see first
figure).

7. If this entry is not contained, there are still memory area and/or address
conflicts. Therefore you must check in the BIOS whether the IRQ used by the
CP1413 is released (when you start the computer press F2 > Advanced >
PCI Configuration > ...Resource Exclusion). In some BIOS versions you
have the option of reserving the IRQs for ISA slots. This would be suitable
here.

8. With these setting options it should be possible to retain the entry of the
CP1413 in the Resources (see first figure), because this is the basic
requirement for proper functioning.

9. If the entries are retained, you can test the access path (...Setting the PG/PC
Interface > Select CP1413 > Properties > "Mode" tab > Reset > Restart >
Test)
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10. If the CP1413 works now, you still have to assign an unambiguous Ethernet
address. For this click the "Ethernet (MAC) Address" tab and enter the address
in the appropriate field.
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11. If it doesn’t function properly despite assignment of resources through the
CP1413, then you can remedy the situation by deinstalling and then reinstalling
the CP1413 in the PG/PC interface.

5.4.9 Operating modes of the Industrial Ethernet OSM/V1

Entry ID: 897664 - Date: 06/29/1999

QUESTION:
Which operating modes are supported by an Industrial Ethernet OSM/V1 (optical
switch module) on which port?

ANSWER:
An Industrial Ethernet OSM has 4 ITP ports and 2 fiber-optic cable ports:

• The fiber-optic cable ports are for configuring a 100-Mbit/s fiber-optic cable
backbone network. The default operating mode here is FDX (full duplex) and
cannot be changed. In "Full Duplex" mode a station (OSM) can send and
receive simultaneously. This is implemented by networking the OSM via a
dual-line fiber-optical cable. One line is only for sending, the other only for
receiving. The function of a fiber-optic cable line is defined by the cabling. The
send and receive connections of the neighboring OSM in one cable must be
connected diagonally opposite. For this the send connection must be
connected to the receive connection of the neighboring OSM.
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• The ITP ports (Industrial Twisted Pair) have a transfer rate of 10 Mbit/s. Here
the operating mode is factory-set to HDX (Half Duplex). This is the standard
operating mode of the Industrial Ethernet CPs (CPs up to 10/99 - then Full
Duplex mode is possible). You can however use DIP switches to change to
FDX (Full Duplex) mode. With the switch setting "FDX = 0" the "Half Duplex"
operating mode is activated. Furthermore, the green "FDX" LED only lights
when "Full Duplex" mode is activated.

! Notice

If you switch to "Full Duplex" operating mode, this is valid immediately for
all 4 ITP ports.

5.4.10 Redundant communication with two CP1613s for PCS 7 version
V5.x

Entry ID: 2361347 - Date: 10/16/2000

QUESTION:
How can I set up redundant communication with two CP1613s in PCS 7?

ANSWER:
Proceed as follows to set up redundant communication with two CP1613s in
PCS 7:

Step 1: Hardware settings

The CP1613 is a Plug&Play card and therefore requires no hardware settings
(jumperless). You do not have to activate the "Memory Gap" function in the PC
BIOS.

Step 2: Setting the PG/PC interface

1. Install the CP1613 (RFC1006) twice. The resources are set automatically.

2. Connect the access path "CP_H1_1" with "CP1613(ISO)" and the access
path "CP_H1_2" with "CP1613(ISO)<Board 2>".

3. Press the Properties button and in the window that opens set the MAC
addresses of the network cards.

Step 3: Configuring the redundancy

1. Configure H system via the PCS 7 Project Wizard. Here you must check
whether in the Properties of the CP443-1 the "Ethernet profile for high-
availability connections, activate quick switching of connections" is
activated.

The two Ethernet CPs in the controller must be located in different
subnetworks and thus also be physically separated.
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2. Furthermore, you must not used any TCP/IP protocol, because the timeout of
this protocol (60 sec) cannot be used for a redundant system.

3. If you have created the project using the Project Wizard, you must delete the
OS created by default, because it cannot be used for the redundant
communication.

4. Add a "SIMATIC PC Station" in the SIMATIC Manager.

5. Open the SIMATIC PC Station and via the Configuration key add a WinCC
application. The application there by default should be deleted to prevent the
danger of any confusion when configuring connections.

6. In the SIMATIC PC Station you must configure the CPs of the OS that are to
be used.

7. For this you must add the CPs to the configuration and in the
Properties/Assignment tab you must do the assignment to the interface
parameterization used (ISO).

Furthermore you must assign the appropriate subnetworks to the CPs. For this
you select in Properties the "General" tab and under Interface you click the
"Properties" button. In the dialog that opens you go to the "Parameters" tab
and assign the appropriate subnetwork to the CP1613.

8. Here you might have to change CP1613 to CP1613(ISO) and
CP1613<Board2> to CP1613(ISO)<Board2> (the text must correspond to the
device name from the configuration in the PG/PC interface list). If a change is
not made, then the CPs are always displayed as crossed out in the PG/PC
interface settings under "STEP7 configuration". They are then not available.

Step 4Configuring connections in NetPro

In NetPro you must configure an H connection between the H station and the
SIMATIC PC station. Select H-CPU and create a new connection as follows:

1. Station: select the name of the SIMATIC PC station.

2. Application: select the name of the WinCC application.

3. Type: select "High-availability S7 connection".

Note

If the default application is deleted, then there is only one application here.

Alternative:
Alternatively you can configure the connections with OS marked. For this you must
make the following settings:

1. Station: select "SIMATIC H station".

2. Module: select "CPU417-4 H/CPU417-4 H".

3. Type: select "High-availability S7 connection".
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After saving and compiling you can use the configuration in "Set PG/PC
interface". For this you must select the "STEP7 Configuration" tab in the
interface setting and select the configuration file from the "DRIVE:\...\Project
name\XDBs\*.xdb" directory. Then both CPs are displayed in the "Interface
parameters used" window.
For more information see the WinCC Help (Find > H/F System).

Now you can load the hardware configuration, the program and the connections
into the controller.

Transferring connection data:

Map to the connection name from NetPro ("Subnetwork type " column and WinCC
Unit = "Named Connections").
After mapping, the XDB file is also available in the OS directory, so that the
reference in the PG/PC interface setting can updated under "STEP7 configuration".

Server / Multiclient:

1. Copy the project with WinCC Project Duplicator from the engineering station to
the server and the multiclients.

2. You must create the packages on the servers and load these packages onto
the multiclients.

3. With redundant servers you only have to load the package of one server onto
the multiclients, because the information about the redundant servers is
contained in the packages through the redundancy configuration.

Connection diagnostics:

You can diagnose the redundant connection via the menu "Simatic/SIMATIC
NET/S7 Connection Diagnostics".

5.4.11 Time synchronization for PCS 7 V5.x via CP1613

Entry ID: 2416068 - Date: 11/03/2000

QUESTION:
In PCS 7 V5.x, how can I configure the time synchronization via a CP1613
(Industrial Ethernet)?

ANSWER:
Proceed as follows to configure time synchronization via the CP1613:

Notice

If you want to configure the CP1613 as time master, then you need the HotFix1 for
SIMATIC PCS 7 OS V5.0 + SP1. The HotFix can be found on the Internet pages
of SIMATIC CUSTOMER SUPPORT under the Entry ID 2326215.
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1. Open the SIMATIC Manager.

2. Open the hardware configuration of your station.

3. Right-click the CP 443-1 and select "Properties...". In the "Options" tab the
command "Activate time synchronization" must be enabled. If you have
several stations, you must execute this step for each CP.
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If you want to define one or more automation systemss as time master, then
proceed as follows:

4. Right-click the CPU and select Properties.... In the Diagnostics/Clock tab the
CPU is selected as clock master. You must set the synchronization interval in
the CPU to "1s".
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If you want to use more auomation systems, you can also use them "As master"
or "As slave".

5. If you use an external time transmitter or a PC is to be clock master, you must
set "As slave" for all CPUs.
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Now you must set the following in the WinCC Explorer of each computer to be
synchronized:
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6. Open Time Synchronization in the Control Center and select the required
logical device (CP1613(ISO)).
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7. Make the relevant settings depending on whether the PC is to function as clock
master or clock slave.

8. Check whether the application "CCTMTimeSync.exe" has been inserted in
the runtime properties of the computer. If not then add it.



Configuring Networks

Process Control System PCS 7, Tips and Tricks
5-36 A5E00080064-01

9. Finally you must make a few settings for the CP1613 in the PG/PC interface.
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10. Click Diagnostics and under "IE Network Diagnostics" select Time
Synchronization.
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As soon as a valid time is transferred to the CP 1613, this time is displayed in the
Time field with the comment synchronous.

Note

If the PC is used as clock master, it might happen that the time is displayed as
"not synchronous". Time synchronization should nevertheless function in this
case.
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5.4.12 Installation/Configuration of the CP 1413

Entry ID: 388442 - Date: 07/24/1998

QUESTION:
The CP 1413 is not recognized by the system. What should I do?

ANSWER:
The following settings have proven to be reliable for installing a CP 1413:

IRQ: Generally a free interrupt is required (preferably IRQ 10)

I/O area: 03E0 - 03E7 (a jumper between 1-2 and 3-4 is to be slotted at switch X3
on the card)

Memory area: 00F00000 - 000EFFFF

Notice

If, after installation and reboot of the computer, the following error messages is
issued:
"Resources (F segment, I/O 3E0, IRQ 10) are already being used by other
components", then perhaps simply rebooting Windows NT is not sufficient to
completely reset the CP1413.

Remedy: power down the computer and leave it turned off for at least 20 seconds.
Only then will the system correctly recognize the CP1413.

5.5 CP Profibus

5.5.1 FMS Broadcast support

Entry ID: 897564 - Date: 06/29/1999

QUESTION:
Do SIMATIC NET CPs support the "FMS Broadcast" function?

ANSWER:
The "FMS Broadcast" function is supported by the following CP and firmware
releases:

• CP443-5 Basic release 8 and firmware version V2.20 and higher

• CP343-5 release 3 and firmware version V2.20 and higher

! Warning

If you load a FMS Broadcast configuration for older releases (CP or firmware),
there is malfunction of the CP.
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5.5.2 Time synchronization via PROFIBUS with CP5412 (A2) V4.X

Entry ID: 372737 - Date: 06/13/2000

QUESTION:
Can I do time synchronization via PROFIBUS with PCS 7 V4.x?

ANSWER:
Yes, this is possible.
You can set the time via PROFIBUS with the CP5412 (A2).
In the following document we describe how to set the CP5412, how to set the
synchronization in the Control Center V 4.x under WinCC and how to define a time
receive utility (e.g. DCF77 or GPS).

uhrsyn1_e.pdf (665 KB)

5.5.3 Installation/Configuration of the CP 5412 A2

Entry ID: 674986 - Date: 12/04/1998

QUESTION:
The CP 5412 is not recognized by the system. What can I do?

ANSWER:
Open the PG/PC interface and check whether under ’Access point of the
application’ ’S7ONLINE (STEP7)’ is set for the CP 5412 A2.

Then press the ’Install’ button and select the CP 5412 A2 in the left window.

Check the resource settings of the CP using the following table:

 IRQ Generally a free interrupt is necessary.

 I/O area The I/O area depends on the setting of the DIP switch on the module. The standard
setting of the module is ’OFF-OFF-OFF-OFF’. This corresponds to the I/O area 240-243.

The I/O areas for other DIP switch settings are to be found in the installation instructions
for the CP5412.

 Storage area Generally a free storage area is necessary.
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5.6 Field Devices

5.6.1 Incorporating new LINK modules in PCS 7 V4.02

Entry ID: 2121195 - Date: 04/20/2000

QUESTION:
How can you incorporate new LINK modules (6ES7157-0AA**-0XA0) in PCS 7
V4.02?

ANSWER:
For configuring the modules you need the device master file "siem8052.gs*". This
file can be found on the Internet page of SIMATIC Customer Support under
"PROFIBUS GSD Files / LINK". On this page you will find several language
versions of the file and the associated bit maps. Open the HW Config and close
any hardware configurations. Then select Tools > Install new GSD... and
incorporate the new GSD file in your catalog. Update the hardware catalog via
Tools > Update catalog. The LINK module is now located in the hardware catalog
under "PROFIBUS DP/More FIELD DEVICES/Gateway". Under the actual device
are all the slaves that can be operated with the LINK.

The figure shows a possible configuration.
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Configuring the DP/PA link is different to the normal procedure for PA slave
interfacing. This is why we have given a few explanations below.

The first usable PA address can be the address 3. For this the device must be in
slot 0. Slot 0 always has the address 3 in the field. Slot 1 then has address and so
on. In the example given there are no addresses 3 and 4. For error-free
communication, however, you must still always configure the slots.

Each slave that occupies a slot is called a "simple slave". Here, for example, a
SITRANS P is used with the PA address 5. All PA slaves that occupy more than
one slot in the HW Config are called "complex slaves". In these cases a "Begin
Element" must be configured first with the name of the device. The first slot used
also mirrors the address in the field. The SITRANS PS2 has the PA address 7 on
the bus starting at slot 4. The desired functions are configured in the next slots and
the complex slave is terminated with an "End Element". With the first complex
slave used the linear addressing can no longer be implemented, because the next
free slot after the complex slave automatically contains the next PA address. For
this example, this means that the E+H PROMAG 33 has the PA address 8. By
chance its configuration also starts at slot 8. If, in the previous module, only 3
functions had been configured, then the E+H PROMAG 33 would have got slot 7
but still have received the PA address 8.
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In the case of the PROMAG you must note that the number of possible functions is
the same as the number of functions configured. The E+H PROMAG 33 has 3
functions. This is why three slots are occupied. If a functionality is not wanted, then
the "==Free Place" element must be used (see example). Furthermore you must
make sure that all functions are slotted in the order given in the catalog. This
sequence cannot be changed. The next slave can be configured on slot 13 and
then has the bus address 9.

5.6.2 Configuration of PA field devices with PDM via Industrial Ethernet

Entry ID: 2253966 - Date: 05/22/2000

QUESTION:
How can I configure my field devices with PDM via Industrial Ethernet?

ANSWER:

If you want to parameterize PA field devices with your PG/PC via an Industrial
Ethernet bus, then the following hardware and software requirements must be met:

Hardware:

• CP443-5 Extended with firmware V3.0 (6GK7 443-5DX02-0XE0)

• CP443-1 with firmware V5.0 (6GK7 443-1EX02-0XE0)

• CP1413 or CP1613 (ISO) for Industrial Ethernet

Software:

• PCS 7 V5 SP1

Proceed as follows to configure:

1. Open the HW Config and configure a SIMATIC 400 station with the hardware
you are using.

2. Insert a CP443-5 Extended V3.0 (6GK7 443-5DX02-0XE0) and a CP443-1
(6GK7 443-1EX02-0XE0) into the station.

3. Open the Properties of the CP 443-5 Extended and in the Operating Mode tab
set the CP as DP Master.
In the Options tab and activate the Activate data record gateway option in
the Parameterize field devices (data record routing) field.

4. For the CP443-1 there are no settings required for the routing.

5. Connect the DP/PA Link to the CP443-5 Extended via a PROFIBUS cable.
Connect your PROFIBUS PA field devices with the DP/PA Link.

6. Via Set PG/PC interface set the Ethernet CP (CP1413 or CP1613) as access
point for your application.



Configuring Networks

Process Control System PCS 7, Tips and Tricks
5-44 A5E00080064-01

7. In the SIMATIC Manager insert a PG/PC alongside your S7-400 stations. Open
the Properties of the PG/PCs and in the Interfaces tab create a new Ethernet
interface. Link this up with the existing Ethernet of the CP443-1. In the Assign
tab you assign the Ethernet interface just created to the CP1413 or CP1613.
Switch the S7ONLINE access to active.

8. Open NETPRO and compile the configuration. Your project from the SIMATIC
Manager into the CPU. Set the PROFIBUS address on the field device
corresponding to the setting in the HW Config. Start the PDM tool by double-
clicking the field device in the HW Config.

9. You are now in a position to parameterize your PA field device via the
Industrial Ethernet, PROFIBUS DP and PROFIBUS PA.

5.6.3 Statuses of the outputs of the ET 200M with CPU STOP

Entry ID: 39703 - Date: 05/27/1997

QUESTION:
What statuses can the outputs of the ET 200M have with CPU STOP?

ANSWER:
The behavior of the outputs is parameterizable on the S7-300 modules (outputs
are de-energized, hold last value or transfer configurable default value).
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5.6.4 PCS 7/ AS SIMOVERT for PCS 7 version V4.02

Entry ID: 624931 - Date: 11/26/1998

QUESTION:
How do I start up a SIMOVERT?

ANSWER:
The following instructions are for starting up the SIMOVERT Master Drive, Servo
Control in conjunction with PCS 7 and WinCC .
More information is available in the on-line help and in the instruction manuals.

1. Settings on the SIMOVERT
SIMOVERT can exchange data with the DP master via the bus. In order for the
SIMOVERT to be able to use bus communications you must enter the following
bus parameters using the hand-held controller or the PC:

- Bus address (here: 18)

- Baud rate (here: 187,5kBit/s)

- Base type (here: PPO-TYP 2)

The individual settings are given in the instruction manual. With the PC you can
make the settings via the COM-PROFIBUS software. For this you need a floppy
disk with the device master data files (GSD).

2. Configuring in PCS 7

Open S7 from the desktop or from the Start bar

Figure 1
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- Create project and assign S7400 Station

- Double click the icon to open the hardware catalog

- Configure the DP master system (e.g. CPU 414-2 DP) and set the user
address of the DP master to 2, with a transfer rate of 187.5 Kbits/s
(Figure 1)

- From the hardware catalog under PROFIBUS-DP \ SIMOVERT link
MASTERDRIVES CB1 to the master system

- When querying PPO 2: select 4 PKW I 6 PZD (example) (Figure 2)

Figure 2

Set SIMOVERT to user address 18 (Figure 3)
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Figure 3

Also make sure that the I/O addresses on the module have the same values as
shown in Figure 4.
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Figure 4

3. Insert block FB 194 into the project

- Create plan container, create CFC plan.

- First import FB 46, copy FB 194 into the project from the field device
library.

- Note presettings from the field device instruction manual, page 3-14
onwards.

- Parameterize INPUTS/OUTPUTS block as in Figure 5

- Map the project and create it in OS Faceplate with associated variables.
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Figure 5
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Assignment table for changing direction and speed

 Element  Left  Stop  Right  GSW 1  GSW 2

FW_OP_EN 1 1 1 1 1

RV_OP_EN 1 1 1 1 1

OFFOP_ON 1 1 1 1 1

L_FORW 1 1 1 1 1

L_REV 1 1 1 1 1

L_OFF 1 1 1 1 1

INCH_1EN 1 1 1 1 1

INCH_1EN 1 1 1 1 1

FORW_ON 0 0 1 0 0

MOT_OFF 0 1 0 0 0

REV_ON 1 0 0 0 0

INCH_1 0 0 0 1 0

INCH_2 0 0 0 0 1

 Element  Left  Stop  Right  GSW 1  GSW 2

FW_OP_EN 1 1 1 1 1

RV_OP_EN 1 1 1 1 1

OFFOP_ON 1 1 1 1 1

L_FORW 1 1 1 1 1

L_REV 1 1 1 1 1

L_OFF 1 1 1 1 1

INCH_1EN 1 1 1 1 1

INCH_1EN 1 1 1 1 1

FORW_ON 0 0 1 0 0

MOT_OFF 0 1 0 0 0

REV_ON 1 0 0 0 0

INCH_1 0 0 0 1 0

INCH_2 0 0 0 0 1
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Inputs/outputs on FB 194

 ELEMENT  TYPE  MEANING

ALLOC?IN BYTE Job ID

AUT_L BOOL Linkable input for selecting between MANUAL and
AUTOMATIC

AUTO_DIR BOOL 1=ON 2: switch on Option 2, counter-clockwise rotation
0=ON 1: switch on Option 1, clockwise rotation

AUT_ON BOOL AUTO Mode: 1=ON, 0=OFF

AUT_ON_OP BOOL Select operating mode 0=MANUAL/1=AUTOMATIC

AUTOP_EN BOOL Operating options upon enable AUTO (1: ENABLE)

AUX_PR06 ANY Additional value 6 for Interrupt_8P

AUX_PR08 ANY Additional value 8 for Interrupt_8P

AUX_PR09 ANY Additional value 9 for Interrupt_8P

AUX_PR10 ANY Additional value 10 for Interrupt_8P

BA_EN BOOL Batch enable

BA_ID DWOR
D

Batch ID

BA_NA STRING Batch Name

CLOCKW BOOL 1=clockwise rotation field

COUNT BOOL 1=Counter-clockwise rotation field

EN BOOL Active

FORW_ON BOOL 1=START, 1:switching on Option 1, e.g. clockwise

FW_OP_EN BOOL Select enable for clockwise

INCH_1 BOOL Switch on speed 1

INCH_2 BOOL Switch on speed 2

INCH_1EN BOOL Enable speed 1

INCH_2EN BOOL Enable speed 2

INV_EN BOOL Inverter enable

L_FORW BOOL AUTO mode: 1=switch on Option 1, clockwise

L_INCH_1 BOOL Switchable input to switch on the GSW 1

L_INCH_2 BOOL Switchable input to switch on the GSW 2

L_OFF BOOL AUTO mode: 1=switch off Options 1+2

L_RESET BOOL 1=error acknowledgment: error messages are reset if the
cause of the error is no longer present

L_REV BOOL AUTO mode: 1=switch on Option 2, counter-clockwise

LINK_MAN BOOL Selection for 1: linkable, 0: operator-controllable

LINK_MAN_INCH BOOL Selection for 1: linkable, 0: operator-controllable

LIOP_SEL BOOL Selection for value (1: linkable, 0: operator-controllable)

LIOP_SEL_SP BOOL Selection for value (1: linkable, 0: operator-controllable) (SP)

LOOK BOOL 1=switch off Option 1 and 2

LOWER BOOL 1=Lower motor potentiometer

MANOP_EN BOOL Manual operation enable (value transfer)

MOT_OFF BOOL Operator: motor 0=OFF
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 ELEMENT  TYPE  MEANING

MSG_EVID DWOR
D

News event ID

MSG_LOOK BOOL Message lock option

MSS BOOL Motor OFF

NO_FAULT BOOL 0=external fault 1

OCCUPIED BOOL Occupied by batch

OFFOP_EN BOOL Operator enable OFF

P_IND_IN BYTE Parameter index (IND)

P_NO_IN WORD Parameter number (PNU)

P_VAL_IN DWOR
D

Parameter value (PWE)

PAR_MODE BOOL 1=Parameter job

PLC_CONT BOOL 1=PLC controller

RACK_NO WORD User address of device in HEX

RAISE BOOL 1=Raise motor potentiometer

RAMP_EN BOOL Enable speed ramp

RAMP_ON BOOL Start up speed ramp

REMOTE BOOL 1=Automatic mode, 0=Manual mode

REV_ON BOOL 1=Switch on Option 2, counter-clockwise

RESET BOOL 1=error acknowledgment: error messages are reset if the
cause of the error is no longer present

RUNUPCYC INT Number of run-up cycles

RV_OP_EN BOOL 1=START, 1:switch on Option 1, e.g. clockwise

SP_EN BOOL Setpoint value enable

SP_EXT REAL External setpoint value (main setpoint value)

SP_OP REAL Manual input of setpoint value

SPEXON_L BOOL Switchable input for selecting the external setpoint

SPEXT_EN BOOL Enable for external setpoint

SPEXTSEL_OP BOOL 1=External, 0=Internal

SPINT_EN BOOL Enable for internal setpoint value

SPM_IN BOOL Spontaneous message

STEP_NO WORD Batch step number

SUBN_ID BYTE Master system ID

ALLOC BYTE Job recognition

ENO BOOL Block processing OK

MSG_ACK WORD INTERRUPT_8P: ACK_Status output

MSG_STAT WORD INTERRUPT_8P: Status output

P_IND BYTE Parameter index

P_NO WORD Parameter number

P_VAL DWOR
D

Parameter value

PV REAL Main actual value

SPM BOOL Spontaneous message processing
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 ELEMENT  TYPE  MEANING

QALARM BOOL 1=Warning

QAUTOP BOOL Status: 1=operation enabled for AUTO mode

QCOMP BOOL 1=Comparative frequency reached

QCONT BOOL 1=Main protection addressed

QDIR BOOL Clockwise rotation field

QERR BOOL Error

QFORW_OP BOOL Operation enabled for Option 1

QINCH1OP BOOL 1=Enable speed 1

QINCH2OP BOOL 1=Enable speed 2

QGR_ERR BOOL 1=Message: error is present

QLOCK BOOL 1=Message: lock time is running, switch command locked

QMAN_AUT BOOL Display bit for status MANUAL / AUTO

QMANOP BOOL Display bit for operator enable of the manual value

QMSG_ERR BOOL Display bit for Interrupt8P Error

QMSG_SUP BOOL Display bit for message suppression active

QMSS_ST BOOL Non-acknowledgeable motor protection switch

QOFF_OP BOOL 1=Operator enable OFF

QOP BOOL 1=Ready for operation

QOP_ERR BOOL Operating error

QPARF BOOL Display bit for operating error

QPARMODE BOOL 1=Parameter job

QPERAF BOOL Display bit for I/O access error

QPZD BOOL 1=I/O access control demand

QRACKF BOOL Display bit for rack error (user address)

QRAMP BOOL 1=Speed ramp active

QREMOTE BOOL Display bit for remote/on-site operation

QREV_OP BOOL Operation enabled for Option 2

QRUN BOOL 1=Run

QSP_DEV BOOL 1=No setpoint-actual deviation

QSPEXTEN BOOL External enable

QSPINTEN BOOL Internal enable

QSPEXTON BOOL 1=External, 0=Internal

QVOL_ERR BOOL 1=Undervoltage error
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5.6.5 Linking an S5-95F to PCS 7 V4.0x

Entry ID: 630950 - Date: 11/01/2001

QUESTION:
How do I implement a link between PCS 7 V4.0x and an S5-95F?

ANSWER:
The description below explains how to configure a link between an S5-95F and
PCS 7 V4.0x.

Requirements

• For communication, you require the function blocks "RCV_95F" and
"SEND_95F". These blocks are in the library "PCS 7 S5-95F Comm Blocks" on
the CD with order no. 6ES7851-0CC00-0YA0. This library is not part of the
standard PCS 7 V4.0x package.

• To configure communication with the CP 541, you require the appropriate GSD
file. You will find this on the Customer Support pages under entry ID 630950.
How to import this file into HW Config is explained in the FAQ with entry ID
2383630.

Configuring the PLC:

1. Insert the DP standard node in HW Config. You will find the node under
"Profibus DP > Other Field Devices > Other > CP 541". Set the following bus
parameters: PROFIBUS DP, transmission rate: 500 Kpbs, protocol: Universal
DP / FMS (other settings are also possible but they must match up with the
configuration on the S5-95F).



Configuring Networks

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 5-55

2. You must now transfer the required parameter assignment to the CP 541 from
the hardware catalog (for example, Profibus-DP > Other Field Devices > Other
> CP 541 > 8 words DO...).

 

3. Save and compile your configuration.

4. Close HW Config and open a CFC chart.

5. Install the function blocks "RCV_95F" and "SEND_95F" in the CFC chart.

! Notice
When you install the blocks in the CFC chart, it is possible that an error message
"Overwrite new version" appears because the function blocks (FB1 and FB2)
have the same names as blocks already in your configuration. In this case, you
must rename your function blocks.

6. Interconnect the blocks in the CFC chart (for more information, refer to the
online help; "F1 key").

7. Compile your configuration and close the CFC editor.

8. Open the instance data blocks of the function blocks "RCV_95F" and
"SEND_95F" in the SIMATIC Manager. The individual words must have the
system attribute "S7_m_c" = "True" for WinCC.

The number of words depends on the configuration in HW Config (for example,  8
words DO + 8 words for the error code from the S5-95F = 16 words per DB when
using two data blocks, one for the send job and one for the receive job).
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Set the system attributes for each word separately.

9. Close the DB editor.

10. Select the data block in the blocks container in the SIMATIC Manager. In the
"Edit" menu, select "Operator Control and Monitoring" in the Special Object
Properties and set the option. This means that the data block can be controlled
and monitored by the operator in WinCC following the PLC-OS transfer.

These configuration steps are necessary for each individual instance data block for
"RCV_95F" and "SEND_95F".

OS Configuration

1. Install the faceplate from the above CD. Make sure that you read the
instructions in the Readme file.

2. Open the WinCC Graphics Designer and a new picture.

3. Insert an OLE control as PCS 7 faceplate "S5 95F.FP 95F"
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4. Setting Parameters for the Faceplate
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To allow messages from the faceplate to appear in the group display of the picture
and to allow the picture to be acknowledged, a group display must now be installed
in the picture and linked with the CFC block.

5. Open the Dynamic Wizard and select the option "Connect group display to
PCS 7 tag structure". Then select, for example, your receive block.

 

You have now completed configuration.
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5.6.6  Starting up SIPART DR 21 for PCS 7 version V4.0x

Entry ID: 667846 - Date: 07/26/1999

QUESTION:
How do I start up a SIPART DR 21?

ANSWER:
These instructions are for starting up the compact controller SIPART® DR 21 in
conjunction with PCS 7 and WinCC. For more information consult the online help
and instruction manuals.

Settings on the SIPART DR 21

For the controller you must change the default settings as follows in order for
communications via PROFIBUS-DP to work properly. The settings affected are
maintained even after power down. (See Operating the SIPART, point 4.)

Table 1

 Structure switch  Setting

S 41 0

S 84 1

S 85 2

S 86 0

S 87 0

S 88 0

S 89 0

S 90 User number (3-125) here: 21

S 91 Response monitoring (1-25) here: 1

Table 2: Implementation of SIPART DR 21 with WinCC requires the following additional
settings on the controller:

 Structure switch  Setting

S 1 1

S 23 0

S 42 2

S 76 2

S 77 2

S 78 2

S 79 1

Notice

You must set all the structure switches mentioned to these values when using
them with PCS 7. Leave all the other structure switches in the ex factory settings.
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Configuring in PCS 7

• Open S7 from the desktop or from the Start bar.

• Create a project and assign an S7-400 station to it.

• Open the hardware catalog by double-clicking the symbol.

• Configure a DP master system (e.g. CPU 414-2 DP) and set the user address
of the DP master to 2 with a transfer rate of 187.5 Kbits/s (Figure 1)

Figure 1

• Under PROFIBUS-DP \ Controller in the hardware catalog connect the SIPART
DR** to the master system.

• Upon request make sure you select AKZ > / 20 PZDs (Figure 2).
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Figure 2

• Set the SIPART DR 21 to user address 21 (Figure 3).

Figure 3



Configuring Networks

Process Control System PCS 7, Tips and Tricks
5-62 A5E00080064-01

• Make sure that the I/O addresses on the module 0 (universal module) have the
same address area. If not, you must set the value either via Select line/ right
click or via Object Properties > Match Addresses.

• All the settings are shown in Figure 4.

• You can enter the PNUs in decimal form in the parameter list.

• You must make the settings that can be taken from Table 3.

Figure 4
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Table 3

 PNU  SIPART 19  SIPART 21

10 269 254

11 289 276

12 293 280

13 270 255

14 271 256

15 272 257

16 273 258

17 274 259

18 275 260

19 276 261

20 277 262

21 287 274

22 291 278

23 292 279

24 284 271

25 285 272

26 288 275

27 290 277

28 266 251

29 2 2

• Double-click the SIPART DR 21 icon and select the Parameterization tab.
Select the Change value…  button or double-click the line concerned and then
enter a value (Figure 5).
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Figure 5

• Store Hardware Config, load the AS and exit the configuration.

Insert block FB 193 into the project

• Create a plan container and a CFC plan.

• Import the FB 46 first, then copy the FB 193 into the project from the field
device library.

• Pay attention to the presettings that are given in the field device instructions
manual page 3-51 onwards.

• Parameterize the block INPUTS/OUTPUTS as in Figure 6. (The figure shows
the SIPART 21, the inputs for SIPART 19 are to be parameterized in the same
way.)

• Now map the project and create an OS faceplate with the associated variable.
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Figure 6
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Meaning of the PNUs with SIPART

Table 4

 PNU element  SIPART  Lower limit  Upper limit  Comment

GAIN 102 21 0.1 100.0

19 0.1 100.0

TN 103 21 1.0 9984

19 1.0 9984

TV 104 21 1.0 2992 0 = off

19 1.0 2992 0 = off

LMN0 106 21 0.0 100.0 -1 = Auto

19 0.0 100.0 -1 = Auto

TMHEAT 21 109 0.1 1000 0 = off

19 113 0.1 1000 0 = off

TMCOOL 21 110 0.1 1000 0 = off

19 114 0.1 1000 0 = off

POS_PAUS 21 111 20 9980 permiss. step width 20

19 115 20 9980 permiss. step width 20

POS_LGTH 21 112 20 9980 permiss. step width 20

19 116 20 9980 permiss. step width 20

A1 128 21 -110 110

131 19 -110 110

A2 129 21 -110 110

132 19 -110 110

A3 130 21 -110 110

133 19 -110 110

A4 131 21 -110 110

134 19 -110 110

HYS 132 21 0.1 10

135 19 0.1 10

SP_LLM 21 134 -10.0 110

19 136 -10.0 110

SP_HLM 21 135 -10.0 110

19 137 -10.0 110

SP_RTM 21 136 0.1 9984 0 = off

19 138 0.1 9984 0 = off

LMN_SAF 21 139 0.1 110

19 141 -10.0 110.0

SP_AUX1 19 107 -10.0 110

SP_AUX2 19 108 -10.0 110

SP_AUX3 19 109 -10.0 110

SP_AUX4 19 110 -10.0 110
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Operating the SIPART 21 for setting the structure switch

• Press and hold the gray button (6 / Shift key) for about 6 second.

• When "PS" appears on the lower display (9), let the button go. "onPA" appears
on the large display (3).

• Press the up arrow key (15) twice then "StrS" is displayed.

• Press the yellow field (11 / Enter key) for about 5 seconds. The display
changes to the structure switch level.

• Scroll down to the switches using the yellow keys (7) and (8).

• Change the values using the green keys (14) and (15) on the right-hand edge.

• Go back and exit the settings by pressing the green key (16 / Exit key) at the
top right twice.

Meaning of the Inputs/Outputs on FB 193

bfb193_e.pdf (44 KB)

5.6.7 Starting up SIPART DR 19 for PCS 7 version V4.0x

Entry ID: 668919 - Date: 07/26/1999

QUESTION:
How do I start up a compact controller SIPART DR 19?

ANSWER:
These instructions are for starting up the compact controller SIPART® DR 19 in
conjunction with PCS 7 and WinCC. For more information consult the online help
and instruction manuals.

Settings on the SIPART DR 19

For the controller you must change the default settings as follows in order for
communications via PROFIBUS-DP to work properly. The settings affected are
maintained even after power down. (See Operating the SIPART, point 4.)

Table 1

 Structure switch  Setting

S 42 0

S 92 1

S 93 2

S 94 0

S 95 0

S 96 0

S 97 0

S 90 User number (3-125) here: 21

S 91 Response monitoring (1-25) here: 1
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Implementation of SIPART DR 19 with WinCC requires the following additional
settings on the controller:

Table 2

 Structure switch  Setting

S 1 2

S 23 0

S 43 2

S 83 2

S 84 2

S 85 2

S 86 1

Notice

You must set all the structure switches mentioned to these values when using
them with PCS 7. Leave all the other structure switches in the ex factory settings.

Configuring in PCS 7

• Open S7 from the desktop or from the Start bar.

• Create a project and assign an S7-400 station to it.

• Open the hardware catalog by double-clicking the symbol.

• Configure a DP master system (e.g. CPU 414-2 DP) and set the user address
of the DP master to 2 with a transfer rate of 187.5 Kbits/s (Figure 1)
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Figure 1

• Under PROFIBUS-DP \ Controller in the hardware catalog connect the SIPART
DR** to the master system.

• Upon request make sure you select "AKZ > / 20 PZDs" (Figure 2).

Figure 2

• Set the SIPART DR 19 to user address 21 (Figure 3).
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• Make sure that the I/O addresses on the module 0 (universal module) have the
same address area. If not, you must set the value either via Select line/ right
click or via Object Properties > Match Addresses.

Figure 3

• All the settings are shown in Figure 4.

• You can enter the PNUs in decimal form in the parameter list.

• You must make the settings that can be taken from Table 3.

• Double-click the SIPART DR 19 icon and select the Parameterization tab.
Select the Change value…  button or double-click the line concerned and then
enter a value (Figure 5).
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Figure 4
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Table 3

 PNU  SIPART 19  SIPART 21

10 269 254

11 289 276

12 293 280

13 270 255

14 271 256

15 272 257

16 273 258

17 274 259

18 275 260

19 276 261

20 277 262

21 287 274

22 291 278

23 292 279

24 284 271

25 285 272

26 288 275

27 290 277

28 266 251

29 2 2
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Figure 5

• Store Hardware Config, load the AS and exit the configuration.

Insert block FB 192 into the project

• Create a plan container and a CFC plan.

• Import the FB 46 first, then copy the FB 192 into the project from the field
device library.

• Pay attention to the presettings that are given in the field device instructions
manual page 3-36 onwards.

• Parameterize the block INPUTS/OUTPUTS as in Figure 6. (The figure shows
the SIPART 21, the inputs for SIPART 19 are to be parameterized in the same
way.)

• Now map the project and create an OS faceplate with the associated variable.
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Figure 6



Configuring Networks

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 5-75

Table 4: Meaning of the PNUs with SIPART

 PNU element  SIPART  Lower limit  Upper limit  Comment

GAIN 102 21 0.1 100.0

19 0.1 100.0

TN 103 21 1.0 9984

19 1.0 9984

TV 104 21 1.0 2992 0 = off

19 1.0 2992 0 = off

LMN0 106 21 0.0 100.0 -1 = Auto

19 0.0 100.0 -1 = Auto

TMHEAT 21 109 0.1 1000 0 = off

19 113 0.1 1000 0 = off

TMCOOL 21 110 0.1 1000 0 = off

19 114 0.1 1000 0 = off

POS_PAUS 21 111 20 9980 permiss. step width 20

19 115 20 9980 permiss. step width 20

POS_LGTH 21 112 20 9980 permiss. step width 20

19 116 20 9980 permiss. step width 20

A1 128 21 -110 110

131 19 -110 110

A2 129 21 -110 110

132 19 -110 110

A3 130 21 -110 110

133 19 -110 110

A4 131 21 -110 110

134 19 -110 110

HYS 132 21 0.1 10

135 19 0.1 10

SP_LLM 21 134 -10.0 110

19 136 -10.0 110

SP_HLM 21 135 -10.0 110

19 137 -10.0 110

SP_RTM 21 136 0.1 9984 0 = off

19 138 0.1 9984 0 = off

LMN_SAF 21 139 0.1 110

19 141 -10.0 110.0

SP_AUX1 19 107 -10.0 110

SP_AUX2 19 108 -10.0 110

SP_AUX3 19 109 -10.0 110

SP_AUX4 19 110 -10.0 110
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Operating the SIPART 19 for setting the structure switch

• Press and hold the gray button (6 / Shift key) for about 6 second.

• When "PS" appears on the lower display (9), let the button go. "onPA" appears
on the large display (3).

• Press the up arrow key (15) twice then "StrS" is displayed.

• Press the yellow field (11 / Enter key) for about 5 seconds. The display
changes to the structure switch level.

• Scroll down to the switches using the yellow keys (7) and (8).

• Change the values using the green keys (14) and (15) on the right-hand edge.

• Go back and exit the settings by pressing the green key (16 / Exit key) at the
top right twice.

Meaning of the Inputs/Outputs on FB 192

bfb192_e.pdf (84 KB)

5.6.8 Starting up SIMOCODE for PCS 7 version V4.0x

Entry ID: 675048 - Date: 11/17/1999

QUESTION:
How do I start up the SIMOCODE motor protection and control device?

ANSWER:
These instructions are for starting up the SIMOCODE® -DP 3UF5 motor protection
and control device that supports communications in conjunction with PCS 7 and
WinCC. More information is available in the online Help and the instruction
manuals.

Settings on SIMOCODE® -DP

SIMOCODE® -DP can exchange data with DP masters via the bus. In order for
SIMOCODE® -DP to be able to participate in bus communications, the following
parameters must be set beforehand using the hand-held controller or PC:

• Bus address (here: 10)

• Baud rate (here: 187,5kBit/s)

• Basis type (here: 2)

• Lockout-DP (here: NO)

See under "Communications / Data Communications" in the instruction manual for
the individual setting options.
See pages 7-8 and 7-9. You can use COM-PROFIBUS to make the settings with
the PC. For this you need a floppy disk with the device master data file (GSD).
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Configuring in PCS 7

• Open S7 from the desktop or from the Start bar.

• Create a project and assign an S7-400 station.

• Open the hardware catalog by double-clicking the icon.

• Configure a DP master system (e.g. CPU 414-2 DP) and set the user address
of the DP master to 2 with a transfer rate of 187.5 Kbits/s (Figure 1).

Figure 1

• Under PROFIBUS-DP \ Switchgear in the hardware catalog connect the
SIMOCODE-DP to the master system.

• When prompted, you must select "Base type 2" (Figure 2).
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Figure 2

• Set the SIMOCODE® -DP to user address 10 (Figure 3).

Figure 3

• Make sure that the I/O addresses on the module have the same values as in
Figure 4.

• Parameters must be set in the hardware catalog on the SIMOCODE- DP.
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• For this double-click the SIMOCODE® -DP icon and select the Parameterize
tab.

• Activate the Change value... button or double-click the relevant line and enter
the appropriate value (Figure 5).

• The parameters to be set for this project are in the "sico_xx_e.pdf" that you
can download separately. These figures have been attached in a separate file
for the sake of clarity.

Figure 4
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Figure 5

sico_xx_e.pdf (107 KB)

• Store the Hardware Config, then load the AS and finally exit the configuration.

Incorporating block FB 196 in the project

• Create a plan container and CFC plan

• Import the FB 46 first, and then copy the FB 196 from the field device library
into the project.

• Note the presettings on page 3-3 onwards of the field device instruction
manual.

• Parameterize the block INPUTS / OUTPUTS as in Figure 6.

• Now map the project and create an OS faceplate with the associated variable.
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Figure 6

See end of document for meanings of the parameters for SIMOCODE.
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Assignment table for reversal of direction

 Element  Left  Stop  Right

FW_OP_EN 1 1 1

RV_OP_EN 1 1 1

OFF_OP_ON 1 1 1

L_FORW 1 1 1

L_REV 1 1 1

L_OFF 1 1 1

FORW_ON 0 0 1

MOT_OFF 0 1 0

REV_ON 1 0 0

Meanings of the Inputs/ Outputs on the FB 196

bfb196_e.pdf (56 KB)

5.6.9 Application of the simulation system SIMBApro in PCS 7

Entry ID: 726049 - Date: 06/28/2000

QUESTION:
How can I apply the simulation system SIMBApro in PCS 7?

ANSWER:
SIMBApro is a software package (runs under WindowsNT/95, at the moment only
in German), to which belongs a S7-400 SIMBAsys module. The module is
obtainable at the moment as:

• SIMBAsys-EA > SIMATIC S7-400 module range (can simulate up to 8 full
racks)

• SIMBAsys-DP > PROFIBUS DP range (can simulate up to 32 slave stations)

SIMBApro permits you to configure up to 32 SIMBAsys-* modules via a simulation
bus that has to be installed separately. You can connect it either via a PC-COM
interface or via the interface of an ISA card CP 5412 (necessary for more than 4
SIMBAsys modules). There is an import function permitting you to simulate existing
SIMATIC STEP7 projects. A mixed simulation with physically available modules is
possible, but this does not mean that these modules connected to the bus can also
be simulated at the same time. You can operate, link and control the simulated
input and output values. Simulated slaves behave just like real slaves on the DP
bus. Using the SIMBAsys-DP module in its present delivery status you can
simulate the ET 200 M / ET 200 U distributed I/O systems (but not all the modules
included in them), the SIMOVERT distributed device systems and the SIMOCODE
low-voltage controllers.
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INSTALLING THE SIMBApro SOFTWARE PACKAGE

1. You install via the Setup of the floppy disk supplied. Follow the dialog boxes of
the Setup program.

2. To use the Import function it is necessary to make a Registry entry that, when
compiling the HW Config, prevents the deletion of certain temporary files that
are required for importing in SIMBAPRO. The Registry entries are made by
double-clicking the SDBVIEW.reg file that is located in the Installation directory
of SIMBAPRO.

3. The further procedure is for a SIMBAsys-DP module.

MOUNTING THE SIMBAsys MODULE

1. The module occupies a S7-400 slot on the subrack. There are no slotting rules,
because the simulation module is completely neutral and is not even
recognized by the CPU as a module. The connection is serial, i.e. via the COM
interface of the PC. For this you must use the cable set supplied according to
the following diagram. Labeling the connectors will help when mounting the
module.

2. Switch on the rack’s power supply. The green RUN LED blinks after a
successful start-up.

3. Configuring the PROFIBUS DP master remains the same for the simulation
with one exception:
It is absolutely necessary that you operate the PROFIBUS at 187.5 Kbaud
for the simulation.

4. Note the address of the PROFIBUS master for the simulation configuring.

5. If you are working with several simulation modules that cannot all be linked
to the PC via a COM interface, then you must connect them to a CP5412 via a
simulation bus (PROFIBUS with 1.5 Mbit/s). More information on this
connection is given in the instruction manual.
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CONFIGURING WITH SIMBApro

1. Open the program and then you must first of all create a project (Project >
New).

2. Now, in the opened project, you must create a new simulation module under
Configuring > Simulation module new.

3. As soon as you assign a name for this group the following dialog box opens
automatically:

4. Here you must select the SIMBAsys module used and the associated interface

and then "Add". 

5. If you are working with several simulation modules, you must proceed in the
same way for these, too. The marked SIMBAsys module can now be
configured.

6. If you want to use existing SIMATIC STEP7 projects, then you have to
import them. The addresses for simulation configuring are assigned
automatically. This avoids conflicts (frequent application: a large existing
project, but for which the relevant modules are not available). Before importing,
you must verify the baud rate of 187.5 Kbit/s that is absolutely necessary for
operating the PROFIBUS DP, and if necessary, change it.
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Importing-for the Simulation of existing SIMATIC STEP 7 Projects 

1. Select the hardware configuration to be imported.

2. For importing, SIMBApro uses the temporary file SDB100x.DAT, that you
created for the hardware configuration last loaded from the S7 HW Config. The
path of this file can be seen above. Here you must select the correct DP
master (here: r00s03 = Rack 0/Slot 3). The requirement here is that you have
executed the registration file as described in the software installation
instructions.

Comment: in PCS 7 V5 the name of the file has changed. It now reads
SDB200x.DAT.

3. Here, all the PROFIBUS-DP users configured in the HW Config are displayed
as available users. The user numbers, the module types and the logical
addresses (including that of the master) are all completely included as
information. You can only simulate a physically present user when it is
switched off. Simulating a physically present user that is switched on leads to
errors, for example, address conflicts.
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Note

You can only ever simulate slaves that SIMBApro offers for selection. If not all of
the users are recognized when importing, then you must proceed as follows to
enter the non-recognized DP users.

4. If only part of the users are imported or nothing at all, then you must first set
the master address on the SIMBAsys module to be configured for the
simulation DP bus, i.e. of the free addresses you must select the DP master
address assigned in the HW Config and enter it via "Set Master" (this happens
automatically when importing).
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5. The addresses that are still free you can now add with the slaves available at
the time (those that are marked). Press OK and the configuration data (user
number/ type) is transferred (see example).

Mark slave: (Configuring > Configure) and press .

6. You can now configure DP slave users configured in this manner yourself.

You must now place the required I/O modules in the free rack slots (light gray)
(Mark module > Select rack slot > add). You must not forget the logical input and
output addresses here.

7. Now, once all the users and modules to be simulated are included in the
SIMBApro project, you must set up the connection between the SIMBAsys
module and the SIMBApro program (mark required SIMBAsys module:
Simulation > Connect.
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8. In the case of active serial communication, the yellow H4 LED should now
blink. When the connection is set up, you must then load the simulation project
(mark required SIMBAsys module: Simulation > Load.

9. After successful loading the RUN LED lights permanently and the symbols of
the modules in the SIMBApro project change their color from hatched gray to
green.

10. If the mater address is correctly configured in SIMBApro and communication
between the SIMBAsys module and the PROFIBUS DP is active, then the
yellow H3 LED lights.

Note

Connect first, then load. Clearing down the connection.   

11. If all the elements of the hardware configuration of the SIMATIC STEP7 project
are physically present and/or simulated, and the relevant OBs for diagnostic
and process interrupts are loaded, then there should be no more problems with
the CPU. If the rack with the SIMBAsys module has a power failure, then you
must reload the simulation project, because there is no buffering.

SIMULATING MODULE-SPECIFIC PARAMETERS

Notice

At the moment, process and diagnostic interrupts are not available as modules for
the ET 200 M distributed I/O system.



Configuring Networks

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 5-89

ET 200 M I/O system:

Now, if you click the symbol of an I/O module, the associated faceplate opens.
(Faceplates and the associated setting options are only available for I/O modules
at the moment). Right-click the input or output value to open the dialog box with the
setting options specific to the module concerned. You can either set the input
values statically, or change them dynamically via a common formula system. You
can link up several inputs (e.g. interrupt surge).



Configuring Networks

Process Control System PCS 7, Tips and Tricks
5-90 A5E00080064-01

You can link only analog values or only digital values with each other.

The following calculating rules hold:

• Point calculation before line calculation

• Processing of formulas from right to left

• Integers only

Analog values:

• Addition

• Subtraction

• Multiplication

• Division

Digital values:

• NOT

• & AND

• | OR

• ^ Exclusive OR

You cannot manipulate output values. It is possible to set up a channel link
between output channels (source) and input channels (target and source). A
number of FM *** modules are listed under the available modules, but for which
there is no faceplate and therefore no setting options.
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SIMOCODE low voltage controllers

To open these faceplates click the module in the simulation project. The setting
options are module-specific.
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SIMOVERT device system:

Note

INFT LED = internal program fault
EXTF LED = bus failure on the PROFIBUS
If it is not possible to set up a connection between the simulation program and the
simulation module, you should check the release of all COM interfaces in the
BIOS.
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5.6.10 PCS 7 and the controller module FM355-PID

Entry ID: 747643 - Date: 02/08/1999

QUESTION: How do I integrate the controller module into the PCS 7 system?

ANSWER:

MOUNTING

1. Attach the FM355 PID controller to the DIN rail.

2. The bus connection is to made via a bus connector (supplied) or via an active
bus module (see HW Config > DP Slave Properties > Special).

Notice

In order to be able to use the Back-up Operation function (in case of CPU failure)
with an operator panel under PCS 7, you must connect the PROFIBUS-DP via an
ET200M IM 153-2.
The basis requirement is connection of the power supply voltage 24V to L+ and M
(right front connector > Connection assignment on inside of front door). You must
connect the available signal lines to the appropriate inputs and outputs. You will
find help here from the connection assignment diagram located on the inside of
the front door and from the instruction manual of the module.

Installing The Software Package

1. Execute the SETUP of the first of the 3 floppy disks supplied.
(FBs for the CPU and parameterizing interface for the PG/PC under STEP 7)
Libraries are automatically updated by the SETUP
Hardware Catalogs > PROFIBUS DP > SIMATIC 300
CFC > Catalogs > Library > FM_PID is created
- PID_CS (connection FM 355 <=> user program)
- STRT_355 (for simulation if process is inactive) are contained there.

2. To integrate the module into WinCC you must install the "Technological
Blocks" library of version V4.02, because this contains the driver block for the
FMCS_PID controller module with the associated OS faceplate.

Configuring Hardware

1. Call HW Config and insert the relevant controller module (S controller or K
controller) into the required rack slot.
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You will find the controller module in the HW catalogs either as

- direct user under SIMATIC 300 > FM 300 > FM 355 or

- DP user under the DP slave used

For example: PROFIBUS-DP > ET200M > IM 153-1 > FM 355 S

Bus parameter: PROFIBUS \ 1.5Mbit/s \ DP

2. Now define the basic properties > I/O addresses and basic parameters.
Double-click the order number of the FM 355 built into the rack and the
following dialog box opens:
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Parameterizing Controller Channels

Press the Parameters... button to open the "Dialog box" overview in which you are
to specify the properties of the controller channels.

Notice

The controller channel cannot be edited if you have set "Analog input is not to be
edited" at the analog input with the same number. Likewise, a step controller only
functions with repeated manipulated value if you have made the appropriate
settings for the analog input used for the feedback.
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After completing parameterization you must save the overview.
Now you must save the complete HW Config and load it in the CPU.
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Using The Blocks in CFC

Integrating the module in WinCC:

1. You must use the "FMCS_PID" block (contained as FB114 under PCS 7 in the
"Technological Blocks" library V4.02 and higher).

2. Drag the block into the CFC plan. To be able to do this, the project must
already know an OP_A_LIM (FB46) in the block container.

Notice
You cannot use the FMCS_PID (FB114) block with the PID_CS (FB31) contained in the
FM_PID library created specially for the controller. Otherwise a channel error (QCH_F=1)
occurs on the PID_CS. A communication is not set up between the blocks although the
have inputs and outputs wit the same names and functions. The extensive CFC Help on the
FMCS_PID (FB114) informs you that you can monitor all the relevant process values with
this block and change all the relevant controller parameters. In order for you to be able to
use the faceplate incorporated in the runtime, it is important to make the following input
assignments.

4. Set the following switches on the FMCS_PID (partially still hidden), so that you
can operate the setpoint value and the manipulated value from the faceplate:

Setpoint value: SP_TRK_ON = 0 (otherwise the setpoint value of the PV is tracked)

SP_OP_ON = 1 (operator release for manual setpoint value)

Manipulated value: LMN_REON = 0 (external manipulated must not be released)

LMNOP_ON = 1 (operator release for manipulated value)

All "Link inputs" (LIOP...) must be 0.
Other operator release switches for: (1 = release)

Manual/Automatic > MANOP_EN

AUTOOP_EN

Setpoint value ext./int. > SPEXT_EN

SPINT_EN

All "Link inputs" (LIOP...) must be 0.
Other operator release switches for: (1 = release)

Manual/Automatic > MANOP_EN

AUTOOP_EN

Setpoint value ext./int. > SPEXT_EN

SPINT_EN
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5. Addressing the block is also important. For this you must provide the following
inputs with the available values

SUBN_ID (Subnetwork number - DP master system)

RACK_NO (Number of the module rack - station)

SLOT_NO (Number of the slot - slot)

! Warning

HEX format, they are to be seen in HW Config > Online > Module status

6. For each controller channel used you must use an FMCS_PID and enter the
relevant channel number under CHANNEL.

7. After compiling and loading into the CPU you must check in test mode the
correct addressing/parameterization via the output QPARF = 0. Here it is
possible that you get an error message about the local data when compiling. In
this case you must change the local data for example according to the "PCS 7
recommended list".

8. After perfect functioning of the block in the CFC test mode, you can configure
the associated OS.
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Configuring OS

1. Open OS and insert an OLE control in an image in the Graphics Designer. In
the dialog box that opens select a PCS 7 FMCS_PID Control.

2. Such an OLE is required for each controller channel. You must link the Control
in each case to the associated block/measuring point.
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3. Double-click the Control to edit the properties. Since the default settings are
useful here, you can accept them as they are.

4. Once you have incorporated the completed image in runtime, you should have
a useful faceplate (symbol or loop, depending on the display setting).
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5. Now, via this Symbol/Faceplate/Loop, you can communicate with the FM 355
controller module from runtime, i.e. you can change the controller parameters
and influence the process values if released.

Using Digital Inputs

Generally there are 8 digital inputs on each FM 355 unit (on the right front
connector, connections 2...9). The inputs have no direct relationship with the 8
digital outputs of an FM 355 S controller, because in each case two of these
outputs are directly assigned to one controller channel. If the digital inputs are to be
included in the connections in the CFC plan, you must use the STRT_355 block
(library: FM_PID) in the plan.
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The inputs of this block are only for simulating process values (see On-line Help).
The status displays of the individual digital inputs (STA_DI1 ... STA_DI8) show the
values currently present at the inputs. You can link them, for example, with
switchable "link inputs" of the FMCS_PID block. You can edit the properties of
these inputs in the HW Config.
(Overview FM 355 > Extras)
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Additional Remark

Some of the options supplied with the PID_CS block cannot be used by the
FMCS_PID. Thus, for example, integrated controller optimizing is only possible
with the PID_CS. Since you cannot operate and monitor this block, and it doesn’t
have a prepared faceplate, it is thus not suitable for a WinCC connection.

Controller optimizing

Using the PID_CS you can optimize inaccurate controller parameters. The
requirement here is that there is a true controlled system available with the
associated actuator, or a comparable simulation system.
Procedure:

1. Create a project that doesn’t contain an FMCS_PID (FB114), otherwise there
will be conflicts between the blocks.

2. Drag the PID_CS (FB31) from the FM_PID library into the CFC plan and note
the instance data block created by the CFC (needed for the subsequent test
program).

3. Then set on the block the channel number "CHANNEL" to be optimized and
the address "MOD_ADDR" (see here HW Config > FM 355 Properties >
Addresses).
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4. Call the Overview FM 355 and select Test > Open Instance DB.

5. In the dialog box that opens select the Instance DB belonging to the PID_CS in
the on-line view of the project.

6. If the selection is made correctly, as a requirement for optimizing you must first
measure or define via Test the motor manipulated value of the integrated/non-
integrated actuator.

7. Now go through the dialog boxes for measuring and optimizing. There is a
good on-line help system available if you have any problems. Note the
optimized controller parameters thus obtained so that you can enter them
correspondingly in a project with WinCC link (with the FMCS_PID) under
runtime.

Operator Interface with Operator Panel OP)

General:

• Operation is only possible in the case of CPU failure or CPU stop.

• Monitoring is always possible.

• You can set up a maximum of three OP<>FM 355 connections.

At the moment there are no options for testing.
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5.6.11 Connection of the PT100 to analog input module
SM 331 AI 8x12BIT

Entry ID: 766011 - Date: 12/04/2000

QUESTION:
How do I connect the PT100 to the analog input module SM 331 AI 8x12BIT?

ANSWER:
Using the channel 0/1:

1. Connect the PT100 to the inputs 2 and 3 and jumper the inputs 3 and 5, and
the inputs 2 and 4.

2. Open the HW Config and add the analog input module to the remote ET 200M
station. Make the following settings in the Properties of the module:
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3. Save and compile the HW Config and load it into the AS.

4. Incorporate the driver block into the CFC plan and parameterize it as
illustrated in the following figure:
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5. If you enter 0.0 at the inputs V0HRANGE and V0LRANGE, the measured
temperature is output at output V0.

6. If you change the inputs mentioned, then you must set CH_USE00 first to 0
and then to 1 again to activate the changes.

7. At the inputs SUBN1 ID, RACK1_NO and SLOT1_NO you must specify the ID
of the DP master system (1), the PROFIBUS address of the DP slave (8) and
the slot (6) of the module.

8. Compile the plan and load it into the CPU.

9. To trigger an interrupt if the upper or lower temperature limit is exceeded you
can activate "Process interrupt upon exceeding limit value".

10. You must specify the limit values under "Trigger for process interrupt".
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Notice

If the limit value is reached and the OB (OB 85) required for processing the
message is not available, the CPU goes into STOP.
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5.6.12 Connecting a SITRANS P (DS series) to PCS 7 via a PROFIBUS
PA - communication

Entry ID: 766281 - Date: 09/28/1999

QUESTION:
How does a SITRANS P work under PCS 7?

ANSWER:
The SITRANS P transducer of the DS series can be used for measuring different
pressures, levels and flow rates. In the DS series there is a special version for
connecting to a PROFIBUS PA, which is a version of the PROFIBUS DP. Since
the PROFIBUS PA has a low transfer rate and thus a low power loss, you can use
it in hazardous areas. Thus you can use the SITRANS P without or with an EEx-ib
explosion protection.

Volume Time requirements

DP/PA coupler small low

DP/PA link large high

Likewise for connecting the PROFIBUS PA to the PROFIBUS DP you can choose
an intrinsically safe version or a non-intrinsically safe version. However, you must
also ensure that the coupling between DP and PA is always outside the explosion
area. You can set up this link and convert the data format and transfer rate either
using a DP/PA coupler or with a DP/PA link, the implementation of which
depends on the number of field devices per automation system. Additional acyclic
services have been introduced alongside the cyclic data traffic of the PROFIBUS
PA (as with PROFIBUS DP) via which the manipulated variable values are written
and the measured values read. Using these acyclic services you can change
numerous parameters of modern field devices during operation. This
parameterization of the PA field devices must be done using the SIMATIC PDM
software. This permits you to continue with the start-up, diagnostics and
maintenance of process devices and the configurat ion of networks.

CONNECTION OPTIONS of the SITRANS P ON THE PROFIBUS PA

The DP/PA coupler is transparent, i.e. the field devices are addressed directly by
the automation system. However, you can only operate the connected PROFIBUS
DP with 45.45 Kbit/s. The CPU used must support this transfer rate.

• You need a 24-V power supply for the coupler.

• You must connect the DP bus to the DP socket of the coupler (PA bus see
DP/PA link)

The DP/PA link (IM 157 + DP/PA coupler) on the other hand is a slave on the
PROFIBUS DP (max. 12 Mbit/s) and is a master for the PROFIBUS PA (31.25
Kbit/s). Field device addressing is thus indirect.

• The link itself consists of the interface module IM 157 (no stand-alone
operation) and up to 5 DP/PA couplers of the intrinsically safe version or up
to 2 DP/PA couplers of the non-intrinsically safe version.



Configuring Networks

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 5-111

• The IM 157 and each of the couplers must be supplied with 24V.

• The connection between the interface module and the coupler (as well as
between the couplers themselves) is done using the S7 backplane bus
connectors. At the moment it is not possible to make a connection via an
active backplane bus.

• The DP bus is connected on the DP socket of the IM 157. This means that the
DP socket of the coupler remains free.

• The supply of the field devices with auxiliary energy is done via the data line.
This is why you must keep an eye on the number of connectable devices on
the bus phase. You can find out this number from the sum of the maximum
power consumption of the connectable devices and the current available (see
technical data of the coupler concerned in each case, current reserve of 20 mA
is recommended).

• The sum of all the field devices on one DP/PA link is limited to a maximum
of 30.

• On the SITRANS P the PA bus is connected to the screw terminals under the
screwed housing cover "FIELD TERMINALS" (any polarity) and on the coupler
to the screw terminals labeled PROFIBUS PA using a bus cable (two-wire,
shielded, hazardous area --> blue color, otherwise gray).

• Furthermore you must fit a bus terminator to any open bus end.
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STARTIN UP & ADDRESSING

1. As delivered all devices have the address 1. Thus, if you use several field
devices on one bus, this would lead to address conflicts. This is why you have
to assign one address for each device. An address area of 1 to 126 is
possible.

2. You must to the address setting on the SITRANS P either via the
parameterizing software SIMATIC PDM ⇒ (see 6. PARAMETERIZING...) or by
using a SITRANS P with optional digital display locally on the device itself.

3. The device has three operating buttons located under a protective cap next to
the cable inlet of the PA bus. Hit the mode key (M) twice to select Mode 15
(bottom left in the display). Using the arrow keys you can set the desired
address. Pressing the mode button again acknowledges the address.

4. Furthermore, in Mode 7 you can do a zero point alignment by pressing the
arrow buttons simultaneously. See the operating instructions for more
information.

5. Software package SIMATIC PDM

Using this software you can configure, parameterize, start-up, diagnose and
maintain a selection of process devices (SITRANS P, SIPART DR 20 & 21
amongst others). You can add PDM as an option package to SIMATIC STEP7
(version V4.02) or PCS 7 (version V4.02), or as independent program with a
STEP7 OEM version. More details are available in the supplied installation
instructions and the readme file in the...\Sim_PDM\ folder. Install as described in
the installation instructions. An important part of the installation are the
authorizations (see the authorization instructions). You need one for the program
itself and another if you are using more than 16 devices (basic version). Each
following communication path used by SIMATIC PDM needs another separate
authorization.

- PROFIBUS DP/PA

- HART modem

- HART multiplexer

The following statements refer to SIMATIC PDM as option package under
STEP7, because you can also use the package in the HW Config.

6. When installing in the SIMATIC Manager you create two new views (under
(View)).

7. You cannot configure in the Process devices - System view, it is only for
rapidly displaying an overview. All the configured process devices are listed
here. A device is entered in this view the first time you call SIMATIC PDM from
it.
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8. The Process devices - Network view is for configuring process devices and
networks.

! Warning

Networks and devices that you have configured with the HW Config are not
automatically included in this network view. You must create it subsequently
taking into account the consistency (see SIMATIC PDM Brief Instructions and the
closing notes of this document).

9. Likewise, with the installation you must update the hardware catalog of the
HW Config.

10. You must insert a PROFIBUS PA library.
You will find the SITRANS P under the sensors.

11. In STEP7 version V4.02 and higher the PROFIBUS DP library includes the
interface module IM 157 for DP/PA link by default. Updating here is done
under "Controller", because SIMATIC PDM supports the compact controller
SIPART DR20 and DR21. We will not be going into this controller in detail
here. However, the brief instructions for SIMATIC PDM include notes on how
to handle the controllers.
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CONFIGURING THE SITRANS P IN THE HW CONFIG

1. Call the HW Config in the relevant project (new / to be extended):

2. If the DP/PA is compiled via a pure coupler, you must use drag&drop to place
the Profile 2 of the SITRANS P directly on the DP master system.
Pay attention here to the baud rate of the PROFIBUS DP.

3. When using a DP/PA Link you must link the IM 157 with the DP bus. You
then place the SITRANS P on the PA bus that is thus created.

4. For other configuring options (HART etc.) see the brief instructions for
SIMATIC PDM.
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5. Specify the required bus address by right-clicking the element and selecting
(Object properties) (also for the DP/PA link).
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6. Save the project and then load this module.

7. If there are no address conflicts or other errors, the CPU goes into RUN. On
the coupler the yellow lights light indicating DP and PA bus activity, as does
the green "ON" display. When using an IM 157 it must also be supplied with
voltage ("ON"). No error displays may be active. If an error does occur, you
must eliminate it using the diagnostics buffer of the CPU.

PARAMETERIZING THE SITRANS P WITH SIMATIC PDM

1. You call the SIMATIC PDM program by clicking the process device. Here it
doesn’t matter from which view you call the program (Process devices -
Network view, Process devices - System view, HW Config).

2. The first time you call the program you must select the device. Here you must
pay special attention to the device properties (for example, differential
pressure where various nominal pressures are possible PN 32 ... 420).

3. When selecting the device you must insert the device in the Process devices -
System view.

4. After selecting the device you must specify the user.

5. If you are a maintenance engineer, you can only make the changes
necessary for operation and maintenance.

6. However, if you are a specialist, you have full access. This can be protected
by a password.
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7. The parameter table that now opens contains all the preset values of the
device.

8. White fields can be changed by the user.

9. In order to retain changes off line, you must save.

10. Via the (View) menu you can read on-line data from the device, e.g. measured
value display, interrupt status and device status.
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11. In order to be able to set up this on-line communication you must set up a
link between a PROFIBUS PG/PC interface and the PROFIBUS with the
SITRANS P as illustrated below.

Note

• A complete overview of the network topology that can be used is given in the
SIMATIC PDM Help (with HART modem, HART multiplexer).

• Notes on the network parameters are given in the readme file in
the...\Sim_PDM\ folder.

• This communication has been implemented in a sample project via a CP 5611
(PROFIBUS).

• The status of the communication is displayed in the Status line.

• In the case of an existing on-line link you can write changed parameters of the
parameter table into the device via the (Device > Load in device) menu. Via
(... > Load in PG/PC) you can see the parameters already set in the device.
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USING PCS 7 BLOCKS

The SITRANS P is a sensor. It supplies the automation system with different
values (inputs). You read out these values using the PCS 7 block PA_AI (FB101)
(under Libraries > PCS 7 Driver Blocks). You cannot operate or monitor the block
itself. It doesn’t support messages either. The outputs of the block must be used for
switching. At the LADDR input you must enter the address value from the HW
Config.
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CLOSING NOTES

Consistency of System view, Network view, HW Config:
Avoid making double entries in the Process devices - System view of one and the
same device.

HOW A DOUBLE ENTRY OCCURS:

• Configure the device in the HW Config

• Call from their of SIMATIC PDM via the device

• This causes the device to be entered in the System view

• Now if you configure the same device in the Network view and do not select
the device as an existing device, this creates a double entry in the System
view.

HOW TO AVOID THIS:

• When assigning the PA device, you must select it from the System view.

• For building into the PCS 7, SIMATIC PDM is contained as an independent
folder in the PCS 7 Toolset V4.02 package.
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5.7 Routing

5.7.1 Loading a complete S7-400 station with Industrial Ethernet CPs in
RUN state of all components concerned for PCS 7 version V5.x

Entry ID: 1000471 - Date: 08/20/1999

QUESTION:
Why is the load operation sometimes interrupted when I try to load an S7-400
station that contains Industrial Ethernet CPs from NETPRO?

ANSWER:
The following system configuration in NETPRO will be taken:
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Here the complete middle station "AS400_IE1_Router_N2_N3" is to be loaded
from NETPRO with the option "Target System Load Marked Stations". Another
thing that makes the loading process difficult is that there are a lot of different
communications links (communications relationships) configured between the 3
stations. Each link has bidirectional data traffic. Both MPI and LAN (Industrial
Ethernet) are possible as interface with the problem described below.
Furthermore, there might also be problems in the data storage (SDBs = System
Data Blocks) in the CPU and in the CP.

After marking required station and activating the relevant load option, the loading
process is normally executed automatically by NETPRO. However, with system
configurations with high communications loads, the following problems might occur.
The Setup tool opens the following dialog:
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A user could not be parameterized. In this case the user is one of the two Industrial
Ethernet CPs in the station to be loaded. Since the loading operation reloads all
the system data blocks (including connection SDBs), you must switch the modules
to STOP. For this you must bring down all the subsystems of the CPs in a
"controlled" manner. In constellations with many communications links this
process can take a long time (a matter of minutes). But the CPUs have a
parameter called the "parameter assignment monitoring time". Once this time
has expired, the CPU signals a parameter assignment error and stops the loading
process.

Remedy:
Acknowledge the opened dialog. A new window opens that looks like this:

You can restart the loading process with "Retry". In most cases you can continue
the loading process, sometimes the CPU signals an error again. The parameter
assignment error is also displayed in the "SIMATIC Manager" in the menu item
"CPU416-1 (right click) Target System Modules Status Diagnostic Buffer".
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Generally, you can avoid an interruption of the loading process by doing the
following:

• Set all modules to STOP before starting the loading process. Then all the
modules are down to start with and the monitoring time configured in the CPU
is then sufficient.

• The parameter assignment monitoring time can be increased in the CPU:
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The selected parameter "Transfer of parameters to modules" is to be increased as
required. Here you can even set times of 60 to 70 seconds.

5.7.2 SIMATIC S7 modules that support routing for PCS 7 version V5.x

Entry ID: 584459 - Date: 04/10/2000

QUESTION:
How can I create the network gateways when networking stations?

ANSWER:
With STEP 7 V5 and higher you might be able to reach S7 stations beyond
subnetwork boundaries on-line with the PG/PC, e.g. to load user programs or a
hardware configuration, or to be able to execute test and diagnostics functions.
You can connect a PG at any point in the network and set up an on-line connection
to all stations that can be reached via network gateways.

Network gateway:

The gateway from one subnetwork to one or several other subnetworks is in a
SIMATIC station that has interfaces to the subnetworks concerned.
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Requirements:

• The modules of the station must support routing.

• The network configuration does not go beyond project boundaries.

• The modules must be loaded with the configuration data that contains the
current "knowledge" about the entire network configuration of the project.
Reason:
All the modules using the network gateway must receive information as to
which subnetworks can be reached via which routes (= routing information).

Routing-compatible SIMATIC S7 CPU modules:

CPU Bestellnummer

315-2 6ES7 315-2AF03-0AB0

316-2DP 6ES7 316-2AG00-0AB0

318-2DP 6ES7 318-2AJ00-0AB0

CPU 412-1 6ES7412-1XF03-0AB0

CPU 412-2 6ES7412-2XG00-0AB0

CPU 414-2 6ES7414-2XG03-0AB0

CPU 414-3 6ES7414-3XJ00-0AB0

CPU 416-2 6ES7416-2XK02-0AB0

CPU 416-3 6ES7416-3XL00-0AB0

CPU 417-4 6ES7417-4XL00-0AB0

626 P/DP 6ES7 626-2DG03-0AE3

633 DP 6ES7 633-2BF01-0AE3

634 DP 6ES7 634-2BF01-0AE3

Routing-compatible SIMATIC S7 CP modules:

 CP  Firmware version  Product release  Order number

342-5 V3.00 2 6GK7 342-5DA01-0XE0

343-5 V3.00 6 6GK7 343-5FA00-0XE0

343-1 ISO V4.0 6 6GK7 343-1BA00-0XE0

343-1 TCP V4.0 6 6GK7 343-1EX00-0XE0

443-5 Basic V3.00 1 6GK7 443-5FX01-0XE0

443-5 Extended V3.00 1 6GK7 443-5DX02-0XE0

443-1 ISO V3.11 9 6GK7 443-1BX00-0XE0

443-1 ISO V1.0 1 6GK7 443-1BX01-0XE0

443-1 TCP V3.11 7 6GK7 443-1EX00-0XE0

443-1 TCP V1.0 1 6GK7 443-1EX01-0XE0

443-1 (MP) V5.0 1 6GK7 443-1EX02-0XE0
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Note

The two products "CP 443-1 ISO (V1.0)" and "CP 443-1 TCP (V1.0)" are replaced
by the product "CP 443-1 (MP = multiprotocol)" as of 07/99. As well as new
functionalities, this module supports all functions and configurations of the
previous modules.

Routing-compatible SIMATIC S7 IM modules:

 IM  Version  Order number

 467  V2.00  6ES7 467-5GJ02-0AB0

Should the target S7 station (CPU or CP) support routing?

1. PROFIBUS:
The CPs do not have to support routing.

2. Industrial Ethernet:
Not all the available firmware releases of the CPs support the "PG Channel
Routing" functionality. Because of the subnetwork information "long TSAPs"
(Transport Service Access Points) are used for addressing the modules. Only
the above-mentioned modules as of the firmware releases marked support this
functionality. However, for each Industrial Ethernet CP there is routing-
compatible firmware for the SIMATIC S7.

3. CPU:
The CPUs do not have to support routing.

5.7.3 With PG channel routing: CP cannot be reached via special
diagnostics for PCS 7 version V5.x

Entry ID: 770706 - Date: 03/17/1999

QUESTION:
Why is it that the CP cannot be reached sometimes via "Target system > Module
state > Diagnostics" when I do PG channel routing on 2 subnetworks?

ANSWER:
The CP can be reached directly via NCM Industrial Ethernet, but not via routing.
This behavior only occurs when the PG is addressed via a subnetwork. Here the
PG attempts to set up a second link to the target CP in addition to the existing link.
But this is not possible, because the CP-resident PG task via LAN only supports
one link. This behavior also depends on whether the menu item "Target system >
Module state" is active. If it is active, then you cannot set up a link to the CP.

Remedy:
After the "Cannot set up link" message close the "Module state" window. This
clears down the existing link and you can then set up another link without any
problems.
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5.7.4 NCM diagnostics mask gives the wrong information on the
gateways used for PCS 7 version V5.x

Entry ID: 845349 - Date: 09/20/1999

QUESTION:
What should I watch out for with the entries in the "On-line Path" field of the NCM
diagnostics mask?

ANSWER:
In the "On-line Path" field of the NCM diagnostics mask "CP Information", you
get information on the module addressed and on the gateway used. Let us take
a look at the following system configuration to make things clearer:

The modules in the individual stations are Industrial Ethernet ISO CPs
(CP 443-1 ISO (6GK7 443-1BX01-0XE0)).
Here, using the programmer "PG740_4", a connection is to be set up with the
NCM Diagnostics to the marked CP 443-1 ISO in the station "AS400_Station_2".

You have 2 options, because the programmer has 2 interfaces:

• You can use the MPI network as an entry point, because both the programmer
and the station "AS400_Station_1" have an MPI interface.
The requirement here is, however, to have a CPU that supports routing. But
the CPU 417-4 does not.
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• Or you use the "Ethernet(1) (1111 1111)" network as entry point if the
programmer has an Ethernet interface card, as in this case.

Industrial Ethernet entry point
In order to be able to enter via the Ethernet you must make the following settings in
the Start mask of the NCM Diagnostics:

If the configured networks are also correctly implemented physically and the
modules are configured correctly, then you should receive the following diagnostics
mask.
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All the information entered in the NCM Start dialog is correctly listed in the
"CP Information" field.

MPI Network entry point

For this you must specify the following in the NCM Start mask:
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! Warning

With the NCM version without SP2 errors might occur if you use the MPI network
as entry point. The connection is still set up. If you study the "CP Information"
field a little more closely, then you will spot a display problem.
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Actually, now all the information specified should be displayed in the "CP
Information" field. As you see, however, only the information on the rack, slot and
interface is correct. All the other information in this field is useless.

Conclusion:
Make sure that the connection is set up correctly. The "CP Information" field,
however, contains incorrect information in the case of making an entry to the
system via MPI, and must therefore be considered with caution.
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6 Plant Hierarchy

6.1 Basics

6.1.1 Changing the CPU assignment in the Technological Hierarchy for
moving CFC /SFC charts in PCS 7 V4.x and V5.x

Entry ID: 5827568 - Date: 11/30/2000

QUESTION:
How can I move CFC/SFC charts in the Technological Hierarchy from one PLC
station to another?

ANSWER:
Please proceed as follows to move charts in the "Technological Hierarchy" from
one PLC to another:

1. Switch to the view "Technological View " and select a hierarchy folder whose
charts are to be assigned to a specific PLC station.

2. You must change the assignment of the hierarchy folder via "Object
Properties" and the "AS-OS Assignment" tag. From the list select the chart
folder that is assigned to your target station.

3. Then you can set the following option as required:
"Transfer selected assignment to all lower-level objects".

4. Acknowledge your entries with "OK".

Then all the charts of the hierarchy folder and of all the lower-level hierarchy
folders are moved from the chart folder of the old S7 program into the chart folder
of the target S7 program of the PLC station.

Notice

If there are charts in different hierarchy folders and there are cross-over
connections between these charts, then the connections are lost. This also applies
to interconnections to global operands.
In version V5.x and higher of PCS 7 you have the option of moving such charts
into the components view without losing the cross-over connections (see Entry ID
!1922887! ).
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6.1.2 Copying folders in the technological hierarchy and changing the
names of CFC charts in PCS 7 version V5.x

Entry ID: 2845898 - Date: 08/14/2000

QUESTION:
How can I copy subsystems in the technological hierarchy and easily adapt my
name system?

ANSWER:
You often use system names for the CFC charts (e.g. the power plant coding
system). The following text describes how to proceed to copy whole areas of the
technological hierarchy and then easily adapt the names of the CFC charts.

1. In the technological hierarchy, select a hierarchy folder and set the option
Code building under Options > Technological Hierarchy > Settings.

2. Set the technological hierarchy of a subsystem with the associated charts. The
hierarchy should already reflect your name layout.
Example:
V100
________RA1
____________T01 (CFC1)
____________T02 (CFC2)

3. Select the hierarchy folder "V100" and select the menu order Edit > Copy.

4. Select the project name or a hierarchy folder superordinate to the "V100" and
select the menu command Edit > Paste.
The subsystem "V100" is pasted with the subordinate structure and you can
adapt the names. The names of the CFC charts included are assigned
automatically.
Example:
V100
_______RA1
___________T01 (CFC1)
___________T02 (CFC2)
V101
_______RA1
___________T01 (CFC3)
___________T02 (CFC4)

5. In the technological hierarchy, select a hierarchy folder and deselect the option
"Code building" for all hierarchy folders. The message
"Are the changes to apply to hierarchy folders already created"
is displayed and you acknowledge with YES. The hierarchy folders are then no
longer involved in creating names.

6. Now select the project name in the technological hierarchy and select the
menu command Extras > Charts > Edit chart names.
You are displayed a list of all the existing charts with the chart names and
associated hierarchy.

7. Now adapt the chart names. In the Hierarchy column select the hierarchy path
for each individual chart and copy (right-click > Copy) the hierarchy path into
the Chart column (right-click > Paste). The charts now display the coding
system you have created.
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6.1.3 Changing the entries in the alarm origin in PCS 7 version V4.01 or
earlier

Entry ID: 787149 - Date: 08/10/1999

QUESTION:
How can I change the entries in the alarm origin?

ANSWER:
You can choose between the following entries for the alarm origin (AKZ = system
ID):

• "Alarm origin = "AKZ"

• "Alarm origin = "AKZ+Chart"

• "Alarm origin = "AKZ+Chart+Block"

If you take the file from the system, then "AKZ+Chart+Block" is set. The following
figure shows the point where you can make these changes manually.
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Notice

On principle, no warranty is given for changes made directly in the registry
database, because this is the responsibility of the user. In any case, it is
recommended to make a back-up of the registry before proceeding with the steps
described. In addition, these settings are computer-specific. This means that you
must set them again if you copy the project onto another computer.

Two files are attached for downloading. You can have the Registry entries made
automatically. Copy the "AlarmOrigin.exe" file into a separate directory and then
start it with a double-click. The two unpacked files are as follows:

• AlarmOrigin_d.REG = Entries for the German version of Windows NT

• AlarmOrigin_e.REG = Entries for the English version of Windows NT

AlarmOrigin.exe (22 KB)

6.2 Modifying Projects

6.2.1 Modifying a project in the Technological Hierarchy

Entry ID: 2874118 - Date: 08/17/2000

QUESTION:
What options do I have for modifying a project in the Technological Hierarchy?

ANSWER:
The following shows you the relationships and options in the Technological
Hierarchy (TH):

Relationships:
When solving an automation task there are almost always device-to-device
relationships between the individual structures. For example, automation runs in
the AS always have to be operated and monitored on an OS, or functions in
several ASs of a subsystem have to communicate with each other.

The technological objects (systems, subsystems, process IC points, …) processed
in the Technological View also contain objects (such as CFC/SFC charts with
blocks, OS pictures, ...), which are normally distributed on multiple devices (AS,
OS, field devices) of the control system.

When processing the technological objects (create, copy, rename, move, delete),
the functions usually have an effect on multiple devices. In the case of system-wide
engineering the device-to-device relationships are managed by the Engineering
System (ES). This ensures the consistency and availability of the automation
structures.
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Functions:
The functions that you can run with system-wide engineering and whose device-to-
device relationships are managed by the ES include the following:

• Copying a complete subsystem that includes charts for the AS and pictures for
the OS.

• Deleting a subsystem whereby all the objects belonging to the subsystem are
deleted.

• Moving a subsystem to other devices (AS and OS).

Note

In the case of AS-AS device-to-device connections, you have to image them on
CFBs (communication function blocks) and then connect these via a
communications channel.

Copying a SIMATIC station or an S7 program:
In the Components View you can copy complete SIMATIC stations or finished S7
programs. Below are a few notes on this:

• Copying a SIMATIC station (CPU) in the project:
When copying a SIMATIC station, the hardware properties of the station are
copied 1:1. In the associated program folder all interconnections to global
operands and runtime groups, and the interconnections between the charts are
retained. The station is given a new name. The technological hierarchy is
retained. All charts affected by the copying process are now exist twice in the
technological hierarchy (original and copy with different names).

• Copying a SIMATIC station (CPU) project to project:
When copying a SIMATIC station from one project to another project, the
hardware properties of the station are copied 1:1. In the associated program
folder all interconnections to global operands and runtime groups, and the
interconnections between the charts are retained. The station is given a new
name.
The technological hierarchy of the copied station is also built up in the target
project. If the station in the source project has relationships to the TH, then
these are reestablished in the target project (set up of a TH or use of a TH with
the same name in the target project).

• Copying an S7 program in the project or from project to project:
When copying a program folder, all interconnections to global operands and
runtime groups, and the interconnections between the charts are retained. You
get a 1:1 copy with a new name.

• Supplementary documentation:
In hierarchy folders you can import or create supplementary documentation
(Text, Excel or Word documents). This gives you the opportunity of assigning
documents to a subsystem or to process IC points. The associated dialog box
is displayed for a selected hierarchy folder via: Insert > S7-Software >
Supplementary documentation.
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• Checking the names:
In the technological hierarchy there is a function (Options > Technological
Hierarchy > Check Names), with which you can detect name conflicts of
hierarchy folders and charts. You can also see whether the name of the
hierarchy folder is longer than that set under Options > Technological
Hierarchy > Settings. Longer names can occur, for example, when copying
from other projects or if the name layout is changed afterwards. A check report
is issued after checking.
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7 CFC-Plans

7.1 Basics

7.1.1 Checking system resources before loading

Entry ID: 2936844- Date: 09.05.2000

QUESTION:
What should I watch out for before loading a program modification from the ES into
the PLC?

ANSWER:
The system behavior of a PCS7 PLC is exactly defined for each system state. If
certain system limits (resources) are violated during loading, this can lead to the
PLC STOP state. Since the loader in the CFC doesn’t check all the conditions, the
user has to check specific resources PLC given below before loading:

• Is the memory in the PLC large enough? (see also Entry ID: 2698524)

• Is the maximum cycle time not exceeded? (see also Entry ID: 2847489)

• Is the local data correctly segmented? (see also Entry ID: 2718726)

• Is the maximum number of ALARM_8P resources not exceeded?

• Is the number of possible inputs, outputs or markers exceeded?

7.1.2 Creating the special OBs via a MSG_CSF block

Entry ID: 5127064- Date: 11/03/2000

QUESTION:
How can I prevent the PLC from being put into "STOP" after failure of a DP slave?

ANSWER:
By default the PLC goes into "STOP" upon the occurrence of an event (e.g. a DP
slave fails). This is a system property. The PLC’s operating system must react
deterministically to all events.

If this system reaction should be undesirable for a plant, then you can influence the
behavior by calling a special OB (OB80 to 86). This OB is then called by the PLC in
the case of failure.

Using station diagnostics (diagnostics buffer of the PLC) and "Help on event" you
are informed of the failed OB that is called by the PLC in the case of an event (if
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the OB is available; if not the default reaction of the system is to put the PLC into
STOP).

Remedy:

The control system message concept of PCS 7 provides for the reporting of rack
failure, failure of its own modules, battery failure, cabinet status and errors that
occur when the operating system accesses blocks or Obis that are not loaded.
Messages for these events are generated by the "MSG_CSF" block.

In each S7 program of a CPU create a chart and insert a MSG_CSF block into it. In
conjunction with the CFC compiler this block generates all the required special OBs
(OB 72, 80, 81, 83, 84, 85, 86, 87, 100, 121 and 122). These blocks are transferred
to the PLC when loading the CPU. Thus in case of failure the special OBs are
available in the PLC and this avoids the default reaction of the CPU to go into
"STOP".

If a special OB is now called (e.g. following a rack or DP slave failure), then the
MSG_CSF sends a corresponding message to the OS responsible and the CPU
does not go into "STOP" on principle.

In PCS 7 version V5 or higher you are informed of the missing block by a warning
from the CFC compiler.

7.1.3 Delta compiling in the CFC is not possible when modifying the
interface of a block in PCS 7 version V4.02

Entry ID: 1007262 - Date: 11/02/1999

QUESTION:
Why can’t I use delta compiling when I modify the interface of a block (e.g. by
adding a block input or changing the format of an output from Integer to Real, for
example)?

ANSWER:
In the case of these program modifications DELTA compiling cannot be executed
in version V4.02. If your modifications include a change of variable type or if you
have added variables, then the programming language CFC demands a complete
compilation of the program with a subsequent download of the entire program.
Now, if you use more than 50% of the CPU memory capacity, this could lead to
problems. In the process system this circumstance would mean that only half the
memory could be used. As of version V5.x the CPU is deleted and compressed
before total loading. Then total loading functions even if more than 50% of the CPU
memory is occupied. However, the CPU is then also put into STOP which is critical
in process system.
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7.1.4 Blocks with the same number in the CFC

Entry ID: 1023992 - Date: 09/08/1999

QUESTION:
What should I do when two blocks (FC or FB) from different libraries have the
same number?

ANSWER:
The number of a block, for example FC76, must be unique. You must not assign
the same number twice. Therefore, when you write your own blocks, you should
select a free number. If you use blocks from different libraries that have been
purchased, then proceed as follows:

1. Place the block (e.g. FC76) of library 1 in the CFC.

2. In the symbol table change the relevant entry (e.g. "ACOS FC76 FC76"
becomes "ACOS FC176 FC176").

3. In the SIMATIC Manager rename the block under "Blocks" (e.g. "FC76"
becomes "FC176").

4. Recompile the CFC plan.
Now, the instances that have already been placed are changed to FC176. In
the CFC, the block FC176 is included in the folder for your own blocks in the
program (e.g. "S7 Program(1)"). You can place other instances there, too.

5. Now, you can place the block with the identical name from library 2 quite
normally in the CFC, because the "double" number is now free.

7.1.5 Error message: Coordination rules have been violated FBxxx

Entry ID: 1096269 - Date: 09/20/1999

QUESTION:
What does the error message "Coordination have been violated FBxxx" mean
when downloading a program into the CPU?

ANSWER:
One cause could be that you are accessing the block in Debug mode (SCL or
STL). Values could still be forced in the CPU.

Remedy:

• Terminate forcing and remove the connection cable. This terminates the
Debug access.

• If this doesn’t clear the problem, do an overall reset for the CPU.

• For test purposes download a DB. In this way you can determine whether the
problem is connected specifically to the block displayed or whether no blocks
at all can be loaded into the CPU.
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7.1.6 Sample program: request fault for time interrupt, measuring the
time-out

Entry ID: 1155460 - Date: 01/04/2000

QUESTION:
What can I do against the request fault for a time interrupt OB in the diagnostics
buffer?

ANSWER:
In the diagnostics buffer you get the request fault. The time interrupt that must be
processed has not yet finished its last cycle and is still processing. In this case you
should restructure your program. Unfortunately, now in the diagnostics buffer, you
can only see which time interrupt OB is affected by this. What you do not see is by
how long a time the processing was exceeded. This, however, is an important
piece of information that you need before you can start to restructure your program.

In the libraries you have a "TIME_BEG" block and a "TIME_END" block. With
these blocks you get the precise information about how long the current cycle
time of a block was. Since, however, the monitoring time in the CFC is 1 second,
you cannot accurately monitor a 100ms time interrupt. The value at the output of
the TIME_END is updated constantly. Until now, because of the "TIME Format" of
the output a lot of effort was required to store the maximum value. For this you
needed a series of blocks and markers or DBs.

With the MAX_TIME block, only the maximum value is shown directly at the
block output. Only this is important for optimizing. Through the Reset input you
can also constantly reset the whole set-up for new tests. The benefit here is that
you only need one block. It is connected directly to the "TIME_END".

If you use more than one type of time interrupt in your project, then it is best to use
the MAX_TIME5. With this block you can monitor up to five time interrupt types
simultaneously and also reset each one separately. If you are already using block
number FB3 or FB4 in the project, then you can just choose a new FB number
when you insert the block.
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Downloadable sample program:
Copy the MAX_TIME.exe or MAX_TIME5.exe file into a separate directory and
then start it with a double-click. The project is now unpacked with all the associated
subdirectories. You can then open and process the unpacked project with the
SIMATIC Manager.

MAX_TIME.exe (45 KB)

MAX_TIME5.exe (40 KB)

Note

The sample program is freeware. Every user can use, copy or forward this
program FREE OF CHARGE. The authors and owners of this program take no
responsibility whatsoever for the functionality and compatibility of this software.
Use of the software is entirely at the users own risk. Since this software is free of
charge, there is no warranty, nor claim for error correction and hotline support.

7.1.7 Wrong string length when transferring to WinCC in PCS 7 version
4.02

Entry ID: 1436308 - Date: 11/18/1999

QUESTION:
Why after changing the string length is the original string length still transferred to
WinCC?

ANSWER:
In the CFC you have created instances from a function block that contains a
parameter of the String type. When mapping, this string is supposed to be
transferred to WinCC. In this case the attribute S7_m_c has the value TRUE. If you
subsequently change the length of the string and reimport the block into the CFC,
then the old string length will still be transferred to WinCC.

This behavior occurs in version V4.02.

Possible solution:

1. Set the attribute S7_m_c of the string variable to FALSE

2. Import the block into the CFC editor

3. Set the attribute S7_m_c to TRUE again

4. Reimport it.

Now the string is transferred to WinCC with the changed length.
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7.1.8 Numbers of the instance data blocks of the CFC

Entry ID: 1578540 - Date: 02/21/2000

QUESTION:
Can the numbers of the instance data blocks of the CFC change during
configuring?

ANSWER:
The numbers of the instance data blocks that are assigned to the block instances
in the CFC are assigned automatically by the CFC. You cannot influence the
numbers. When an instance data block has been assigned to a block instance, the
number of the instance data block can only change through the following actions:

• A plan is copied into another project.

• Compression is performed via the menu item Tools > Settings for compiling.

• A block type is newly imported. In this case only the numbers of the instances
that are newly imported change. Changing the DB attributes doesn’t lead to
renumbering.

• The projected is stored out of the SIMATIC Manager with or without
reorganization. As of CFC version V5 + SP3 (PCS 7 version V5.0) the numbers
of the instance data blocks are retained.

Apart from this, the instance numbers are retained.

7.1.9 Sample program: generating message in the AS with new and old
values upon changing values

Entry ID: 1871311 - Date: 03/23/2000

QUESTION:
How can I generate a message in the AS containing the new and old values
whenever a value changes?

ANSWER:
In the example a message is stored in WinCC when a value (VALUE) is changed.
The message contains both the old value and the new value of the VALUE
variables. Proceed as follows:

1. Create a block in which you compile the attached SCL source.

2. Interconnect the block thus created (FB9) in the CFC with a MESSAGE block
as follows:
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3. It is important that the FB9 in is called directly in front of the MESSAGE block
in the run order.

4. In the message configuration of the message block you then enter the
following, for example, for ’Text 3’ (Event) or ’Text 5’ (Operation) with the first
message:
"value has changed: old value: @1%3d@ new value: @2%3d@"
This outputs the first and second message auxiliary values in the
corresponding message. (Here format adaptations are necessary if the VALUE
variable is not of the Word type.)

5. After compiling, loading and mapping, then upon each change of the value of
the VALUE variable, the message 1 of the MESSAGE block is stored.

SCL code of the FB9 block:

SCL_Code_FB9.pdf (2 KB)
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The PCS 7 project as self-extracting file:
Copy the hyst.exe file into a separate directory and then start it with a double-click.
The PCS 7 project is now unpacked with all the associated subdirectories. You can
then open and process the unpacked project with the SIMATIC Manager.

Hyst.exe (1685 KB)

Note

The sample program is freeware. Every user can use, copy or forward this
program FREE OF CHARGE. The authors and owners of this program take no
responsibility whatsoever for the functionality and compatibility of this software.
Use of the software is entirely at the users own risk. Since this software is free of
charge, there is no warranty, nor claim for error correction and hotline support.

7.1.10 Interconnect ANY Pointer to a complete data block in the CFC für
PCS 7 Version 4.02 or higher

Entry ID: 1885730 - Date: 02/18/2000

QUESTION:
How can I interconnect complete data blocks for transfer in the CFC using the
communications blocks (BSEND/BRCV, USEND/URCV...) or even the BLKMOV
block?

ANSWER:
As of PCS 7 version V4.02 you have the option of connecting a complete data
block in the CFC to the inputs SD_i/RD_i of the communications blocks. For this
select the input in the CFC and open the "Connection to operand" dialog. Here you
can specify "DB15", for example. When compiling the CFC program an ANY
Pointer is generated internally and it points to the complete data block.

! Warning

If you subsequently change the length of the block, you must trigger Overall
Compiling and Overall Loading in the CFC of version V4.x. Otherwise the new
length of the data block is not updated by CFC. As of the CFC version V5, it
suffices to trigger Change Compiling and Change Loading.
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7.1.11 Format adaptation for the process value output when configuring
messages in the CFC

Entry ID: 1926599 - Date: 04/03/2000

QUESTION:
How is the format statement to be understood when configuring messages?

ANSWER:
In configuring messages in CFC you want to specify a certain format statement
(e.g. 6-digit floating point number with an accuracy of two points and leading zeros)
for your message values. In order to obtain the correct syntax in the form of
@1%06.3g@, you can use a WinCC tool. Using this tool it is possible to easily
determine the format statement required for message configuring of the CFC block.

The tool is available for you in the Alarm Logging of WinCC. Proceed as follows:

1. Start WinCC.

2. Open the Alarm Logging editor.

3. Insert at least one user text block and one process value block (procedure:
in the tree view select the appropriate block type, right-click and select the
menu item Insert/Remove).
This is not necessary if you have started the Alarm Logging wizard.

4. Open the following window via the menu "Messages > Texts for multiple
messages" or
you select a message from the single messages table. Select "Properties".
Select the "Texts" parameterization dialog.
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5. Press the [...] button at the end of the user text field and the following mask
opens:

6. Explanation of the fields:

• Process value block: you select a process value block that you have defined.

• Type: here you select the type of your process value.

• Position: position of the variable in the message block concerned (not
relevant here).

• Number of Digits: total number of the digits to be displayed, where the point is
counted as a separate digit.

• Precision: number of places after the point +1.

This figures then appear appropriately in the "Format Specification" field. You can
copy this statement and insert it in the message configuration concerned.
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7.1.12 Absolute addressing of global operands in the CFC or in the SFC

Entry ID: 2098423 - Date: 05/02/2000

QUESTION:
In the SFC or CFC why can’t I set up a connection to an absolute addressed global
operand?

ANSWER:
Probably the syntax of the global operands has been input incorrectly.
Contrary to the regulated type of writing DB20.DBX2.3, you must use DB20.DX2.3
in STEP7.

Other examples for addressing the global operands:

DB20.DB3 Third byte in the data block 20

DB20.DW2 Data word 2 in the data block 20

DB20.DD4 Double-word 4 in the data block 20

Please note:
A REAL or INT parameter can only be addressed symbolically.

Example:
You want to supply an IN parameter of the type REAL.

 Correct  Incorrect

DB1.value DB1.DD0

7.1.13 "CPU memory insufficient" message when loading the AS

Entry ID: 2698524 - Date: 07/24/2000

QUESTION:
When loading from the ES I get the message that there is insufficient space on the
CPU. What is to be done in this case?

ANSWER:
It might be necessary to reorganize and compress the RAM after frequent loading
of blocks. This is necessary if the size of the largest coherent memory area is not
enough to load a new object from the PG into the CPU.

The requirements is that an online connection to the CPU is set up. Proceed as
follows:

1. Mark the S7 program in the online view or in the "Available users" window.

2. Select the menu command "Target system > Module status".

3. In the following dialog box select the "Memory" tab. In this tab there is a button
for compressing the memory.
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7.1.14 Central changing of type of blocks CFC charts

Entry ID: 2771574 - Date: 08/02/2000

QUESTION:
Can a block built into several CFC charts be changed centrally?

ANSWER:
Central changing of type has the following effect:
All instances of a block type (FB or FC) that have already been included in CFC
charts, are changed if the interface description of a type changes (e.g. user block is
changed or block with new version from a library).

Example:
If a parameter changes in the block type "CTRL_PID", then when the "CTRL_PID"
is imported into the chart folder, the change of this parameter is made in all
instances of this type.

Procedure:

1. Change the block as required in the SCL source or in the block container of the
CPU.

2. After making the change to the block, open any CFC chart in the CPU.

3. Select the menu command "Options > Block types".

4. Select the changed block in the left window and with the ">" button move the
block into the right window. In the dialog that opens accept the new version of
the block by pressing the "Yes" button.

The old version is replaced by the new version in all charts of this CPU. If, during
the course of this action sources have to be deleted (e.g. because an input on the
block has to be removed or renamed), then you will receive a list of all the sources
deleted from all the charts.

7.1.15 Linking PCS 7 message block with group display.

Entry ID: 325658 - Date: 12/04/1998

QUESTION:
How should I configure a message block so that it can be link to a group display?

ANSWER:
Proceed as follows:

• Create a new library and insert an S7 program.

• Insert the message block from the Project Block Container into the Block
Container of the new library.

• Rename the block in the library (any free FB number).

• Open the block with the STL editor. Select any input (e.g. I_1) and right click
the input to open the object properties. In this window you must insert the
system attribute ’S7_m_c’ and set the value to ’true’. Now store the block you
have just changed.

• Insert the new block into the CFC plan and assign a name.
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• Open the object properties of the block and under ’Special Object Properties’
activate the HMI option. Now acknowledge with OK.

• Recompile the program and map it.

• The EventState variable is created in WinCC. This can now be linked with the
group display.

7.1.16 Warning: "CHANGE the OBx: the FCy must be called." when
compiling the CFC

Entry ID: 391247 - Date: 10/11/1999

QUESTION:
What does this warning mean and why are OBs created with the FUP editor
corrupted after the CFC is compiled?

ANSWER:
This messages appears if the OBx has already been edited manually using the
STL or FBD editor. The CFC recognizes this, doesn’t overwrite the changes and
issues the above-mentioned message.

You have two options for clearing this warning:

• You do not want to edit the OBx manually:
In this case you simply delete the OBx off-line from the block container. The
next time you compile the OBx is recreated without any warning.

• You have made important manual changes in the OBx:
Check whether it is absolutely necessary to make these changes in the OBx.
As far as possible, you should group the program code inserted in the OBx in
an FC. You can then build this FC into the CFC and call it in the OBx. You can
access the temporary variables of the OBx in your FC with the block SFC6
(RD_SINFO).

If you cannot do this, then you must incorporate the FCy by hand into the OBx.
This is because in the FCy all the blocks that are supposed to be processed in the
OBx are called from the CFC. You should watch out for the following in this case:
Call the FCy generated by the CFC in the OBx with the UC command:
STL: UC FCy
FBD: Via "Add > Program Elements" open the program element window. In the
item "Control Panel > [CALL]" you can enter the UC call in the FBD.

! Warning

If you call the FCy with CALL FCy, the OBx will be damaged when the CFC is
compiled.
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7.1.17 Linking string as message-accompanying value

Entry ID: 674578 - Date: 06/13/2000

QUESTION:
Can I also link strings as message-accompanying values of the Alarm_8p block?

ANSWER:
You may not link variables of the String type directly with the message-
accompanying values SD_1 to SD_10 of the Alarm_8p block. However, there is
the option of converting the string into an "array of bytes". This can then be linked
as message-accompanying value.
From the attached SCL code you can see how to convert a string in a block written
in SCL. You should also note the following:

1. In the SCL Editor call the "Create Block" tab under the menu item "Options >
Settings ...". Here you must activate the option "Consider system attribute
S7_server".

2. Now you can compile the SCL code.

3. Mark your newly created block in the block container of the SIMATIC Manager.
Via the menu items "Edit > Special Properties" open the "Message" window.

4. Here, in the "Configure message" menu you must select the "New Device"
button and WinCC must be selected as display device. Leave this window with
OK.

5. Now mark the first message "Sub_No_1" and then the new device. Now, in
the "Text" tab, you enter "$$AKZ$$" for the origin in the first text line "Text 1".
If you want to configure other messages, mark "Sub_No_2" (Sub_No_3, etc)
and also enter here "$$AKZ$$" in the text line "Text 1".

6. Under "Text 3" you must enter "@1%s@". Then the text appears in the
message line under "Event".

Now you can incorporated the block generated in the CFC and configure
messages as usual.

SCL-Sourcecode_e.pdf (4 KB)

7.1.18 No more accompanying message values displayed in WinCC

Entry ID: 674649 - Date: 12/04/1998

QUESTION:
What could be the reasons for no more accompanying message values being
displayed during interrupt logging?

ANSWER:
Check the following points:

• If you have change the configuration of the accompanying message value,
then, after downloading the program into the AS, you must restart the AS. This
is necessary to reinstall the INTERRUPT _8P block.
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• When configuring the accompanying message values there must not be any
gaps. If, for example, the fifth accompanying message value is not configured,
the accompanying values six to ten cannot be displayed in WinCC.

• It is not permitted to configure variables of the STRING type directly as
accompanying message values. A workaround for this is described in the FAQ
"Configuring string as accompanying message value" (Entry ID 674578).

7.1.19 Valve block PCS 7 doesn’t support on-site operation

Entry ID: 762780 - Date: 03/01/1999

QUESTION:
Can I have on-site operation with the valve block "VALVE"?

ANSWER:
No, it is not possible to have on-site operation with the valve block "VALVE" in
PCS 7.

7.1.20 Message when inserting blocks in CFC plan

Entry ID: 766298 - Date: 03/01/1999

QUESTION:
I have created a new project. Why, when I insert blocks in a CFC plan, do I get the
message "HMI properties could not be created"?

ANSWER:
In the Control Panel under Country Properties you have set "English (USA)" and
have made a user-defined setting in the country settings.

In order to stop this message appearing open Country Settings via
Start>Settings>Control Panel. There you select the "Numbers" tab and enter a
period instead of a comma for the decimal separator character.

7.1.21 Notes on using the ALARM_8P

Entry ID: 770488 - Date: 12/08/2000

QUESTION:
How should I configure the ALARM_8P block in the CFC?

ANSWER:
The system function block SFB35 looks like this in the CFC:
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Proceed as follows to configure:

1. Enter the value "EEEE" for the "ID" parameter.

2. The "EV_ID" parameter is assigned automatically. You can find the messages
again in the Alarm Logging via this value.

3. By configuring a WinCC station you can assign a message text to each
"SIG_x" input.

Note
You must specify the message text for each language that you want to use in
WinCC.

4. The message is activated by a change of edge at the "SIG_x" input.

5. When an alarm is triggered, all the process values are supplied as well. In
order to be able to display these in WinCC you must add the desired process
value to the message list (e.g. on the new page).

6. No data of the data type STRING can be transferred for the process values.
Remedy:
Convert the string into an ARRAY OF BYTES.
Information on this is available on the Customer Support pages under Entry ID
!674578!

7. You can use the table below to convert the "EV_ID" parameter into the
corresponding message number. Here you have to convert the hexadecimal
parameter "EV_ID" into a decimal value
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Example:
The "EV_ID" parameter has the hexadecimal value 75337h. This corresponds to
the decimal value 480.055. The message "SIG_1" thus receives the number
872.895.288 in the Alarm Logging.

 EV_ID  IN 1  IN 2  IN 3  IN 4

0 872.415.232 874.512.384 876.609.536 878.706.688

1 872.415.233 874.512.385 876.609.537 878.706.689

2 872.415.234 874.512.386 876.609.538 878.706.690

3 872.415.235 874.512.387 876.609.539 878.706.691

... ... ... ... ...

... ... ... ... ...

480.055 872.895.288 874.992.440 877.089.592 879.186.744

 EV_ID  IN 5  IN 6  IN 7  IN 8

0 880.803.840 882.900.992 884.998.144 887.095.296

1 880.803.841 882.900.993 884.998.145 887.095.297

2 880.803.842 882.900.994 884.998.146 887.095.298

3 880.803.843 882.900.995 884.998.147 887.095.299

... ... ... ... ...

... ... ... ... ...

480.055 881.283.896 883.381.048 885.478.200 887.575.352

7.1.22 Error message: Maximum length of code area reached

Entry ID: 771569 - Date: 09/13/1999

QUESTION:
What is the meaning of the error message "Maximum length of code area
reached"?

ANSWER:
All blocks (FBs) are incorporated into OBs. Here, all the blocks that are
incorporated into an OB in the CFC are grouped in an FC.
These FCs are called in the OB in each case. In the assembler, an FC may only
have 64KB. If you put too many blocks into an OB, you might possibly exceed this
size. You can avoid this problem by creating a run group in the CFC for each OB
and incorporate part of the blocks in this run group. Since a separate FC is created
for the run group, the size of the FCs decreases and the error message no longer
occurs.
This problem occurs particularly often with OB100. The FC42 is usually assigned to
this OB. You can have this displayed over the reference list in the CFC.
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7.1.23 Generating a new time stamp despite identical operator
messages

Entry ID: 822508 - Date: 04/26/1999

QUESTION:
Why are identical operator messages generated with a new time stamp?

ANSWER:
You create messages in message class "Operator messages" with the MESSAGE
and ALARM_8P blocks. If there is a "HIGH" signal permanently at the message
input of the block, the associated message is generated again with a new time
stamp as soon as another message input receives a "HIGH" signal. This is a
system property of the message class "Operator messages".

The message class "Operator messages" is defined as follows in WinCC:

• Messages without "gone" state

• Messages without acknowledgment

• WinCC behavior:
Each "HIGH" state of the block is entered in the operator activities log, as soon
as a message is sent from the MESSAGE or ALARM_8P block through a 1/0
or 0/1 transition at any block input.

• A change in WinCC is not possible because of the missing "going" message.
Example:
Operation via an I/O field.

• A change in the AS block is not possible because neither the message class
nor the WinCC acknowledgment behavior is known to the block algorithm.

Remedy:
Provide the input concerned with pulses when using the MESSAGE or ALARM_8P
block for operator messages. A permanent "HIGH" signal is not permissible in this
case.

7.1.24 Missing OBs in the run properties of a block

Entry ID: 865057 - Date: 05/31/1999

QUESTION:
Why can’t I see some OBs in the run properties of a block?

ANSWER:
In the CFC you open the run properties of a block because you want to incorporate
the block into a specific OB. But this OB is missing from the list. Probably you have
given the OB a symbolic name. The OB is thus displayed only under the
symbolic name in the CFC.

Remedy
You can delete the symbolic name and press the F5 key in the CFC. The OB
reappears in its usual place.
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7.1.25 OB number display in the block header

Entry ID: 905116 - Date: 06/29/1999

QUESTION:
In the CFC Plan why isn’t the correct OB number displayed in the block header?

ANSWER:
In the block header you generally get a display of the number of the OB in which
the block was last inserted in the runtime sequence. If you add a block in the
runtime sequence of several OBs simultaneously, it might happen that the OB
number of the time interrupt OB is not entered as usual.

Proceed as follows to correct the situation:

1. Open the runtime sequence from the CFC editor.

2. Remove the block concerned from the time interrupt OB.

3. Close the runtime sequence.

4. Open the runtime sequence again.

5. Reinsert the block concerned into the time interrupt OB.

6. Close the runtime sequence.

7. Update the view of the CFC Plan by pressing the "F5" key.
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7.1.26 Language of message texts in the CFC

Entry ID: 982759 - Date: 07/27/1999

QUESTION:
How can I copy the message texts in the CFC into another language?

ANSWER:
You have configure the message texts in the CFC. Now you want to copy the texts
into another language. Proceed as follows:

1. In the SIMATIC Manager under Tools open the window Display Language.

2. Install the required language.

3. Click the Apply button.

4. Acknowledge with OK.

5. Open the Display Language window again.

6. Select the required language in the top right window ("Language installed in
project").

7. Set the checkmark for Copy Texts.

8. Press the As Standard button.

9. Click the Apply button".

10. Acknowledge with OK.

The configured message texts are now copied into the required language and can
be mapped to WinCC.
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8 Import-Export-Assistant

8.1 Basics

8.1.1 Language Setting in the SIMATIC Manager

Entry ID: 00001- Date: 22.08.2000

QUESTION:
What do I need to remember before importing?

ANSWER:
Before you import, check the language setting in the SIMATIC Manager. If you
create a model, for example in German, and the SIMATIC Manager is currently set
to English, the German message texts will be written into the English text file.



Import-Export-Assistant

Process Control System PCS 7, Tips and Tricks
8-2 A5E00080064-01



Process Control System PCS 7, Tips and Tricks
A5E00080064-01 9-1

9 SFC-Plans

9.1 Basics

9.1.1 Variable updating and archiving.

Entry ID: 364055 - Date: 07/07/1998

QUESTION:
Which other applications still use cyclic read requests?

ANSWER:
Cyclic read requests are used by CFC and SFC. CFC/SFC use only cyclic read
requests. If there are no more cyclic resources available, then an error message is
output and the corresponding fields are displayed with a red background. The data
is not requested acyclically.

CFC/SFC have no variable optimization. Therefore, one resource is occupied in the
WS per 37 variables to be displayed.

All the variables of the currently opened plans enter into the set of variables to be
displayed, even if a plan is not in the foreground at the time. This is implemented to
ensure rapid switching between several plans.

9.1.2 Detail window of the SFC visualization cannot be operated in
PCS 7 version 4.0x

Entry ID: 1703113 - Date: 12/23/1999

QUESTION:
Why can’t you operate all the setting options in the detail window of the SFC
visualization?

ANSWER:
In version V4.x of the PCS 7 you get this behavior if no user is configured in the
User Administrator. The first time that WinCC Runtime is activated no error occurs.
If you then deactivate and then reactivate WinCC Runtime without closing the
Control Center, then all the fields in the detail window of the SFC visualization are
grayed out.
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Remedy:

• Deactivate WinCC Runtime and restart the Control Center

or

• Create at least one user in the User Administrator

9.1.3 Interconnection of inputs on the SFC_CTRL block

Entry ID: 382741 - Date: 07/20/1998

QUESTION:
How can you prevent the output LI_ERR being set?

ANSWER:
It is absolutely necessary that only the CMODINI or EN_OM input is set at one
time.
Likewise either the SCT or SGC input only.
It is also important that the inputs OM_BY_LI and LM_BY_LI are only set or reset
by pulses, a lingering 1 signal is not permitted.
The inputs T_OPRQCA and S_ERRCA may also only be acknowledged as pulses
after occurrence of an error.

It’s only allowed to set one instruction at a time.

Notice

For working through the SFC steps it is important that the output INSTOUT is set,
otherwise no commands are output.

9.1.4 Maximum number of SFC plans in one S7 CPU with and without
control blocks in PCS 7 version 4.0x

Entry ID: 734508 - Date: 02/02/1999

QUESTION:
What is the maximum number of SFC plans possible in one S7 CPU with and
without control blocks?

ANSWER:
The maximum number of SFC plans depends on a number of factors. Since these
factors depend on the configuring of the project concerned, it is not possible to
make a concrete statement on the maximum number of SFC plans possible.
The factors involved are described below:
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Communications instances (CFBs) of the CPU

The maximum possible number of communications instances depends on your S7-
CPU. Each AS-AS communications block (Send/Receive) and each message-
supporting block (ALARM_8P, message, technological block, field device block and
also SFC) occupies one of these communications instances. You have to find out
the number of the occupied communications instances in a project by manually
counting the blocks concerned.
The following list shows you how many communications instances each S7-CPU
has:

 CPU landscape  CPU
412-1

 CPU
413-1

 CPU
413-2

 CPU
414-1

 CPU
414-2

 CPU
416-1

 CPU
416-2

Maximum number of
simultaneous CFB blocks,
incl. PMC MC

150 150 150 300 300 600 600

Internal lists of the SCL compiler

When compiling the S7 program, the SCL compiler creates an internal list for each
OB and each sequence group of an OB. In this list are stored and processed the
symbols and identifiers contained in the program for the duration of the compilation
process.

The capacity of these lists is limited:

• PCS 7 Version V4.01 - maximum 4700 symbols

• PCS 7 Version V4.02 - maximum 9400 symbols

Each symbolically defined parameter (variable, constant, block name etc.)
occupies one entry in these lists. You cannot compile the S7 program if your OB or
a sequence group contains so many symbols that your internal list overflows.

You must build the SFCs directly into an OB and process all the other S7 blocks in
corresponding sequence groups. You cannot build the SFCs into sequence
groups. This is the only possible way of achieving maximum loading of SFCs per
OB. If you have nevertheless built in so many SFCs into one OB that the SCL
compiler can no longer compile them, then you must reduce the number. You can
do this by distributing some of the SFCs to other OBs. The number of symbols an
SFC occupies depends on how many symbolic parameters you have processed or
assigned in that SFC. It depends, therefore, on your configuring.

WinCC variables

After the AS-OS transfer several variables are created per SFC in the WinCC
variable pool. WinCC only process a limited number of variables (depending on the
authorization at least 128 tags, maximum 64k tags). Thus the maximum number of
WinCC variables is also the limit of the maximum possible number of SFCs. This
limit depends on your configuring.
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Main memory of the CPU

Another limit that depends on the configuring is the main memory of the CPU used.
If the S7 program can no longer be loaded into the CPU after compiling, because
of the size, then nor can it create any more SFCs or extend the S7 program.

Communications load of the bus systems

With PCS 7 you can implement various bus systems (MPI, PROFIBUS, Industrial
Ethernet). These also have different performance data. Apart from the SFCs
contained in the project, there are also other aspects to the communications load:

• WinCC variables

• AS-AS communication

• Messages

• Etc.

You bus system must be able to update all the SFC plans contained in the project
within the configured cycle time in the visualization system. If the bus system is
already loaded by other communications, there are correspondingly less
communications resources free for the SFCs. It is not recommended to load a bus
to its maximum performance limits.

Summary

All these factors make the maximum number of SFCs depend on the configuring of
the individual project in each case. Thus no concrete or general valid statements
can be made here on the maximum possible number of SFCs. Nor can you use a
formula to calculate the number, because it is too complicated to take all the
factors into account. This again depends on the configuring of the other units
contained in the project.

9.1.5 Maximum number of transitions and alternative branches

Entry ID: 752341 - Date: 02/08/1999

QUESTION:
What is the maximum number of alternative branches permissible in an SFC plan?

ANSWER:
You can integrate a maximum of 255 transitions in one SFC plan. If you use all
these for alternative branches, you cannot integrate any more transitions into the
SFC plan. It is thus no longer possible to expand the plan.
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9.1.6 Using the SFC Control block

Entry ID: 790830 - Date: 12/04/2000

QUESTION:

What should I watch out for when using the SFC_CTRL block?

ANSWER:

Field of application of the SFC_CTRL:

• You can use it to query the status of the SFC plan and influence its run.

• The control station is handled as a base operation in CFC. As such you can
insert it into the CFC chart from the block catalog, interconnect it and
parameterize it (family: SFC_CTRL).

• Just like other instances in the SFC you can use the control block in the step
and transition loops. Thus with an SFC chart you can control the same or
another SFC chart via the control block. You are able to use one control block
per SFC chart.

Run properties:

The control block and the SFC chart are built into a cyclic task of your choice (e.g.
OB35) or into a run-time group (Version 5.x). Here you must make sure that the
control block is inserted directly in front of the SFC chart in the run sequence.

Important measures to be taken in Hand or Automatic mode:

If you want to use an SFC control block to control an SFC chart, then you must pay
attention to the following when parameterizing the inputs:

The CMODINI input determines the operating mode of the SFC when started via
the SFC CTRL block (input START). The following holds here: CMODINI = 1
automatic mode and CMODINI = 0 hand mode. Also note that in the SFC editor
under "Chart > Properties > Run properties > Properties", the option "Use default
settings for SFC start" must not be selected. Otherwise the operating mode of the
SFC chart at start will be determined by the default settings made.

For switching the SFC from Automatic mode to Hand mode you must set the
inputs as follows:

• "EN_OM" to 1

• Positive edge to "OM_BY_LI"

For the switching from Hand mode to Automatic mode of the SFC you must set
the inputs as follows:

• Release of Automatic mode by SFC test mode or the SFC visualization off
(press on "F" (Version 4.0x) or the symbol "padlock" (Version 5.x); next to the
operating mode indicator (Hand or Auto) or in SFC-visualization (OS))

• Positive edge to "LM_BY_LI"
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Notice
• At the inputs "OM_BY_LI", "LM_BY_LI", "Start", "Abort", "Hold", "Restart" and

"Reset" you must only set edges (positive edges) for activation.
• You must specify the type of processing of the SFC chart ("SCT" or "SGT").
• If you want cyclic operation, a command output and/or time monitoring, then

you must specify this also at the appropriate inputs ("CYCLEXEC",
"INSTROUT" and "TIME_MON").
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10 Configuring SIMATIC Connections

10.1 Basics

10.1.1 Implementing the SFB 12 and SFB 13

Entry ID: 1152252 - Date: 01/10/2000

QUESTION:
What should I watch out for when implementing the SFB 12 and SFB 13 blocks
(BSEND/BRCV)?

ANSWER:
Notes on implementing the SFB 12:

• The REQ parameter starts a job with a positive edge at the input. It must not
be reset and set again, before the DONE or the ERROR bit has been set.
One of the two bits is set after each send job. After that, a send job can be
triggered again via the REQ parameter. To ensure functionality, you must
program at least one zero run at the REQ input of the SFB.

• If the ERROR bit is set, the STATUS should be evaluated in any case to be
able to obtain any additional information on the cause of the error and to be
able to troubleshoot it directly. If necessary, this STATUS can be evaluated
any way, because in one case (job still running, distributed 11) the ERROR bit
does not have to be set.

• The parameter ID includes the local ID that was assigned when the connection
was configured.

• The parameter R_ID must be identical for both partner SFBs and unique in the
system.

• The length specification in the ANY parameter SD_1 is evaluated only the first
time the SFB is called, and the send buffer made available according to this
value. This value specifies the maximum transferable data volume for this
instance. For subsequent calls of the SFBs only the LEN parameter is
evaluated and the specified data volume is transferred accordingly.

ID and R_ID cannot be used dynamically because they are evaluated the first time
the SFB is called and are defined for this instance. They can no longer be changed
in subsequent calls.
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Notes on implementing the SFB 13:

• The parameter EN_R can be constantly at 1, since this SFB works
asynchronously and through certain calls, sent data might not be able to be
transferred. Here you must observe the general notes for SFB 12 and SFB 13
on using the data.

• The same statements apply for the parameters ID and R_ID as for the SFB 12.
Likewise, as with the SFB 12 the same applies for RD_1 as for SD_1.

• Either NDR or ERROR is set after completion of a process. Only after the NDR
bit has been set can you access the data in the receive buffer (data
consistency).

• As with the SFB 12 the STATUS should be evaluated at least after the set
ERROR bit.

General notes on SFB 12 and SFB 13:

In order to guarantee data consistency even during the transfer, you might proceed
as follows:

• In the Send CPU you work with a DB. The contents of this DB should, for
example, be sent to a partner. You copy this DB into the send buffer specified
in the SD_1 parameter. The length of the data is entered in the LEN
parameter.

• The REQ parameter is set and the send process is triggered.

• Data is received on the partner CPU.

• When the NDR bit is set, the receive buffer RD_1 is copied to another data
area (e.g. DB). The length of the data received is given in the LEN parameter.

• You can work with this data area until the next copy process.

Furthermore you must make sure that the data in DONE, NDR, ERROR and
STATUS is only available in the cycle of the occurrence of the event.
Correspondingly, the evaluation and the event handling must be made in the same
cycle or at least triggered there.

10.1.2 Different time response when setting up and clearing down
connections

Entry ID: 415724 - Date: 08/24/1998

QUESTION:.
Why are there different time responses when setting and clearing down
connections?

ANSWER:
A connection defines the communication properties between two users. STEP 7
stores all the properties of a connection and assigns a unique ID to each
communications partner per connection. This is the connection ID.
You can set up a connection in different ways:
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• When actively setting up a dynamic connection, there is a slight increase in the
cycle time.

• When actively setting up a permanent (static) connection the existing
resources are occupied.

Static connections are used if in an installation configuration you have sufficient
connection resources in each station that no longer have to be released.
Furthermore, you don’t have to consider the time-critical connection set-up and
cleardown.
Static connections are set up once and are then permanent.

Dynamic connections are used if you want to exchange data serially with various
communications partners or want to use the existing connection resources more
effectively. The actual setting up and clearing down is not done at the start-up of
each station, but as required via an explicit request from the user program.
It is therefore absolutely necessary to consider the time taken for setting up and
clearing down connections in the case of time-critical processes.

10.1.3 Sample program: configuring the blocks AG_SEND/AG_RECV (
V4.02 )

Entry ID: 676702 - Date: 01/25/2000

QUESTION:
How do I have to configure the AG_SEND/AG_RECV blocks in the CFC?

ANSWER:
Proceed as follows to configure the AG_SEND/AG_RECV blocks in the CFC:

1. Open the connection table of a CPU.

2. Insert a new connection via Insert > Connection

3. Select your partner station. As the connection type select FDD connection,
ISO on TCP connection or ISO transport connection.

4. Select the connection created and open its object properties with a right-click.
If necessary, you can change the connection ID here.

5. Note the Local ID and the Partner ID of the connection.

6. Load the connection table of both CPUs into the AS.

The other configuration steps depend on whether you want to transfer just a part of
the data block or the complete block.
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Configuration steps if you want to transfer just part of the data block:

1. Use the two functions AG_SEND and AG_RECV in a separate block. This is
necessary, because it is not possible to specify an Any pointer as a parameter
in the CFC. Switching of the SEND and RECV inputs must therefore be in STL.

2. Adapt the Any pointer of the SEND input of the AG_SEND to your data
structure.
Meaning of the parameter P#DB1.DBX0.0 BYTE 14:
DB1: data is sent from data block 1
DBX0.0: send data beginning with data byte 0, bit 0
BYTE 14: 14 bytes are sent

3. Save the function block and make the same adaptations to the Receive block.

4. Place the function blocks in each CFC Plan.

5. Parameterize the following inputs of the blocks as follows:
ID: first part of the local ID of the station in which the block is called. If ’0001
000A’ is set as Local ID, the ’1’ is switched.
LADDR: start address of the CP in the local station, via which the
communication is to run. You can take this address from the HW Config (object
properties of the CP, Addresses tab).

Configuration steps if you want to transfer the complete data block:

1. Insert the AG_SEND and AG_RECV blocks into an CFC Plan of the CPU
concerned.

2. Parameterize the following inputs of the blocks as follows:
ID: first part of the local ID of the station in which the block is called. If ’0001
000A’ is set as Local ID, the ’1’ is switched.
LADDR: start address of the CP in the local station, via which the
communication is to run. You can take this address from the HW Config (object
properties of the CP, Addresses tab).
SEND or RECV: required data block (e.g. DB19)

The PCS 7 project as self-extracting file:

Copy the "AG_SEND_RECV.exe" file into a separate directory and then start it with
a double-click. The PCS 7 project is now unpacked with all the associated
subdirectories. You can then open and process the unpacked project with the
SIMATIC Manager.

AG_Send_Recv.exe (417 KB)

Note

The sample program is freeware. Every user can use, copy or forward this
program FREE OF CHARGE. The authors and owners of this program take no
responsibility whatsoever for the functionality and compatibility of this software.
Use of the software is entirely at the users own risk. Since this software is free of
charge, there is no warranty, nor claim for error correction and hotline support.
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11 Operator Station

11.1 Basics

11.1.1 DCF 77 receiver for WinCC

Entry ID: 1046241 - Date: 09/20/1999

QUESTION:
How can I use the DCF 77 time signal in WinCC?

ANSWER:
The DCF 77 signal of the Federal Institute in Mainflingen near Frankfurt transmits
the official time for the Federal Republic of Germany. The transmission is wireless
via radio signal at a frequency of 77.5 kHz. Upon installation of the DCFRS you
also get this radio clock facility on your PC. WinCC takes the system time of your
computer. In order to get the exact radio signal, proceed as follows.

1. Switch on your PC.

2. Insert the supplied driver floppy disk into the floppy disk drive (usually drive A:)

3. Install the driver software.

4. Activate the DCF 77 receiver service.

5. Connect the DCF 77 receiver cable to the selected COM port.

6. Adjust the receiver so that the control LEDs flash every second.

If you can’t get a clear reception, check the following:

• Make sure that the receiver is as far away as possible from PCs, monitors,
laser printers, motors, motor drives or other simple sources of interference.

• Also keep the receiver as far away as possible from metal surfaces and
reinforced steel.

• Set up the receiver parallel to the transmitter antenna. The transmitter antenna
is located near Frankfurt am Main. Also take the side of the building facing
Frankfurt.
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11.1.2 GPS receiver (2XV9450-1AR13) for WinCC

Entry ID: 1069326 - Date: 09/20/1999

QUESTION:
How can I use the GPS satellite time in WinCC?

ANSWER:
WinCC takes the time from the system time of your computer. In order to receive
the exact radio signal from the GPS satellites, you must proceed as follows:

1. Switch on your PC.

2. Insert the supplied driver floppy disk into the floppy disk drive (usually drive A:)

3. Install the driver software.

4. Activate the DCF 77 receiver service in the Control Panel.

5. Connect the WinGPS receiver cable to the selected COM port.

6. Adjust the receiver so that it points to the sky.

The DCF 77 receiver service is used. The GPS decoder converts the GPS time
signal internally into a DCF 77 signal. This is read by the driver software and
transferred to the system time of the PC. you can’t get a clear reception, check the
following:

• Point the receiver antenna to the sky.

• Make sure that the antenna has as large a clear "view" as possible. If there is a
direct connection between your receiver antenna and the satellite, this is
known as visual contact.

11.1.3 OPC under WinCC V. 5

Entry ID: 1136345 - Date: 09/21/1999

QUESTION:
Which version of OPC is used with WinCC V5?

ANSWER:
OPC Version 2.0 is used with WinCC version V5. This version supports a new
Automation Interface.

11.1.4 Periodic beeping after starting WinCC

Entry ID: 1320229 - Date: 02/21/2000

QUESTION:
Why does the PC loudspeaker beep as soon as WinCC has been started?

ANSWER:
When you start WinCC, the loudspeaker begins to beep periodically. This can
caused by a number of things:

• You computer name has more than 13 characters
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• The computer name includes special characters or blanks

• For WinCC V5.0:
On your computer you must have Network Services installed and activated. If
you don’t have a correct network card in your computer, then, under Start >
Settings > Control Panel > Network, in the Network Card tab, you must
configure the "MS Loopback Adapter". In the Protocols tab you must at least
install the "TCP/IP Protocol".

11.1.5 Copying projects with WinCC V5.0

Entry ID: 1443781 - Date: 11/22/1999

QUESTION:
Can I copy projects with WinCC V5.0?

ANSWER:
With WinCC version V5.0 and higher you can no longer simply copy WinCC
projects. Now only the Project Duplicator can be used to copy projects.

11.1.6 Growing log file in the project path

Entry ID: 1936932 - Date: 02/25/2000

QUESTION:
Why is my log file getting larger in the project path?

ANSWER:
All the changes made in the configuration database are logged in the log file
("<Project_name>.LOG"). If the Runtime data cannot be written in the RT
database, then they are written in the configuration database. This of course also
affects the size of the log file. In this case the size increases very rapidly.

This behavior can have the following causes:

• Incorrect name of the Runtime database:
This can happen through a copying process or similar. The name of the
database is made up as follows:
Configuration database: "<Project_name>.DB"
Runtime database: "<Project_name>RT.DB"

• Runtime database is not available:
It has probably been deleted or moved by mistake.

Remedy:
Check the RT database. If something is wrong here or you are not sure, then you
can recreate it. The safest way of doing this is with "Database Upgrade".

! Warning

The previous Runtime data are lost in this process. If you want to prevent this,
then you should do a data back-up beforehand.
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11.1.7 WinCC V5.0: starting the project automatically depending on the
user logged in

Entry ID: 1958892 - Date: 03/09/2000

QUESTION:
How can I start a WinCC project automatically depending on the user logged in
when the computer is booted?

ANSWER:
When starting the computer you want to have a specific project started in the
WinCC Control Center or in WinCC Runtime depending on the user logged in. If
you are using the "AutoStartRT.exe" program, it is only possible to start WinCC
directly when the computer is booted independent of the user logged in.

There is however one possibility of starting a project depending on the user
logged in either in RT or only in the Control Center. For this you must create a link
to the "<Project_name>.mcp" file of the required project in the following directory:

<DRIVE:>\Winnt.400/Profiles/<Username>/Startmenu/Programs/Autostart

If this project is terminated in the RT, then the next time the computer is booted
with the corresponding login, then it starts again in Runtime mode. If another user
has another project open on this computer, then a link is to be made to this project
under the other user profile in the same way as described above.

11.1.8 Automatic program start after computer start-up

Entry ID: 1995242 - Date: 03/23/2000

QUESTION:
How can I get a program to start automatically after computer start-up?

ANSWER:
In addition to the standard method in Windows of putting the program concerned in
the Autostart folder, you also have the option of entering the program permanently
in the Windows registry. Then it will always be executed regardless of the user
logged on.

The Registry entry concerned is as follows:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\
Run

Proceed as follows to add a program.

1. Start menu > Run, enter regedit.

2. Find the code:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Ru
n

3. Insert a new character string (right-click\new\character string)

4. Double-click the code just create and a window opens in which you must enter
the complete path of the application to be started, for example:
"C:\Programs\<<MyApplication.exe>>"
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Notice

In general, no warranty can be given for direct changes in the registry database,
because this is entirely the responsibility of the user. In any case it is
recommended to make a backup of the registry before proceeding as described
below.

11.1.9 Removing Runtime data from the database in V 4.0 and higher

Entry ID: 218453 - Date: 02/17/2000

QUESTION:
In version V4.0 and higher of WinCC, how can you delete the Runtime data
(messages, archive values) from the database?

ANSWER:
The requirement for the following procedure is that the WinCC project is already
running with separate databases for Runtime data and configuring data. This
means that in an older project the "Database Upgrade" tool must have been
executed correctly.

1. Tag Logging cyclic archives in DBASE format:
the DBASE files, the complete contents of the PDE directory, can be deleted
without a problem, because they are recreated automatically.

2. Runtime database:
if you want to delete the Runtime data, then proceed as follows:
- Delete <Project_name>RT.DB
- Copy the WinCC.DB file from the BIN directory of WinCC to the current
project
- Rename the copy to <Project_name>RT.DB
- Delete the <Project_name>.log file
Complete

! Caution

If you only delete the RT database and do not make sure that it is recreated by
going through the steps described above, then the RT tables are created in the
CS database and the process values archived there. This results in rapid growth
of the log file, because it logs all the changes in the CS database. In the long run
this leads to a lack of hard disk space and inevitably to a system crash.

Note

If the WinCC.db file is not on your computer, then proceed as follows:

1. Close your current project and create a new one.

2. Close WinCC.

3. Now you can open your old project again.

4. The WinCC.DB file is now in the Siemens/WinCC/bin directory.



Operator Station

Process Control System PCS 7, Tips and Tricks
11-6 A5E00080064-01

11.1.10 Removing unnecessary data from WinCC databases with
WUNLOAD.

Entry ID: 2464133 - Date: 06/20/2000

QUESTION:
In my project, in both Runtime and in the configuration database I have a number
of tables the data of which I no longer need. How can I remove this data?

ANSWER:
You can minimize the size of your databases using the wunload.exe program.
This program generates a new database. The structure of the new database is
identical to that of the source database. However, you can choose the tables
from which the data is taken.

Note

Just as much memory is required to copy the database as is required by the
source database. If the size of your source database is 1GB, then you need 1GB
of free space on the source drive.

Proceed as follows to remove the data not needed:

1. Start wunload.exe. The tool is located in the "...\WinCC\bin" directory.

2. Select the source database.
Make sure that the source database is not being used by any program.
(WinCC, scview, Excel, etc. ).
By default the path "...\ProjectPath\WUnload\DatabaseName.db" is proposed
for the target database.



Operator Station

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 11-7

3. In the next step you can choose the tables from which the data is to be
transferred into the new database.
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In the case illustrated the data is not taken from the archives AnwARC and
AnwARC_1. Once you have made your choice, click Continue. If you click the
Table button, you can check the tables from which the data is to be copied.
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4. Click the Do button. Now a new database is generated. This process might
take a long time depending on the size of the database. You get the following
message upon successful completion of the process:
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5. You can replace the source database with the newly created database.

! Warning

In order to avoid loosing data, make a backup of the original database before
starting.

11.1.11 Variable updating with several clients

Entry ID: 379351 - Date: 07/20/1998

QUESTION:
If an image is selected on several clients, does WinCC do a multiple request for the
variables on the WS?

ANSWER:
No. The WinCC data manager groups together requests from several applications.
Thus one variable, regardless of the cycle, is only ever requested once at any one
time in the channel.

When using the cyclic read job, the channel manages the cycle processing. In this
case the data manager requests the variable just once per cycle in the channel.
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11.1.12 Inserting separately generated OS into PCS 7 or S7 project

Entry ID: 677622 - Date: 12/04/1998

QUESTION:
How can I insert a separately generated OS into an existing S7 project?

ANSWER:
Proceed as follows to insert a WinCC project that you have created "outside"
PCS 7 or S7 into a PCS 7 or S7 project:

• Into your S7 project you insert an OS that has the same name as the OS you
have already configured.
(In SIMATIC Manager select the top folder, right-click it and select ’Insert New
Object’ - ’OS’).

• Open the Explorer, switch to the path in which your S7 project is stored.

• In the ’wincproj’ folder of your S7 project is a folder with the name of the OS
just created in the S7 project. Delete this folder and insert your existing OS
project.

• To be on the safe side, you should store your entire S7 project again with
consistency check. If no errors are indicated, you can continue working with
the inserted OS.

11.1.13 English texts disappear when switching languages

Entry ID: 724240 - Date: 01/22/1999

QUESTION:
After importing a project and switching the language to "English" I no longer see
any text. Why?

ANSWER:
You have configured your project originally on a computer using an English version
of WindowsNT. Now you want to use the project on a computer that is running a
German version of WindowsNT, but you want to edit it under WinCC in "English".
You realize that after switching the language, you can no longer see any texts.

Reason:
In the English version of NT you have selected English/British as the language
ID. This is not available in the German version of NT. In the English version of
WindowsNT you must make sure that you select English/United States as the
language under WinCC. Otherwise you cannot port the project between the
operating system versions.
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11.1.14 WinCC Redundancy Project Duplicator

Entry ID: 779613 - Date: 04/06/1999

QUESTION:
How should I use the Project Duplicator?

ANSWER:
The Project Duplicator supports you in creating a copy of your project for the
partner server. You should always use the duplicator for this procedure. Do not
attempt to do it manually.

Note

The duplicator offers you two options for making a copy of the project concerned:

• "Save as..."
This makes a copy of the project, if you want, under a different name.

• "Duplicate"
This makes a copy of the project on another computer which is the
requirement for using the "Redundancy" option. Here the Project Duplicator
adapts the settings for the other computer.

Below is a description of the options and necessary procedures.

Notice

Never copy or duplicate a project over another project. Make sure that the target
directory is empty.

Creating a redundant project

1. Start the Project Duplicator. The following dialog box opens:
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2. Select the source project. Here you must specify the complete path and the
MCP file. You do this by clicking the top "..." button, or by entering the path
manually.

3. Close the file browser with Open and the Project Duplicator box then looks like
this:

4. Now select the target computer and the target directory by clicking the bottom
"..." button, or by entering the path manually.
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5. Now click Duplicate to create the project on the other computer.

6. When this box appears the copying process has been completed.
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Normally, you shouldn’t have to do any more matching here, because the
duplicator has already done it.

Saving the project under another name

1. Execute steps 1 to 3 as under "Creating a redundant project".

2. Click the Save as... button and specify where and under which name the
project is to be saved. In the example the new project is called "WinCC_dupli".
If you click Save a window opens displaying the files that are being copied.

3. When copying has been completed, close the Project Duplicator.
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Copying into a non-existent target directories

If you manually enter target directories after the computer name and these
directories do not exist on the target computer, then these directories are
created, but the duplicating process is aborted with an error.

1. Start the Project Duplicator and manually enter the target directory.

2. In the Explorer of the target computer you can see the directories selected, but
the duplicator has not yet copied the project there.
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3. A window opens that you close with Yes to All or exit with No.

If you exit with No, you can continue with step 5.

4. If you close with Yes to All to continue, the following error box opens that you
acknowledge with OK.
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5. Close the notes box.

6. After closing the notes box you can retrigger the duplicating process with
the newly created directory. This time the project is duplicated correctly.

11.1.15 Increasing the performance by taking into account
communication mechanisms with WinCC

Entry ID: 833225 - Date: 06/29/1999

QUESTION:
What should I watch out for with respect to the communication when configuring, in
order to obtain the best performance possible?

ANSWER:
Before you start configuring, it should be clear whether you want to implement an
S5 or S7 link. The S7 protocol differs from the S5 in communication and the
requesting of values.
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SIMATIC S7

• The data manager makes one request to the S7 when an image is selected.

• The values gathered can come from different data areas (e.g. DBs).

• The message length depends on the PDU size of the CPU (3xx / 4xx) and
varies between 208 and 448 bytes.

SIMATIC S5

• A separate message is created for each data block requested.

• The message length is 237 bytes in the case of S5 PROFIBUS and 496 bytes
in the case of Ethernet 496 Bytes with block transfer.

• You can simulate the functionality of the S7 if you implement S5-PMC. Curves,
image variables etc. are sent in the cycles configured. The message bits are
no longer set cyclically. Instead, event-controlled message telegrams are sent.

In order to achieve high performance you must also note the following:

It doesn’t matter whether you use a SIMATIC S5 or S7. Without variable trigger
individual requests are always sent in the case of image change. It is only
optimized afterwards. With variable trigger all the variables are requested together
at the same update rate.

How many tasks/messages can be processed per second depends on the
communications processor you are using in the SPS. The less different data
areas (e.g. data block) you address, and the less Address gaps there are in the
addressed data areas, the higher the performance.

Additional messages are requested for the Message System, Global Script and
Tag Logging. You must also take this into account when configuring. If you have
several curves from different data blocks, these values are requested by separate
messages. If these values are needed by Graphics Runtime in the image at the
same time, these are requested in an additional message.

In subsequent processing the values are requested by the controller or at least one
message is required:

• Monitoring of Alarm Logging area.

• Tag Logging depending on data collection cycle, at least one per collection.

• In the case of "GetTag" function calls in scripts, the variable is requested
cyclically (1 sec) after the first request.

• When you select an image, all the values are requested and processed
depending on the updating cycle.

• Additional applications (e.g. customer developments).

More information on optimizing configuring under WinCC is to be found in the
Comprehensive Support.
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11.1.16 Language switching for East European languages

Entry ID: 996777 - Date: 11/21/2000

QUESTION:
How can I implement language switching for East European languages?

ANSWER:
WinCC only supports German, English and French as operating system
languages. The software tool "KIRILLICA" has been successfully used for Russian
and Balkan languages. You can procure this from the Internet at
http://www.linkundlink.de/p1x4.htm. The full version is charged. When you start
"KIRILLICA", you can choose the languages that you want to install. "KIRILLICA"
offers a keyboard layout with which you can make your entries on the screen.
Then, when you want to use a language, you have to make a number of settings:

Text Library:
In the Text Library you have to set the language required in the corresponding
column via the menu command "Options > Language Font".

Alarm Logging:
In the Alarm Logging you can change the language for the message window
templates as follows (up to WinCC V4.02/SP1):

1. Right-click the message window.

2. Select "Properties" in the pop-up menu.

3. In the "Configure Message Window" that opens click "Font" in "General" tab.

4. In the next dialog you can choose the language for the template.

Note

In WinCC V5 and higher you set the language for the alarm messages in the
Graphics Designer in the Properties for the WinCC Alarm Control.

Graphics Designer:
In the Graphics Designer the characters are not displayed correctly upon entry in
the Properties and Configuration dialog. Acknowledge with "OK" and then you will
be able to recognize the correct characters in the objects. You must change the
font in the Properties dialog under "Font" in the "Character Set" attribute.
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11.1.17 Editor for the Dynamic Wizard

Entry ID: 00010- Date: 12.07.2000

QUESTION:
How do I write a Wizard that can run in the Dynamic Wizard of the Graphics
Designer?

ANSWER:

PCS 7 provides you with an editor with which you can create Wizard scripts
allowing the user to generate actions simply in the Graphics Designer.

The editor provides an interface with which you can create new scripts, modify
scripts and read them in; in other words, make them known to the actual Dynamic
Wizard on the OS.

To include a script, follow the steps below:

1. Start the program "C:\Siemens\WinCC\bin\DynWizEdit.exe" in the Windows
Explorer or using the "Run" function in the "Start" menu of Windows NT.

2. Select the language you require in the toolbar (for example "English").

3. Select the "File > New" menu command and formulate the Wizard script in
ANSI-C.

4. Save the Wizard script in any suitable folder.

5. Using the menu command "Dynamic Wizard" and "Read in Wizard Script",
read in the selected script so that it is available in the Graphics Designer. The
progress of the compilation is displayed in the display window. The new entry
appears in the "Dynamic Wizard" window in the Graphics Editor following
successful compilation.

Note:

Under certain circumstances, you will have to regenerate the header file in the
WinCC Explorer. If necessary, open the WinCC Explorer and then "Global Script".
In Global Script, select the "Tools > Regenerate Header" menu command.
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11.1.18 Software installations and authorizations in the multi-user system

Entry ID: 2887917 - Date: 10/16/2000

QUESTION:
Which software and which authorization do I need for the various OS systems?

ANSWER:

In the following is an overview of software installations and authorizations required.

Software installation required:

 OS-Single => Manadatory Programs

SIMATIC AuthorsW

SIMATIC NET S7 1413 oder SIMATIC NET S7 1613, oder SIMATIC NET S7 5412

WinCC Windows Control Center

Bibliothek "Field Device Blocks"

Bibliothek "Technological Blocks"
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 OS-Single => Optional Programs

SFC-Visualization

S7 Redconnect

WinCC Storage

WinCC User Archive

WinCC Chipcard Reader

WinCC Video

 OS-Server => Manadatory Programs

SIMATIC AuthorsW

SIMATIC NET S7 1413 oder SIMATIC NET S7 1613, oder SIMATIC NET S7 5412

WinCC Windows Control Center

Bibliotheken: Field Device Blocks

Bibliotheken: Technological Blocks

 OS-Server => Optional Programs

SFC-Visualization

S7 Redconnect

WinCC Storage

WinCC User Archive

WinCC Chipcard Reader

WinCC Video

 OS-Client/OS Multiclient => Manadatory Programs

SIMATIC AuthorsW

WinCC Windows Control Center

Bibliotheken: Field Device Blocks

Bibliotheken: Technological Blocks

 OS-Client/OS-Multiclient => Optional Programs

SFC-Visualization
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Authorizations required

 OS-Single => Manadatory Authorizations

WinCC RC x Tags (z. B. 128 Tags oder 64K Tags; abhängig von der Anzahl der
projektierten externen Variablen im Variablenhaushalt des WinCC Explorers in PCS 7
standardmäßig 64K)

WinCC Basic Process Ctrl

WinCC Advanced Process Ctrl

S7-5412 oder 1413 oder 1613

 OS-Single => Optional Authorizations

SFC Visualization

WinCC Chipcard Reader

WinCC Redundancy

WinCC Server

WinCC Storage

WinCC Video

WinCC User Archive

 Server => Manadatory Authorizations

WinCC RC x Tags (z. B. 128 Tags oder 64K Tags; abhängig von der Anzahl der
projektierten externen Variablen im Variablenhaushalt des WinCC Explorers in PCS 7
standardmäßig 64K)

WinCC Basic Process Ctrl

WinCC Advanced Process Ctrl

WinCC Server

S7-5412 oder 1413 oder 1613

 OS-Server => Optional Authorizations

SFC Visualization

WinCC Chipcard

WinCC Redundancy

WinCC Storage

WinCC Video

WinCC User Archive

 OS-Client => Manadatory Authorizations

WinCC RT 128 Tags

WinCC Basic Process Ctrl

WinCC Advanced Process Ctrl

 OS-Client => Optional Authorizations

SFC-Visualization
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 OS-Multiclient => Manadatory Authorizations

WinCC RC 128 Tags (abhängig von der Anzahl der projektierten externen Variablen; i. a.
128 Tags, da die Variablen auf dem Server liegen)

WinCC Basic Process Ctrl

WinCC Advanced Process Ctrl

 OS-Multiclient => Optional Authorizations

SFC Visualization

WinCC Chipcard Reader

WinCC Storage

WinCC Video

WinCC User Archive

11.1.19 Scaling variables with PCS 7

Entry ID: 1008166 - Date: 08/23/1999

QUESTION:
Why is scaling of variables lost after mapping?

ANSWER:
After mapping, all defined scalings of a variable that are located in the DB are lost.
This happens when you define a new variable in the DB. However, you should
make sure that scaling isn’t done on the OS. Scaling is done in the AS.

11.1.20 WinCC client cannot open the project from the server

Entry ID: 1014417 - Date: 08/24/1999

QUESTION:
Why can’t the WinCC client open the project from the server?

ANSWER:
The project is supposed to opened by the WinCC client from the server. But you
cannot open or activate the project. On the client you get a message that no
connection can be set up to the database server. If this error message appears,
then this is due to the link between client and server.

Check the following:

1. In WinCC, Multi-user system must be set in the project properties. All
computer names (server and all clients) must be entered in the computer
properties of the server.
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2. Select Start > Settings > Control Panel > Network > Protocols > Properties
TCP/IP Protocol. If the "Take IP address from a DHCP server" function is
activated in the "IP Address" tab, then such a DHCP server service must also
be available. This means that there must be a computer with Windows NT
server connected to the network. The computer must be configured as a DHCP
server. If this function is not activated, select the "Specify IP Address" function.
You must assign an IP address to each computer.

3. In the DOS window execute the command "ping +TCP/IP address" (e.g. ping
127.0.0.1) for the other computers in each case. Wait for a response.
If you don’t get an answer, you must check the complete network
configuration and parameterization.
If the response comes only after a relative long time (e.g. after several
seconds), then in the case of large networks you can speed things up by
setting up and activating the LMHOST query. You do this via Start > Settings
> Control Panel > Network > Protocols > Properties TCP/IP Protocol in the
"WINS address" tab. An example of a host file is given in
<Drive>\WINNT.400\system32\drivers\etc under the name "Host".
If you get a response as usual, use the Explorer to test whether you have
access to a drive of another computer. If not, then you must check the drive
releases and if necessary, make the appropriate releases.

11.1.21 Adapter for 3COM card interface with RJ45 with Primergy
computers

Entry ID: 1025091 - Date: 04/19/2000

QUESTION:
How can I connect my network cable to the 3COM card for 100Mbit/s transfer of
my PCS 7 Primergy computer?

ANSWER:
The current PCS 7 Primergy computers are supplied with new 3COM cards. These
network cards have a new 100-Mbaud interface (RJ45 connector). In order to be
able to connect these network cards to "conventional" network lines, you need the
adapter ITP9/RJ45 (2m). You can procure this adapter with order number
6XV1850-2DH20.
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11.1.22 APDIAG message in loop display call of a faceplate

Entry ID: 1548903 - Date: 11/26/1999

QUESTION:
Why do I get an error message when calling the loop display of a faceplate?

ANSWER:
You have planned a trend image in the loop display of a faceplate, but have not
programmed a trend image. When the loop display is called in WinCC Runtime,
you get the following error message in APDIAG:

========================OnErrorExecute=====================

dwErrorCode1: (ThreadId 351) 1007007

dwErrorCode2: (ThreadId 351) 2

szErrorText: (ThreadId 351) PDLRTAPI or DMAPI

szErrorTextInfo: (ThreadId 351) Error in DMApi

szApplicationName: (ThreadId 351) PDLRuntimeSystem

bCycle: (ThreadId 351) Acycle

szFunctionName: (ThreadId 351) @c1

lpszPictureName: (ThreadId 351) @SCREEN.@WIN12:@1001.@TOP10:
@PL_MEAS_MON

lpszObjectName: (ThreadId 351) (NULL)

lpszPropertyName: (ThreadId 351) (NULL)

dwParamSize: (ThreadId 351) 12

szErrortext: (ThreadId 351) WinCC Runtime: PDL Runtime :
image not selected

=======================OnErrorExecute=====================

This is caused by the Global Script standard function Faceplate Trend. The
function checks whether a trend image is configured for this faceplate. If so, the
configured trend image is displayed in the faceplate. If not, it fades in the default
image @CONL1_Error.PDL. If you haven’t configured a trend image, this behavior
is inevitable.

Note

FAQ Entry ID 264713 includes a description of how to incorporate a curve window
correctly in a faceplate.
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11.1.23 Hardcopy printout doesn’t work on some computers with a client-
server configuration under PCS 7 V4.02.

Entry ID: 1712549 - Date: 01/04/2000

QUESTION:
Why can’t I print on some computers with a client-server configuration under PCS 7
V4.02?

ANSWER:
If printing under Windows NT works from the other programs, then check the
following:

Step 1:

In the project directory of WinCC Project there is a subdirectory for each computer
of a project (whether server, client or single-user workstation). This subdirectory
has the same name as the computer concerned in each case. In this folder there is
a "..\Pas" subdirectory. In the folder there must be a file named DoJobAsync.pas.

If this file is not available, then proceed as follows:

1. Find this file.

2. When found, copy the file into the "Pas" folder of the computer concerned.

3. Restart you computer.

Downloadable file:
DoJobAsync_1.exe (31 KB)

Step 2

If you still can’t print after Step 1, the C script for the Print button can be replaced
by the following statement:
ProgramExecute("prtscr -nomcp");

! Warning

This statement does not work under Multi-VGA.

The script is in the images @Overview1.pdl, @Overview11.pdl, @Overview12.pdl
and @Overview13.pdl.

1. Mark the pushbutton, open Properties and select the Event tab.

2. Double-click the action.

3. Comment out the available action code.

4. Insert the statement ProgramExecute("prtscr -nomcp"); in the next line.

5. Recreate the action.

6. Click OK and then save the image.
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11.1.24 Automatic login of a defined user with chipcard reader

Entry ID: 1947167 - Date: 03/06/2000

QUESTION:
How can a preset user be logged in automatically by removing the chipcard when
using a chipcard reader?

ANSWER:
If you remove the chipcard from the reader, the system logs you off. At this point no
user is logged in. You have the following options to log in a defined user in this
process:

Automatic login of a predefined user when removing the card

The C script is called cyclically as a global action. Since the chipcard has the
higher priority, the script only becomes really effective when the chipcard is
removed. Note here, however, that the cyclic call of the script affects the
performance of the computer.

1. Open the Global Script editor.

2. Go to File > New Action.

3. Enter the following C script
#include "apdefap.h"
int gscAction( void ) {
#pragma code ("useadmin.dll")
#include "PWRT_api.h"
#pragma code()
PWRTSilentLogin ("login","passwort");
return 0;
}

4. Set an appropriate trigger time. This decides the maximum time for the user
set in the C script to be logged in. 5 or 10 seconds should suffice. The higher
this time, the less you system will be loaded by it. The time for the user to be
logged on is then of course accordingly longer.

5. Make sure that in the Properties of the computer, in the Startup tab you have
activated the Global Script Runtime.
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Login of a predefined user by pressing a button

The following C script is laid behind a button, for example. This is then only
executed when you press the button.

#include "apdefap.h"
void OnClick(char* lpszPictureName, char* lpszObjectName, char*
lpszPropertyName) {
#pragma code ("useadmin.dll")
#include "PWRT_api.h"
#pragma code()
PWRTSilentLogin ("login","password");
}

If, for example, a user with the login "defaultuser" and the password "default" is the
predefined user, the corresponding line is: PWRTSilentLogin
("defaultuser","default");

11.1.25 Intrinsically safe operating unit for hazardous area Zone 1 and
Zone 2

Entry ID: 2553068 - Date: 07/03/2000

QUESTION:
Is there an intrinsically safe operating unit for use in hazardous areas?

ANSWER:

There is a special intrinsically safe operating unit for use in hazardous areas. The
operating unit is connected to an Operator Station at a possible distance of up to
200 m. The intrinsically safe operating unit is released for the Operator Stations on
the Basis SIMATIC RI45. It is designed for EEx ib IIC T4 protection class IP 65 on
the front and provides a 15-inch TFT color display with a resolution 1024 x 768 or
an 18-inch TFT colors display with a resolution of 1280 x 1024 as well as an Exm
power supply concept with DC 24 V 3 A. A membrane keyboard in protection class
IP 65 is provided with the operating unit. An intrinsically safe trackball is required to
operate a PC from a hazardous zone. The trackball is for designed for EEx ib IIC
T4 protection class IP 65 on the front (trackball at rest). The intrinsically safe
trackball can be used in conjunction with the display and keyboard. It is connected
directly to the front end in the hazardous area.

Note

The mouse cursor reacts at about 1 Hz.
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Ordering data:

Intrinsically safe operating unit for hazardous area Zone 1 and Zone 2, consisting
of

EXPC-34-XGA
Exi front end for PC, EEx ib IIC T4, with 15" TFT color display and
Exi PC membrane keyboard, BVS 99.E.2036X

or

EXPC-33-XGA
Exi front end for PC, EEx ib IIC T4, with 18" TFT color display and
Exi PC membrane keyboard, BVS 99.E.2036X
EXTA-M3
Intrinsically safe trackball, BVS 95.D.2091X, EEx ib IIC T4 protection class IP 65 at
the front (trackball at rest)
EXPC mounting housing
various steel mounting housings for the EXPC, wall and table versions

Orders and more information:

EX TEC Oesterle GmbH
Schorndorfer Str. 55
D-73730 Esslingen
Phone: +49 (0) 711 31 54 55 0
Fax: +49 (0) 711 31 54 55 29
Internet: www.extec.de

11.1.26 Time jumps with defects in the DCF77

Entry ID: 384263 - Date: 03/01/1999

QUESTION:
The radio clocks are subject from time to time to interference. This results in time
jumps that the system cannot cope with. What can be done in such cases?

ANSWER:
Remedy:

If you set a high updating interval in the Receive Service in the Control Panel,
several messages are compared thus also providing a consistency check.
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11.1.27 Group display in the overview area of WinCC doesn’t show
anything

Entry ID: 674987 - Date: 12/04/1998

QUESTION:
What can I do if no messages are displayed in the overview area of WinCC?

ANSWER:
Check whether one of the following cases applies:

• In one image faceplates were not inserted as OLE Control, but with the
dynamic wizard ’Image selection via measuring point’. In this case the
messages of this faceplate are not forwarded to the overview area in the group
display.
Remedy:
Insert a group display into the image for each faceplate. Link the ’Group Value’
property of each group display with the dynamik wizard "Connect group display
to PCS 7 tag structure".

• The messages from images that are at a lower level to others in the Picture
Tree Manager are not put through to the next highest level automatically.
Remedy:
Place a group display in the higher level image. Link the group display with the
lower level image using the dynamic wizard ’Link group display with image’.
You can switch the group display to be hidden via the property ’View’.

• If you have inserted faceplates or group displays into an image, their
messages are display in the overview area only if the Picture Tree Manager
has been stored.
Remedy:
Deactivate WinCC and open the Picture Tree Manager. In the Options menu
the ’Completely recalculate group display hierarchy when stored’ option must
be selected. Now store the Picture Tree Manager. If there are still no
messages displayed in the overview area, close and re-open the Control
Center.

11.1.28 Clients only start up slowly or not at all after server switchover

Entry ID: 708854 - Date: 01/12/1999

QUESTION:
If Server_A fails, the clients automatically switch over to the Server_B. In such a
case, it sometimes happens that not all the clients start up properly. They log on
correctly to the Server_B, but then hang. What can I do about this?

ANSWER:
You must add the IP address and the names of all the computers (including local
computers) in the WinCC network to the end of "Host" and "Lmhosts" files in the
path C:\WINNT\system32\drivers\etc. You enter the IP address and the computer
name separately with TABULATOR. In "WINS Address" properties of the TCP/IP
protocol you must activate the LMHOSTS query, so that the host list can be loaded
from the local PC. You should not import LMHOSTS. You must remove any
superfluous network protocols.



Operator Station

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 11-33

11.1.29 PCS 7 faceplates are not correctly displayed in RT

Entry ID: 740175 - Date: 01/25/2000

QUESTION:
Why aren’t my PCS 7 faceplates correctly displayed in RT?

ANSWER:

Problem 1:

In the WinCC-RT the PCS 7 faceplates are only partially displayed. The right and
bottom edges are missing (about 1cm).

• In the properties configuration of the symbol display of PCS 7 image blocks,
the inserted bitmaps are only partially displayed. They disappear at the left
edge of the processing window.

Solution :
Under Control Panel > Display > Settings set "Small fonts" for the fonts.

Problem 2 (PCS 7 V4.02):

In WinCC-RT a PCS 7 faceplate is displayed as an empty frame. The contents of
the faceplates are displayed with a horizontal and vertical shift. The faceplate can
be operated normally, however.

Solution:
The display problem is due to a wrong version of the MFC42.dll.

1. Search drive C:\ for the DLL and you will find this file at least once in the
directory (in C:\WinNT\System32).

2. Right-click this file, select Properties > Version tab.

3. If a file version 6.xx is now displayed, then this is the reason for the display
problems. The correct file version is 4.21.7160.

Note

The DLL is put on your computer when you install new software, e.g. Office 2000,
or another new application.

Procedure for clearing the problem:

1. You cannot delete or overwrite the DLL, because Windows NT does not
usually permit this.

2. Move the DLL from C:\WinNT\System32 to C:\Temp, for example.

3. Copy the correct DLL into the C:\WinNT\System32 directory.

For license reasons we cannot offer this DLL as a download. But perhaps you
have other computers which have the required version of this DLL. You could
then copy it onto the computer concerned.

4. Restart the computer (now the ’old’ DLL is used).
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! Warning

In general, no warranty can be given for replacing the DLL, because this is entirely
the responsibility of the user. Nor can any statement be made as to how replacing
the DLL affects other applications, because this depends largely on the user
programs concerned that are installed.

11.1.30 Criteria for the authorization levels in the User Administrator with
PCS 7

Entry ID: 771444 - Date: 04/28/1999

QUESTION:
What are the criteria for the authorization levels in the User Administrator with
PCS 7?

ANSWER:
The following levels have been set:

There is no authorization level for calling image information. Image information can
always be called.

 Step  Name  Examples of functions that can be behind these levels

1 Edit User Administrator - Call on-line functions
- User authorization matrix

2 Release for the area - Display system configuration
- Image selection
- Image and measuring point selection by name
- Mark/call screen composition

3 System change, start ES Deactivate Runtime from button bar

4 Monitoring - Change language
- SFC selection box
- Batchflexible selection box

5 Process operations - Acknowledge
- Change limit values for tolerance
- Process operations (e.g. change setpoint values)
- Operating mode operations
- SFC: switch on, switch off and stop plans, acknowledge
transitions and step errors

6 Higher-level process
operations

- Lock/release messages
- Operation release for blocks
- Change control parameters (e.g. KP,TN,TV,FP)
- SFC: issue commands ON/OFF, AUTO/MAN
- Compose new curves on-line

7 Report system

8 Archive operations - Read access to archive in the Tag Logging
- Write access to archive in the Tag Logging
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11.1.31 Time synchronizing for clients

Entry ID: 775488 - Date: 08/19/1999

QUESTION:
Is time synchronizing possible for clients with CP1413 or CP5412A2?

ANSWER:
Yes, by synchronizing with the computer time of the servers. The requirement here
is that the computers are in a local network. Synchronization is as follows:

1. Install the DCF77 tool on all clients that are to be synchronized (on the PCS 7
V4.02 toolset CD under DCF77 or on the WinCC V4.02 CD under Smarttools >
DCF77Client).

2. Call the tool (Start > Control Panel>DCF-77)

3. Under Connection you must now set the server computer (time master).

Make sure that the same time zone is set on both computers.

4. In the Control Panel you must complete by starting "DCF77 Time Signal
Receive Service" via the Services icon.
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11.1.32 Unwanted quitting of WinCC Runtime via the Help system

Entry ID: 786888 - Date: 01/21/2000

QUESTION:
Even if I lock the Windows combination, I can still access the operating system
level via the Help system in WinCC Runtime. What can I do about this?

ANSWER:
This is a Windows NT system property. However, you do have various possibilities
of suppressing this.

1. Installing and deinstalling Online Help

The disadvantage is that here Online Help is no longer available in WinCC. This is
an acceptable alternative in most cases for the simple operation of the system. In
this case you have to install WinCC without Help system or deinstall the WinCC
Help system afterwards.

Note

Even if you have the PCS 7 system already installed, you can subsequently
deinstall the WinCC Help system without having to deinstall the complete
software.

Proceed as follows:

1. Open the Control Panel of Windows NT and start the Tool software.

2. In the dialog box that opens you double-click the entry SIMATIC WinCC
Windows Control Center V4.02 in the list of installed software. This starts the
WinCC Setup program.

3. Select the button "Do you want to remove or add parts of WinCC?".

4. In the "Select Components" dialog box deactivate the check box for the "Help"
component and then press the Continue button to execute the Setup program
to the end.

5. Now restart the computer.

System behavior with deinstalled WinCC Help system as of version V4.02:
If you install WinCC without Help system, Online Help no longer appears when you
press the Help button or the F1 key. The operator thus has no possibility of leaving
Runtime.
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2. Inhibiting Online Help via authorization levels

Creating a new user in the User Administrator:

1. Create a new user in the User Administrator.

2. Add an "Online Help" authorization level to the new user.

3. For this user click all the authorization levels except "Online Help".

4. In the associated Object Properties window, in the Properties tab under
Button/Other, select Online Help as authorization level.

5. In Runtime the Online Button is locked for the new user under the login.

Modification in Windows Explorer:

1. In the Windows Explorer, click the Type column under the path
<DRIVE>:\Siemens\WinCC\bin.

2. Select the "xxx.hlp" files.

3. Right-click properties in the menu that opens.

4. Click the Security tab in the window that opens.

5. Click the Authorizations button.

6. In the window that opens modify the access type for the user logged in under
Windows. The use may not have any Administrator rights.

In this way, access cannot be made to the Online Help in WinCC despite logging in
with all user rights.

3. Inhibiting via NT user rights

1. Press the Start button and select Programs.

2. Select Administration (general).

3. Select User Manager.

4. In the window that opens the Windows user must not appear under
Administrator with unrestricted rights.

5. In the User" menu item create a new local "User" group and the Windows user
may not have unrestricted rights.
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4. As of PCS 7 Version 5.x via Registry entry

In PCS 7 version V5 it is possible to inhibit the entire Online Help of PCS 7 with the
following Registry entry:

1. Start menu > Run, enter regedit.

2. Find the code:
HKEY_LOCAL_MACHINE\SOFTWARE\Siemens\AUTSW\Global\RuntimeHelp

3. Change the value from 1 to 0.
This inhibits the entire Online Help of PCS 7 and the user can no longer switch
to the Windows interface.

Notice

Basically, no warranty can be given for direct changes in the registry database,
because this is entirely the responsibility of the user. In any case it is
recommended to make a backup of the registry before proceeding as described
below. Furthermore, these settings are computer-specific. This means that when
copying the project to another computer, the settings have to be made again.

11.1.33 Closing images that the wizard has created upon image change

Entry ID: 831864 - Date: 04/28/1999

QUESTION:
Why is it that only the faceplates close upon image change and not the images that
have been configured with the wizard?

ANSWER:
Use the following C function for the image change in your project. You can use it to
change the described behavior.

#include "apdefap.h"

void OnLButtonDown(char* lpszPictureName, char* lpszObjectName, char*
lpszPropertyName, UINT nFlags, int x, int y)

{

#pragma code("ssmrt.dll")
#include "ssmrt.h"
#pragma code()

CMN_ERROR Err;
char szReturnPath(_MAX_PATH) = "";
SSMRTOpenTopField2 (SSMGetScreen(lpszPictureName),"USER.PDL",
TOP_ATTACHTOWORKFIELD, szReturnPath, sizeof(szReturnPath), &Err) !=
FALSE;

}
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11.1.34 Hard-copy printouts on color printers

Entry ID: 840776 - Date: 12/07/1999

QUESTION:
How can I optimize hard-copy printout on a color printer?

ANSWER:
You want to document specific process states by printing out a flow diagram of
actual values or various curve groups. The printout is done via the hard-copy key
(Print). In this case the screen background is printed out as well on the color
printer. This means a high consumption of toner cartridges.

You can reduce consumption by incorporating a C action in your project. Here,
however, there is a difference depending on the PCS 7 version you use.

Proceed as follows to be able to use the attached C scripts in PCS 7 V4.01 and
PCS 7 V4.02:

• Use the Split Screen Wizard to define the structure of the basic picture.

• Use the Picture Tree Manager to create the hierarchy of the pictures in your
project.

PCS 7 V4.01:

Incorporate the following script into your HMI software. Activate it via the hard-copy
key. The screen background is switched to White for the printout.

Aktion401.pdf (4 KB)

PCS 7 V4.02:

Incorporate the following script into your HMI software. Activate it via the hard-copy
key. The screen background is switched to White for the printout.

Aktion402.pdf (5 KB)

PCS 7 V4.02 + SP1:
Incorporate the following script into your HMI software. Activate it via the hardcopy
button. The screen background is switched to white for the printout.

The following script prints the complete screen: overview lines and working area
(corresponds to the system image and bottom button bar).

Aktion402SP1_komplett.pdf (3 KB)

The following script only prints out the working area (system image).

Aktion402SP1_Arbeitsbereich.pdf (3 KB)
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11.1.35 Switching the client when the server fails

Entry ID: 978169 - Date: 07/26/1999

QUESTION:
Why, in the case of WinCC redundancy, when the connected server fails, doesn’t
the client switch automatically to the other server?

ANSWER:
You are employing redundancy. When the connected server fails, the client doesn’t
switch automatically to the other server. This might be because you have not
installed the redundancy package on all the clients. This package must be installed
on all the clients. The package includes the project switcher that you must enter in
the start-up parameters of the computer. You must configure the computer names
of both servers. The computer names of all the clients must be known to both
configured servers. Now, if one of the computers fails, the clients are switched
automatically to the second server. When the failed computer starts up again, the
clients are not automatically switched back to it (V4.01).
You need no authorization on the clients for the redundancy package.

11.1.36 Saving process images locally on the client in the case of WinCC
multistation systems

Entry ID: 982658 - Date: 07/27/1999

QUESTION:
How, in the case of WinCC multistation systems, can I save the process images
locally on the client?

ANSWER:
You have a project that runs on a WinCC multistation system. Now, process
images are to be save locally on the client so that these images, and not those
from the server, are used. For this you copy the process images on the client into
the directory <DRIVE>\SiemensWinCC\BIN\PDLCache. If necessary, you must
create this directory yourself. This images must still be available on the server. The
date of the image files of the client must be of the same or later date as the
images on the server. As soon as the image files on the server have a more
recent date, the client loads the images from the server.
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11.1.37 Project access in WinCC Client-Server Environment

Entry ID: 986394 - Date: 07/30/1999

QUESTION:
Why isn’t it possible for a WinCC client to open the project on the server although
the resources are released on the NT side and the client is entered in the project?

ANSWER:
If you have the complete Engineering Toolset installed on the server, check the
settings of the SIMATIC workstation in the Control Panel. Multi-user system
must be set for Workstation. If this setting doesn’t help, check the value of
MultiUserMode in the Registry.

1. For this click the Start button and select Run.

2. Enter regedit in the entry field.

3. Open the code

"HKEY_LOCAL_MACHINE\SOFTWARE\Siemens\AUTSW\SQLANY\DBADMIN".

4. Set the value for the MultiUserMode entry to 1.

5. Close regedit.

6. Restart the computer.

Notice

Basically, no warranty can be given for direct changes in the registry database,
because this is entirely the responsibility of the user. In any case it is
recommended to make a backup of the registry before proceeding as described
below. Furthermore, these settings are computer-specific. This means that when
copying the project to another computer, the settings have to be made again.
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11.2 Alarm Logging

11.2.1 Messages missing from Alarm_8P

Entry ID: 189296 - Date: 01/21/1998

QUESTION:
All messages generated by Alarm_8P are not displayed in runtime although the
messages are in the alarm log.

ANSWER:
This can happen if the tag name of the faceplate is longer than 32 characters.

11.2.2 Limit value message present although limits not exceeded

Entry ID: 1903489 - Date: 02/18/2000

QUESTION:
Why does the message remain although the value is within the configured limits?

ANSWER:
This behavior can occur if you are using indirect limits. If the value to be
monitored exceeds one of the limits, the message is triggered. It is not enough in
this case then to change the indirect limits so that the value to be monitored is
within the limits again. The message retains the status "arrived". Only when the
value goes back to within the old limits does the message disappear.

If it is not possible for technical reasons to set the get the value back to within the
old limits, you can reset the message with "Lock" and then "Release".

11.2.3 Only 1000 messages visible in the archive window

Entry ID: 1957448 - Date: 03/08/2000

QUESTION:
Why are only the last 1000 messages displayed in my archive window although
there are more messages in my archive?

ANSWER:
The display is restricted to 1000 for the sake of performance. This gives the
impression that only 1000 messages are in the archive, but this does not reflect the
actual number of messages in the archive. Generally the last 1000 messages are
displayed.

Remedy:
By making specific selections you have the option of accessing the older messages
in the archive. It is best to make these selections such that they do not contain
more than 1000 messages.
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Example:
Your archive is set up for 3000 messages. You have divided your system into 4
parts.

1. Set the relevant message class for each part of the system.

2. Distributed the configured individual messages to these classes.

3. Create message windows with selections according to class.

Now, if the maximum number of messages does not exceed 1000, then in the
Archive View you will see all the messages for that particular part of the system.

This is just an example of how to get round this behavior. You can, of course, use
other selections.

11.2.4 Deleting individual messages from a group message

Entry ID: 2383298 - Date: 06/13/2000

QUESTION:
How can I delete individual messages from a group message?

ANSWER:
In your message configuration you have different individual messages in one group
message. You now want to delete an individual message from the group message.
Proceed as follows to do this:

1. Open WinCC and the Alarm Logging.

2. Select the individual message that you wish to delete from the group message.

3. Double-click the Group field. A scrollbox opens displaying the various group
messages. If you select none, then the individual message is not assigned to
any group and can thus be removed from the group message.
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11.2.5 Changing the acquisition cycle of Alarm Logging (V4.01 / V 5.x)

Entry ID: 268814 - Date: 03/08/2000

QUESTION:
How can you change the acquisition cycle of Alarm Logging?

ANSWER:
In the Registry you can define for the message system the update time for the
event variables and the process values. If you increase the update time, you can
improve performance. But you must pay attention to the necessary message
speed. You must make the entries manually by creating the code at the following
point in the Registry:

1. Start menu > Run, enter regedit.

2. Find the code:
HKEY_LOCAL_MACHINE\SOFTWARE\SIEMENS\WINCC\Alarm
Logging\CONSTANTS

3. Add two new values (right-click\new\DWORD value)
"CycleAlarms"= "00000000" // Message variable cycle (default value 0)
"CyclePValues"= "00000000" // Process value variables (default value 3)
You can enter the following values for the update time in the Registry values:
0 = Upon change (500ms)
1 = 250ms (DO NOT USE, INCREASES SYSTEM LOAD)
2 = 500ms
3 = 1s
4 = 2s
5 = 5s
6 = 10s
7 = 1min
8 = 5min
9 = 10 min
10 = 1h

Notice

Basically, no warranty can be given for direct changes in the registry database,
because this is entirely the responsibility of the user. In any case it is
recommended to make a backup of the registry before proceeding as described
below. Furthermore, these settings are computer-specific. This means that when
copying the project to another computer, the settings have to be made again.
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11.2.6 Messages are not displayed in the archive

Entry ID: 493560 - Date: 01/04/2000

QUESTION:
Why are my messages not displayed when changing from the message window to
an archive window?

ANSWER:
Usually the causes are as follows:

• When configuring the message, the "will be archived" property was not
selected.

Remedy:

• Activate this property for the messages in the Alarm Logging Editor.

• A selection has been configured in the message archive that filters out the
messages.

Remedy:

• Check the selection set in the Alarm Logging Editor.

11.2.7 WinCC, generate message when logging on

Entry ID: 495670 - Date: 11/22/1999

QUESTION:
How can I generate a message when logging on?

ANSWER:
The following example shows how you can generate a message in Alarm Logging
at each logon. This message contains the name of the logged-on user as a
process value block. For this, proceed as follows:

1. You must create an internal text variable (8 bits, length sufficient for the longest
user name) for each previously and currently logged-on user:
"@CurrentUser"
"OldUser"

2. In addition an internal bit variable is required for triggering the message
system: "Loginbit".

3. In the message system you must link the "Loginbit" as an event variable to a
message incorporate the variable "@CurrentUser" as a process value block in
the message.

4. The following script is to be incorporated as a new action in the "Global Script"
editor under Actions/Global Actions. The Sleep call (see script) from Windows
is needed, because the Alarm Logging has its own variable image that is
updated every second. This means that the variable @CurrentUser in the
message system does not yet have the current value at the time the message
is generated. With the Sleep call the action is delayed until the variable
@CurrentUser is updated in the variable image.
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Program code :

#pragma code ("Kernel32.dll")
void Sleep(int a);
#pragma code()
char *NewUser, *OldUser;

OldUser=GetTagChar("OldUser");
NewUser=GetTagChar("@CurrentUser");
// Test output for diagnostics
printf("new-user: %s\r\n",NewUser);
printf("old-user: %s\r\n",OldUser);
printf("%d\r\n",strlen(NewUser));

if(strlen(NewUser)!=0)
{
SetTagBit("Loginbit",0);
// 1sec delay because of Alarm Logging Tag update
Sleep(1000);
SetTagBit("Loginbit",1);
SetTagChar("OldUser",NewUser);
}

return 1;

11.2.8 Differences between message processing in the message list and
in the archives

Entry ID: 56549 - Date: 10/25/1999

QUESTION:
What are the differences between message processing in the message list and in
the archives?

ANSWER:
Via the Message Window view (parameterization in the "General" tab under
Configure Message Window) you can access the Message list. The message list
is the work sheet of the message system.

The following RT functions are executed in the message list:

• Scrolling of newly arrived messages from bottom to top

• Updating of registered messages due to their new status

• Acknowledge functions

• Loop in Alarm

• Acknowledge horn
(parameterization via Configure Message Classes > Acknowledge Central
Alarms)

Unlike the message list, the views "Short-term Archive Window" and "Follow-up
Archive Window" serve to view the corresponding archives. Both types of archive
are updated in parallel. The follow-up archive is thus not a background archive to
the "Short-term Archive".
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In the archive views the messages are displayed in chronological order. The
functions described above for the message window cannot be executed in the
archive window.

Infotext:
The Infotext is additional information that is firmly assigned to a message number
and that can be changed on line. The Infotext can be edited in all views.

Comment:
The comment is additional information that is assigned to a specific message.
If the message is deleted in the archive, the assigned comment is also lost.
The comment can only be edited in the follow-up archive window.

11.2.9 Exporting and importing message texts with Excel (WinCC V5
SP1)

Entry ID: 56558 - Date: 08/02/2000

QUESTION:
How can I export message texts, change them and then import them again?

ANSWER:

Exporting messages in WinCC

1. First open your WinCC project and then the Alarm Logging.

2. In the menu bar click Messages > Export single messages... in order to
export your messages in a text file (*.TXT).



Operator Station

Process Control System PCS 7, Tips and Tricks
11-48 A5E00080064-01

3. In order to enter the name of the file to which you wish to export, press the "..."
button next to the File: field.
Enter the required name in the window that now opens.

4. If you want to export special messages only, press the Selection... button.
In the window that now opens you mark the messages to be exported.

5. You then press Export and the text file is created. The content of the exported
text file (*.txt) is separated by commas.

Editing messages under Excel

1. First open your Excel program and with File > Open... open the file you have
just created.

2. In the window that now opens press the radio button next to Separated.

3. In the next step you must select the item Comma in the Separator field.

4. If you now acknowledge the third step with the End button, an Excel sheet
appears.

5. Now, in the Block: 3 column you can change the message texts.

6. After changing a message text you must enter a zero in all the TextID columns
of this row in order for the change to be accepted.

7. Finally you save the file with File > Save.

! Warning

Do not save this file as *.xls, but as *.txt.
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Importing messages in WinCC

1. Open WinCC and Alarm Logging, then you can import the messages again
with Messages > Import single messages....

2. Press the "..." button and then select the file from the previous steps in order
to import it.

3. Now, in the Mode field select the item Import new messages only.

4. Press the Import button and the changed messages will be available to you.
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11.2.10 Message attributes with Import/Export files

Entry ID: 684800 - Date: 12/10/1998

QUESTION:
With the Import/Export of messages I can assign a parameter per message line
that defines the attributes of each message. What is the bit assignment here?

ANSWER:
Below is an excerpt from the "M_Global.h" file from the WinCC directory. The table
contains the definition of the individual bits of the "Message attributes" parameter:

 Designation  Value  Meaning

MSG_PARAMS_SQUIT 0x00000001 // Individual - group quit

MSG_PARAMS_HORN 0x00000002 // Horn control

MSG_PARAMS_ARCHIV 0x00000004 // Archive

MSG_PARAMS_PROTOCOL 0x00000008 // Protocol

MSG_PARAMS_VARFLANK 0x00000010 // Variables - flank

MSG_PARAMS_LOCKED 0x00000020 // Message locked at start-up

MSG_PARAMS_INFOTEXT 0x00000040 // Message has Infotext

MSG_PARAMS_LOOPINALARM 0x00000080 // Loop In Alarm

MSG_PARAMS_APFUNC 0x00000100 // AP function for message

MSG_PARAMS_NORMDLL 0x00000200 // Standardization DLL

11.2.11 Function of the variable types in the individual messages

Entry ID: 70682 - Date: 04/26/1999

QUESTION:
Which functions do the different variable types have for the individual messages?

ANSWER:

• Event variable:
This variable triggers the message (incoming and outgoing state).

• Acknowledge variable:
If a message is acknowledged, then this bit is set to "1". In this way you can
evaluate in the controller.
In WinCC version V4.02 and higher this bit can also be changed in the
controller and the message is then displayed as acknowledged. You can thus
acknowledge the message in the SPS or from another computer, and the
message is also displayed as acknowledged on the local computer.



Operator Station

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 11-51

• State variable:
You can use an 8-bit, 16-bit or 32-bit value without sign as state variable. If
the bit "0" is selected as state bit, then the following assignments are valid for
further state processing depending on the data type used:

 Data type  Assignment state bit

8-bit without sign Bit 4

16-bit without sign Bit 8

32-bit without sign Bit 16

Example:
Function of the state variable with a 16-bit value with state bit "0" selected:

 Message arrives  Bit "0" is set to "1"

Message must be acknowledged Bit "8" is set to "1"

Message is acknowledged Bit "8" is reset to "0"

11.2.12 Group message functionality

Entry ID: 70691 - Date: 12/05/1997

QUESTION:
What is the function of a group message?

ANSWER:
Configuration and function of the group message:
Click on "User-defined" and then select "Insert group message" with the right
mouse button. The "New group message" box opens.

Parameters of the new group message:

• Name: assign group message name.

• Status variable:
same function as for normal messages.
Bit #1 = status
Bit #2 = messages that afford a receipt are waiting

• Disable variable:
If the group message is disabled during runtime in the disable dialog, then the
bit defined here is set (Also all subordinate group messages and their single
masseges).

• Acknowledge variable:
If the acknowledge bit of the acknowledge variable (e.g. via button or
controller) is set, then all the messages of the group message are
acknowledged.

After terminating with "OK" the new group message is displayed under "User-
defined". Now click on "User-defined" and press the right mouse button. In the
"Add messages" menu you can now select the messages that are to be included in
the group message.
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11.2.13 Using any configuration function in conjunction with "Loop in
Alarm"

Entry ID: 70700 - Date: 05/15/1997

QUESTION:
How can you trigger a function other than "OpenPicture" in the "Loop in Alarm", for
example, a configuration function ?

ANSWER:
Example of a function that is to make a picture window visible in a picture.

void LoopVisible(Picture Picturename)
{
SetVisible("logpicture","Picturewindow1",1);
}

Explanation of parameters:
logpicture : name of the picture that contains the picture window "Picturewindow1".
Picturewindow1: name of the picture window that is to become visible.
1: visible, 0: invisible

This function must be created and integrated using Global Script as configuration
function. Assigning the parameter "Picturename" is purely for the sake of
completeness, because Alarm Logging expects parameter assignment
corresponding to the action "OpenPicture". The selected picture for the action in
"Loop in the Alarm Configuration" has no relevance and is purely for the sake of
completing parameter assignment.

11.2.14 Messages: "Transfer buffer too small", "TagQueue overflow",
"Messages are lost"

Entry ID: 850372 - Date: 05/17/1999

QUESTION:
My message get lost. How can I remedy this?

ANSWER:
If you get at least one of the following messages, this indicates that messages are
getting lost in WinCC. These messages are to be found, for example, as entries in
the WinCC LOG files in the "Diagnostics" directory:

• ALGRT : Transfer buffer to small

• ALGRT : TagQueue overflow

• ALGRT : Message are lost

One remedy here is to enlarge the queue. Make the change in "Regedit".

Notice

Basically, no warranty can be given for direct changes in the registry database,
because this is entirely the responsibility of the user. In any case it is
recommended to make a back-up of the registry before proceeding as described
below. Furthermore, these settings are computer-specific. This means that when
copying the project to another computer, the settings have to be made again.
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Proceed as follows:

1. Start menu > Run, enter regedit

2. Find the key:
HKEY_LOCAL_MACHINE\SOFTWARE\SIEMENS\WINCC\Alarm
Logging\CONSTANTS

3. Find the name " InputQueue". If this entry doesn’t exist, enter a new value
(right-click > New > DWORD value)

4. Enter the following value or change the existing value accordingly:
InputQueue ="10000"

The default value for the queue entry is 1500. If you get the above-mentioned
messages, you can increase the value, as in our example, to 10000.

This method helps only in the case of a temporary overload of the system, for
example at system start-up. In the case of permanent system overload the error
messages are just delayed.

Notice

In the Alarm Logging up to 2 messages per second can be processed (see also
Release Notes, "Specifications")
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11.2.15 Signal module without Split Screen Wizard with own message
classes

Entry ID: 892149 - Date: 06/28/1999

QUESTION:
I am using my own message classes (not created by Alarm Logging Wizard) and
not the Split Screen Wizard. What should I watch out for when implementing the
signal module?

ANSWER:
The signal module requires the internal variable @Signal1, @Signal2 or
@Signal3. These are normally created by the Split Screen Wizard. If you are
working without the Split Screen Wizard, you must create these variables yourself
manually. They are internal variables of the type "16-bit value without sign".

When you use the signal module, you must proceed as follows:

1. Start the Alarm Logging Wizard. The messages are linked to the various
message classes.

2. On the first page set the check mark for "Audible signal device".

3. On page 3 you can assign the signals @Signal1, @Signal2 and @Signal3 to
the different message classes.

The message classes 1 to 10 are preassigned by the Alarm Logging Wizard. You
have two options for setting your own message classes:

• For your message classes you use the predefined message classes 11 to 16.
These are offered for activating on page 3 of the Alarm Logging Wizard.

• Before starting the Alarm Logging Wizard you can define your own message
classes in the Alarm Logging. You should make sure to use message classes
11 to 16. If you want to configure other message classes or more than 6
message classes, you can in principle also use message classes 1 to 10.
However, if you now run the Alarm Logging Wizard, the message classes 1 to
10 will be overwritten again. You must undo this again manually in the Alarm
Logging. You give the message classes the names again that you had
originally configured. Message classes 11 to 16 are included by the Wizard if
you have configured them beforehand. The relevant variables @Signal1, 2 and
3 can be linked to the displayed message classes. Here Alarm is for message
class 1, Warning for message class 2, Tolerance for message class 3, … and
operating message for message class 10.

The user text blocks are also overwritten by the Alarm Logging Wizard. You
must then also rename these afterwards.

Acknowledging the signal module:
You acknowledge the signal module by setting the variables @Signal1, 2, 3 to 0.
You can do this by making the following function calls:
SetTagWord("@Signal1",0);
SetTagWord("@Signal2",0);
SetTagWord("@Signal3",0);
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11.2.16 Area-specific messages

Entry ID: 2770292 - Date: 08/02/2000

QUESTION:
Why are certain messages that have been configured in the Engineering Station
not displayed in the Runtime of the Operating System?

ANSWER:
You have configured messages in the ES. Some of these are not displayed in the
Runtime of the OS. This is because there is a connection between the OS area
ID, the Picture Tree Manager and the message display on the Operator
Station.

The Operator Station supports the area-specific messages. This means that in the
Runtime, in Area 1 there is only output of messages which have the text of the
highest hierarchy level of the Picture Tree Manager (1st Area) entered in the user
text block "Area" (Alarm Logging).

Exceptions:
The only exceptions are messages that have an empty "Area" user text block.
When triggered, these messages are displayed in all areas. If there is an incorrect
OS area ID in the user text block, then, when triggered, the message concerned is
not displayed in any area.

The OS area IDs are specified in the Engineering Station and are entered in the
"Area" user text block upon transfer of the AS/OS connection data for each
message. A distinction is made between two cases when specifying the OS area
ID:

• You specify the OS area ID in the Technological Hierarchy (select Hierarchy
folder > right-click > Properties > HMI Attributes tab).

• The OS area IDs are entered automatically. This is the case if you click the
checkbox "Derive image hierarchy from the Technological Hierarchy" (select
Hierarchy folder > right-click > Options > Technological Hierarchy >
Settings).

In the first case you must make sure that the configured OS area ID in each area
matches the highest hierarchy level of the Picture Tree Manager.

In the second case the OS area IDs and the hierarchy levels in the Picture Tree
Manager are generated automatically. This always ensures correct assignment.
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11.2.17 Meaning of the group signal technology and system messages

Entry ID: 2847488 - Date: 08/14/2000

QUESTION:
When transferring the AS/OS connection data, what is the meaning of the
messages created and how are the system messages of the Alarm Logging wizard
to be interpreted?

ANSWER:
When transferring the AS/OS connection data, 7 different control system
messages are created. The meanings of the messages are listed in the table
below:

 Message number  Message classification  Meaning

1 AS fault synchronous Programming error, access fault
2 AS fault asynchronous Timing error, communication error, power supply fault
3 Module fault Diagnostics error, remove/plug alarm, rack failure
4 Stop/abort fault System error, parameter error, firmware update error,

abort event
5 H/F system event Error in redundant systems
6 Communications error General communications error
7 Fault not in the CPU Fault in CP or FM module

The Alarm Logging wizard generates about 140 system messages that have
reference to the Operator Station. You also have the option of switching off
generation in the Alarm Logging wizard. The meanings of the messages can be
found in the online Help of the WinCC Explorer under System messages >
System messages (Alarm Logging). The following abbreviations are used in the
online Help:

 Abbreviation  Meaning

WCCRT General WinCC Runtime
PDLRT Picture processing Runtime
TLGRT Tag Logging Runtime
ALGRT Alarm Logging Runtime
NRMS7 Standardization DLL S7
RPTRT Report Runtime
TXTRT Text Library Runtime
GSCRT Global Script Runtime
SCRIPT Script Processing
USERT User Administrator
LBMRT Lifebeat Monitoring
STRRT Storage Runtime
STORAGE Storage
CSIG Picture Tree Manager
SYNC Time Synchronization
REDRT Redundancy Runtime
SWITCH Project Switcher
SWRED SW Redundancy
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11.2.18 Texts in group messages also in other languages

Entry ID: 1008101 - Date: 01/25/2000

QUESTION:
Why, with PCS 7 V4.02, are no texts shown in the group displays when languages
other than German, English or French are set in WinCC?

ANSWER:
Generally PCS 7 V4.02 supports only German, English or French. If nevertheless
other languages were configured and used in WinCC, the standard texts still
appeared in the group displays, e.g. in English:

• "Tolerance high" = "TH"

• "Tolerance low" = "TL"

• "Alarm high" = "AH"

• "Alarm low" = "AL"

• "Warning high" = "WH"

• "Warning low" = "WL"

• "System Fault" = "S"

• "Operator Input Request" = "OR"

• "Failure" = "F"

Version V4.02 includes implementation of additional system operations with regard
to language settings in WinCC and the group displays. The group display texts
were then only shown by default in the WinCC languages German, English or
French. If you want to have the group display texts shown in other WinCC
languages, proceed as follows.

All group display texts are defined in a separate registry code that corresponds to a
fixed WinCC language ID. The following list contains all the available WinCC
language IDs:
Only the SUBLANG_DEFAULT languages of Windows are supported by WinCC.

 Symbolic designation  Value (hexadecimal)  Abbreviation

LANG_ARABIC 0x0401 -

LANG_AFRIKAANS 0x0436 -

LANG_ALBANIAN 0x041C -

LANG_BASQUE 0x042D -

LANG_BULGARIAN 0x0402 -

LANG_BYELORUSSIAN 0x0423 -

LANG_CATALAN 0x0403 -

LANG_CHINESE 0x0404 -

LANG_CROATIAN 0x041A -

LANG_CZECH 0x0405 CSY

LANG_DANISH 0x0406 DAN

LANG_DUTCH 0x0413 NLD
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 Symbolic designation  Value (hexadecimal)  Abbreviation

LANG_ENGLISH 0x0409 ENU

LANG_ESTONIAN 0x0425 -

LANG_FAEROESE 0x0438 -

LANG_FARSI 0x0429 -

LANG_FINNISH 0x040B FIN

LANG_FRENCH 0x040C FRA

LANG_GERMAN 0x0407 DEU

LANG_GREEK 0x0408 -

LANG_HEBREW 0x040D -

LANG_HUNGARIAN 0x040E HUN

LANG_ICELANDIC 0x040F ISL

LANG_INDONESIAN 0x0421 -

LANG_ITALIAN 0x0410 ITA

LANG_JAPANESE 0x0411 -

LANG_KOREAN 0x0412 -

LANG_LATVIAN 0x0426 -

LANG_LITHUANIAN 0x0427 -

LANG_NORWEGIAN 0x0414 NOR

LANG_POLISH 0x0415 PLK

LANG_PORTUGUESE 0x0416 PTB

LANG_ROMANIAN 0x0418 -

LANG_RUSSIAN 0x0419 RUS

LANG_SLOVAK 0x041B SKY

LANG_SLOVENIAN 0x0424 -

LANG_SORBIAN 0x042E -

LANG_SPANISH 0x040A ESP

LANG_SWEDISH 0x041D SVE

LANG_THAI 0x041E -

LANG_TURKISH 0x041F TRK

LANG_UKRAINIAN 0x0422 -

1. Click the Start button and select Run

2. Enter regedit in the edit box and press OK

3. Open the following code
"HKEY_LOCAL_MACHINE\SOFTWARE\Siemens\PCS 7 Libraries\text"

4. The registry code ...\text contains all the available WinCC language IDs. When
PCS 7 V4.02 is installed the codes 0x407 for German, 0x0409 for English and
0x040C for French are already available by default.

5. Select the desired language ID from the list

6. Create a new registry code under ...\text

7. Name the new code with the required WinCC language code
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8. Create another code in the newly created registry code

9. Name this Message Classes

10. Generate the following entries in the "Message Classes" code:
"Tolerance high" = "TH"
"Tolerance low" = "TL"
"Alarm high" = "AH"
"Alarm low" = "AL"
"Warning high" = "WH"
"Warning low" = "WL"
"System Fault" = "S"
"Operator Input Request" = "OR"
"Failure" = "F"

11. Edit the values of the entries as required. Note that you may only use a
maximum of two characters. For the sake of standardization you should keep
the values,
e.g. values for "Alarm high":
Standard = "AH"
User-specific = "Ao" (alarm on top)

12. After you have created all the new registry elements and have configured the
necessary values, close the registry editor.

13. Restart the computer to activate the registry changes.

Notice

In general, no warranty can be given for direct changes in the registry database,
because this is entirely the responsibility of the user. In any case it is
recommended to make a backup of the registry before proceeding as described
below. Furthermore, these settings are computer-specific. This means that when
copying the project to another computer, the settings have to be made again.

11.2.19 Determining the number of messages in WinCC

Entry ID: 1020608 - Date: 08/27/1999

QUESTION:
How can I determine the number of messages created in WinCC?

ANSWER:
You want to find out how many messages have been created in WinCC. You have
two options:

Transfer.log
Count the entries in the Transfer.log file. This file displays the number of mapped
messages.

Example:
Entries in the Transfer.log file:
1587 Alarm_8 subalarms
7208 Alarm_8P subalarms
70 AS control system messages
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You must now add up these entries. Accordingly, 8865 messages were created for
this AS. If you map the messages of several ASs, then you must add them
together.

Message export from WinCC
In WinCC, other messages are created in addition to the mapped messages:

• OS control system messages

• Manually configured messages

If you want to include these, then it is recommended to proceed as follows:

1. Export the messages in Alarm Logging

2. In the Messages > Export individual messages menu you must specify the
name for the export file. After the messages have been exported successfully,
the number of messages is displayed.

11.2.20 Action call via Alarm Logging in PCS 7/WinCC

Entry ID: 1025092 - Date: 09/09/1999

QUESTION:
How can I configure an action call via Alarm Logging in PCS 7/WinCC ?

ANSWER:
If you select the option "triggers an action" under "This message" in the
"Parameters" tab of the Single Message dialog box, then the global standard
function "GMsgFunction.fct" is called at each message event.

If you now want special functions to be executed by this, then you must modify the
standard function "GMsgFunction.fct". You can find it under the "Alarm" entry in the
Global Script Editor.
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In the example described here, the message number and the status are checked.
Then the correct image name of the "OpenDialog.fct" function is transferred. For
this you must include the following #include statement and code in the
GMsgFunction:

#include "AP_PBIB.H"
if ((mRT.dwMsgNr==1) & (mRT.dwMsgState==1))
{

printf("Message 1 \n");
OpenDialog("OPDialog.pdl");

}
if ((mRT.dwMsgNr==2) & (mRT.dwMsgState==1))
{

printf("Message 2 \n");
OpenDialog("OPDialog2.pdl");

}

Then you must generate the project function "OpenDialog.fct". Use the code given
below. "OpenDialog.fct" needs the image name as parameter and open the image
in a window of fixed size. In order to be able to use the
"SSMOpenTopFieldFixedSize" function, you must include the header file
"apdefap.h".

#include "apdefap.h"
BOOL OpenDialog(char* picture)
{

CMN_ERROR Err;
SSMOpenTopFieldFixedSize(’1’,picture);
return TRUE;

}

In the image you can position various controls such as buttons, faceplates and text
fields for operator commands. For example, you can acknowledge the associated
message by using the function "AcknowledgeMessage(1); (1 = message number).

You can also call the "OpenDialog" function from other points in your project. It
doesn’t necessarily have to be triggered by the message.

! Warning

The standard function "GMsgFunction.fct" is not in the Project directory, but in
the WinCC Installation directory. Therefore this function is overwritten as soon
as you upgrade WinCC or reinstall it. You should make a back-up copy of this
function after each modification.
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11.2.21 Message: Message overflow detected

Entry ID: 1624059 - Date: 12/14/1999

QUESTION:
When does the "Message overflow detected" message appear?

ANSWER:
In the "WinCC_Sys_0x.log" file there are several entries of the following type
(excerpt from a log file):

03.08.1999,11:09:45:105,1000200,4,ES1,,WinCC-Runtime,Connection
ProgrammAS1(1)#01 established
03.08.1999,11:09:45:195,1000200,4,ES1,,WinCC-Runtime,Connection
ProgrammAS2(1)#02 established
04.08.1999,10:05:03:482,1003082,4,ES1,Administrator,NRMS7PMC,MldReceiveM
sg: RDFT_EVT_PMC_ALARM8/_ALARM_T Connection ProgrammAS1(1)#01,
EV_ID 0x00000086: Message overflow detected
04.08.1999,10:05:03:893,1003082,4,ES1,Administrator,NRMS7PMC,MldReceiveM
sg: RDFT_EVT_PMC_ALARM8/_ALARM_T Connection ProgrammAS1(1)#01,
EV_ID 0x0000006A: Message overflow detected
04.08.1999,10:05:07:167,1003082,4,ES1,Administrator,NRMS7PMC,MldReceiveM
sg: RDFT_EVT_PMC_ALARM8/_ALARM_T Connection ProgrammAS1(1)#01,
EV_ID 0x0000006C: Message overflow detected
04.08.1999,10:05:07:267,1003082,4,ES1,Administrator,NRMS7PMC,MldReceiveM
sg: RDFT_EVT_PMC_ALARM8/_ALARM_T Connection ProgrammAS1(1)#01,
EV_ID 0x0000006A: Message overflow detected

First the connection to the ASen is set up, then the messages are displayed in
conjunction with the error message "Message overflow detected".

Background:
The Alarm-8P blocks can only store 3 statuses (received, sent, acknowledged). If
WinCC is not in Runtime and the messages change their status several times, then
the corresponding block cannot pass on this change of status to WinCC. When you
restart the Runtime of WinCC, the block then forwards all these messages.

11.2.22 Messages are not displayed in the faceplate.

Entry ID: 1965122 - Date: 03/13/2000

QUESTION:
Why are measuring-point-specific messages not displayed in the faceplate?

ANSWER:
The measuring-point-specific messages are not displayed in your faceplate. This is
generally because the origin name of a message ($$AKZ$$) is longer than the
text block provided in WinCC. This is indicated by the fact that messages
requiring individual acknowledgment are no longer displayed at all in the faceplate.
You can no longer directly acknowledge messages requiring acknowledgment in
the faceplate.
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Remedy:

• FAQ Entry ID 996785 includes a description of one way of changing the user
text block in the WinCC Alarm Logging.

• In the <<transfer.log>> file of the mapper you can find out which message texts
were too long and thus truncated.

11.2.23 Creating a message upon connection failure

Entry ID: 382120 - Date: 06/29/1999

QUESTION:
How can I generate a message in the case of connection failure?

ANSWER:
For this use the option package "Basic Process Control". This package includes
the tool "Life Beat Monitoring". With this you can monitor all the AS connections.
An alarm is generated automatically if there is a failure.
If you do not want to configure monitoring with this package, you can do it yourself
manually. For this you query the connection for failure in a Global Action and
depending on this you trigger a message via an internal variable which in turn
addresses the signal module (if available).

1. Create an internal variable of the "binary" type. (The status of this variable
triggers a message)
In the example this variable is called "ConnectionBool".

2. Insert a new line in the Alarm Logging:

 Properties:  Class: Alarm

Type: AlarmHigh

Event variable: ConnectionBool

Origin: MPI connection

Event: connection failure between AS-OS

Requires individual acknowledgment,

Controls horn

Will be activated

Will be logged

3. Write the following function in the Global Script:
The first parameter of the function "GetTagBit" is a variable from the
connection to be monitored, in the example "S7$Program(1)_switch".

#include "apdefap.h"
int gscAction( void )
{

unsigned long status(1);

GetTagBitState("S7$Program(1)_switch",&status(0)); //return type :short int
printf("%d",*status);
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if (*status==1)
SetTagBit("ConnectionBool",1); //return type:BOOL
else
SetTagBit("ConnectionBool",0); //return type:BOOL

return(0);
}

1. Set the trigger to the variable trigger of the process variables of the connection
to be monitored, here "S7$Program(1)_switch".

2. Save compile the function.

3. Under GlobalScript\Options ---> Regenerate header.

4. Under Computer\Start-up ---> Check Global Script Runtime.

5. Activate Runtime.

11.2.24 Sequence-of-events log when deactivating WinCC

Entry ID: 384262 - Date: 01/28/2000

QUESTION:
If I print the sequence-of-events log on an inkjet printer, page by page, and
supposing WinCC is terminated and there are still 3 messages in the buffer. What
happens to them?

ANSWER:
If WinCC fails, the messages are written to the printer spooler and remain there.
When WinCC starts to run again, the pages are output again, but only then when
the page is full.
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11.2.25 Sorting of message texts between ES and OS (WinCC)

Entry ID: 680629 - Date: 12/08/1998

QUESTION:
How are the message texts sorted between ES and OS (WinCC) ?

ANSWER:
The table shows how the message texts are sorted between ES and OS (WinCC)

 ES  OS

Text 1 Output in Origin field (-> BATCH)

Text 2 Output in Area/Group field

Text 3 Output in the Event field (BATCH)

Text 4 Output in the ChargeName field

Text 5 Output in the Operation/Operating text field (BATCH)

Text 6 Output in the Free1 field

Text 7 Output in the Free2 field

Text 8 Output in the Free3 field

Text 9 Output in the Free4 field

Text 10 Output in the Free5 field

Infotext Output in the Infotext field
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11.2.26 Triggering an action by activating a message

Entry ID: 773963 - Date: 12/08/2000

QUESTION:
How can I trigger an action by activating a message?

ANSWER:
If you want to trigger an action by activating a message (alarm or similar), then in
the parameters of the message concerned you must enable the check box "triggers
an action" and incorporate your action in the function "GmsgFunction".

Procedure:

1. In the "Alarm Logging" editor select the message that is to trigger an action.

 

2. Open the parameters of the single message (right-click > Properties). In the
"Single message" dialog window, select the "Parameters" tag. Enable the
check box "triggers an action".



Operator Station

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 11-67

 

3. Start the "Global Script" editor from the WinCC Explorer from "Standard
Functions > Alarm" select the function "GmsgFunction". Change the standard
function "GmsgFunction" to suit your required action.
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Notice
1. Changing the function "GmsgFunction" is only effective for the active

project.
2. If you do a reinstallation, the changed function is replaced by the

original function.
3. The complete function is always run through. This is non-critical if only

one action or always the same action is to be triggered. If you wish to
make a distinction, however, then you have to program this appropriately.
For this you use the known C statements such as "If", "Switch", "Case"
etc.

4. Try to keep the function as short as possible. If you implement an
extensive program code here, this affects the performance of the whole
system. More information on this is available in the online Help of WinCC.

Notice
If you want to do a complete AS/OS transfer, then the "triggers an action"
setting in the Alarm Logging is reset again. A transfer of changes however
does not affect this setting.
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11.2.27 WinCC hooter when a message arrives

Entry ID: 775455 - Date: 12/14/1999

QUESTION:
In WinCC how can I get a hooter to sound when a message arrives?

ANSWER:

1. WinCC Basic System

In the "Acknowledgment" properties you can assign a variable for a central
signaling system to each message class. You can give it any name you want (e.g.
hooter variable). This variable is of the "binary" type. If a check mark is set for
"triggers hooter" in the Properties dialog of the message, the hooter variable is set
when the message is issued. You can acknowledge this hooter variable with the
"Acknowledge hooter" button. You must add this button to the message window
template.

There are two acknowledging strategies that can be set in the "Acknowledgment"
properties of the message class:

• Case 1: separate Acknowledge button
Central signaling systems that are triggered when a message arrives are
acknowledged using a separate Acknowledge button in the toolbar or via the
keyboard. This button must be provided in the message window.

• Case 2: individual acknowledgment
Central signalers that are triggered upon arrival of a message are
acknowledged with the acknowledgment of the triggering message. The
exception here is the button for the group acknowledgment in the lower
operator bar, which acknowledges messages only and not the hooter.

The "Acknowledge Hooter" in the WinCC footer is valid for the signal module only.

2. Basic Process Control (Signal Module, Alarm Logging Wizard)

The "triggers hooter" check mark in Properties of the message has nothing to do
with the hooter control of the signal module. This check mark is only valid for
the first case (separate Acknowledge button). In order to trigger a hooter via the
signal module you must run the Alarm Logging Wizard and assign a signal 1-3 to
the individual message classes. The check mark that the wizard sets has no
significance for the signal module. More detailed descriptions of how to install the
signal module are given in the documentation. You must acknowledge the hooter
using the "Acknowledge hooter" button in the footer of WinCC. Hooter
acknowledgment in the message windows is only valid for case 1.
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11.2.28 Triggering of the horn with messages

Entry ID: 979559 - Date: 07/27/1999

QUESTION:
Can I deactivate for specific messages the "Trigger horn signal" presetting for all
messages?

ANSWER:
You have created a project with the PCS 7 version V4.01 and SP1. Now you want
to set up a signal module with horn triggering. During configuring you have
started the Alarm Logging wizard without having selected the "Connect Audible
Signal Device" option. Therefore, in the message properties, the "trigger horn"
option is not activated. So far, so good.

After this you would like to install the signal module and the set up the audible
signal function. For this you restart the Alarm Logging wizard and activate the
"Connect Audible Signal Device" option for required message classes and set up
the necessary signals accordingly (@Signal1, @Signal2 and @Signal3). Once you
have run through the wizard the "Connect Audible Signal Device" option is set in
the message properties.
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Notice

Now, during start-up, you wish to deactivate the horn triggering for one
specific or all message classes. Start the Alarm Logging wizard again and
deactivate the "Connect Audible Signal Device" option. You set the signals of the
individual message classes to "none". In the message properties, contrary to what
might be expected, the "Connect Audible Signal Device" option is NOT
deactivated once the Alarm Logging wizard has run through its routine, but it
remains set for all those messages for which this option was previously set. This
means that you are obliged to open the Properties window for each individual
message and deactivate this option manually.

With regard to "horns", you must distinguish between two options that have
nothing to do with each other:

Basis WinCC: the signal module is not used:

In Alarm Logging you can select each individual message and right-click to open
the "Properties" dialog. In the "This message" field, you can activate "trigger horn".
What is meant be "horn" here depends on the class to which the message
belongs. You can trigger one horn for each message class. For each message
of this class you can decide whether or not the horn is to sound. What you have to
do will be illustrated here taking the example of the "Alarm" message class.

1. Select the message class, e.g. "Alarm".

2. Right-click to open the Properties dialog.
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3. In the "Acknowledge" tab you define when a horn is to be triggered (with
simultaneous acknowledgment) by selecting a variable in the "Acknowledge
Central Horns" field.

4. Apply this variable to a binary output module via a link to an AS. In this way
you can control any type of audible and visible signal device. You can do the
acknowledging from the message window.

If you enter an internal variable for the variable, you can use this horn triggering to
produce visual displays on the screen.

WinCC control system options for PCS 7: signal module is used:

1. You set up the whole message system over the Alarm Logging wizard (in the
"Base Data" node).

! Warning

The Alarm Logging editor itself also has a wizard. You must make a distinction
here.

2. The "Properties" dialog is not used in the Alarm Logging. You open the Alarm
Logging wizard (Base Data). On the first page of the dialog you can set the
checkmark for the "Connect Audible Signal Device" option. Then, on the third
dialog page in the "Audible Signal Device" field, the active signal "@Signal1" is
assigned automatically to the "Alarm" message class, the active signal
"@Signal2" to the "Warning" message class, and the active signal "@Signal3"
to the two message classes "AS Control System Messages" and "OS Control
System Messages". In versions lower than V5 this assignment does not
work completely. In such cases you can enter them manually.

3. Click the Apply button and an overview of the settings opens. These are the
settings with which the Alarm Logging wizard will configure the message
system. Assignment of the variables @Signal1, @Signal2 and @Signal3 to the
message classes is not entered in the Alarm Logging, but is handled
dynamically in Runtime over the HMRT.exe.

4. On its initial run the Alarm Logging wizard (Base Data) creates the
REPORTHORNASSIGN table in the database. If you have not set the
"Connect Audible Signal Device" option, the table is empty. Otherwise it
contains the signal assignments. If, upon making a repeat run of the Alarm
Logging wizard, you deactivate the "Connect Audible Signal Device" option, the
contents of the database table are deleted, but the table itself remains.

5. If you activate the Runtime, the Audible Signal Runtime.exe (HMRT.exe)
also starts up, because it has been set in the start-up list by the Alarm Logging
wizard. If the database table is empty, it terminates automatically, because
there are no audible signal assignments. The HMRT.exe connects to the
AlarmLoggingRuntime and knows when a new "Alarm", "Warning", "AS
Control System Messages" or "OS Control System Messages" occurs. In such
cases it sets the appropriate signal: "@Signal1, @Signal2 or @Signal3". If you
click the Acknowledge Horn button you simply deactivate all these three @
signals.
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6. In addition, you can make this sounding of the horn and acknowledgment
dependent on the area and thus dependent on the login. If there is a
hierarchy in the Picture Tree Manager, then in Alarm Logging the individual
messages are assigned to an area from this hierarchy and at the same time
users are configured in the User Administrator. Upon occurrence of a
message, the horn is only triggered if the user logged into Runtime has
authorization for the area to which the message concerned is assigned. For
this reason it is not possible, as described under "Basis WinCC: signal
module is not used", to assign in Alarm Logging one or the other @Signal
variable to the individual messages. There is only one link element, that is
the HMRT.exe. The HMRT.exe transfers the states of the @Signal variables to
the driver of the signal module via which the individual relay contacts can then
be switched.

When you install WinCC, the driver of the signal group is displayed as a new icon
in the Windows Control Panel ("Signal Unit Configuration"). Double-click this icon
to start the driver interface via which the module can be tested.

Information on the topic "Horn Control" is also available in the FAQs with Entry IDs
775455, 776118, 632703.

11.2.29 Text length of the ’Origin’ message text in Alarm Logging

Entry ID: 996785 - Date: 08/05/1999

QUESTION:
Can I extend the limitation of the ’Origin’ to 32 characters with mapped messages?

ANSWER:
If the name of the origin of one of your messages ($$AKZ$$) is longer than 32
characters, then it is truncated at the beginning when mapped. You can extend
this limitation by increasing the length of the ’Origin’ user text block (Alarm
Logging > Message Blocks > User Text Block > Origin with a double-click).
You can adapt the length of other user text blocks in the same way.
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11.3 Global Script

11.3.1 Menu item "Compile all functions " is not active in the Global
Script

Entry ID: 1172924 - Date: 10/11/1999

QUESTION:
The menu item "Compile all functions " is not active in the Global Script. What
should I do?

ANSWER:
You project is a multi-user system. In the case of a multi-user system project this
option is not possible. This is because it is not possible to make a unique
assignment of the functions. This is why the "Compile all functions" item is not
active under the menu item "Options" in the Global Script.

11.3.2 The object window is no longer visible in the Global Script editor

Entry ID: 1321558 - Date: 11/08/1999

QUESTION:
Why is the object window no longer visible when you move it to the edge?

ANSWER:
If you move the object window (functions and actions) to the edge in the Global
Script editor, this window disappears and you cannot make it visible again. You
must make the following entry in the Registry to make the window visible again.

1. Start menu > Run, enter regedit.

2. Find the code:
HKEY_CURRENT_USER/Software/Siemens/WINCC/Script/ap_gsccs/ObjTree
Bar

3. Set the "Floating" value from 1 to 0.

4. Restart the Global Script.

5. The window is displayed again.

Notice

Basically, no warranty can be given for direct changes in the registry database,
because this is entirely the responsibility of the user. In any case it is
recommended to make a backup of the registry before proceeding as described
below. Furthermore, these settings are computer-specific. This means that when
copying the project to another computer, the settings have to be made again.
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11.3.3 Global/local actions do not run in Runtime

Entry ID: 1797191 - Date: 01/25/2000

QUESTION:
Why don’t any actions run on my computer?

ANSWER:
In Global Script you have programmed local or global actions. These actions are
not executed in Runtime.

The most common reasons for this are:

• You have not selected Global Script Runtime in the start-up list.

• You have not defined a trigger for the action. This is indicated in the Global
Script editor by a red cross next to the function name.

Notice

As far as possible try to use variable triggers instead of the cyclic trigger. The
cyclic trigger could overload your system.
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11.3.4 WinCC project or standard functions are not found.

Entry ID: 2013047 - Date: 03/28/2000

QUESTION:
Why do I get an error after compiling even though the contents of the C script are
correct?

ANSWER:
If your error image is similar to the one illustrated below, then the problems is most
likely in the header files for the project and standard functions. These are
referenced via the files ap_pbib.h and ap_glob.h. If these files are defective or
empty, then you get the error described.

Solution:
Often there is an empty copy of each of the specified files in the WinCC\bin or
WinNT\system32 directory. In the directories find the files with the names
ap_pbib.h or ap_glob.h. If these files are in the directories specified, then they can
be deleted.

11.3.5 Error message in the diagnostics file: "Script: More than 5000
actions in work"

Entry ID: 2357302 - Date: 07/03/2000

QUESTION:
What causes the following error message in the diagnostics file "Script: More than
5000 actions in work"?

ANSWER:
There are various possible causes for this error message:

• The actions in the Global Script cannot be processed in the time given.
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Example:
Every second there should be 5 global actions. Since more time is needed for
processing the 2nd action as planned, the remaining 3 actions are entered in a
queue. If this process repeats itself, then all the actions that cannot be processed
are entered in the buffer until it is full. When the queue overflows, the error
message concerned is generated in the diagnostics file.

• The error message often occurs when you archive a large number of variables
cyclically selective or acyclically in the Tag Logging. The Start / Stop
functions (begin / end archiving) are executed every 500ms. Since this
happens for each variable, the "script.exe" application is heavily loaded. Never
archive more than 10 variables with this method.

Remedy:
Use the ODK functions to lock and release process archives:
TLGConnect(NULL,NULL);
TLGLockArchiv(NULL,"Archivename",TRUE,NULL); //TRUE = lock FALSE =
release
TLGDisconnect(NULL);

11.3.6 Increased memory use when incorporating a DLL in WinCC
scripts

Entry ID: 2687225 - Date: 07/21/2000

QUESTION:
If I implement a DLL created with Visual C++, I notice that there is increased
memory use on the PC. What has this got to do with?

ANSWER:
Check whether you have created the DLL in the Release Version. WinCC is
supplied as Release Version. This means that WinCC also uses the Release
Version of the Microsoft DLL MFC42.DLL.

If your DLL is available in the Debug Version, then Global Script has to load the
Debug Version of the MFC42.DLL in addition. This therefore increases memory
use.

Always use the Release Version of your DLL in conjunction with WinCC.

You can create the Release Version as follows:

1. Open the project file of the DLL.

2. Check that the DLL has been created under the Win32 Release configuration.

3. If necessary switch the active configuration to "Win32 Release". You do the
switch in the Microsoft Visual C++ Studio under Create > Define active
configuration.

4. Recreate the DLL.

5. Replace the Debug Version with the Release Version of the DLL.
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11.3.7 Querying Boolean variables in OS scripts (C actions)

Entry ID: 2787299 - Date: 08/04/2000

QUESTION:
How do you query Boolean variables in OS scripts (C actions)?

ANSWER:

When programming C actions, make sure that a Boolean variable is an "int"
value. Then the variable in the OS can have the value "0" (FALSE) or any value
not equal to "0" (TRUE).

• If you want to query the "TRUE" status, you must formulate this in your script
with "!=0".

• If you want to query the "FALSE" status, you must formulate this in your script
with "==0".

11.3.8 Disassembly and assembly of strings

Entry ID: 334112 - Date: 05/28/1998

QUESTION:
How can you disassemble and then reassemble a string?

ANSWER:
You can split a 12-character string into two 6-character strings:

Action (mouse click) behind a button:

#include "apdefap.h"
void OnClick(char* lpszPictureName, char* lpszObjectName, char*
lpszPropertyName)
{char array(2)(6);

strcpy(array(0),GetTagChar("pro"));
SetTagChar("int1",array(0));
SetTagChar("int2",array(1));}

Merging two 6-character strings into one string:

Action (mouse click) behind a button:

#include "apdefap.h"
void OnClick(char* lpszPictureName, char* lpszObjectName, char*
lpszPropertyName)
{
char int2(7),array(13);

strcpy(array,GetTagChar("int1"));
strcpy(int2,GetTagChar("int2"));
strcat(array,int2);
SetTagChar("pro",array);
}
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11.3.9 Fetching program windows to the foreground via an WinCC script

Entry ID: 415808 - Date: 04/25/2000

QUESTION:.
How can I fetch the window of another program to the foreground?

ANSWER:
Using the Windows API function FindWindow you can find a handle to a window.

For example, you want to bring an Access window to the foreground:

HWND Handle= NULL;
Handle= FindWindow("OMAIN",NULL);
if(Handle)

{

ShowWindow ( Handle, SW_SHOWNORMAL );
SetForegroundWindow(Handle);

}
else
ProgramExecute("C:\\MSOffice.97\\Office\\ACCESS.EXE");

If the window is not found, then Access is restarted.

Note on the FindWindow function:

The first parameter is the class of the window.
You can determine the class using a compiler (e.g. Spy from Visual C++).

The second parameter is the title of the window (title bar). You can specify
either one of the two parameters or both in combination. In this example the
command is then as follows:

Handle=FindWindow(NULL,"Microsoft Access -");

When looking for the name of the window note that the title is language-dependent
with some languages and then the window might possibly not be found in a
different language. The class is always independent of the language.

If you know the class of the window, then you can use this procedure for other
applications too.
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Her is a list of the names of the window classes for a number of applications:

 Application  Class

Access OMAIN

Internet Explorer 4.0 IEFrame

Microsoft Excel97 XLMAIN

Microsoft Outlook97 rctrl_renwnd32

Microsoft PowerPoint97 PP97FrameClass

Microsoft Word97 OpusApp

MS-DOS – Input prompt ConsoleWindowClass

Netscape Afx:400000:b:10008:6:947d03d8

Notepad Notepad

Paint: MSPaintApp

Calculator SciCalc

Windows Explorer ExploreWClass

Simatic Manager s7tgtopx

WordPad WordPadClass

11.3.10 Maximum number of characters in a C script

Entry ID: 493535 - Date: 09/28/1998

QUESTION:
What is the maximum number of characters in a C script?

ANSWER:
A maximum of 32 000 characters may be used per C script. If you need larger
scripts, then you must divided them across several project functions that you can
call when required.
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11.3.11 Querying of authorization levels using C-Script

Entry ID: 71069 - Date: 12/21/1998

QUESTION:
How can you use Script to query whether a logged-on user is granted a specific
authorization level?

ANSWER:

• The following internal variable must be created in the Control Center:

Variable name: @CurrentUser

Type: Text variable 8-bit character set

• Example: "Background color" property of an object - authorization affecting the
background color. If the authorization is granted, the background is green. If
not, it is red.
#include "apdefap.h"
long _main(char* lpszPictureName, char* lpszObjectName, char*
lpszPropertyName)
{
///////////////////////////////////////////////////////
// Query whether logged-on user has authorization level 4
//
if (PASSCheckAreaLevelPermission("@CurrentUser",4))
return CO_GREEN;
else
return CO_RED;
}

Note

The requirement for using this function is that Basic Process Control must be
installed. You do not need an authorization for this, however.
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11.3.12 Defining global C variable that is known to all functions

Entry ID: 71096 - Date: 07/26/1999

QUESTION:
How can you define a C variable that is known to all functions?

ANSWER:
In the script of WinCC all functions and actions, no matter whether they are actions
on the object or global script actions, are incorporated at runtime in a common
program. Each client in a multi-client environment has its own runtime program.
This means that each variable defined in this program context is addressable in the
functions and actions. If remains unknown to other clients.

Procedure:
Creating a new project function, e.g.:

void dummy()
{
}

Now, if you create a variable in the function dummy, e.g.:

void dummy()
{
int a = 0;
}

then this variable is known only in the function dummy.

If, however, the variable is to be known in the whole C program, you simply declare
it outside the scope of the function, e.g.:

int a = 0;
void dummy()
{
}

This variable a is now accessible at runtime in the whole program (all functions, all
actions on the object, all project functions, all standard functions).
In order to be able to use this variable a in an action on an object, for example,
then it simply has to be declared externally. In other words, the compiler is
informed that it doesn’t have to create this variable itself, but that it will be created
elsewhere at runtime. This variable a only exists locally on a computer. In a multi-
client environment this variable remains unknown to other computers. In this case
you can only resort to internal WinCC variables and use them as data transfer
area.
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Example:
void OnPropertyChange(..........)

{ extern int a; // Variable is not created on the stack, only information

// is given that it has been instanced elsewhere.

a += 1; // This is why it may not be initialized here.

}

Now, if this variable is accessed, the common variable a is changed in the whole
program.
If you declare this variable in a project function, then this variable exists in the
whole project.
If you declare this variable in a standard function, then this variable exists across
all projects.

11.3.13 "Button up" doesn’t work after calling a standard function.

Entry ID: 715336 - Date: 01/18/1999

QUESTION:
Why is the first mouse click ignored when I execute one of the functions listed
below via a button?

ANSWER:
If you execute one of the functions listed below via a button, then a box opens.
When you close the box again, the button is displayed as being pressed as soon
as you position the mouse pointer on it. The first mouse you use to close the box is
ignored and thus ensures that the button behaves "normally" again.

This effect happens with the following standard functions:
OnBtnComment
OnBtnEmergAckn
OnBtnInfo
OnBtnLock
OnBtnSelect
TlgTableWindowPressOpenArchiveVariableSelectionDlgButton
TlgTableWindowPressOpenDlgButton
TlgTableWindowPressOpenItemSelectDlgButton
TlgTableWindowPressOpenTimeSelectDlgButton
TlgTrendWindowPressHelpButton
TlgTrendWindowPressOpenArchiveVariableSelectionDlgButton
TlgTrendWindowPressOpenDlgButton
TlgTrendWindowPressOpenItemSelectDlgButton
TlgTrendWindowPressOpenTimeSelectDlgButton

When a dialog box opens, the dialog box manager takes the OnButtonUp
message out of the processing loop, which is why the button remains pressed.

Remedy:
Use the mouse click event for window commands and not "press left" or "press
right".
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11.3.14 GetTagMultiWait with "float" data type

Entry ID: 814450 - Date: 06/23/1999

QUESTION:
Why doesn’t my GetTagMultiWait work when I use a C variable of the "float" type?

ANSWER:
In versions V4.0, V4.01 and V4.02 a GetTagMultiWait doesn’t work when you use
a C variable of the "float" type.

No matter what value "AnyTag1" and "AnyTag2" have, in "first" and "second" zero
is returned. You must declare the C variables (here "first" and "second") as
"double".

Example:
double first,second;
GetTagMultiWait ("%f%f","AnyTag1",&first,"AnyTag2",&second);

11.3.15 Operations with picture names

Entry ID: 92301 - Date: 09/25/1999

QUESTION:
Operations that include a picture name as a parameter, e.g. SetPictureName, are
not executed correctly.

ANSWER:
For all standard functions that include the picture name with the parameter
designation "lpszPictureName" as call parameter, you must specify the picture
name without the .PDL extension.

Example:
Configuration of the "SetPictureName" function for a picture window: this is to
display a detail picture in a picture window in a main picture.

SetPictureName("MainPicture","PictureWindow1","DetailPicture_Controller.P
DL");

Meaning:

MainPicture Basic picture contained in the picture window

PictureWindow1 Picture window in which the detail picture is to be displayed

DetailPicture_Controller.PDL Detail picture that is to be displayed in the picture window
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11.3.16 ProgramExecute - program is not started

Entry ID: 92310 - Date: 10/25/1999

QUESTION:
Why doesn’t the program specified start when I make a "ProgramExecute" call.

ANSWER:
The call must be as follows:

Example:
...
ProgramExecute("C:\\Siemens\\WinCC\\bin\\ddeserv.exe");
...

It is important to specify "\\"instead simpler"\". This corresponds to the C
convention.

If this doesn’t help, check whether the path specification and program name are
correct.

11.3.17 Global Scripts: difference between project function and global
event

Entry ID: 790445 - Date: 04/09/1999

QUESTION:
What is the difference between a project function and a global event?

ANSWER:
Project functions are called in events or other project functions. They can
however also be incorporated through WinCC applications such as Tag Logging or
Alarm Logging. Here you usually have to keep to clearly defined transfer
parameters that are described in the on-line Help.

Events are called cyclically depending on their triggers. These can be both object-
specific events in an image, and global events that are called independently of
Graphics Runtime.

1. Project functions
Project functions can be renamed and you can also change the transfer
parameters. You can define yourself the return value of the function and the
parameters with which the function has to be called.
In the Graphics Designer you can update the property of an object by event
(e.g. size) via the return value (here "andy") of a project function. The data type
of the return value depends on the type of the property that is to be affected.
The data type in the example given is declared as integer (INT), because this
integer value is transferred to the property through the return (andy). Note that
no return values are given in the case of VOID functions.

2. Global Event
Global events have no transfer parameters. You can execute the event by
changing variables or also with time triggers. You define the trigger criterion
in the trigger of the event concerned.
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11.4 Graphics Designer

11.4.1 Economic hard copy printout on color printers

Entry ID: 1005865 - Date: 10/13/1999

QUESTION:
How can I prevent my gray image backgrounds from taking too much out of the
color cartridges of my printer?

ANSWER:
Printing out an image with a non-white background with the hard copy key of
PCS 7 (WinCC) heavily loads the color units of your printer. You can reduce this
load by executing the following C script when you press the hard copy button.
Furthermore, it is recommended to protocol such hard copies and give them a
password level.

Proceed as follows to be able to use the attached C scripts:

• Use the Split Screen Wizard to define the structure of the basic picture.

• Use the Picture Tree Manager to create the hierarchy of the pictures in your
project.

C script for PCS 7 V4.01 (WinCC V4.01)
Pr_15640_01.pdf (3 KB)

C script for PCS 7 V4.02 (WinCC V4.02)
Pr_15640_03.pdf (3 KB)

11.4.2 Changing the Default Trigger when configuring (V4.02 and
higher)

Entry ID: 1024702 - Date: 09/09/1999

QUESTION:
Can I change the Default Trigger setting in WinCC?

ANSWER:
In V4.02 and higher of WinCC you can change the Default Trigger in the Graphics
Designer under Tools > Settings > Object Presetting. Upon delivery however
this is set to "when changed". This produces a much higher communication load
than another value. With this setting, the channel used must poll the process
variables as fast as possible. Performance problems will most likely occur with this
default setting. You should therefore use the option to change the Default Trigger.
Set a value of 2 seconds and only use "when changed" when necessary.
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11.4.3 After selecting the variable browser, the Control Center is in the
foreground

Entry ID: 144152 - Date: 10/13/1997

QUESTION:
Why does the Control Center come to the foreground when you link a variable to
an object via the variable browser in the Graphics Designer?

ANSWER:
Under Windows NT, Control Panel, Mouse, Mouse Properties, "Motion" tab there is
a setting "Jump to default button". The checkbox "Jump to default button in dialog
boxes" must not be checked.

11.4.4 Image blocks are no longer displayed after copying buttons.

Entry ID: 1903171 - Date: 02/18/2000

QUESTION:
Why can I no longer call image blocks via a copied button?

ANSWER:
With the wizard "Create instance(s) in system image" you have created instances
using the option "Call several displayable blocks via a button each". Then you have
copied the buttons created. Now, no block window is displayed with one of the
buttons.

The causes are as follows:
The wizard creates one image window for each button. This is necessary
because assignment of buttons and images windows is done in Runtime. When
opened, the image windows are entered in a list administered by the standard
function Registry2. Then one image window from this list is assigned
permanently to each button.

If you copy the buttons without copying the image windows, then not all the buttons
can be assigned an image window. The image blocks are not called in this case..
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Example:

In the above example no image block is called with "Button 3". The assignment of
the buttons to the image windows ("Bildfenster") depends on the order of
initialization of the buttons when the image is opened. If "Button 2" were at a higher
level than "Button 3", "Button 3" would be assigned an image window. No image
window would then be able to be opened with "Button 2".

Which button remains without an image window?

The initialization of the buttons is done level by level. First the buttons on level 0
are initialized, then on level 1 as so on. On any level, the buttons that are initialized
first are those that you created first on that level or first moved to that level.

IMPORTANT
There must always be as many image windows configured as calling buttons.
If you copy a button, then copy an image window with it.
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11.4.5 Display/ mask out first page/ final page of the Dynamic wizard

Entry ID: 1937166 - Date: 04/03/2000

QUESTION:
How can I display/mask out the first page and final page of the Dynamic wizard?

ANSWER:
When you call the Dynamic wizard, you have two options for masking out the first
page and final page of the Dynamic wizard. In order to be able to display the first
page and final page again, you must change an entry in the Registry:

1. Start menu > Run, enter regedit.

2. Find the code:
HKEY_CURRENT_USER / Software / SIEMENS / WinCC / GraphicsDesigner /
DynamicWizard

3. Find the values "ShowFirstPage" and " ShowFinalPage":
If the values are set to "1", the first page and the final page are displayed.
If the values are set to "0", the first page and the final page are not displayed.

This check of the Registry is no longer necessary in WinCC V5 and higher. Here
the check can be made in the Graphics Designer. In the "DynamicWizard"
toolbar select any wizard with a right-click. The following dialog opens in which
Show first page and Show final page should be selected.

Note

In general, no warranty can be given for direct changes in the registry database,
because this is entirely the responsibility of the user. In any case it is
recommended to make a backup of the registry before proceeding as described
below. Furthermore, these settings are computer-specific. This means that when
copying the project to another computer, the settings have to be made again.
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11.4.6 Creating a user-specific operator input

Entry ID: 218555 - Date: 01/27/1998

QUESTION:
How can you create operator inputs by API call?

ANSWER:
At present you can only create operator inputs using I/O fields if the property
"Operator Input Yes" has been set in the configuration of the I/O field.
However, there are often requests that operator inputs should be able to be set by
pressing a button or another object. This is possible by employing a number of API
calls.

These API calls have been grouped together and supplied in the function
"OpInputB" such that the same functionality as the operator input of an I/O field is
achieved.

1. Supplying of "OpInputB" function

If the function is called by a "mouseclick" event on a button or other object, then it
can be supplied as follows:

double value_old=0;
double value_new=1;
char* comment="operation of button33";
OpInputB(comment,value_old,value_new);

or
char* comment=" operation of button10";
OpInputB(comment,0,0);

The function must be supplied with the comment string and the new value and old
value, where these values can also be transferred simply with 0 if no variables are
written.

The result of the function is an operator input with the number 12508141 that
displays the old value and new value in process value_2 and process value_3 and
contains the following comments in the comment box.

Transfer of the variable ID as used for the I/O field is not provided, since it cannot
be acquired.No entry is made in the logbook for this function.



Operator Station

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 11-91

2. The "OpInputB" function

#pragma code ("Kernel32.DLL");
BOOL GetComputerNameA(LPSTR Computername, LPDWORD size);
BOOL GetLocalTime(SYSTEMTIME* stTime);
#pragma code();
#include "M_GLOBAL.H"
#include "msrtapi.h"
//
===============================================================
// Function: OpInputB()
//
===============================================================
// Description: Function to create user specific operator messages
// Call e.g. released by a button: OpInputB(CommentText,W_old,W_new);
//
===============================================================
void OpInputB( char* CommentText,double doValueOld, double doValueNew)
{
CMN_ERROR g_sErr;
LPCMN_ERROR pError = &g_sErr; /* Global Error Block */
BOOL fRet = TRUE;
DWORD dwBufSize;
static DWORD l_svID = 0; //Connection ID to Alarmlogging

DWORD dwVarID=0; // Tag-ID set to 0
MSG_RTCREATE_STRUCT MsgCreate;
MSG_COMMENT_STRUCT MsgComment;
SYSTEMTIME stTime;
GetLocalTime( &stTime ); // Get time/date

MsgCreate.dwMsgNr = MSG_SINGLE_OPERATION; // Operator Message
Number
MsgComment.dwMsgNr = MSG_SINGLE_OPERATION; // Operator Message
Number
MsgCreate.stMsgTime = stTime;
MsgComment.stTime = stTime;
MsgCreate.wPValueUsed = 7; // 3 Process Tags( 0..2 )
MsgCreate.dPValue(0) = dwVarID; // Tag-ID
MsgCreate.dPValue(1) = doValueOld; // previous value
MsgCreate.dPValue(2) = doValueNew; // current value
MsgCreate.dwMsgState = MSG_STATE_COME; // state "COME"

strcpy( MsgComment.szText, CommentText );
strcpy( MsgComment.szUser, GetTagChar("@CurrentUser")); // assign logged
user
// get computer name
dwBufSize = sizeof( MsgComment.szComputerName );
GetComputerNameA( MsgComment.szComputerName, &dwBufSize );
printf("ComputerName: %s \r\n",MsgComment.szComputerName);
do {
if( l_svID==0) {
fRet= MSRTStartMsgService( &l_svID, NULL, NULL, 0, NULL, pError ); // activate
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service
if(!fRet) break;
printf( "Alarm Connected %d \r\n", l_svID );
}
fRet = MSRTCreateMsg( l_svID, &MsgCreate, pError ) ; // create message
// Create comment
if(fRet == FALSE ){
printf("MSRTCreateMsg_Error %s \r\n",pError->szErrorText);
}
else {
MSRTSetComment( l_svID, &MsgComment, pError );
}

break;
} while(TRUE);

fRet=MSRTStopMsgService(l_svID,pError); // cancel service
printf("StopMsgService %d %s \r\n",fRet,pError->szErrorText);
if (fRet==TRUE)
l_svID=0;
}

11.4.7 Setting date and time

Entry ID: 268841 - Date: 03/02/1998

QUESTION:
How do you set date and time via the Windows box?

ANSWER:
The Windows properties box for date and time can be called by the following
action, e.g. with a hotkey:

#include "apdefap.h"
void OnClick(char* lpszPictureName, char* lpszObjectName, char*
lpszPropertyName)
{
// Set date and time with ControlPanel-Date-Time
ProgramExecute ("C:\\WIN.95\\control.exe timedate.cpl");
}
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11.4.8 Increase timeout when starting up/terminating runtime.

Entry ID: 268850 - Date: 09/25/1998

QUESTION:
How can I increase the timeout for terminating the runtime?

ANSWER:
In some cases, when activating/deactivating WinCC, you get the message "Could
not start/terminate <Application> in time set". In this case this behavior can be
corrected by adapting the timeout for the runtime.
Proceed as follows:

1. Click Start in the task bar and select the Run option.

2. In the window that opens enter regedit and confirm with OK.

3. Under
"HKEY_LOCAL_MACHINE\SOFTWARE\SIEMENS\WINCC\ControlCenter\Co
nstants" enter a DWORD with the name "Application Deactivation" and a
DWORD with the name "Application Activation". You must specify the value in
millisconds (decimal). The default value is one minute. Reboot the PC to
activate the changes.

Notice

No guarantee is ever given for changes made directly in the registry database,
because this is the sole responsibility of the user.
It is recommended in any case to make a back-up copy of the registry before
accessing as described above. These settings are also different from computer to
computer. This means that when you copy a configuration to another computer,
you have to make the settings again on the target computer.

11.4.9 Changing variables configuration as of WinCC V5.0

Entry ID: 2717651 - Date: 07/24/2000

QUESTION:
How can I change the variables configuration as of WinCC V5.0?

ANSWER:
As of version V5 of WinCC, there is the CrossReference tool. You can use this to
change variables configuration in pictures, messages, functions and archives.

In this editor you can only rewire the variables individually. Copying of parts of
the system is only possible if you rename and rewire each variable individually.
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11.4.10 Limitation of number of screen windows in one image

Entry ID: 70940 - Date: 05/12/1997

QUESTION: - Is there a limitation of number of screen windows in one image?

ANSWER:
It might happen that when you change images, the next image is not displayed
completely in the image window if the image window contents are identical and
there are more than 8 identical image window contents in the two images. In this
case, it is helpful to make the change via a "dummy image".

11.4.11 Symbol bars in the Graphics Designer can no longer be changed
in size and location.

Entry ID: 70967 - Date: 02/25/2000

QUESTION:
In the Graphics Designer I can change neither the size nor the location of the
symbol bars, therefore I can no longer configure correctly. What can I do about
this?

ANSWER:
The entries have got mixed up in the Registry.

Remedy:
In the path Siemens\WinCC\bin find all files with the *.reg extension. The following
files are available:

• 1024x768.reg

• 1152x882.reg

• 1280x1024.reg

• 640x480.reg

• 800x600.reg

The file designations refer to the screen displays. Check you screen settings and
double-click the corresponding file to execute it. This resets the default values for
the Graphics Designer accordingly in the Registry.

If you don’t have any of the screen settings given above, then you can delete the
appropriate paths in the Registry. They are then recreated automatically when you
restart the computer and WinCC.

The Registry branches to be deleted:

HKEY_CURRENT_USER / SOFTWARE / SIEMENS / WINCC / Graphics Designer
and
HKEY_CURRENT_USER / SOFTWARE / SIEMENS / WINCC / Graphics Settings

Note

In general, no warranty can be given for direct changes in the registry database,
because this is entirely the responsibility of the user. In any case it is
recommended to make a backup of the registry before proceeding as described
below. Furthermore, these settings are computer-specific. This means that when
copying the project to another computer, the settings have to be made again.
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11.4.12 Performance loss through transparent drawing

Entry ID: 70976 - Date: 07/08/1997

QUESTION:
How can you achieve better performance in conjunction with transparent objects?

ANSWER:
Transparent drawing costs a lot of performance and should be avoided as far as
possible. An alternative is to work with background colors or levels instead of
transparent characters.

11.4.13 Input of multiple-line text with one button

Entry ID: 70985 - Date: 06/13/2000

QUESTION:
How can you input a multiple-line text with one button?

ANSWER:
If you are using WinCC as of V4.02 Service Pack 1:
First create your button right-click it. Now select Properties and in the Properties
tab click Script and open the text entry field by double-clicking Text. Now you can
enter your text. As soon as you reach the end of a line, press SHIFT + RETURN.
Now you can continue with your text in the new line.

If you are using WinCC up to and including V4.02:
This functionality is not yet available to you in this version. With a little trick
however you can create a multiline text.

Solution via static text:

1. Create static text

2. Create button

3. Select both (multiple selection), and then Properties > Text

4. You now have a multiple-line editor for the text

5. If you want to center something, you have to pad out with blanks.

Once the required text has been edited on the button, you can delete the static text
object. It is only an aid.

Notice

When creating the objects, you must pay attention to the order. The static text
must be created before the button.
Since this is not a standard function, but a workaround, problems arise when
exporting with Language.exe. It is therefore recommended not to use this option in
conjunction with this tool.
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11.4.14 Configuring status displays with configuration or dynamic dialog

Entry ID: 715335 - Date: 01/18/1999

QUESTION:
How do I configure status displays using the configuration dialog in such a way that
under Properties of the status display I can see which status display belongs to
which bit?

ANSWER:
You have made a status display dynamic via the configuration dialog. The status
display is to display two images (EMF) at bit x.0 and bit x.1. The functionality is OK.
However, you cannot see which status is assigned to which bit when you have the
Properties of the status display displayed (Properties/Status).

You should not assign the image to a bit of the variable, but to its value. The value
of the variable then corresponds to the status of the display. Thus, if you want the
image of bit x.1, then you must select status 2 in the Properties dialog.

However, this is only the case if you have used the configuration dialog. Then it
makes much more sense to check the assignment in the configuration dialog. The
behavior is different if you use the Dynamic dialog to make the status display
dynamic. In this case in the Properties dialog you can assign the images to the
statuses continuously and in the Dynamic dialog you can link the value areas to
these statuses.

11.4.15 Inoperability of the system message/error box

Entry ID: 803922 - Date: 04/29/1999

QUESTION:
If I click the system image with an active message/error box, do I have a possibility
of bringing the box back to the foreground, although I have locked the key
combination?

ANSWER:
Using the wizard you have generated an event "Display message box, error box"
and called them in RT. Once you click the system image, the box disappears in the
background. Since you have locked the key combination (e.g. ALT+TAB), you can
no longer bring the box back into the foreground.

The box has the property that the trigger type with which it was created is no longer
processed as long as the box is active. You opened with the box with a mouse click
trigger, therefore no other mouse click is processed. Nor can you press a button to
deactivate the RT. The change using ALT+TAB is also blocked. The only option
you have of terminating RT is to switch the PC off and on again.

Remedy:
Using the wizard create a modal box that always remains in the foreground, or run
a query as to which display mode is required. See FAQs with the Entry IDs 92352
and 268859 for descriptions of how to create a modal box (SIMATIC Customer
Support - Search page).
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11.4.16 Optimized configuration through direct link

Entry ID: 92250 - Date: 09/25/1996

PROBLEM:
Options and configuration of the direct link.

ANSWER:
In addition to C operations WinCC offers the option of configuring results with a
direct link. If you use the direct link instead of C operations, you can increase
performance.
Proceed as follows to select the direct link: under a graphical object in the "Event"
tab of the "Properties" menu you click the lightning symbol (for example under the
Mouse > Mouse Click event) with the right mouse button (menu item Direct Link).

The following options are available:

• Source: Constant
Target: Object in picture
You can enter a number value and link it, for example, to the target object "I/O
field" with the property "Output value". If you click on the selected object during
runtime, the specified value is output in the I/O field.

• Source: Constant
Target: Active window
You enter a picture name or use the Select button to select a picture name and
link it with the property "Picture name". If you click on the selected object
during runtime, the corresponding picture is opened. This way of changing
pictures is the same as the "OpenPicture" operation, but the reaction time is
much better, because there is no need to interpret C code.

• Source: Property
Target: Object in picture
You must select the selected source object and a property and then you can
select a target object and a property for the target object. If you click the
selected object during runtime, the property of the target object is activated.
This makes it possible to link the properties of different objects directly. (For
example, by mouse click you can make the background color of a circle the
same as that of a rectangle.)
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11.4.17 Displaying the integer values from the SPS as decimal values in
WinCC

Entry ID: 92413 - Date: 10/08/1999

QUESTION:
How can I display an integer value from the SPS as a decimal value in WinCC?

ANSWER:
In order for an I/O field to display the value standardized, or to transfer the value
standardized to the controller, you must configure the following actions:

• Action on "Output value" property of an I/O field (important: "float", if you want
decimal places):
float a;
a=GetTagFloat("DB21_DW1");
return (a/100);

• Action on "Input value" event of an I/O field:
float a;
a=GetInputValueDouble(lpszPictureName, lpszObjectName);
SetTagFloat("DB21_DW1", a*100);

11.4.18 Configuring a status display

Entry ID: 2843157 - Date: 08/14/2000

QUESTION:
How do you configure a status display in the OS?

ANSWER:
Taking an example we will show you how to proceed to create a status display.

Example:
A status display with two alternatives is to be created. It is to be updated by the
parameter "QOPENED" of a valve block. If the block is open (QOPENED = 1), then
Alternative 1 is displayed. If the valve is closed (QOPENED = 0), then Alternative 0
is displayed.

Creating a status display is done in two steps:

1. The symbols for the individual alternatives are created. If the symbols already
exist, then can also be transferred.

2. The status display is configured.

You do the first step once per type of status display. The second step you do as
often as you create instances of this type. In our case once for each valve.
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Creating the symbols for the alternatives (Step 1)

1. In the Graphics Designer open a new picture (e.g. with the name Status.pdl)
one after the other create the statics for the Alternative 0 and Alternative 1.

2. Throw a lasso round Alternative 0, group the objects and export (File >
Export) the alternative in EMF format into the file "valve_v1_h_0" (valve,
version 1, horizontal position, Alternative 0).

3. Throw a lasso round Alternative 1, group the objects and export the alternative
in EMF format into the file "valve_v1_h_1".

Configuring the status display (Step 2)

1. Call the process picture into which you wish to include the status display (e.g.
RMT1.PDL). Remove the smart object Status display from the object palette
and link this with the parameter "QOPENED" of a valve block (selection field
Variable in the dialog box Status Display Configuration).

2. Add the status 1 to the status display.
Press the Add button in the dialog box Status Display Configuration.

3. Assign the file (picture) "valve_v1_h_0" to the status 0 and the file (picture)
"valve_v1_h_1" to the status 1.

4. Terminate configuration of the status display.
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11.4.19 Displaying Faceplates in a Process Picture

Entry ID: 00011- Date: 12.07.2000

QUESTION:
How do I display faceplates in a process picture?

ANSWER:

To allow you to control the controllable blocks from the PCS 7 libraries, PCS 7
supplies you with faceplates. Faceplates are created as OCXs and display all the
inputs and outputs of a block required for controlling a process.

Configuration is extremely simple. You connect the faceplate to an instance of a
structure type by means of a wizard and the faceplate fetches all the relevant
information automatically during run time.

You can use faceplates in two ways:

• The faceplate is integrated permanently in the process picture and cannot be
moved within the process picture by the operator.

• The faceplate can be called up dynamically by the operator during run time.

Permanent Display of the Faceplate in the Process Picture

Follow the steps outlined below:

1. Open "Smart Objects" in the Object Palette.

2. Select "Control" (mouse click).

3. Hold down the left mouse button and drag the faceplate to the working window;
the "Insert Control" dialog opens.

4. Select the control you require (for example, "PCS 7 MEAS_MON Control"); the
control is displayed in the process picture.

5. Now connect the faceplate with a structure type (block instance on the ES)

6. Select the faceplate in the process picture.

7. Start the "Connect picture block to tag structure" dynamic wizard (Standard
Dynamics)

8. Select the required tag in the Wizard dialog (for example "...FC 111...").

In the properties of the faceplate, you can select one of the views ”symbol",
"faceplate" or "loop". The view you select then appears when the process picture
is displayed in run time.
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Symbol

The "symbol" is made up of the tag name (if necessary invisible) with the message
display and "pictures" that you assigned to the individual tags. During run time, the
relevant faceplate is opened when the operator clicks on the symbol.

Faceplate

The faceplate contains specific values of the relevant block that the user normally
want to have visible at all times in the process picture. These might include, for
example, the measured value, operating limits, and alarm and error indications.
There is also a combobox in which further views of the block can be selected (limits
that can be adjusted, Batch Control etc.)
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Loop

With "loop", the displays that can be activated individually in the faceplate are
displayed one beside the other.

You select the display in the properties of the faceplate in the "view" list box.

By double-clicking on the faceplate while holding down the "CTRL key", the
faceplate with all variables (static) appears in the run-time display.

Dynamic Display of Faceplates in Run Time

Using a dynamic wizard, you can display a faceplate in run time by clicking on a
picture object (for example, on a status display or a static circle). It is not possible
to display the faceplate by clicking on a user object.

Compared with permanent display, the dynamic display of a faceplate has the
advantage that picture selection times are reduced and that the picture seen by the
operator is not crammed full of picture objects.

Follow the steps outlined below:

1. In your graphic, select the object in which you want to activate display of the
faceplate and start the "Picture selection via measurement point" dynamic
wizard in the "Picture Functions" tab of the Dynamic Wizard.

2. In the wizard, set the following properties to suit your requirements:
Trigger: for example, left mouse key
Structure type: for example, valve
Measurement point: for example, valve block of the CFC chart "NK 111"
Display type: for example, group display
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The meaning of the display types you can select in the Dynamic Wizard is as
follows:

Loop display => Work area
The loop display of a faceplate is displayed in the work area. This means that you
can no longer move or minimize the faceplate. You deselect the faceplate by
calling a new process picture in the work area.

Loop display => Process window
The loop display of the faceplate is displayed is the process window. You can then
both move and close the faceplate.

Group display
The faceplate is displayed in a picture window. You can both move and close the
faceplate.

11.4.20 Moving an image window only within the working area of the Split
Screen Wizard

Entry ID: 1292350 - Date: 11/08/1999

QUESTION:
How can I achieve a situation where a movable image window always remains
within the working area created by the Split Screen Wizard?

ANSWER:
Take the attached C script as an example. In the image window concerned you
incorporate it under the event Position Y / Change. For the X position you must
write an appropriately matched script.

Bildfensterscript.pdf (3 KB)

Note

The sample program is freeware. Every user can use, copy or forward this
program FREE OF CHARGE. The authors and owners of this program take no
responsibility whatsoever for the functionality and compatibility of this software.
Use of the software is entirely at the users own risk. Since this software is free of
charge, there is no warranty, nor claim for error correction and hotline support.
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11.4.21 Setting/Resetting bit via mouse click (toggle function)

Entry ID: 2012110 - Date: 03/27/2000

QUESTION:
How can I set and reset a WinCC variable by mouse click with C script?

ANSWER:
The following function shows how you can alternately set and reset a WinCC
variable by mouse click.

#include "apdefap.h"
void OnClick(char* lpszPictureName, char* lpszObjectName, char*
lpszPropertyName)
{
BOOL z;
z=GetTagBit("MyBitVariable");
if (z==0)
SetTagBit("MyBitVariable",1);
else
SetTagBit("MyBitVariable",0);
}

11.4.22 Flickering of bar display when updating

Entry ID: 2442720 - Date: 06/14/2000

QUESTION:
I have about 30 analog values displayed as bar diagrams in an image. Since
transferring the update PCS 7 V4.02, the individual bar windows flicker when
updated. What can I do about this?

ANSWER:
Check whether "Deactivate optimized drawing" option is activated in the WinCC
Control Center. The options are to be found in the WinCC Control Center under
each computer in the Properties dialog and then under Graphics Runtime >
Deactivate > Optimized Drawing. If this item is activated, then deactivate it.
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11.4.23 Sample program: Open picture windows "@TOP01...@TOP16" in
any position in the picture "@1001.pdl"

Entry ID: 2511096 - Date: 06/27/2000

QUESTION:
How can I open picture windows "@TOP01...@TOP16" in any position in the
picture "@1001.pdl"?

ANSWER:
You want to change the position of "@TOP01...@TOP16" in the picture
"@1001.pdl". The pictures are to be opened at the current cursor position. This
picture position is permanently linked to the Properties/Events of the picture
windows "@TOP01...@TOP16" in the picture "@1001.pdl".

The functions "SSMOpenTopFieldFixedSize" or "SSMOpenTopField" do not
offer you any parameters (x, y) for change the picture position of the window to be
opened.

The following solution opens the picture window at the current cursor position.

For this, under Object Properties you must activate the event
"Events\PropertyTopics\Miscellaneous\Display"
of the picture window "@TOP01-@TOP16" in the picture "@1001.pdl" with the
following C function:

C function:

Bildfenster.pdf (3 KB)

The function reads the current cursor position and accordingly sets the properties
X-Position, Y-Position of "@TOP01-@TOP16".

Note
The sample program is freeware. Every user can use, copy or forward this
program FREE OF CHARGE. The authors and owners of this program take no
responsibility whatsoever for the functionality and compatibility of this software.
Use of the software is entirely at the users own risk. Since this software is free of
charge, there is no warranty, nor claim for error correction and hotline support.
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11.4.24 Calling SFC plan via button

Entry ID: 364046 - Date: 07/09/1998

QUESTION:
How can I call an SFC plan via a button or another graphics object?

ANSWER:
You have two options for calling an SFC plan via a button or another graphics
object.

1. You can place the SFC default images in WinCC images and link them with an
SFC plan.

2. You can configure any graphics object (e.g. rectangle) into an operation in
which an SFC plan is opened.

This object then represents the SFC plan.
However, as opposed to the SFC default image, this object holds no information on
the current status of the SFC plan.
In the operation you can select either the general or detailed view of the SFC plan.
The operation can be formulated as follows, for example:
#include "apdefap.h"
void OnLButtonDown(char* lpszPictureName, char* lpszObjectName, char*
lpszPropertyName, UINT nFlags, int x, int y);
{
#pragma code ("sfccli.dll")
#include "sfccli.h"
#pragma code ()
long left, top, width, height;
SSMGetWorkFieldCoordinates(SSMGetScreen(lpszPictureName), &left, &top,
&width, &height);
// General view
SFCOpenOverview("Planname", left, top, width, height, (void*)0);
// or Detailed view
SFCOpenSection("Planname", left, top, width, height, (void*)0);
}
In the operation you must replace "Planname" by the variable name of the SFC
plan (e.g. "S7$Programm(1)_SFCPlan"). You can select this in the variable list
(e.g. "S7$Programm(1)_SFCPlan.EventState") and must then be shortened by
"EventState".
If more representative objects are to be configured for SFC plans, you can also
create the operation described above as "Global Script".
For this you need to formulate the following scripts SFCOverview and SFCSection:
void SFCOverview(char* lpszPictureName, char* lpszPlanName);
{
#pragma code ("sfccli.dll")
#include "sfccli.h"
#pragma code ()
long left, top, width, height;
SSMGetWorkFieldCoordinates(SSMGetScreen(lpszPictureName), &left, &top,
&width, &height);
// General view
SFCOpenOverview("Planname", left, top, width, height, (void*)0);
}



Operator Station

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 11-107

// ----
void SFCSection(char* lpszPictureName, char* lpszPlanName);
{
#pragma code ("sfccli.dll")
#include "sfccli.h"
#pragma code ()
long left, top, width, height;
SSMGetWorkFieldCoordinates(SSMGetScreen(lpszPictureName), &left, &top,
&width, &height);
// Detailed view
SFCOpenSection("Planname", left, top, width, height, (void*)0);
}
Thus the formulation of the operation is reduced to SFCOverview or SFCSection,
SFCOverview(lpszPictureName, "Planname");
// or
SFCSection(lpszPictureName, "Planname");
where the "Planname" is replaced by the variable for the SFC Plan.

11.4.25 Generate user object in the Graphics Designer

Entry ID: 372414 - Date: 07/15/1998

QUESTION:
How can I create a symbol in the Graphics Designer and make it dynamic?

ANSWER:
In the Graphics Designer you can create a dynamic object by creating the object as
a user object and then making it dynamic.
How to do this is described in detail in the following document:

anwobj_e.pdf (64 Kbytes)

11.4.26 Controlling status display with EventState variable

Entry ID: 673583 - Date: 11/30/1998

QUESTION:
How can I control a status display via an EventState variable?

ANSWER:
You cannot link the EventState variable directly with the ’Current status’ property.
You must make this property dynamic with a C script that evaluates the EventState
variable. The meanings of the bits in the EventState variable can be found in the
online Help of control center under ’Value supply of group display’. The C script
given below can serve as an example.

EventState_Script_e.pdf (4 KB)
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11.4.27 Unknown Objects instead of Faceplates

Entry ID: 678986 - Date: 12/08/1998

QUESTION:
Why are only Unknown Objects instead of Faceplates displayed in WinCC?

ANSWER:
You haven’t installed the image blocks (Faceplates) on your computer. Install the
PCS 7 standard libraries again and in the Setup select the ’Image blocks for
WinCC’ option.

11.4.28 Opening a picture in the process window with LoopInAlarm

Entry ID: 837177 - Date: 05/03/1999

QUESTION:
How can I avoid the whole screen being filled when I open a picture using the
OpenPicture function via LoopInAlarm?

ANSWER:
In the Global Script write a project function that looks like this:

#pragma code("ssmrt.dll")
#include "ssmrt.h"
#pragma code()

BOOL OpenPicture(char* picture)
{
CMN_ERROR Err;

if (!SSMRTOpenTopField (’1’, picture, NULL, 0, &Err))
{
printf ("SSMRTOpenTopField failed: %s\r\n", Err.szErrorText);
return FALSE;
}
else
return TRUE;
}

• In the case of multiple-screen mode (Multi VGA) you must adapt the first
parameter of the SSMRTOpenTopField function accordingly.

• Compile the function, save it and regenerate the header. When saving the
function give the file the same name as the function, in this case OpenPicture.

• In the Alarm Logging under Message Properties select in the Variable/Actions
tab the function name Call Picture, and select the picture to be opened as
Picture name/Call parameter.

Note

It is important that the function entered with LoopInAlarm has a transfer parameter
and returns a value.



Operator Station

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 11-109

11.4.29 PCS 7: group displays in a user object

Entry ID: 865859 - Date: 05/31/1999

QUESTION:
Can I incorporate a group display in a user object?

ANSWER:
Yes, you can incorporate a group display in a user object. Here you must observe
the following points:

• The property "Group relevant" of the group display must be made
parameterizable. This means that the properties "Group value" and "Group
relevant" must be set to "external" in the user object. In this way the messages
are also displayed in the overview of WinCC Runtime.

• You can also configure several group displays in a user object. But then only
the messages of a group display are displayed in the overview area.

11.4.30 Display of bitmaps of the faceplates linked as icons

Entry ID: 996786 - Date: 08/05/1999

QUESTION:
Why are the bitmaps of the faceplates linked as icons no longer displayed?

ANSWER:
When linking the bitmaps into faceplates displayed as icons, WinCC notes the
absolute path of the directory in which the bitmap is stored. If, for example, you
copy the project onto another computer, you must copy the bitmaps into the same
path. You can determine the name of the path in which WinCC searches for the
bitmap as follows:

1. Use an ASCII editor (WordPad, NotePad) to open the image
Image_name.PDL created by WinCC from the WinCC project directory GraCS.

2. Search in this file for the name of the bitmap. The complete path is then given.
If no path is displayed, the bitmap is in the GraCS directory.

Notice

Under no circumstances should you change this file with the ASCII editor.

Remedy:
You can avoid this problem by storing all the required bitmaps in the WinCC project
directory "...\GraCS" and from there link them into the faceplate.
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11.5 Text Library

11.5.1 Destroyed text library table

Entry ID: 268805 - Date: 03/02/1998

QUESTION:
What can be done if errors or crashes occur when accessing the text library?

ANSWER:
In this case the text library is more than likely inconsistent. This is usually the case
with very old configurations that have probably been created with version V1.x of
WinCC.

How can you check and if necessary, repair your configurations?
Checks for standalone system:
Load the configuration in the Control Center, start ISQL and enter the following
command:
Select * from txttable

If you see "Deutsch" or "German" as column name in the header, then the txttable
is inconsistent.

Use the following commands:
"alter table txttable rename Deutsch to L7"

or

"alter table txttable rename German to L7"

and the error is eliminated if an L7 column has not been created in the meantime.

If an L7 column has been created in the meantime, the correction is more
complicated:

Check the number of languages in txtlanguages:

Select * from txtlanguages; number of lines = number of languages

Select * from txttable should produce two extra columns. If not, then you must
delete all the text tables. The texts are lost (drop table txtversioninfo; drop table
txtlanguages; drop table txttable).

If there are two more columns than entries in txtlanguages, you must check which
column of txttable is to be deleted. You choose between the column with the
header L7 and that with the header "Deutsch" or "German". If you decide to delete
the "German" column, you must enter the following command:

"Alter table txttable delete German".

If you decide to delete the L7 column, you must enter the following commands:

"drop index TXTTABLE_7"

"alter table txttable delete L7"

"alter table txttable rename German to L7"
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11.5.2 Cannot open Text Library

Entry ID: 492977 - Date: 09/25/1998

QUESTION:
After a system crash I cannot open my text library any more. What can I do?

ANSWER:
WinCC creates temporary files during configuration. This coordinates multiple
access, for example. If there is an unexpected system crash, these files are not
deleted. This is why at the next startup access to the text library is locked.

In the Configuration directory you must delete the files Txtbibcs.tmp and
Algcs.tmp. If you have a multi-user system, delete the file Textbib.txt.

11.5.3 Import/export of EXCEL tables to and from the text library

Entry ID: 56567 - Date: 02/18/1997

PROBLEM:
What must be noted when importing/exporting EXCEL tables to/from the text
library?

ANSWER:

1. In the text library you create all the columns (= languages) you require. Sort the
text IDs beforehand, i.e. Text ID 1 at the top of the list and so on.

2. Export a file. The default is the project name plus the extension .CSV. Use, for
example, TEXTIB in the project directory as target folder.

3. Double-click the file to open it in the Explorer. EXCEL starts and texts are
displayed. You can improve the display by selecting the table and setting the
optimum column width under "Format". Edit in EXCEL, i.e. change texts, insert
new text or new lines. Never add new columns. The first 4 rows must not be
changed (header data). Text IDs must never be duplicated. It is best just to
continue with the sequence of the sorted text IDs.

4. The complete table must be selected before storing. Once you have selected
the complete table, select Format in the EXCEL menu bar and then the Cells
menu item. In the box that now opens you select the first tab, Numbers, and
select Text as the type of category. Then you click OK.

5. Store the file with Save As under the same file name (e.g. in another
directory). The .CSV format is default.

6. As EXCEL sporadically saves the CSV-files incorrectly. It is important tocheck
the files in a text editor before importing them into WinCC. Each column is
seperatted by means of a ";"
eg. 79 ; eins ; one
80 ; zwei ; two

7. Now import the file into the text library. Important: Exit EXCEL prior to this.

8. The texts are now displayed in the text library. Store them by activating the
"Save" key.
Up V_3.0 is the aimed storing no more necassary, it is stored automatically.



Operator Station

Process Control System PCS 7, Tips and Tricks
11-112 A5E00080064-01

11.6 Projects management

11.6.1 Improvement of performance through changing the variable
scaling

Entry ID: 2623090 - Date: 07/07/2000

QUESTION:
What is the best way to scale variables?

ANSWER:
With the more recent versions of WinCC (V4, V5) you can configure the scaling of
the external variables under the Properties of the variable.

Projects are often migrated from older versions of WinCC to the newer versions of
WinCC. Here, it can happen that the scaling is done using C scripts. If this is the
case in your project, then it is recommended to reconfigure the scaling via the
Properties dialog.
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11.6.2 ODBC error when creating a multi-user configuration

Entry ID: 268823 - Date: 03/02/1998

QUESTION:
In which cases can problems arise in the creation of multi-user configurations?

ANSWER:
With multi-user configurations there must not be any BLANK in the folder or
configuration name. This is OK for standalone systems, but not for multi-user
configurations.
You must not implement any SYBASE versions other than that supplied with
WinCC.
The reason is that this version contains patches that are not contained in regular
versions.

11.6.3 Locking key combinations is sometimes ineffective

Entry ID: 332356 - Date: 09/21/1999

QUESTION:
What should I do if locking the key combinations is ineffective under WinCC?

ANSWER:
Proceed as follows:

• Create new configuration (do not make any other settings)

• Terminate WinCC

• Start WinCC (new configuration)

• Start Runtime without graphics

• Terminate Runtime

• Terminate WinCC

• Start WinCC

• Re-open the original configuration

• Start Runtime

The error should now be cleared.

If this procedure doesn’t work, check the following Registry entries:

1. Start menu > Run… , enter regedit .

2. Find the code
HKEY_LOCAL_MACHINE/Software/Microsoft/Windows NT/Current
Version/Winlogon

3. Check whether the following entries have been made:
Gina.dll = "almxgina.dll"
and
Userinit = "userinit,ALMXPMGR.EXE,nddeagnt.exe"
Keys can only be locked if these two entries are made.
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Then you can check whether the lock has actually been entered:

1. Start menu > Run… , enter regedit .

2. Find the code HKEY_CURRENT_USER/Software/Microsoft/Windows
NT/Current Version/Winlogon

3. All the keys are entered under this path.
For example, AllowAltTab or AllowCtrlAltDel ...
If these keys are set to "1", they should work, if they are set to "0", then they
are locked.

Note

Basically, no warranty can be given for direct changes in the registry database,
because this is entirely the responsibility of the user. In any case it is
recommended to make a backup of the registry before proceeding as described
below. Furthermore, these settings are computer-specific. This means that when
copying the project to another computer, the settings have to be made again.

11.6.4 Sporadic problems when starting up clients

Entry ID: 492745 - Date: 09/25/1998

QUESTION:
My clients boot faster than the server and the timeout for connecting to the
database expires. What can I do about this?

ANSWER:
Under Control Panel you must click "System" and then select the "Start Up/Shut
Down" tab. The value "Display list for xx seconds" must be set on the client to 30
seconds more than that on the server. If this is not enough, then you must try again
gradually increasing the values each time until the optimum setting is obtained.

11.6.5 Connection Status in the Control Center

Entry ID: 632781 - Date: 11/02/1998

QUESTION:
What is the meaning of the displays in the Control Center in the case of
"Connection Status"?

ANSWER:
Via the menu item Tools > Connection Status you can very quickly check the
status of your process connection(s). What you see in the CONTROL CENTER
under CONNECTION STATUS (variables read, variables written, number of read
jobs …) are all the individual variable requirements.
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Example:
You read off a number of 4000 (number of read jobs). That is the number of
variables that can be requested by the channel via the data manager. This is not
the number of requests by the channel to the SPS. The number of requests is
optimized by the channel.
Entries and their meanings:

 Column  Explanation

Status Either "OK" or "Cleared down"

Error What error codes are displayed depends on the type of
connection. In the case of an S7 connection these are error
codes that are described in the on-line help.

Write jobs Display of queued write jobs.

Read jobs Display of queued read jobs.

Variables read Display of the sum of variables read during the course of a
runtime session.

Variables written Display of the sum of variables written during the course of a
runtime session.

Notice

If the display of read and write jobs increases constantly and doesn’t decrease at
all, this is probably an indication that the data route is overloaded or that there is a
basic problem with the connection.

11.6.6 Using the GetTag and GetTagWait functions

Entry ID: 665138 - Date: 11/18/1998

QUESTION:
When do I use "GetTag()" and when do I use "GetTagWait()" for reading
variables?

ANSWER:
GetTag:
If you use GetTag, the value of the variables is read from the process image of
the data manager. The first call of the function initializes a cyclic reading of the
variables from the controller. The updating cycle is 2s. If you send the calls in a
global operation, from that moment on the variables are requested cyclically by
WinCC during the entire runtime. If you initialize the calls in an image, updating
stops after the image has been deselected.

This call is best used if:

• The updating cycle is sufficient in the data manager.

• You want to have a short updating time in the image.
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GetTagWait:
If you use GetTagWait, a read job is sent by the data manager to the controller. In
this case the value is not taken from the process image in WinCC. The job is sent
just once when the function is called. Nor does this initialize cyclic updating of the
variables. Calling the function takes more time because the value is accessed in
the controller and you have to wait for this.

This call is best used if:

• You need the current value in the SPS.

• To have the very latest process value is more important than the updating time
in the image.

11.6.7 Checking network settings and the communications channel

Entry ID: 2839551 - Date: 08/09/2000

QUESTION:
How can I check the network settings and the communications channel in the OS?

ANSWER:

The variables list affords you the possibility of checking the network settings (rack
number, slot number etc.) and the communications interface (MPI on Board,
Industrial Ethernet etc.) of a PLC.

Checking the network settings

Proceed as follows:

1. In the WinCC Explorer of the OS open the Variables List and then the
SIMATIC S7 Protocol Suite. Right-click the interface that you wish to check
(MPI, Industrial Ethernet(I), PROFIBUS(I) etc.).

2. In the pop-up menu click Properties.

3. In the dialog box click the Properties button.

4. Select the Connections tab and check the following settings:

- Station address (address of the CPU on the bus system)

- Segment (ID) (set a 0 here)

- Rack number (from HW Config; normally 0 for the central rack)

- Slot no. (Slot no. of the CPU from the HW Config; the CPU occupies two
slots, specify the number of the slot where the MPI interface is slotted.)

5. Close the dialog box.

Note

If you are using the internal MPI interface of the CPU, then enter 0 for the rack
number and for the slot number. If an incorrect rack or slot number is specified,
the communication connection is not set up. In the case of a link via PROFIBUS or
Industrial Ethernet, the slot number of the CPU must always be specified and not
slot number of the communications module.
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Checking the communications channel

1. In the Control Center of the OS open the variables list and then the SIMATIC
S7 Protocol Suite. Right-click the interface whose communications channel you
wish to check (MPI, Industrial Ethernet(I) etc.).

2. In the pop-up menu click System Parameters.

Select the Device tab and check the logical device name for the communications
channel. The device name depends on the installation of the MPI card or the
installation of the CP. By default you can specify "S7Online" as logical device
name. If you do not get a connection to the PLC, then select one of the logical
device names offered for MPI or CP.

11.6.8 Error message "Cannot find server, start project locally?" when
opening an OS from the SIMATIC Manager

Entry ID: 1628028 - Date: 12/14/1999

QUESTION:
What is the meaning of the message: "Cannot find server, start project locally?"?

ANSWER:
In the SIMATIC Manager you have inserted an OS and now want to open. When
you do so, you always get the error message:

"Cannot find server, start project locally?"

The computer entered in WinCC nevertheless matches the actual release name.
The WinCC Object Manager that is responsible for opening an OS requires a
release name for the project path. Check in the Explorer whether this release is
available. If not, you must issue the release. If you have problems issuing the
release, reinstall the SP5 of Windows NT 4.0. Then you can issue the release and
open the OS from the SIMATIC Manager.

11.6.9 License error message "No License for PLS1"

Entry ID: 2290170 - Date: 05/23/2000

QUESTION:
Why do I get a license error message when opening the Interrupt Logging Wizard
or the Split Screen Wizard?

ANSWER:
You are using WinCC V5.0+SP1 or PCS 7 V5 without the authorization for the
options package "Basic Process Control". After starting the Split Screen Wizard
you get the message:
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Or after starting the Interrupt Logging Wizard you get the message:

Cause:
Without the license for the options package execution of both functions is denied.
Remedy:
Install the license for the "Basic Process Control" package.

11.6.10 Licenses required for WinCC V5.0 / SP1 for server/client
operation

Entry ID: 2397327 - Date: 12/04/2000

QUESTION:
Which licenses are required for WinCC V5.0 / SP1 for server/client operation?

ANSWER:
The OS server requires the "WinCC RT 64k Tags" license, the OS client requires
the "WinCC RT 128 Tags" license. In order to prevent the RT ending after a
certain time on the servers and the clients with the following message:
"Your software license has expired",
an Autostart function is offered with WinCC V5.0 + SP1 and higher. In Windows
NT under "Start > SIMATIC > WinCC > AUTOSTART" you can specify the project
that is to be started directly in the RT. The WinCC Explorer must not be opened for
this.

Note

If you open your project via the WinCC Explorer, then the "A9WRC130" license
is required. This license is not part of the software packages for the OS server or
OS client.
Information on which licenses and software you required for the different OS
systems is available in the FAQ "Software installations and authorizations in the
multi-user system", Entry ID !2887917!.
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11.6.11 PCS 7 OS project cannot be created or is not displayed.

Entry ID: 364054 - Date: 07/07/1998

QUESTION:
On my Engineering Station (ES) I cannot create an OS project in the SIMATIC
Manager or no OS project is displayed although it is present.

ANSWER:
In the SIMATIC Manager check whether an OS project can be inserted in general.’
Procedure:’
Right-click the project container and then Insert new object > OS.

If an OS is displayed in the menu, then proceed as follows:

1. In the system path in which the PCS 7 system is installed check whether the
directory ...\Siemens\WinCC\wincproj is there and whether it contains the
WinCC project "first".

2. In the system path in which the PCS 7 system is installed check whether the
directory ...\Siemens\Step7\S7bin contains the following DLL files:
-S7omwina.dll;
-S7omwinb.dll;
-S7omwinc.dll;
-S7omwind.dll;
-S7omwine.dll;
-S7omwinx.dll;

3. In the project path in which the project is stored check whether the directory
...\Projectname\winccom contains the following files:
-winccom.cs;
-winccom.db;
-Wbproj.dbf;
-Wp1proj.dbf;
-wbproj.lck;
-wiproj.lck;
-wp1proj.lck

4. In the project path in which the project is stored check whether the directory
...\Projectname\wincproj is there and whether it contains an OS project with the
OS names created.

If not, then the PCS 7 system has not been installed correctly.

Remedy:
The PCS 7 system must first be deinstalled and then reinstalled.

If there is no OS displayed in your menu, then proceed as follows:

1. Close WinCC.

2. Open the Control Panel (Start > Settings > Control Panel).

3. Open the Software folder.
The "Software Properties" window opens. This window contains a list of all the
applications that you have installed under Windows NT. In this list you select
the entry SIMATIC WinCC > Windows Control Center.
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4. Start the WinCC Setup by double-clicking.
In the Deinstallation / Insert window you must activate the button Do you
want to remove or add parts of WinCC. The "Select Components" window
opens next.

Finally, you must mark the text (not the checkmark) "Communication". In the right
area check that the following options are set as follows:

• S7Dos set

• OPC not set

• Object Manager set.

If not, then WinCC has not been installed correctly.

Remedy:
Set the options as described above and complete the set-up. Leave all the other
settings as they are.

After installation you must reboot the computer.

Note

The AS511-NT option is needed for a serial link and occupies one COM interface
of the computer. This can be set as required.
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11.7 Communication

11.7.1 Cyclic reading service

Entry ID: 2000360 - Date: 03/24/2000

QUESTION:
What does "Use cyclic read service of PLC" mean with the channel unit?

ANSWER:
In your WinCC project you set up a connection to an S7. With the channel unit, e.g.
MPI, which supports the desired protocol, you activate the check box "Use cyclic
read service of PLC".

All S7 controllers support the cyclic reading service. Cyclic reading service means
that at a selected point in time (e.g. upon image selection) variables are logged on
with the controller in a specific cycle and then sent by the controller without any
request to WinCC.

The amount of possible cyclic read services depends on the CPU:

 CPU  Cyclic read services

CPU 318, 412, 414, 612, 614 16

CPU 416, 417, 616 32

At least one cyclic read service is required per cycle.

The size of the PDU limits the number of variables that can be sent per cyclic read
service (Header + Header per variable), i.e. more than one read service might be
needed for a cycle.

PDU sizes of the CPUs with different protocols:

 Protocol  CPU  PDU size  Header size

MPI CPU 300/400 240 bytes 17 bytes per data area

PROFIBUS CPU 300/400 240 bytes 17 bytes per data area

Industrial Ethernet CPU 300 240 bytes 17 bytes per data area

Industrial Ethernet CPU 400 480 bytes 17 bytes per data area
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11.8 Configuring System

11.8.1 Key combination CTRL+ESC doesn’t remain locked after RESET

Entry ID: 1008102 - Date: 04/05/2000

QUESTION:
The key combination CTRL + ESC doesn’t remain locked after restarting the
computer. Why?

ANSWER:
The key combination "CTRL" + "ESC" can be used again when:

1. The power fails on the computer while WinCC Runtime is activated

2. After return of power Windows NT is started by Autologon

3. WinCC in is included in the Autostart group

Remedy:
To relock the key combination "CTRL" + "ESC", restart WinCC Runtime.

11.8.2 Error in the event display: "S7OPCIAX"

Entry ID: 1118180 - Date: 09/21/1999

QUESTION:
Why does the error "S7OPCIAX" occur in the event display?

ANSWER:
This entry is made about every four seconds in the event display. A possible cause
for this is that you have installed the CP5611 driver in the PG/PC interface, but
have not slotted a CP5611.

11.8.3 Automatic logon under Windows NT doesn’t always work

Entry ID: 1140065 - Date: 10/04/1999

QUESTION:
Why doesn’t the automatic logon under Windows NT always work?

ANSWER:
The automatic logon under Windows NT only works once for you. Immediately after
the 1st automatic start-up there is a 0 again in the Registry entry
"AutoAdminLogon".

Cause:
You have set up a user with administrator rights but without password
("DefaultPassword"="" (empty) ).

Remedy:
Assign a separate password for this user (not a default password) and then the
automatic logon will function perfectly.
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11.8.4 Automatic restart of Windows NT

Entry ID: 1144558 - Date: 12/22/2000

QUESTION:
How can I trigger an automatic restart under Windows NT after a system crash
(blue screen)?

ANSWER:
When the system crashes, a blue screen is displayed that provides information on
why and when the system crashed. By default the blue screen is displayed
permanently.
This situation is exceptionally critical for systems that have to be in operation round
the clock. However you can configure the operating system so that a restart is
triggered automatically after a system crash. Proceed as follows for this:

1. Open the system properties via
"Start > Settings > Control Panel > System".

2. Select the "Start/Close down" tab.

3. Set the check box "Automatic restart" in the "Restore" field

11.8.5 Switch off message from Windows NT event log
Entry ID: 1468062 - Date: 11/22/1999

QUESTION:
In Runtime mode the Windows NT system box appears periodically indicating that
the event log is full. What can I do about this?

ANSWER:
This behavior is due to the settings for the event log. The event log settings are to
be found under Event Log > Event Log Settings

The system box "Event log full" appears if "Do Not Overwrite Events (Clear Log
Manually)" is selected. In this case, no more events are entered as soon as the
"Maximum Log Size" is exceeded.

Possible solutions:

• Increase the maximum log size.

• Select "Overwrite Events as Needed" or "Overwrite Events Older than …..
Days". In these cases the log overwrites the oldest messages as soon as the
"Maximum Log Size" is reached.
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11.8.6 Implementing the WinCC Client on a computer with more than
one IP address (two network cards or RAS access) in
WinCC V4.02

Entry ID: 990306 - Date: 11/21/2000

QUESTION:
Why can’t I start the WinCC client in WinCC V4.02 on a computer with 2 network
cards or an RAS access and one network card?

ANSWER:
You are implementing WinCC V4.02. In this case the cause is that the
DBCLIENT.EXE, which is used by WinCC for operating the client connection,
comes across two different network addresses (IP addresses). In this case then no
connection at all can be set up to the server, which is why you cannot start WinCC.

You must define an unambiguous IP address for the DBCLIENT.EXE, in order to
operate WinCC. You can do this by making the following entries in the Windows
Registry:

1. Select the menu command "Start > Run" and enter "regedit".

2. Find the key:
HKEY_LOCAL_MACHINE\SOFTWARE\SIEMENS\AUTSW\SQLANY\DBCLIE
NT

3. In the Registry change the keys to the following values:
"PurgeConnection [1, Yes=1, No=0]"=dword:00000001
"AutoShutDown [1, Yes=1, No=0]"=dword:00000000
"SuppressOutput [0, Yes=1, No=0]"=dword:00000000
"PacketSize [512]"=dword:00000200
"ClientOption"=" -x tcpip{MYIP=xxx.xxx.xxx.xxx}"
"ClientName [dbclient]"="dbclient"

Example:
xxx.xxx.xxx.xxx stands for the entry 142.120.212.169
When entering the parameters, note that it is imperative to have a space in front of
the "-x" parameter. If you forget this space, the application call DBCLIENT –x
becomes DBCLIENT-x and nothing happens.

Once you have entered these parameters, you must restart WinCC in order for the
Registry to recognize the updates.

Notice

Basically, no warranty can be given for direct changes in the registry database,
because this is entirely the responsibility of the user. In any case it is
recommended to make a backup of the registry before proceeding as described
below. Furthermore, these settings are computer-specific. This means that when
copying the project to another computer, the settings have to be made again.
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11.9 Tag Logging

11.9.1 Tag Logging and memory behavior

Entry ID: 1117419 - Date: 09/21/1999

QUESTION:
Why are the current values not stored in the database?

ANSWER:
For the sake of performance, 50 values are always stored in a buffer. This is only
the case for follow-up archives. The current value can be read out using the API
functions, e.g. GetArchiveData.

11.9.2 Nothing is displayed in the table OCX

Entry ID: 1333228 - Date: 11/08/1999

QUESTION:
Why is nothing displayed in the table OCX with Tag Logging?

ANSWER:
If in Runtime, no value is displayed in the table OCX, then the archive variable is
not selected in the OCX.

Remedy:

1. Open the Graphics Designer and double-click the OCX

2. Select the archive variable and acknowledge with the Accept button. If the
variable disappears, then you can enter it manually. In this case you must also
enter the archive name: e.g.: "Archive_name\Variablen_name"

11.9.3 Values from the Tag Logging Archive are not displayed.

Entry ID: 1442788 - Date: 11/22/1999

QUESTION:
Why are the values displayed as of image opening in the curve image, but no
values from the archive?

ANSWER:
A frequent cause is the computer name. It can be found in the "Control Panel"
under "Network", in the "Identification" tab. The computer name must not have
any special characters nor any spaces. Underscores _ are permitted. The
computer name must not be longer than 14 characters (e.g. PCS 7_OS1 or
PCS 7_ES_Warte)

Important
If you change the computer name, then you must also change the name of the
computer in the WinCC project.
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11.9.4 Tag Logging and Variable Names

Entry ID: 144365 - Date: 10/07/1999

QUESTION:
Why, when you select the curve window with the "Read data immediately from
archive" option activated, isn’t there any data displayed?

ANSWER:

Up to WinCC V4.02: the variable names of the archive variables include illegal
signs such as ( / ).

As of WinCC V4.02: if you use quotes ( " ) in the names of the project variables,
those variables are not archived in Tag Logging.
Most other special characters are processed. As far as possible do not use any
special characters in the names of the project variables. If you do use special
characters, then test whether the variables concerned can actually be archived.

There are characters that Tag Logging converts automatically. For example, the
Tag Logging editor converts hyphen ( - ) and hash ( # ) to underscore ( _ ).

11.9.5 Space requirements for measured value archives

Entry ID: 144377 - Date: 03/09/1998

QUESTION:
How much space is required on the hard disk for measured value archives?

ANSWER:
Space requirements (in bytes) = (28 + 18) * number of measuring points * number
of data records in the archive.
The value 28 bytes is the requirement of one stored value.
The value 18 Bytes is the requirement of the index which is also supported.
Practical example:
An archive with 52 measuring points, 302400 data records for the cyclic archive
with the aim of archiving for a week in a cycle of 2 seconds.

Calculation:
(28 + 18) * 52 * 302400 = 723340800 ==> about 710 MB
There is a tool for determining the exact space requirements of a specific table in
the database. This tool is supplied with the SYBASE database.
The tool is called dbinfo.exe and is located in the path ...\siemens\common\sqlany.
For help on the program you enter dbinfo -?.
C:\TEMP>dbinfo -?
Usage: dbinfo (switches) databasefile
Switches (use specified lower-case letters, as shown):

 -o <file> log output messages to file  Output to a file

-q quiet: do not print messages No output of messages.

-u output page usage statistics Output of page usage information for each table.
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Sample call:
dbinfo -u -o c:\temp\r200_pdert.log r200_pdert.db

Output:
--------------

 Table
id

 Table
Pages

 
%use
d

 Index
Pages

 
%use
d

 
of File

 Percent Name

164 5 (78) 4 (67) 1 PDE#HD#Process value archive#curve1

The output is the number of pages used for the table concerned. Our page size is
4096 bytes.

The formula is as follows:

(Table Pages + Index Pages) * 4096 bytes
------------------------------------------------------------------- = Bytes/entry
Number of measured values

11.9.6 Action for releasing the archiving

Entry ID: 218573 - Date: 01/29/1998

QUESTION:
How can you release archiving via action

ANSWER:
In Tag Logging under Properties of the process value archive, you can either
release or block archiving at system start.

If you want to undo this setting during runtime, then you must configure the
following action, e.g. behind a key.

#include "apdefap.h"
void OnClick(..........................................
{
TLGConnect(NULL,NULL);
TLGLockArchiv(NULL,"Processvaluearchive",FALSE,NULL);
TLGDisconnect(NULL);
}

Definition:
"Processvaluearchive" --> Name of the process value archive

FALSE --> Unlock Archive

TRUE --> Lock Archive
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11.9.7 Incompatibility of the curve control

Entry ID: 2202297 - Date: 06/05/2000

QUESTION:
Why can’t the curve control in my project run any more?

ANSWER:
You are using WinCC V5 and creating a project that includes an image with a
curve control. If you edit and save these images with curve controls (OCX) in a
WinCC V5.0 +SP1 project, then these controls no longer function in WinCC version
V5.0.

11.9.8 Telegram setup with process-controlled archiving

Entry ID: 2515625 - Date: 06/27/2000

QUESTION:
How can I simplify programming of the process-controlled archiving?

ANSWER:
If you use a SIMATIC S5 controller, then you must send the values to WinCC
blocked in a raw data variable. You can find out how to construct the raw data
variable in the WinCC online Help in the appendix to "Tag Logging Runtime".

If you use a SIMATIC S7 controller, you have two options:

1. You send the values to WinCC blocked in a raw data variable with the STEP7
system block "BSEND". In this case the raw data variable must be constructed
as described in the appendix to "Tag Logging Runtime". In principle the
procedure is the same as for a SIMATIC S5 controller.

2. A simpler method is to use the STEP7 system block SFB37 "AR_SEND".
Here too the data must have a specific format. The information on this format is
in the WinCC online Help under the entry "Data transfer with S7 function
blocks".
The information on the SFB37 is in the STEP7 online Help.

Our experience has show that the second option is easier to use.
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11.9.9 Archiving converted process values in Tag Logging

Entry ID: 71287 - Date: 05/15/1997

QUESTION:
How can you archive a process value in any converted form?

ANSWER:
The following is an example of a scaling function in conjunction with tag logging.
Here it is important that the transfer parameters are declared exactly as in this
example, because these are parameters that are transferred by tag logging to the
function. What happens in the action is up to the user.

The function is created as a configuration function using "Global Script". Then it is
integrated into

Tag Logging

/ Archive

/ Process variable properties

/ Parameters

/ Processing

/ Action

Example of a configuration function for converting a process value:

The value of the process variable (here doValue) can be converted in compliance
with the requirements and the result returned as a return value of the function to
Tag Logging for archiving. The function is integrated as processing method in Tag
Logging. It is called each time the process value is captured. The parameters have
the following meanings:
doLmtValue : last result returned with Return.
doValue : current value
dwCount : number of capture cycles since last archiving
Archiving : TRUE, if archiving takes place

Example: The current process value is to be divided by 10 and archived.
double Norm_PDE(double doLmtValue, double doValue, int dwCount, int
Archiving)
{
return (doValue/10);
}
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11.9.10 Sporadic failures when archiving

Entry ID: 867876 - Date: 05/28/1999

QUESTION:
Why are values sometime lost when archiving?

ANSWER:
You have stored various archives in Tag Logging. But evidently not all the values
are archived. You can proceed as follows to remedy this problem:

1. Check whether "Hysteresis" is activated for archiving. If so, then run a test
without this option and see how the system behaves. If it improves, then leave
this option deactivated until you have checked the other points. After you have
carried out the following points, you can reactivate the hysteresis function.

2. You are probably exceeding the permissible scope of values that are to be
archived in the cyclic archive. According to Release Notes V4.02 permissible
are 30 values per second (chapter 3.8, "Performance Data" Point 5,
"Archiving of measuring data with cyclic archiving"). If this figure is exceeded,
there is overload. If this is the case, you will find the entry "TLGRT Queue
overflow - some records lost" in the WinCC_Sys_0x.log file.
Remedy
Switch the cyclic archive to "Cyclic archive in dBase III format". For this click
"Store cyclic archive in dBase III format " in the opened window in Tag Logging
under <Projectname>.MCP. Now in cyclic archiving you can archive
500 values per second. But for this you need a lot of memory, because the
dBase III files are stored from the very beginning in full size.

3. Alternatively you can increase the archiving cycles without dBase III format so
that the load comes to under 30 values per second.

11.9.11 Inhibiting the display of specific curves in the curve images

Entry ID: 949541 - Date: 07/08/1999

QUESTION:
How can I remove curve images in the RT mode so that the labeling of the
remaining curves follows correctly?

ANSWER:
In a curve window template you have configured several curves. In RT mode you
don’t want to have all the configured curves displayed. Proceed as follows:

1. In the toolbar click the "Parameters" button.

2. Under "Select Object" select the curve that you do not want to have displayed
in the curve image.

3. Under "Display" remove the check mark for "Display curve".

4. Click "Accept" and acknowledge with "OK".

If you want to have the curve displayed again in RT, proceed as follows:

1. In the toolbar click the "Parameters" button.
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2. Under "Select Object" select the curve that you want to have displayed again in
the curve image.

3. Under "Display" set the check mark again for "Display curve".

4. Click "Accept" and acknowledge with "OK".

You have another option, too. Configure the curve window template such that the
"Curve on/off in foreground" button is displayed in the toolbar. Proceed as follows:

1. Open the curve window template.

2. Click "Template".

3. Under Toolbar click "Configure".

4. Set a check mark for "Opens the dialog for selecting curves".

5. Acknowledge OK.

With this dialog in RT you can select the curves that are to be displayed.

11.9.12 Increasing timeout for starting and terminating Tag Logging

Entry ID: 972621 - Date: 07/21/1999

QUESTION:
How can I increase the timeout for starting and terminating Tag Logging?

ANSWER:
Sometimes when you activate/deactivate WinCC you get the message "Could not
start/ terminate Tag Logging in allotted time". In this case you can correct this
behavior by adapting the timeout for Runtime.
Proceed as follows:

1. First click Start in the task bar and select the Run option.

2. In the window that opens you enter regedit and acknowledge with OK.

3. Under
"HKEY_LOCAL_MACHINE\SOFTWARE\SIEMENS\WINCC\ControlCenter\Co
nstants" enter a DWORD named "Application Deactivation" and a DWORD
named "Application Activation". The value must be specified in milliseconds
(decimal). The default value is one minute. Reboot the PC after making the
changes.

Note

Basically, no warranty can be given for direct changes in the registry database,
because this is entirely the responsibility of the user.
In any case it is recommended to make a backup of the registry before proceeding
as described. Furthermore, these settings are computer-specific. This means that
when copying the project to another computer, the settings have to be made
again.
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11.9.13 Display of different trend curves in one image

Entry ID: 1804857 - Date: 01/25/2000

QUESTION:
How can I realize a button-controlled display of different trend curves in one
image?

ANSWER:
Here, only the curve belonging to the measuring point concerned in each
case is to be displayed.

Description:
To start with, create the variables to be acquired in the variables list of WinCC.

1. In Tag Logging create a new process value archive and insert the variables
created into it. Then, for each measuring point, create a curve template and
link this to the measuring point/archive variable concerned. Now save the
changes and close Tag Logging.

2. In the Graphics Designer create an image for the first measuring point. The
PDL name of the image is best derived from the name of the measuring
point and can be copied from the variables list. Insert an application window
into this image and link it to the curve template of the measuring point.

3. Then you adapt the Geometry Properties of the image and the application
window. In the example at the height of 350 pixels and width of 550 pixels. The
values depend on the geometry of the image window in the basic image.

4. Create the image for the other measuring points as described in step 3 and 4.
Link the application window to the curve template concerned in each case and
save the image under the name of the measuring point.

5. The next step is to create a new image with the buttons for calling curves. In
this image you insert an image window with the width and height of the
images already created. The properties are freely selectable. Do not link the
image window to an image, because this is done dynamically during Runtime.

6. If you want the name of the measuring point in the image window, then you
can do this by overlaying the image name. If the window has already received
the correct measuring point name and the image name is not displayed in the
header, then check the Registry as described in FAQ Entry ID 70994.

7. Insert the following C action behind the Mouse click event of the button. Make
sure the image names match here:

#include "apdefap.h"
void OnLButtonDown(char* lpszPictureName, char* lpszObjectName, char*
lpszPropertyName, UINT nFlags, int x, int y)
{
SetVisible("TrendPicture.PDL","Picture Window1",1);
SetPictureName("TrendPicture","PictureWindow1","Plant_Function_Loop_One.
PDL");
}

8. Now you can incorporate the image into the image hierarchy via the Picture
Tree Manager.
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Sample project:
Copy the WinCC_Bsp.exe file into a separate directory and then start it with a
double-click. The WinCC project is now unpacked with all the associated
subdirectories. You can then open and process the unpacked project with WinCC.
To start the Runtime, change the name of the server in the project and enter the
name of your computer.

WinCC_Bsp.exe (2738 KB)

Note

The sample program is freeware. Every user can use, copy or forward this
program FREE OF CHARGE. The authors and owners of this program take no
responsibility whatsoever for the functionality and compatibility of this software.
Use of the software is entirely at the users own risk. Since this software is free of
charge, there is no warranty, nor claim for error correction and hotline support.

11.9.14 Incorporating curve display (trend) in faceplate (with PCS 7 V5.0)

Entry ID: 2539759 - Date: 11/20/2000

QUESTION:
How can I incorporate a trend display in my faceplate with PCS 7 V5.0?

ANSWER:
Faceplates that can display trends (MEAS_MON, CTRL_PID, etc.) call a display
named "@CONL1_<Instance_name>.PDL" when you select trend display. This
display includes the trend display that is supposed to be displayed in the faceplate.
Proceed as follows to incorporate a trend display in a faceplate:

Requirements:

• The measured values to be displayed for the trend display are configured in
the Tag Logging.

If there is no archive available, you must create one beforehand:

1. Open the Tag Logging and start the archive wizard.

2. Create a process value archive and select the variables to be displayed.

3. Save your configuration and close the Tag Logging.

Procedure for incorporating in the faceplate:

1. Determine the name of the faceplate in which you wish to incorporate the trend
display:
the name (for example) is there as a title in the Runtime in the Faceplate or
Loop display (e.g. "System_Subsystem_Function_CFC1_7").

2. Open the Graphics Designer and a new display. This display must be saved
observing the following name conventions:
"@CONL1_<Instance_name>.PDL"
Example: "@CONL1_System_Subsystem_Function_CFC1_7.PDL"
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In this you set up a reference between the display and the faceplate. If you
don’t have a technological hierarchy, you must use the complete correct
faceplate name:
Example: "@CONL1_S7-Program(1)_CFC1_1.PDL"
In the Graphics Designer you can also copy the name from the dialog box by
double-clicking the faceplate. Here you must make sure with PCS 7 V5 that the
instance names are saved with "/" instead of "_". In order to incorporate these
displays into the faceplate you must then replace the "/" with "_".

Note

It is not yet possible to save a file with a file name containing a "/".

3. In the "Controls" object palette select a "WinCC Online Trend Control" and
incorporate it. It must be as big and the display.

4. After incorporation a selection window opens. In the Curves tab, Archive/
Select Variables" field you can set up the link to the variable to be displayed.

5. Then open "Properties" for the Control and change the name of the "Object
Name" attribute to "@CurvonlWindow" (corresponds to
@CurveonlineWindow).

6. Adapt the geometry properties of the Control according to the following screen
shot.
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7. Adapt the height and width of the picture window to be the same as the
Control.

8. As required you can switch the title line of the Control on or off under
"Titleline" and thus enable or disable shifting of the Control in the Runtime. In
addition, under "Sizeable" you can specify whether the size of the Control in
the Runtime.
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9. Save the display.

Notice
If you configure the faceplate in the "LOOP" display mode, then the trend is not
displayed.
The trend in the faceplate is only visible if the faceplate is configured as
"SYMBOL".
If the faceplate is configured in the "FACEPLATE" view, the trend is only visible in
the "LOOP" display, but not in the actual "FACEPLATE".

11.9.15 Incorporating curve display (trend) in faceplate (with
PCS 7 V4.02)

Entry ID: 264713 - Date: 07/03/2000

QUESTION:
How can I incorporate a trend display in my faceplate with PCS 7 V4.02?

ANSWER:
Faceplates that can display trends (MEAS_MON, CTRL_PID, etc.) call a display
named "@CONL1_<Instance_name>.PDL" when you select trend display. This
display includes the trend display that is supposed to be displayed in the faceplate.
Proceed as follows to incorporate a trend display in a faceplate:

Requirements:

• The measured values to be displayed for the trend display are archived in the
Tag Logging.
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• There is a curve template in the Tag Logging for the trend display.

If there is no archive available, you must create one beforehand:

1. Create an archive in the Tag Logging (as process value archive).

2. Start Wizard, select variables and assign to the archive (e.g. from
PID_CONTRL the *.SP, LMN, PVN).

3. Restart curve window template.

4. Select template and assign a name.

5. Add curves with "+" and adapt the names.

6. Link the curves with the archive under "Variable".

7. Save and close.

Procedure for incorporating in the faceplate:

1. Determine the name of the faceplate in which you wish to incorporate the trend
display:
the name (for example) is there as a title in the Runtime in the Faceplate or
Loop display (e.g. "System_Subsystem_Function_CFC1_7").

2. Open the Graphics Designer and the display "@CONL1_Error.PDL". This is
the default display if there is no trend display available for the faceplate.

3. You must save this opened display observing the following name conventions:
"@CONL1_<Instance_name>.PDL"
Example:
"@CONL1_System_Subsystem_Function_CFC1_7.PDL"
In this you set up a reference between the display and the faceplate.

! Warning

You must make sure that the display "@CONL1_Error.PDL" is retained! If you
don’t have a technological hierarchy, you must use the complete correct faceplate
name.
Sample: "@CONL1_S7$Program(1)_CFC1_1.PDL"
In the Graphics Designer you can copy the name from the dialog box by double-
clicking the faceplate.

4. Then you delete the static text in the "@CONL1_<Instance_name>.PDL"
display.

5. In the object palette under Smart Objects you will find the application window
and insert one. It must be as good as the display.

6. A selection window opens after integration. Click Tag Logging and in the
selection window that opens select the curve required.

7. Then open Properties for the application window and in the Application
Window Properties tab change the name of the object name attribute to
"@CurvonlWindow" (corresponds to @CurveonlineWindow).
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8. Adapt the geometry properties of the application window according to the
following screen shot.

9. Adapt the height and width of the picture window to be the same as the
application window.

10. You can switch the frame of the application window on or off as required.
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11. Save the display.

Notice

If you configure the faceplate in the "LOOP" display mode, then the trend is not
displayed.

11.9.16 Error message: "TagLogging is being processed"

Entry ID: 264722 - Date: 02/26/1998

QUESTION:
What can I do when the following error message appears: "Tag Logging is being
processed by another computer <computername> " ?

ANSWER:
In configurations of version V4 parts of areas can be blocked through computer
crash or copying to another computer. The following message is then issued:
"Tag Logging is being processed by another computer <computername> "

Remedy:
The *.LOC and *.LOG files are always stored in the configuration path (*.DB and
*.MCP).
After deleting these files the block is disabled.
The deleted files are recreated when the configuration is opened.
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11.9.17 Curve trend displayed only after start

Entry ID: 264731 - Date: 01/28/2000

QUESTION:
I call Trend, the curve is started but only then is it displayed. How can I change
this?

ANSWER:
Check the settings in the Tag Logging.
In the template "Read data immediately from archive" must be check marked for
image opening.

11.9.18 Display of curves in a client-server system with time
synchronization with time delay

Entry ID: 376161 - Date: 07/20/1998

QUESTION:
In WinCC Runtime the curves are not displayed correctly in the application window
and in the time axis of the curve window the last time value is overwritten with "1s"
& "0s". Why?

ANSWER:
The parameterized time master (ES or OS) is switched off/on and after switching
on the time of the time master is no longer the same as the system time. There is,
therefore, a time delay, and the time master resynchronizes the system. The
resynchronization may lead to overlapping in the process value archive which in
turn causes corrupted display of the curve values and time axis values.

Remedy:
The time master must run continually. It is preferable to choose as time master an
OS that is only seldom restarted. An ES is not suitable as time master because it
has to be restarted so often due to the configuration work.

11.9.19 Performance improvement of Tag Logging

Entry ID: 727093 - Date: 12/08/2000

QUESTION:
How can I improve the performance of Tag Logging?

ANSWER:
In the following is a detailed description of workarounds to determine and optimize
the performance of WinCC Tag Logging. You must execute the three steps one
after the other and test accordingly. Keep the test results in each case so that you
can compare them to be able to appraise and evaluate the improvement.
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Step 1: Determining the performance of WinCC Tag Logging

You can use an internal system tag from the WinCC Tag Manager as an indicator
of the performance of Tag Logging. This is the so-called Tag Logging "health
display". In the process image that contains the error image described, you
display the value of the internal system tag from the WinCC Tag Manager (e.g.
using an I/O field). You monitor the value of this tag over a long period of time (at
least one hour or longer). The value of this tag can be 0 to 50000 decimal. The
important thing is that the value regularly goes back to 0. If value remains on a
value greater than 0 for a long period of time (about 5 to 10 minutes or longer), this
means that due to performance the Tag Logging cannot read values completely
from the archive. Then sections of the Tag Logging window in the WinCC Runtime
are displayed as interpolated.

Step 2: save process value archive (short-term archive) in the dBase III format

Storing process value archives (only short-term archives) in the dBase III format
improves performance when archiving Tag Logging values. A short-term archive in
the dBase III format is better for the special user purpose. Subsequently greater
volumes of data can be read or archived. In fact 500 measured values can be
processed per second.

Proceed as follows for configuring:
Open the Properties (right-click) of the entry "Projectname".mcp in the Tag Logging
window - in our example [spezzw.mcp].
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1. The "Project Properties" dialog window opens. In this window you must enable
the option "Short-term archive using dBase III format" (set check mark in the
check box).

 

2. Close the dialog with "OK". Save the Tag Logging and close it too.

3. Then, in the process image that contains the error image described, you
observe the system behavior and check whether the error image occurs again.

4. If the error image occurs again, continue optimization with Step 3.
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Step 3: increasing the cache of the SQLANY database of WinCC

This gives WinCC the possibility of temporarily storing more Tag Logging values
and of reading the database queue faster. The queue is empties faster and can
thus read new data from the archive.

Proceed as follows:

1. First open the Registry of Windows NT via "Start > Run". Enter the "regedit"
command and acknowledge with "OK".

 

2. After calling the registry you open the following path:
HKEY_LOCAL_MACHINE\SOFTWARE\Siemens\AUTSW\SQLANY

3. If you have a WinCC single-user system, you must change the following
settings:
Open the subpath "\...\DBALONE". Change the value of the entry
"EngineCache [2048]" from 1000 to 2000 (hexadecimal).

4. If you have a WinCC multi-user system, you must change the following
settings:
Open the subpath "\...\DBSERVER". Change the value of the entry
"ServerCache [2048]" from 1000 to 2000 (hexadecimal).
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5. Then observe the system behavior in the process image concerned and check
whether the error image occurs again

11.9.20 Changing the trend image of "Curves over measuring point"

Entry ID: 982717 - Date: 07/27/1999

QUESTION:
Can I change the trend image when the "Curves over measuring point" button is
selected?

ANSWER:
Yes, you can change the trend image. The trend image opens in WinCC Runtime
when the "Curves over measuring point" button is selected. Proceed as follows:

1. Using the Graphics Designer open the image @curvtag.pdl created by the
Split Screen wizard.

2. Change the size of the image or set the "Changeable size" property of the
image to yes.

3. Save the image and close the Graphics Designer.

4. Open Tag Logging and save it again.
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11.10 Report Designer

11.10.1 Stop/ start signal sequence report as of V 4.0

Entry ID: 218564 - Date: 01/27/1998

QUESTION:
How can you stop and start the signal sequence report in runtime?

ANSWER:
The following function calls are required for this:

Switch on example without error evaluation:
MSRTActivateMProt(TRUE,NULL);

Switch on example with error evaluation:
CMN_ERROR pError;
MSRTActivateMProt(TRUE,&pError);

Switch off example without error evaluation:
MSRTActivateMProt(FALSE,NULL);

Switch off example with error evaluation:
CMN_ERROR pError;
MSRTActivateMProt(FALSE,&pError);

In the case of error evaluation the error code is then in the words 1-5 and the error
description in szErrorText.

11.10.2 Sequence-of-events log procedure

Entry ID: 268886 - Date: 01/24/2000

QUESTION:
What exactly is the procedure for a sequence-of-events log?

ANSWER:

Line-by-line output of a sequence-of-event log

Procedure:

• In the tree view of Alarm Logging, under Reports, activate Sequence-of-events
log.

• In the Report Designer create a line layout.
Important: check the column distribution in the line layout under Table >
Selection.

• Then, in the Report Designer, under Print Jobs, open the print job "@Report
Alarm Logging RT Message sequence".

• In the Print Job tab click Line layout for line printer. Now in the Layout field
select the line layout created.
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• In the Define Printer tab select Output on printer.
Under Printer Priorities define the "LPT1" port.

• After WinCC Runtime starts up, the first message to arrive activates the
sequence-of-events log. If not, check under "Computer > Properties > Start-up"
whether Report Designer and Alarm Logging are selected.

Notice

In order to be able to ensure perfect functioning of the sequence-of-events log,
there must be no driver for the printer used installed in the operating system
Win95. Since NT does not permit direct access to interfaces, the corresponding
driver for the printer should be installed. The line printer can only be operated on
the LPT1.

Page-by-page output of a sequence-of-events log

Procedure:

• In the tree view of Alarm Logging, under Reports, activate Sequence-of-events
log.

• In the Report Designer, under Print Jobs, select the print job @Report Alarm
Logging RT Message sequence. Here the page layout "ALRTMEF.RPL" is
selected by default (see View Print Jobs under Parameters or Print Job
Properties).

• Open Page Layout and under "View" select Dynamic Part (already selected
as Default, see check mark).
Click Dynamic Table and open the Object Properties box. Select the Connect
tab.
Click Sequence-of-events log and under Table > Name the Selection
parameter can be seen.
If there is already a connection to Alarm Logging, this is indicated by a red
check mark.
If not, click Selection and press the Connect button. The "Connect" box
opens.
Now Alarm Logging Runtime > Sequence-of-events log must be selected.
Acknowledge with OK. The "Edit" button is then active.
If you press it, the Alarm Logging Runtime: "Log Table Selection" box opens.
Move the "required (existing) message blocks" into "current column order".
With the buttons Move up and Move down define the order and quit the box
with OK.
Now there is a red check mark in the Selection parameter, i.e. the layout is
connected with the Alarm Logging. Save the page layout and quit the editor.

• In the Report Designer, under Print Jobs, open the print job @Report Alarm
Logging RT Message sequence.
Here the page layout "ALRTMEF.RPL" is selected by default in the "Print Job /
Layout" tab. If not, select your page layout.
In the Define Printer tab select Output on printer. Under Printer Priorities
define the Standard Printer port.
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• The first log is printed when a page is full, i.e. usually about 60 incoming
messages. If not, check under "Computer > Properties > Start-up" whether
Report Designer and Alarm Logging are selected.

Note

In the case of sequence-of-events log with page layout, the driver for the printer
used must be installed in the operating system (Win95 or Win NT 4.0). If you have
trouble with the (delivered) floppy disk drivers, use the drivers from the Windows
CD.

11.10.3 Combination line and page layout

Entry ID: 416441 - Date: 08/25/1998

QUESTION:.
Can I combine the line-by-line and page-by-page message printouts?

ANSWER:
You should always use an extra printer (e.g. DR125) for message line printing.
The problems is as follows:
For line layout printing the printer is initialized once and the no more. The LPT1
interface is driven directly without using the Windows drivers. The reason for this is
that when there is a flood of, for example, 1000 messages, the Windows driver is
not fast enough.
When you switch to page layout, the printer is initialized via the Windows driver
with a TrueType font. When you switch back to line layout again, the printer is not
reinitialized and subsequently attempts to convert the TrueType font. It can’t do this
however, because of the interface is driven directly. The printer then uses the next
available hardware font, e.g. Fit, italic.
This results in too large a pitch when you switch back again to line layout.

11.10.4 Using "&" in the static text of the report designer

Entry ID: 492346 - Date: 09/25/1998

QUESTION:
I would like to use the "&" in the static text of a layout. How can I do this?

ANSWER:
Windows interprets the simple "&" as special character for menus and the like. In
the configuration you must enter the symbol twice, like this "&&". A simple "&" is
then printed correctly.
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11.10.5 Multilingual reports

Entry ID: 492720 - Date: 09/25/1998

QUESTION:
How can I print out static texts in multiple languages?

ANSWER:
You must create a page layout for each language. WinCC is released for German,
French and English.

11.10.6 Errors in printout of dynamic sections

Entry ID: 71242 - Date: 07/08/1997

QUESTION:
Why is the dynamic section sometimes printed right on the edge of the page?

ANSWER:
The dynamic section is simply printed out above the static section right on the edge
of the page. This problem occurs occasionally, but the Print Preview of the page is
always output correctly.

Remedy:
Output an invisible variable on the edge of the page in the dynamic section. Now
the distance to the top edge of the page will always be calculated correctly for the
dynamic section.

11.10.7 Trend printouts

Entry ID: 2481909 - Date: 09/18/2000

QUESTION:
How do I set line width and color for trend printouts?

ANSWER:

1. In the Report Designer create a new page layout.

2. Add a dynamic metafile to this page layout.

3. Now connect this metafile to a tag trend. You will find this under "Tag Logging
Runtime MultiClient".
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4. Open the Object Properties of the metafile. Select Tag Selection in the
"Connect" tab and then click "Edit...".

5. Then select "Add...".

6. Select an archive and the associate tag.

7. Acknowledge the "Archive Selection" window with "OK".
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8. Now select the tag in the "Tag Logging Runtime: Tag selection for reporting"
window and then click the "Properties…" button.

9. In the "Properties" window you can now set the line width and color of the
trend.



Operator Station

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 11-151

11.10.8 Deleting print jobs from WinCC Runtime

Entry ID: 384265 - Date: 04/05/2000

QUESTION:
How can I delete a print job given by mistake during WinCC Runtime?

ANSWER:
You start a print job in WinCC Runtime you and it can no longer be deleted. In
order to be able to delete the print job, create the following action (e.g. behind a
button in a WinCC image):

#include "apdefap.h"
void OnClick(char* lpszPictureName, char* lpszObjectName, char*
lpszPropertyName)
{
// Call the printer box
ProgramExecute("C:\\WINNT\\system32\\control.exe printers") // for WinNT 4.0
}

After activation the window opens for the "Print Manager". Now you can delete the
print jobs specified.
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11.10.9 Printing messages with PCS 7 V4.02

Entry ID: 945132 - Date: 07/08/1999

QUESTION:
How can I print my messages selectively?

ANSWER:
When you print the Chronicle list from the follow-up archive over the template
"@alrtfoa.rpl", you can call the selection in the chronicle list. This offers various
filters. After display of the selected messages, you press the Print button. Now,
only those messages selected and displayed on the screen are printed. This
procedure can also be used on the cyclic archive.

11.11 User Administrator

11.11.1 Executing actions depending on authorization level

Entry ID: 774907 - Date: 03/22/1999

QUESTION:
Can I execute specific functions depending on the authorization level of the
operator who is logged on?

ANSWER:
In the following function you are queried as to whether you have an authorization
for higher-level process operating. Depending on this you should be able to
influence the background color of an I/O field. You can trigger the function with any
signal you like.

Example:
Image display, variable ....

Sample script for authorization query:

#include "apdefap.h"
void OnClick(char* lpszPictureName, char* lpszObjectName, char*
lpszPropertyName)
{
BOOL HighPerm;

HighPerm=PASSCheckAreaLevelPermission("OS_low",6);

// if higher permission available
if (HighPerm==1)
// then set background to white
SetBackColor("statusdisplay.Pdl","I/O field3",16777215);

else
// else set background to light-grey
SetBackColor("statusdisplay.Pdl","I/O field3",12632256);

}
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Sample script for defining the background color:

The following function defines the background color of an image element. Using
this you can define the number value of a color.

Example:
white = 16777215 or
light grey = 12632256

#include "apdefap.h"
void OnClick(char* lpszPictureName, char* lpszObjectName, char*
lpszPropertyName)
{
int color;

color=GetBackColor("statusdisplay.Pdl","I/O field3");
printf("%d\n",color);
}

11.11.2 Logging on with the chip-card reader

Entry ID: 640671 - Date: 03/15/1999

QUESTION:
Which setting options do I have when logging on with the chip-card reader?

ANSWER:
You have four options:

• Logging on with chip card and with password:
Setting: chip card on in Control Panel and off in User Administrator.

• Logging on only with chip card:
Setting: chip card on in Control Panel and on in User Administrator.

• Logging on only with password:
Setting: chip card off in Control Panel and off in User Administrator.

• Logging on neither with chip card nor with password:
Setting: chip card off in Control Panel and on in User Administrator.

Making the settings:

1. In the Control Panel open the following tool

In the box that opens you select the required setting, e.g. chip-card reader off:



Operator Station

Process Control System PCS 7, Tips and Tricks
11-154 A5E00080064-01

2. In the User Administrator activate the following checkbox if you only want to
work with the chip-card reader.

Note

If you are working with the PCS 7 V4.01, then you won’t find the "WinCC Chip
Card Terminal Configuration" dialog box in the Control Panel, but in WinCC in the
Control Center, if you go for Properties in the User Administrator.
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11.12 Storage

11.12.1 Storage cannot be set on drive A:\

Entry ID: 1139856 - Date: 09/21/1999

QUESTION:
Why can’t I select the archiving drive A:\ for Storage?

ANSWER:
You are using a multi-user system in your project. The archiving drive A:\ (floppy
disk) cannot simply be selected. This is because Storage in multi-user systems
can only be accessed on linked drives. This means that drive A:\ must be
linked in the Explorer as a network drive.

11.12.2 Storage message: "Server not ready, manual exporting and
creation of data media not possible"

Entry ID: 1547983 - Date: 11/26/1999

QUESTION:
Why, when storing, do I get the message: "Server not ready, manual exporting and
creation of data media not possible"?

ANSWER:
If a project with storage is not shut down properly or the computer crashes, the
temporary file "Archsrv.tmp" is no longer deleted. After copying a project to another
computer Storage no longer functions, because the temporary file still has the
name of the original computer stored.

Remedy:
Delete the Archsrv.tmp file in the project path.

11.12.3 Storage settings with two redundant computers in the project
duplicator

Entry ID: 1623949 - Date: 12/14/1999

QUESTION:
Which Storage settings do I have to make if I use tow redundant computers and
the project duplicator?

ANSWER:
You have a PC in control room with OS software installed on it. You use a second
computer both as engineering station and as OS. The OS project data is
transferred via the project duplicator. Both computers are networked and the
redundancy mode is activated. Now you want to activate Storage. You want to
export the data to a second hard disk in the OS: Since you are using the project
duplicator, you cannot have the same Storage settings on both computers.
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Solution:
Install Storage on both computers. However, Delete should be active on only one
of the computers.

Background:
If the data is not deleted on a computer without removable drive, subsequent
archiving would have written the hard disk full after a time x. This would lead to a
system crash.

11.12.4 Storage with redundant servers

Entry ID: 1624279 - Date: 12/14/1999

QUESTION:
What happens if I export the archive with Storage on just one of the redundant
servers?

ANSWER:
You have two redundant servers. Now you want to export the archives with
Storage on just one of the redundant servers.
You have therefore set Storage so that

• with Server 1 the archive data is exported

• with Server 2 the relevant archive data is deleted.

Problem:
If you export the most recent data, there might be data inconsistency if there is
an error. Supposing that it is the Server1 with Storage that loses the process
connection. The new process data is received by Server2. If Storage on Server1
becomes active before the error is cleared and before database matching, then
the data in export file is not consistent with the database on Server2.

Remedy:
Export the older data.
You must set the time span for old data to meet your individual requirements. The
time span must be large enough. During this time span the servers must have
made a database match.

Example:
Server1 exports data that is one week old. During this week any errors must have
been cleared. So there was already database matching for the data to be exported.
The export file and the server databases always remain consistent.



Operator Station

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 11-157

11.12.5 Message: "Data medium full. Please change."

Entry ID: 218471 - Date: 02/12/1998

QUESTION:
When relocating with Storage you get the message: "Data medium full. Please
change.". What is to be done?

ANSWER:
Storage needs 2.2 times more space (on the data medium) to process a job.
Before relocating the system checks the available memory space on the data
medium.
If there is not enough, the above message is issued.

Remedy:
Keep the relocation time tight, so that the memory requirement for data to be
relocated is low.

11.12.6 Setting up storage with Client-Server

Entry ID: 558326 - Date: 09/29/1998

QUESTION:.
I use Storage in client-server mode. When I select a network drive I get the
message "The archive drive must be prefixed by a UNC name in a multiple station
system".
What should I do?

ANSWER:
You must select the drive and "Properties" in the Explorer. In the Release tab
under Release > Release name you enter Storage. Using the button
Authorization you can view each type of access.
If this is not possible, you must log on as Administrator under Windows NT. Then,
under the menu item Tools > Connect network drive, you must enter your own
computer name and Storage, and then acknowledge. Now, under the specified
drive, you can see Storage with the computer name. You must then use this drive
as your archiving drive.
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11.12.7 Storage cannot initialize the drive

Entry ID: 71106 - Date: 07/08/1997

QUESTION:
Why can’t a newly formatted medium be initialized with "Storage"?

ANSWER:
If the Storage package cannot initialize a newly formatted drive, the cause might be
that Windows has set up a Recycle Bin on that drive. If this is the case, use the
Explorer to remove the Recycle Bin from the drive concerned.

11.12.8 At start, Storage issues the message "... started on other
computer"

Entry ID: 71196 - Date: 02/21/2000

QUESTION:
Why does Storage issue the message "... started on other computer" after I have
copied a project from one computer to another?

ANSWER:
You have probably already copied part of the project concerned during the active
status, so that still temporary files of Storage have been copied too.

Remedy:
Delete all *.TMP files in the current project directory.
Delete the file "TLSGCS.LCK".

11.12.9 Implementation of Storage in the multistation system

Entry ID: 640438 - Date: 11/03/1998

QUESTION:
Can you call Storage from the client in multistation systems?

ANSWER:
Storage must be installed and authorized on the server. On the client it only has to
be installed. You do not need authorization on the clients. You can then work with
Storage from the client. You can only open Storage on one computer at a time.
This means that when you are working with Storage on a client, you cannot open it
in addition on the server or another client.
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11.12.10 Storage installation requirements for client/server

Entry ID: 640636 - Date: 11/03/1998

QUESTION:
Where must the Storage package for a client/server configuration be installed or
authorized?

ANSWER:
You only have to install and authorize Storage on the server. In this set-up you
should also be able to call Storage from the clients (via the button in the runtime
task bar). Otherwise no further settings are required.

11.12.11 Meaning of the UNC name of storage drive

Entry ID: 640707 - Date: 11/03/1998

QUESTION:
What does the following message mean: "Drive must have a UNC name"?

ANSWER:
UNC = Universal Name Code and means that the name must be unique within a
network.

Notice

Even local drives have to be assigned a release name for the Windows network
and linked on the local computer as network drive.

11.12.12 Storage doesn’t roll out any more

Entry ID: 686331 - Date: 12/10/1998

QUESTION:
Storage attempts to roll out and issues the following error message: "Reattempt
after error". If I try to roll out manually, I get the message "Archive is occupied".
What should I do?

ANSWER:
This effect can occur after you have made changes to the archives.

Solution:

1. Set the archiving interval to 0 after failed archiving

2. Exit WinCC and restart

3. Insert a new data medium if necessary
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11.13 Optional package

11.13.1 Hardcopy picture subareas

Entry ID: 1156337 - Date: 10/06/1999

QUESTION:
How can you make a hardcopy of picture subareas (e.g. curve windows)?

ANSWER:
You have located a curve window, for example, in your picture. Now you want to
make a hardcopy of this window. You can do this if you have installed Basic
Process Control on your computer. Then, in the DRIVE: \Siemens\WinCC\bin
directory you will find the prtscrn.dll file. For the hardcopy you must know the
coordinates and size of your window. Then you can trigger the hardcopy as follows
via a button:

#pragma code ("prtscrn.dll")
#include "prtscrn.h"
#pragma code()
long Left, Top, Width, Height;
Left=20;
Top = 10;
Width=800;
Height = 400;
PrtScreenPart ((ULONG) Left, (ULONG) Top, (ULONG) Width, (ULONG) Height);

11.13.2 Redundant servers with multiclient projects

Entry ID: 1936507 - Date: 02/25/2000

QUESTION:
Can I use redundancy with multiclient projects?

ANSWER:
Yes, you can use redundant servers with multiclient projects.

Requirement:
You must have completed configuration of the redundancy project, before you
create the "Package" for the multiclient.

After configuring, create the package and then load it into the multiclient. If the
server fails, the multiclient (as all other clients) fetches the data from the redundant
server.
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11.13.3 "ArchSRV.exe" starts briefly with WinCC Runtime, but terminates
immediately

Entry ID: 2044160 - Date: 11/21/2000

QUESTION:
Why does the application "ArchSRV.exe" terminate again immediately after it has
started briefly with the Runtime of WinCC?

ANSWER:
The following may be the cause of the "ArchSRV.exe" file terminating immediately
after starting with the WinCC Runtime:

• The file "Archsrv.tmp" is located in the WinCC project path. This file may only
exist at the runtime of "ArchSRV.EXE". If the "ArchSRV.tmp" is there, then
delete it.

• Make sure that under "Computer Parameters" in the Control Center, both
"Tag Logging Runtime" and "Alarm Logging Runtime" have been selected
in the "Startup" tab

11.13.4 Configuring the clients with the tool "Project Switcher" after the
project has been duplicated.

Entry ID: 2511949 - Date: 06/21/2000

QUESTION:
I have already duplicated my project onto the partner server. How should I set the
Project Switcher so that the client of Server1 switches to Server2 and vice versa?

ANSWER:
Normally for configuring redundancy you proceed as described in the WinCC
Online Help:

1. Load the project on the server in CS mode.

2. The project is loaded onto the client computer.

3. The client is configured with the "Project Switcher" tool. On the server, among
other things, the "Project Switcher" tool creates a variable in the variables list. It
is via this variable that the client is informed that the server has failed.

4. Then the project is duplicated.

However, you have duplicated the project first and now want to set up the clients.

In this case you must proceed as follows:

1. Open the project on the Server1 in CS mode.

2. Open the project from Server1 on the client.

3. With the "Project Switcher" specify the partner server, in this case Server2.

4. Close the project on the client.

5. Open the project on the Server2.

6. Open the project from Server2 on the client.
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7. With the "Project Switcher" specify the partner server. In this case Server1 is
the partner server.

Notice

If you execute "Project Switcher" only for the project of Server1, then the
switchover from Server1 to Server2 will work, but the switchover in the other
direction will not.
The reason for this is that the settings made by the Project Switcher are not on
Server2.

11.13.5 Operation and behavior of the Project Switcher

Entry ID: 780432 - Date: 04/06/1999

QUESTION:
How do you operate the Project Switcher?

ANSWER:
If you want to switch over the client from one server to another if the standard
server fails, then you must start the Control Center, but do not activate it.

Regardless of the entries for the standard server (set network link beforehand in
the Explorer) and the partner project, you can activate and deactivate the Project
Switcher by button.

• If you deactivate the switcher, you cannot switch automatically nor switch
after acknowledgment with the waiting time appropriately entered.

• If you activate the switcher, then, if you have set Switch automatically, the
system switches to the partner server as soon as the standard server fails.
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Switching behavior

1. In the case of Switch after acknowledgment the client switches over only after
the waiting time set has expired. You have the option of aborting the switch
operation during this waiting time. You get the following display during the
waiting time:

2. After expiry of the waiting time or in the case of automatic switchover, you get
the following display:

3. When the switchover is complete, the following message is displayed:
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In order for the "Switching complete…" box to appear once the client has switched
over successfully to the functioning server, you must enter the task
"CCProjectSwitcherRt.exe" in the Computer properties of the Partner server in
the Startup tab of the client to be switched over. In the case of the first server that
has failed in the meantime the entry is made through the "configuration" of the
WinCC Project Switcher.

11.13.6 Procedure in the case of problems with redundancy

Entry ID: 884083 - Date: 06/24/1999

QUESTION:
Why aren't the archives matched when a server fails?

ANSWER:
There are a number of possible reasons for the archives not being matched.
Check the following points:

1. Check that the computer name is correct in the Red Editor.
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2. Check the release of the RedTemp directory on both computers. The release
must be set with Full Access.

3. Delete the Data.RT file.

4. View the CCRedCodi.log file and look for any error entries.

5. Do not use any special characters in project and variable names.

6. Run the DComTest on both computers.

7. In the case of problems with the command "Ping <computer name>" set up a
Hosts or LMHosts. See here also the FAQ with Entry ID 868014.

8. Use computer names without special characters and with a length of max. 8
characters.

11.13.7 Deleting image compositions created with Split Screen Manager

Entry ID: 1764224 - Date: 01/12/2000

QUESTION:
I have stored image compositions in WinCC Runtime via the buttons in the bottom
bar. How can I delete image compositions that are no longer needed?

ANSWER:
In the WinCC project directory you will find the SSM directory. This directory
contains folders with the login names of the project. These folders contain a file
with the extension SSM for each image composition. Now you can delete the
image composition files no longer needed.

11.13.8 Signal module, update time of the variables @Signal1..@Signal3

Entry ID: 1965159 - Date: 03/13/2000

QUESTION:
When are the variables @Signal1..@Signal3 updated?

ANSWER:
The variables @Signal1..@Signal3 that are created in the Split Screen wizard and
used in conjunction with the signal module are updated only if the signal module
is installed correctly (see FAQ Entry ID 776118) and the software has the
correct parameters. The signal module must therefore be physically present. It is
not sufficient just to have the HMRT.EXE running.
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11.13.9 Lifebeat Monitoring can’t be opened

Entry ID: 384264 - Date: 07/24/1998

ANSWER:
After copying a PCS 7 project from one computer to another, the Lifebeat
Monitoring (LBM) editor cannot be opened in WinCC. Why?

ANSWER:
If the LBM editor is open, the system generates an LBMCS.TMP file in the path
...\"Projectname"\wincproj\"OS Name". The current computer name is stored in this
file. If the project is copied in an active state, then this file is copied, too, and since
the other computer has a different name, the LBM cannot be opened on this
computer. A message is displayed: LBZ_CS - Lifebeat Monitor already open on
different computer.

Remedy:
Delete the file ...\"Projectname"\wincproj\"OS Name"\LBMCS.TMP or close al
PCS 7 applications and then copy the project.

11.13.10 Acknowledgment of signal module by client

Entry ID: 632703 - Date: 11/02/1998

QUESTION:
The signal module is connected to the server. I would like to make an
acknowledgment from a client. Why doesn’t this work?

ANSWER:
For addressing the signal module you need the system variables @Signal1,
@Signal2 and @Signal3. These are generated automatically. In your project you
most likely only have one ’Local computer update’. By acknowledging the
message on the client only the variable known to the local computer is changed.
The local computer variable of the server that controls the horn keeps its value and
nothing happens.

Remedy:
You must use the right mouse button to open the Properties of the variables in the
ControlCenter (Internal Variables\Split Screen Manager) and select ’Update
Project Scope’.
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11.13.11 Integration of multiple video images in one process image

Entry ID: 632780 - Date: 11/02/1998

QUESTION:
In a PCS 7 project I would like to integrate up to 4 video camera images
simultaneously in one process image. Is this possible?

ANSWER:
Using the recommended video card (see below) you cannot integrate multiple
video images. If you configure a process image for displaying multiple video
images, then the video image display is only in one window. The other windows
remain blue. If you select a blue window with the mouse, the video image is
displayed in it, but the first window then goes blue.

The clock frequency of the computer is insignificant here.

Video card:
Order code: "Win/TV NG-T" from Haupauge http://www.hauppauge.com

Obtainable from:

SIEMENS Service Shop Köln
Mathias-Brüggenstrr. 2
D-50827 Köln
Phone: +49-221-576-2879

Fa. Actebis Computerhandels GmbH+Co
Lange Wende 43
D-59494 Soest Herr Sons
Phone: +49-2921-99-0

11.13.12 Using the PCS 7 Video option package

Entry ID: 724520 - Date: 01/28/1999

QUESTION:
How should I use the PCS 7 Video option package under WindowsNT?

ANSWER:
The Video option can be used on stand-alone systems or on an operator terminal
of a multistation system. It is used for displaying film images in process images, or
optionally as a superimposed window in the foreground. The delivery package
includes:

• One video card

• Driver software

• One OCX for connecting to WinCC

At the moment there is only one type of video card offered for this option. This is
the "Win/TV CinemaPro" video card from the Hauppauge company.
This module occupies one ISA slot. The connection to WinCC is linked to this
module. The OCX is tuned specially to this card.
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INSTALLING THE VIDEO CARD

Always use the video card instruction manual.

1. Switch off the computer.

2. Open the computer housing and remove the ISA slot cover. Insert the video
card into the appropriate ISA slot.

3. Close the computer housing.

Connecting the VGA loop cable supplied:

1. 26-pin connector > video card

2. Remove the monitor connector from the graphics card and connect it to the
socket of the loop cable.

3. Connect the loop cable connector to the graphics card.

4. Connect optional audio, video and antenna signal connectors according to the
connector/socket labels

5. If there is a sound card available, you must connect the audio output of the
video card to the line-in connection of the sound card using the audio cable
supplied (with jack plug).

6. Switch on the computer.

SOFTWARE REQUIREMENTS

It is absolutely necessary to use the NT Kernel Driver for the video card. This
driver is included in the SIEMENS delivery package, but you can also procure it by
downloading it from the Hauppauge Web site in the Internet. It is to be found there
as a WinZip file (file name: ntdrv251.zip) under "WinTV for WindowsNT driver".
You must not install the "Win/TV CinemaPro Installation Diskette 3.84.4X"
application supplied by Hauppauge for Win/TV. Instead you can use a WinTV 32-
bit CinemaPro application from the Internet:
http://www.hauppauge.com/html/free_sw.htm#cinemapro

It is available at this address under:

• "WinTV 32-bit CinemaPro application (disk 1)">"cp32_1.zip"

• "WinTV 32-bit CinemaPro application (disk 2)">"cp32_2.zip"

It is recommend to use the current drivers from the Internet. It is also important that
you keep to a specific order of installation, because a number of files already
created by WinCC are overwritten by the 32-bit application.

INSTALLING THE DRIVER AND APPLICATION SOFTWARE

1. The requirement here is a PCS 7 system (including WinCC) in perfect working
order. If this is not the case, then you must first install PCS 7/WinCC.

2. Installing NT Kernel Driver:
Unpack ntdrv251.zip and execute SETUP.EXE. Do not power down the
computer yet.
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3. Now install WinTV 32-bit CinemaPro application. Unpack "cp32_1.zip" and
"cp32_2.zip" and execute SETUP.EXE. The README.TXT explains that you
must be logged on as Administrator in order to install the application under
WindowsNT.

Note

You must still not yet power down the computer.

HARDWARE CONFIGURATION

By installing the software you have entered the WinTV application (Start >
Programs > Hauppauge WinTV). The "readme" that is also available here will be
useful if any installation conflicts occur.

1. Start the application via WinTV.
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2. A message about the hardware configuration is displayed.

3. Now follow the dialog boxes and make the appropriate settings.
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4. After starting with Configure and the brief message Configuring ... Please
wait is displayed in the dialog box, the following two boxes are displayed, each
of which you must acknowledge:

Note

At this point you must power down the computer and actually switch off the power
supply, otherwise the video card will not be installed properly.

Now you have finished the installation.

5. Upon rebooting you can check the critical device driver "wintvio" via
(Start > Settings > Control Panel > System > Device Manager):
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INSTALLING THE Win/TV SOFTWARE

At this point you should once again refer to the original instruction manual for the
video card.

Adjusting the display:

1. Start the WinTV application and via the menu item (Configuration >
Display...) open the Appearance box.

2. Center the image section on the grid so that the film image completely fills the
Hauppauge window.

3. Via the menu item Display you switch on the vertical interpolation in order to
have a smoother display of animated objects.

4. Also check under Options whether "Save settings" is activated.

5. Other configuration options (Audio etc.) can be set as required via the menu
Configuration.

6. After you have made all the settings properly, the video card should function
without any problems under WindowsNT, because this is the basic requirement
for error-free functioning of the WinCC connection. By error-free functioning we
mean that the incoming film camera signal is visible under "Video1/Video2" or,
if there is no film camera signal, a blue background is displayed.
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7. In addition, under "Tuner" there must be at least an image background
flickering visible. A different colored background (for example, green) indicates
a configuration or hardware error.

LINKING THE IMAGE SIGNALS TO WinCC

There are several ways of displaying the images in WinCC runtime
(superimposed window). The simplest way is to call the image from runtime via
the button with the film camera symbol. The requirement here is a set of buttons at
the bottom edge of the screen created via Basis Process Control/Split Screen
Wizard.

You cannot change the size of this opened window (superimposed window).
However, you can shift it around in the working area. Right-click the image window
to change some of the object’s properties:

In this way, for example, you can select the source of the signal or make your own
configurations just like using winTV432. You must activate the "Refresh Timer" if
you want to shift the window around in the working area (OLE CONTROL).
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Configuring in an image using GraphicsDesigner:

1. Place an OLE Control (Object palette > Smart Objects > OLE Control) with the
subsequent video image size in the required image.

2. In the dialog box that opens automatically you must select Add OLE Control
and then WinCC Win/TV CinemaPro Control.

3. Double-click the control to open the following properties dialog box.

4. Later, in runtime, you can right-click the configured video image to call up
these properties just the same as the superimposed window (see above).
Likewise you can change the properties by right-clicking the control and then
selecting Properties. A special point to be noted here is that
"Ext 1" = Video source "0" and
"S Video" = Video source "3".

5. If the basic surface of the OCX doesn’t have the width:height ratio of 4:3, this
might lead to distortion of the image information. But all this only results in a
fixed configured image that you cannot shift nor change the size of it (IMAGE
WINDOW). If this does occur, however, you must create an image window
instead of the OLE- Control (Object palette > Smart objects>Image window).
You must then set the properties of the image window (Right-click >
Properties) accordingly (’movable’, ’maximizable’).
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It is important here to ensure that the ’image name’ is still linked to "@CP-
Video.pdl" and that you set yes for ’Fit image’, otherwise only one image is
displayed with the image size of the superimposed window, no matter how far the
image is stretched. You must also activate the "Refresh Timer" here for ’Shifting’.
Another special point to note here is that the displayed image always has a side
ratio of 4:3 and that when you change the image frame size, the 4:3 ratio is
adapted accordingly. This ensures that there is no distortion. This is independent of
the setting for the 4:3 side ratio in the actual NT application (under (Options)). One
disadvantage of this option is that you cannot preset the video signal source in the
GraphicsDesigner, but can only make a selection with a right-click in runtime.

Notice

• You can only employ one of the above-mentioned options to use the image
information supplied by the video card.

• If you call a superimposed window in a configured image, problems arise.
Thus you cannot call several image windows with different signal sources
(e.g. video and tuner) at the same time. If you can’t produce any video
images via the window(s), then it helps to switch "Video Enabled" or the
relevant signal source ("Ext1...S Video") OFF and then ON again.
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11.13.13 Connecting a signal module

Entry ID: 776118 - Date: 05/31/1999

QUESTION:
How can I connect a signal module?

ANSWER:
You can use the signal module (SBG) for controlling up to three different message
devices (horn, buzzer, lamps etc.). In addition, you have the option of connecting a
hardware acknowledge button. The module contains a hardware timer (watchdog)
that is post-triggered cyclically by the WinCC-RT (RunTime) via an API call so that
no interrupt is triggered. In addition it has 3 universally applicable binary inputs.
The SBG is a PC module with 8-bit ISA bus interface which has been specially
developed for use in OSs. It can be implemented only in conjunction with the
"Basic Process Control" options package. The general configuration of a system
and option for incorporating the signal group can be seen in the following figure.

Installation and settings in WinCC

The signal module can be integrated in a free slot of the OS concerned. It must be
slotted into the motherboard of the OS. If as server OS the OS is to have several
terminals (client OSs), then each terminal can have another signal module.

Starting up the SBG is done in two steps:

• Incorporate the signal module

• Test the signal module
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Hardware installation

1. You must slot the plug-in card (SBG) into the motherboard. This requires a free
ISA slot in the OS.

2. Before incorporating you must check whether the right addresses and memory
areas are set.

3. If the default settings of the card are not possible, you can change them via
DIP switches and jumpers.

Hardware setup

1. After you have incorporated the card, you can test the functionality via the
Control Panel of WindowsNT 4.0. For this you must double-click the relevant
icon in the Control Panel.

2. The dialog box "Signal Unit Hardware Setup" then opens. You can test the
plug-in card over this dialog.

3. The "Split Screen Wizard" generates the internal variables
@Signal1....@Signal3 for the control of the external transducers and
@Signalinput1....@Signalinput3 for the switch ID of external switches. In
addition, it enters the "hmrt.exe" program in the start-up list.

Procedure

• Start Alarm Logging Wizard

• In the dialog box that opens activate "Sounder connection"
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• Over the 3rd page of the dialog you can assign the internal variables to the
message classes
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Acknowledging the signal module:
The signal module is acknowledged by setting the variables @Signal1,2,3 to 0, e.g.
through the commands
SetTagWord("@Signal1",0);
SetTagWord("@Signal2",0);
SetTagWord("@Signal3",0);
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11.13.14 The Split Screen Wizard closes with an error message

Entry ID: 781997 - Date: 04/06/1999

QUESTION:
What should I do if the Split Screen Wizard closes with an error message?

ANSWER:
The Split Screen Wizard closes with the following error message:
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Possible causes
Probably, when copying the project, you have set the write protection for SSM-
relevant (Split Screen Manager) files. Check whether the files in the following
directories have the write protection activated:

• SSM

• Wscript

• GraCS

• Library

You can deactivate the write protection using the DOS command "attrib–r/s" or via
the file properties in the Windows Explorer.

Note

The write protection is usually set when you copy the project from a CD to the
hard disk.

11.13.15 Special features with actions when using a Multi VGA card

Entry ID: 831486 - Date: 09/21/1999

QUESTION:
What should I watch out for with actions when using a Multi VGA card?

ANSWER:
One problem with actions is that when using a function (e.g. SetBackColor) only
the picture name (lpszPictureName) and the object name (lpszObjectName) are
specified. Thus, if you are using multiple screens, there is no unambiguous
assignment of the function and therefore the picture to a specific monitor screen.

#include "apdefap.h"
void OnClick(char* lpszPictureName, char* lpszObjectName, char*
lpszPropertyName)
{
SetBackColor("system.pdl","storage_tank",CO_RED); // background color
}

Now, if you want the action to be executed on all the screens, you must enter the
following C action:

#include "apdefap.h"
void OnClick(char* lpszPictureName, char* lpszObjectName, char*
lpszPropertyName)
{
SetBackColor("@SCREEN.@WIN12:@1001.@DESK:system.pdl","storage_tan
k",CO_RED); // background color
SetBackColor("@SCREEN.@WIN22:@1001.@DESK:
system.pdl","storage_tank",CO_RED); // background color
}
By entering the two lines (for 2 screens) you ensure that the function
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SetBackColor is executed on both screens. @WIN12 stands for Monitor1 and
@WIN22 stands for Monitor2. In this way the image "system.pdl" and thus the
function is assigned to a specific monitor.

If you want to use more than two screens in WinCC Runtime and want to have the
same pictures open on two screens, it might happen that C actions that you
trigger, e.g. by mouse click, on one screen are executed on the other screen.

If, for example, you execute the C function SetVisible and transfer the picture name
absolutely (e.g. "Picture1.PDL",...), the function will always refer to the picture that
was opened first in the case of multiple screens. If you wish to address the current
picture, then you must use the pointer on the current picture:

SetVisible(IpszPictureName,...);

If you wish to close a picture window yourself by pressing an Exit button in the
picture, then you must program the following C action:

SetVisible(GetParentPicture(IpszPictureName), "picture_window_xyz", 0);

You will find the GetParentPicture function under STANDARD
functions\GRAPHICS\GetParentPicture in the GlobalScript.

Background:
In this case, IpszPictureName points to the opened picture window, but the picture
window is integrated in its parent window.

11.13.16 Comparison of exported data with WinCC redundancy

Entry ID: 977358 - Date: 07/26/1999

QUESTION:
Is the exported data also compared with WinCC redundancy?

ANSWER:
You have a project with two redundant servers. You switch off one server, on the
second server messages are exported via Storage. You are now interested about
what happens when the server that has been switched off starts up again after
exporting. The redundancy package only compares data that is entered during
the down time. This data is transferred when the previously "failed" server returns
to the database. However, no data is deleted when the databases are compared.



Operator Station

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 11-183

11.13.17 Mutual recognition of redundant servers

Entry ID: 977870 - Date: 07/26/1999

QUESTION:
How can I determine whether redundant servers recognize each other?

ANSWER:
You want to determine whether redundant servers in your project recognize each
other. You have the following options for this:

1. In the system directory "<DRIVE>\Siemens\WinCC\Diagnostics\", in the
CCRedCodi.log file, there is an entry "<connect to ’computer_name’>". This
entry means that the computer has recognized its partner at start-up.

2. If you are employing redundancy, the variable group "Redundancy" is created
under the internal variables in the variables list of WinCC. This variable group
includes the variable "MasterSlave" = 1/0. This variable indicates whether the
computer is master or slave. Another variable in this group is the
"MasterName" variable. This contains the computer name of the active
masters.

3. If you are employing redundancy, the message window "Control System
Messages" is created amongst others. A message is generated in this window
when the computer recognizes its partner or when it fails. The message text is
"Partner active" or "Partner deactivated" as the case may be.

11.13.18 Recognizing the switch from one server to another

Entry ID: 978631 - Date: 07/26/1999

QUESTION:
How as user can I tell that a client has been switched to another server?

ANSWER:
This information is in the control system messages that are created in the Alarm
Logging wizard. These messages inform you as user about the state of the
servers.
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11.14 User Archive

11.14.1 German Online Help with UserArchive

Entry ID: 762666 - Date: 02/24/1999

QUESTION:
If I press the "Help" button in UserArchive (V4.02 and higher) in Runtime, the
English Help opens. How can I open the German Help for UserArchive?

ANSWER:
In the new UserArchive pressing the "Help" button always opens the English help.
If you want the German Help, then you must create a button outside the OLE
control. Behind this you create a C action (Object Properties > Event > Mouse >
Mouse click) that calls a *.bat file. This batch file then calls the Help. The reason
for this long way round is that the WinExec function can only execute *.exe and
*.bat.
Now you must first create the Help_with_CCUACTLSDEU_HLP.bat file in which
the German Help is to be called. You can create this file with Notepad, for example.
You make the following call in this file:

call C:\Siemens\WinCC\bin\CCUACTLSDEU.HLP

The C action behind the button then looks like this:

#include "apdefap.h"
void OnClick(char* lpszPictureName, char* lpszObjectName, char*
lpszPropertyName)
{
WinExec("C:\\BAT\\Help_with_CCUACTLSDEU_HLP.bat",SW_HIDE); //Return
type:unsigned long int
}

In this example the Help_with_CCUACTLSDEU_HLP.bat is stored in the C:\BAT
path. The parameter SW_HIDE serves to suppress the DOS window.
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11.14.2 Configuring Form View of UserArchive (4.02)

Entry ID: 763895 - Date: 02/24/1999

QUESTION:
How do I get into configuring the Form View of the new UserArchive?

ANSWER:

• Open the GraphicsDesigner create an "OLE Control". The contents are
"WinCC UserArchive > Table Element".

• Double-click the OLE control and assign to the window the archive that is to be
displayed.

• Terminate the dialog and save the image.

• Now press and hold the Control key and double-click the control. Now the
Table View is displayed. Using the Form toolbar button switch the Table View
to Form View. Now you can configure the Form View on the grid that is
displayed.

11.14.3 Raw data with BSEND/BRECEIVE

Entry ID: 803955 - Date: 05/31/1999

QUESTION:
How can I send raw data from the S7 to WinCC with BSEND/BRECEIVE?

ANSWER:

Requirements:

• WinCC version 4.x

• Step7 version 4.x

• NCM S7 for the corresponding STEP7 version if you connect via PROFIBUS or
Industrial Ethernet.

• Complete and correctly installed CP for the communication (e.g. CP 443-1).

STEP7 configuration

• You select the CPU in the TREE VIEW.

• In the LIST VIEW you then start the "VerbPro" editor via Connections > Open
object.

• In the "VerbPro" editor you select a new line and start the connection dialog via
Insert > Connection.

• Set the "Connection Partner" to Unspecified.
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• Then press OK to open the dialog "Connection Properties". If you get an error
message at this point, check whether your CPU is connected to the network.

• Clear the check box "Active Connection Setup".
Under Network Connections > Local enter you CP/CPU and select the type
of interface (Industrial Ethernet, PROFIBUS, MPI, TCP/IP).
Under Network Connections > Partner enter a name for your connection
partner. You can enter any name since it is only a comment. Also enter the
node address of the connection partner (in the example: 08.00.06.01.98.00).

• Now click Address Details
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• Under Partner (WinCC) you must set "0 / 0" for "Rack/Slot".
The Connection Resource is predefined by STEP7; you must set the same
parameter for Partner (WinCC).

• You acknowledge all dialogs with OK and in the "VerbPro" editor you select
Save > Compile all.

• Set the CPU to STOP.

• Now you can load the configured connections into the CPU with VerbPro.

• Restart the CPU.

• In the STEP7 program you need the SFB12 (BSEND) to send data from the
AS to WinCC, and the SFB13 (BRCV) to send data from WinCC to the AS.
STEP7_Code_e.pdf (4 KB)
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WinCC configuration

• Under "Variables List" you insert the channel Simatic S7 Protocol Suite.

• Create a new connection.

• Under "Connection Properties" you set the following (this applies to all types of
connection, in this example an Industrial Ethernet connection):

Address Address of the S7 CP

Rack number Rack number of the associated CPU

Slot number Slot of the CPU

Check box "Send/receive
raw data block"

If a PBK connection is required, this must be checked

Connection Resource * Only "activated" when check box is clicked
* Use same parameter for Connection Resource as in the
VerbPro connection configuration from STEP7

• Now create a raw data variable under this connection. Under Address you
select the Raw Data Type "BSEND/BRCV". Once you select this raw data type,
you can edit the "R_ID" field. Here you enter the R_ID. This must be the same
as the R_ID you entered in the S7 program. The R_ID must be entered in
hexadecimal.

Notice

In the case of subsequent changes on the S7 side, make sure that these IDs still
match.

• Since the User Archive receives and sends data, and does this via the raw
data variable, you must of course specify the same R_ID for the BRCV as for
the BSEND in the program of the AS.

Notice

* Never confuse WinCC raw data type "Send/Receive Block" with
"BSEND/BRCV".
* For each BSEND for the User Archive there is always a BRECEIVE with the
same R_ID.
* You must always specify the receive release of the BRECEIVE when using the
User Archive.
* You must never forget the maximum receive length for the BRECEIVE
parameter "Rd_1".
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11.14.4 Error messages when opening the UserArchive editor

Entry ID: 762748 - Date: 02/24/1999

QUESTION:
Why can’t I open the UserArchive editor and instead get the error message "Error
in opening the configuration components"?

ANSWER:
The computer name in the WinCC project is incorrect. It does not correspond to the
name of the computer that WinCC is currently running on.

Remedy:
Enter the correct computer name in the ControlCenter in WinCC under Computer
> Properties.

11.14.5 Edit column/row width in the User Archive Runtime

Entry ID: 748948 - Date: 02/08/1999

QUESTION:
How can I edit the column/row width in the table view?

ANSWER:

Edit column width:

• Open the GraphicsDesigner with the image in which your User Archive is
displayed.

• Press the Control button and at the same time double-click the OLE control
with which your User Archive is displayed. Now the Table View opens.

• Switch to Form View with the tool tip "Form" 

• Now set the column width by going to the dividing line between columns and
as soon as the double-arrow appears you can change the column width.

• To save, click the GraphicsDesigner image outside the OLE Control, so that
your changes are transferred to the database.

• Now you must save the image.

Edit row height:

• You can only change the row height via the font size, i.e. if you select a larger
font size, then the row height increases automatically.

• You change the font size by double-clicking to get to the OLE control and
selecting the Fonts tab. Here you can change the font size as required.

• To save the settings, terminate the dialog with OK and save the image.
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11.14.6 User Archive Editor: Toolbar non-operable

Entry ID: 730078 - Date: 02/01/1999

QUESTION:
The toolbar of the User Archive editor is grayed and can no longer be operated.
What can I do to change this?

ANSWER:
The toolbar is grayed because the CCUAEditor.exe has not terminated properly.

Remedy:
In your project directory you delete the UAEditor.loc file or rename it. This is also
possible with WinCC in runtime mode.

11.14.7 Exporting/importing the User Archive data records (version V4.02
and higher) in *.csv file

Entry ID: 729763 - Date: 02/01/1999

QUESTION:
When I delete my project RT database, the data records of the new User Archive
(version V4.02 and higher) are gone. Why?

ANSWER:
The data records of the User Archive are stored in the RT database. If you delete
this, the data records are deleted automatically, too. However, you can save the
data records by exporting them beforehand into a *.csv file. After deleting the RT
database you can then also import the data records back into the User Archive.

Proceed as follows to export the data records:

1. In the Control Center open the User Archive editor.

2. Here you select the menu item Runtime data > Export.
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3. In the following dialog box you enter the path and file in which you want to
have your data records saved.

4. Importing the *.csv file functions in exactly the same way. In this case,
however, you select Runtime data > Import and enter the file to be imported.
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11.14.8 Toolbar buttons of the User Archive outside the OCX

Entry ID: 729703 - Date: 06/22/1999

QUESTION:
Can I configure the toolbar buttons of the User Archive (version V4.02 and higher)
in an image even outside the OCX?

ANSWER:
You have two options for creating the toolbar buttons in an image: via a C-Script or
via the Dynamic Dialog.

DynamicDialog:

1. The requirement is that you have already inserted an OLE control in your
image, in which your archive is displayed.

2. Create a button in the image required.

3. Under the "Object properties" of the button you select the Event tab.

4. Under Mouse >Mouse click >Direct connection you configure the function of
your button.

5. Select one of the following constants as source. These specify the functionality
of your button.
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 Constant  Meaning

Form Switch between the form view and table view.

First Display the first data record of the archive.

Previous Page back in the table window.

Next Page forward in the table window.

Last Display the last data record of the archive.

Delete Delete the data record.

New Create new data record.

Edit Change existing field.

ReadVar Direct variable link for reading variables.

WriteVar Direct variable link for writing variables.

Import Import archives.

Export Export archives.

Filter Define filter conditions.

Sort Define sort conditions.

Help Request help.

6. As goal you enter in the "Object" field the name of the OLE control in which
your archive is to be displayed. In the "Properties" field you select
PressTBButton. The goal remains the same for all constants.

7. Now you quit the dynam ic dialog with O.K. and store the image.
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C-Script:

1. Follow steps 1-3 for Dynamic Dialog.

2. Under Mouse > Mouse click > C Action you configure the function of your
button.

3. You create the following script:

SetPropChar("Imagename.pdl","OLE Contro1","PressTBButton","First");
SetPropChar("Imagename.pdl","OLE Contro1","PressTBButton",
"VTB_Focus");

Note

With SetPropChar parameter 1 is the image name in which the button and the
User Archive OCX are located. Parameter 2 is the name of the User Archive OCX.
Parameter 3 is always the PressTBButton. Parameter 4 is a constant that
depends on the function of the button that it is supposed to have (see table for
explanation of constants).

4. Compile the function and save the image.

Note

The difference between the two methods of programming lies in the effects during
runtime. If you use the Dynamic Dialog, the action is processed with the Graphics
Runtime. If you use the C Action, an additional process is started in the runtime for
the C Action and thus requires more system resources. The advantage, however,
is that, for example, in the case of the function with the constant "First", the focus
remains in the image and is not set on the button as is the case with the Dynamic
Dialog. The C Action is only better with keyboard operation, because otherwise
the focus is lost on the OCX.

11.14.9 Using the WinCC User Archive Wizard Scripts V4.02 and higher

Entry ID: 725822 - Date: 01/28/1999

QUESTION:
Can I also use the previous wizard functions on the User Archive (version V4.02
and higher)?

ANSWER:
The wizard scripts in the GraphicsDesigner with which you can create User Archive
functions, only work for the old User Archive (<4.02). This functionality is carried
out via the OCXs with the new User Archive.
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The following wizard script is affected:

• User Archive Functions > Create Archive Objects

11.14.10 User Archive Wizard doesn’t create a complete archive image

Entry ID: 71187 - Date: 09/05/1997

QUESTION:
Why doesn’t the Dynamic Wizard Script for the User Archive create a complete
image ?

ANSWER:
The problem lies in the fact that the Dynamic Wizard can’t assign the buttons when
creating the archive image. The functions are logged on with the "Generate
header" event in Global Script.

Remedy: create a "temp" directory (e.g. C:\temp) on the partition on which WinCC
is installed.
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11.14.11 Date format in conjunction with User Archive

Entry ID: 71169 - Date: 08/07/1997

QUESTION:
In which format is date/time stored in the User Archive?

ANSWER:

1. With field functions TLGSet/GetUserArchivFieldDataAsText and
TLGSet/GetRecordFieldByNumber a date is transferred as a string:
e.g.: "1997-05-22 10:27:41.123"

2. A date is specified as follows from the S5:

 relative DW no.  DL  DR

DW 0 Year

DW 1 Month Day

DW 2 Hour Minute

DW 3 Second Fraction

DW 4 Fraction Reserve

1. Format of the TIMESTAMP of the database,
typedef struct tagTIMESTAMP_STRUCT
{

SQLUSMALLINT year; // year, 2 bytes

SQLUSMALLINT month; // month, 2 bytes

SQLUSMALLINT day; // day, 2 bytes

SQLUSMALLINT hour; // hour, 2 bytes

SQLUSMALLINT minute; // minute, 2 bytes

SQLUSMALLINT second; // seconds, 2 bytes

SQLUINTEGER fraction; // 1/1000000s(millionth), 4 bytes

} TIMESTAMP_STRUCT;

These 16 bytes must be stored as byte sequence in the temporary data record.
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11.14.12 Reading and writing of data records too slow

Entry ID: 537698 - Date: 09/29/1998

QUESTION:.
Why does it take so long for me to read a large data record from the user archive
or write one to it?

ANSWER:
Reading or writing a large data record takes so long in your case because you use
the API calls "TLGGETUserArchivFieldText(...)" and
"TLGSetUserArchivFieldText(...)".
These calls read and write every single value individually from and to the archive
respectively. The thus ensuing frequent disk access causes the overall access time
to be so long.

Remedy:
Use the calls "TLGGetUserArchivFieldDataText(...)" and
"TLGSetUserArchivFieldDataText(...)".
With these calls you access the temporary data record. This reduces the access
time by up to a factor of 10.

11.14.13 Float data type

Entry ID: 537498 - Date: 09/29/1998

QUESTION:.
Why isn’t there a Float data type with UserArchive?

ANSWER:
With UserArchive you don’t need the Float data type. Instead of Float you should
use the Double data type.

11.14.14 Number of decimal places with data type Double

Entry ID: 537598 - Date: 11/21/2000

QUESTION:.
How many decimal places are there in the User Archive with the Double data type?

ANSWER:
With the Double data type there is a maximum of 15 decimal places. The number
varies with the number of significant places, i.e. the places before the decimal
point.
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11.14.15 Defining fields with Wizard Script for User Archive

Entry ID: 506891 - Date: 09/28/1998

QUESTION:
Why doesn’t the Dynamic Wizard for User Archive create the objects completely
when 100 data fields are exceeded?

ANSWER:
The Wizard Script from WinCC is configured for 100 fields. If you wish to extend
the script then the appropriate adaptations must be made. The source code is
stored in the following files that you can open with an editor such as WordPad:

Siemens/WinCC/wscripts/wscript.deu/AnwenderArchivObjekte.wnf
Siemens/WinCC/wscripts/wscript.enu/AnwenderArchivObjekte.wnf

In the file you should search for the section "User Definitions" as illustrated below:

//**********************************************************************
// User Definitions
//**********************************************************************

HWND hwndParent;

CMN_ERROR API_Error;

HANDLE hProject;

BOOL SystemError;

char ArchivNameList (100)(TLG_DB_ARC_NAME_MAX_LENGHT+1);

DWORD maxArchivNumber;

DWORD UserArchivNumber;

int SelectedArchiv = 0;

 FIELD_LIST  FieldList (100);

DWORD maxFieldNumber;

DWORD maxFieldNameLen;

Now in the declaration for FieldList you enter the required number of fields (default
is 100). The value should not exceed 250. The new scripts must then be
recompiled.
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11.14.16 Date/ time in user archive

Entry ID: 492721 - Date: 09/25/1998

QUESTION:
How can I write the current date/time to a data record of the user archive?

ANSWER:
You can, for example, do this using the following script.

#include "apdefap.h"
void OnClick(char* lpszPictureName, char* lpszObjectName, char*
lpszPropertyName)
{
SetTagChar("UsArch@AnwARC@feld4",GetLocalTimeString ()); //Date/Time
}

Description:

UsArch@AnwARC@feld4: Archive variable of date type

11.14.17 Sample program: grouping of repetitive functions on User
Archives in one function.

Entry ID: 2463816 - Date: 06/20/2000

QUESTION:
How can I reduce the code volume with scripts for accessing User Archive?

ANSWER:
If you program scripts for accessing User Archive, then there are large volumes of
code for the administration tasks. This code is the same for accessing all User
Archives. The example here shows an option for grouping the administration tasks
together in one function.

The script structure looks like this for standard programming methods:

1. Generating the sorting and filtering conditions

2. Setting up a connection to the User Archive
uaConnect
uaQueryArchiveByName
if error: return

3. Setting the sorting and filtering conditions
uaArchiveSetFilter
uaArchiveSetSort

4. Opening the query
uaArchiveOpen

5. Actually working with the query
Read, write, delete, insert and so on.

6. Clearing down the connection to the User Archive
uaArchiveClose
uaReleaseArchive
uaDisconnect
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If you program everything with fault check in one function, the function becomes
too large and unclear.
If you take a close look at the list above, you will be able to see that only points 1
and 5 change from case to case.
All the other points remain the same no matter what structure the User
Archive has.

You can split the above structure into 3 functions.

1. The task-related function takes care of point 1. It generates the filters and
sorting conditions.

2. A general function that encapsulates all administration actions. This function
applies for ALL User Archives. The function receive a callback function as
parameter. This callback function is called either for each entry in the query or
just once for the entire archive.

3. A callback function, this function process point 5.

This division means that you don’t have to worry about the administration actions.
You program just one function for query generation and one archive-related
function, which processes the archive entries.

In the following example we use the function uaUtilityEnumRecords.

Function description:

 BOOL uaUtilityEnumRecords(  
  Const char* pszArchiveName ,

const char* lpszFilter,
const char* lpszSort,
BOOL ( UserFunc )( UAHARCHIVE* phUA, void* pUserData ),
void* pUserData )

Parameters:

• pszArchiveName: Pointer to a zero-terminated string. The string contains the
name of the archive as it appears in the User Archive editor.

• lpszFilter: Pointer to a zero-terminated string. The string contains the
filter condition for the archive. The pointer can also be ZERO.

• lpszSort: Pointer to a zero-terminated string. The string contains the
sorting condition for the archive. The pointer can also be
ZERO.

• UserFunc: Name of a callback function. The function is called for each
entry if you transfer a filter. The function is called once for the
entire archive if you do not transfer a filter.

The function must be of the following type:
BOOL ( UserFunc )( UAHARCHIVE* phUA, void*
pUserData ).

• pUserData: Pointer to user data. The pointer is forwarded without
modification to the callback function.
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Return value:

The function returns the value TRUE if:

• no faults have occurred during connection setup and clear-down.

• the callback function always returns TRUE.

• Otherwise the value FALSE is returned.

Function:

The uaUtilityEnumRecords function carries out the following steps:

1. Sets up connection to the User Archive.

2. Sets the filter and sorting conditions if they are transferred.

3. Opens the query.

4. If no filter has been set, the function calls the callback function with the
"handle" to the archive.
If the filter exists, the callback function is called in a loop for each entry in the
query with the "handle" to an entry. As soon as the CB function returns the
value FALSE, the loop is terminated. The function uaUtilityEnumRecords
then returns the FALSE.

5. After the callback function has been processed, the connection to the archive
is set up.

You see the code of the function in the following PDF document:
uaUtilityEnumRecords_1.pdf (7 KB)

Interface of the callback functions:

• phUA: Pointer to a User Archive handle. The "handle" can refer to the
entire archive or just one single entry.

• pUserData: Pointer to the user data.

Return value:

In the case of faults, functions should return the value FALSE.

Sample project:

The sample project demonstrates the application of the function
uaUtilityEnumRecords. The sample project was created with WinCC V5.0. You
can also use the function with WinCC V 4.02.

The sample project contains sample User Archive called "JobData". The archive
has two columns. One column for the product designation and the other column for
the product quantity. In the start image there are four buttons that access the
archive.

• The "Insert Job" button inserts a new line in the archive.
InsertButton_1.pdf (3 KB)

• The "Change Job" button sets the quantity for the specified job ID.
Change_Job_Button_1.pdf (3 KB)
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• The "Get Job with biggest Amount" button provides the name for the job with
the largest quantity specified.
Get_biggestJob_Button_1.pdf (3 KB)

• The "Preset No. of Parts Amount" button sets the specified amount for each
job.
Preset_No_of_PartsButton_1.pdf (3 KB)

The following Zip archive contains the sample project. Load the archive onto the
hard disk. Unpack the archive in a directory. Now you can open and test the
project. Observe the archive window and the global script diagnostics windows.

UAExample_1.exe (331 KB)

11.14.18 Requirement for using the User Archive and project switcher API
on the client

Entry ID: 1935606 - Date: 02/25/2000

QUESTION:
What are the requirements for using the API of the User Archive and of the project
switcher on my WinCC client?

ANSWER:
For this you must install the following options for the client:

• User Archive

• Redundancy

You do not need a license on the client.

11.14.19 Password protection for User Archives in Client-Server mode

Entry ID: 1548250 - Date: 11/26/1999

QUESTION:
Why can’t I use the User Archive with password protection unrestricted in Client-
Server mode?

ANSWER:
The login on the server is decisive for User Archives with password protection. If,
for example, you do not start the Graphics Runtime on your server, then you are
restricted in executing operations or cannot use them at all. The reason for this is
that either Default User no user at all is logged in.
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11.14.20 Function extension of the control variables of the user archive to
WinCC V5.0

Entry ID: 1584496 - Date: 12/14/1999

QUESTION:
I would like to attach data records to a user archive. Is there a simpler way than via
C scripts?

ANSWER:
With WinCC V5.0 the function of the control variables for the user archive is
extended. It is now possible to attach data records to a user archive via the control
variables. This does away with the need for a C script.

Enter the ID "-1" and job "6" to read the current contents of the process variables
into the table. The new values are added to the end of the table. The IDs of the
data records are counted up in sequence. The jobs "Write, Job 7" and "Delete, Job
8" are not possible via ID "-1".

More information on the control variables is available from the online Help on the
user archive.

11.14.21 Error Codes of the User Archive Function "uaGetLastError

Entry ID: 1005800 - Date: 08/20/1999

QUESTION:
What are the meanings of the error codes of the user archive function
"uaGetLastError"?

ANSWER:
Here is a list of the definitions for the return value of the function uaGetLastError:

UA_ERROR_CONNECT_FAILED 100

UA_ERROR_OPEN_FAILED 101

UA_ERROR_CLOSE_FAILED 102

UA_ERROR_REQUERY_FAILED 103

UA_ERROR_MOVE_FAILED 104

UA_ERROR_INSERT_FAILED 105

UA_ERROR_UPDATE_FAILED 106

UA_ERROR_DELETE_FAILED 107

UA_ERROR_IMPORT_FAILED 108

UA_ERROR_EXPORT_FAILED 109

UA_ERROR_READ_FAILED 110

UA_ERROR_WRITE_FAILED 111

UA_ERROR_GET_FAILED 112

UA_ERROR_SET_FAILED 113

UA_ERROR_INVALID_NAME 200

UA_ERROR_INVALID_TYPE 201
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UA_ERROR_INVALID_NUMRECS 202

UA_ERROR_INVALID_COMMTYPE 203

UA_ERROR_INVALID_LENGTH 204

UA_ERROR_INVALID_PRECISION 205

UA_ERROR_NULL_POINTER 1000

UA_ERROR_INVALID_POINTER 1001

UA_ERROR_INVALID_HANDLE 1002

UA_ERROR_INVALID_INDEX 1003

The return values are defined in the header file Ccuacapi.h.

11.14.22 Project cannot be opened on the client with a WinCC
MultiUserProject (WinCC V4.02 and SP1)

Entry ID: 1321095 - Date: 11/08/1999

QUESTION:
Why can’t I open the project on the client with my WinCC MultiUserProject?

ANSWER:
You are using WinCC V4.02 and SP1 and STEP7 V5. Your WinCC project is a
WinCC MultiUserProject. Now, if you want to open the project on the client, you
get the error message "Server not available". You have set your Windows
network settings correctly.

Remedy:
In order to avoid the "Server not available" error message, check the following:

1. In the Windows Control Panel open the "SIMATIC Workstation" application.

2. Here, check the workstation setting: the Client Server mode only works in
WinCC if Multi-user System is set. It doesn’t work with the "Single-user
System" setting.
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11.15 Transferring Data

11.15.1 DDE channel to Excel locally on a computer

Entry ID: 761667 - Date: 02/21/2000

QUESTION:
How can I exchange data with Excel locally on a computer via the DDE channel?

ANSWER:

WinCC

• Start WinCC and create a new project.

• Under "Variables" insert a new driver named "Windows DDE.CHN".
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• Under this channel you create a new connection

• You set the parameters of this connection in the "DDE Connection" tab. In the
case of a local connection to EXCEL the "Computer name" field can remain
empty. Here the local computer name is used automatically. The "Application"
to be communicated with is EXCEL. The "Topic" is the file name of the EXCEL
table. Here you must also specify the table sheet concerned. In the German
version of Excel you enter "Tabellex" for the table sheet, in the English version
"Sheetx" (x = 1,2....).

Note

The parameters might have to be adapted for other language versions of EXCEL.
This example is based on the German version.
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• Finally, still under the connection, you create a new variable via which you can
then communicate with Excel.
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You define the properties of the variables as follows:
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As address you specify the field in the table in which the data is to be written. For
this you first enter the row number and then the column number. You can also
select the format with which you wish to transfer the data. Also when addressing
you must differentiate between the German and English versions of Excel. If you
have a German version of Excel, the address is Z1S1, in the English version R1C1.

Note

The parameters might have to be adapted for other language versions of EXCEL.
This example is based on the German version.
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• Now start the GraphicsDesigner and create an I/O field that is to be connected
to the variables configured above.
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• As additional task insert the file
"<DRIVE>:\Siemens\WinCC\bin\Ddeserver.exe" in the Start-up tab of the
computer Properties.

• Now you can start Runtime.

• Tip
To ensure that the Excel table which you access starts automatically with
Runtime you insert the following task under Computer > Properties, Start tab:
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Here the application is the Excel.exe file to make Excel start with the start of the
Runtime mode. As parameter you specify the Excel file in which you want to write
the data. To make sure that WinCC also finds the file, you should also specify
under Active Directory where the file is stored.

Excel

Now open Excel and create a file with the name specified above. Now you can
write to the variables in WinCC and the value changes in Excel. This also works in
the other direction, of course.

11.15.2 Data exchange between WinCC computers via DDE

Entry ID: 765028 - Date: 03/01/1999

QUESTION:
How can I exchange data via DDE from one WinCC computer to another WinCC
computer?

ANSWER:

General

• You must start the NETDDE.EXE program on both computers. It is by default
under C:\Windows in Windows95. In WindowsNT it is under C:\Winnt.400.

• In addition you must use the DDESHARE.EXE program to make some more
entries in the registry. Here it is important to know which operating system your
computer has.
Under WindowsNT both programs are stored by default in the Winnt.400
directory.
Under Windows95 only NETDDE.EXE is in the Windows path (default). The
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DDESHARE.EXE program must be dealt with first. However, for this you
cannot use ddeshare of WinNT. But you can copy the one from Win3.11.

• Now call the DDESHARE program. You can do this via the Start button and
Run.

1. Under Win95:
With Share > New you create a new share.

In the next window you enter the following data:

Share Name Name of the new connection

Application Name Name of your program on the local computer with which you
are going to set up the connection

Topic Name Here you enter the path in which your project is located.
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2. Under WinNT:

Open a new DDE release via Releases > DDE release.
Enter the following data in the dialog box:

Release name Name of the release

Static / Application Name of the program on the local computer with which
you are going to set up the connection.

Static / Topic Here you enter the path in which your project is located.
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Here you enter the following in addition under Releases > Trust releases:
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WinCC computer (server)

• Now you start WinCC and under Computer > Properties, in the Run tab you
enter "ddeserv.exe" with the parameter "/v".

• In GraphicsDesigner create an image in which you can access the variables.
The variables that you want to read must not be internal variables. You can
use process variables.
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WinCC computer (client)

• Now you start WinCC here too and insert the DDE channel under Connections
in the Control Center.

The channel is called "Windows DDE.CHN" and is located in the "WinCC\Bin"
directory.

• Under this channel you create a new connection and a new variable via which
you communicate with the partner computer.
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• The properties of the connection are to be defined as follows:

Computer name Name of the partner computer

Topic Name of the release

Procedure for reading variables Get automatically when changes are made

• Under this connection you now still create the variable via which you want to
communicate. The data type is the same as that of the partner variables.
Under Address > Select you enter the names of the partner variables.
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• Now you just have to display the variable in an I/O field in your image.

11.15.3 DDE channel to Excel via the network

Entry ID: 765223 - Date: 03/01/1999

QUESTION:
How can I transfer data with DDE from a WinCC computer to Excel that is running
on a different computer?

ANSWER:

General

• You must start the NETDDE.EXE program on both computers. It is by default
under C:\Windows in Windows95. In WindowsNT it is under C:\Winnt.400.

• In addition you must use the DDESHARE.EXE program to make some more
entries in the registry. Here it is important to know which operating system your
computer has.
Under WindowsNT both programs are stored by default in the Winnt.400
directory.
Under Windows95 only NETDDE.EXE is in the Windows path (default). The
DDESHARE.EXE program must be dealt with first. However, for this you
cannot use ddeshare of WinNT. But you can copy the one from Win3.11.
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WinCC computer

• Now call the DDESHARE program. You can do this via the Start button and
Run.

Under Win95

With Share > New you create a new share.

In the next window you enter the following data:

Share Name Name of the new connection

Application Name Name of your program on the local computer with which
you are going to set up the connection

Topic Name Here you enter the path in which your project is located.
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Under WinNT:

Open a new DDE release via Releases > DDE release.
Enter the following data in the dialog box:

Release name Name of the release

Static / Application Name of the program on the local computer with which
you are going to set up the connection.

Static / Topic Here you enter the path in which your project is located.
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Here you enter the following in addition under Releases > Trust releases:

• Now start WinCC and insert the DDE channel in the Control Center under
"Variables".
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The channel is called "Windows DDE.CHN" and is located in the "WinCC\Bin"
directory.

• Under this channel you create a new connection and a new variable via which
you communicate with Excel. The properties of the connection are to be
defined as follows:
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Computer name Name of the partner computer

Topic Name of your release

Procedure for reading variables Get automatically when changes are made

• Now you just have to display the variable in an I/O field in your image.

Excel computer

• Here you also start NETDDE.EXE as described above.

• Here you must also make entries in the registry. You also do this with the
DDESHARE program.
Here it is important that the name of the release is the same. Otherwise you
will of course have to specify Excel as the application and the path in which
your Excel file is located.

• Now, when you start the Runtime mode on the WinCC computer, the
connection is set up.
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11.15.4 Connection of third-party devices to SIMATIC PCS 7 via Novell.

Entry ID: 325357 - Date: 05/08/1998

QUESTION:
I want to read data out of the multiple station OS of SIMATIC PCS 7 via a Novell
network and process it. How does this work?

ANSWER:
Access to data (archive data) from OS system is possible via Warehouse using the
CORNERSTONE program package. This is done via Windows ODBC
mechanisms. If a Novell network is available, it is purely a transfer mechanism and
works just like any other PC network.

11.15.5 Connecting WinCC to WinAC

Entry ID: 646822 - Date: 11/09/1998

QUESTION:
After I have created a PCS 7 project, compiled it properly and then mapped it, I
cannot set up an on-line connection from the WinCC station to the AS. Variables
are not updated and have gray background. The project runs however with a
SIMATIC S7-416. What should I do?

ANSWER:
You must set a WinAC CPU 416-2.... ISA as system in the HW Config. Then, when
you map, the internal ISA channel is used for the data connection from AS to OS
and MPI or PROFIBUS as for a SIMATIC S7-4xx. If you have configured the
project originally with SIMATIC S7-4xx and then wish to switch subsequently to
SIMATIC S7-416 ISA, then it is absolutely necessary to remove the central rack
from the HW Config and insert it again as, for example, WinAC CPU416-2 ISA.
You should however still subsequently specify an MPI connection (e.g. MPI = 4)
that is used as an internal connection.
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12 Configuring SIMATIC Connections

12.1 Basics

12.1.1 AS/OS transfer of a self-written data block

Entry ID: 673454 - Date: 11/20/2000

QUESTION:
How can I do an AS/OS transfer of the variables of a self-written data block to
WinCC?

ANSWER:
Proceed as follows to make an AS/OS transfer of variables of a data block:

1. Open the data block and select the variable(s) that you want to transfer.

2. Right-click and open the "Object Properties" of the variables.

3. In the window that opens you now enter the system attribute "S7_m_c" and
set the associated value to "true".

4. Now close the block.

5. Select the data block in the block container of the SIMATIC Manager.

6. Via the menu item "Edit > Special Object Properties" open the window
"HMI...".

7. In this window you activate the option "HMI".

Now in the SIMATIC Manager you can trigger the AS/OS transfer via "Options >
AS/OS Connection Data > Transfer".
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12.1.2 When mapping with overall reset, the mapper overwrites the
manually set parameters of the messages.

Entry ID: 1436300 - Date: 11/18/1999

QUESTION:
The manually set parameters are overwritten when mapping with overall reset.
What can I do about this?

ANSWER:
You can get round this by mapping only the changes.

If it is necessary to map with overall reset, you can restore the old status as
follows:

1. Export the newly mapped messages.

2. The second column of the export file, the Parameter column, contains the
binary coded parameters of the message.

The individual bits have the following meanings:

Bit 0: message must be acknowledge individually
Bit 1: message triggers horn
Bit 2: message is archived
Bit 3: message is logged
Bit 4: message is created with falling edge
Bit 8: message triggers an action

3. If you change the values accordingly in the Export file, you can import the
messages again and thus restore the old status.

12.1.3 Configuration can no longer be mapped in PCS 7 version earlier
4.02

Entry ID: 264617 - Date: 06/28/1999

QUESTION:
What can I do if my configuration can no longer be mapped?

ANSWER:
There are several solutions:

• Only with PCS 7 version <= 4.01: Delete variables manually

• Delete the first messages manually

• Check the symbol table in STEP 7 for blanks

• Only with PCS 7 version <= 4.01: Delete the contents of the SfcRtBase folder
and in the Control Center delete the SFC Variable Groups
<Program_Name>_SfcMapper.
It is absolutely necessary to delete both, otherwise you will have inconsistent
data.

• In the connection in the Control Center delete all variables that were not
created through mapping. In particular this concerns variables that have been
created manually.
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! Warning

if you use Life Beat Monitoring, a variable entitled @<selected device name> is
created in the monitored connection. This variable cannot be deleted by the
mapper and causes an error message or warning when mapping. Delete this
variable manually. After mapping you can create the variable again by pressing
’Update’ in the editor of Life Beat Monitoring.

• Check whether Basic Process Control is installed on your computer. This
option is required to start the Alarm Logging Wizard.

Procedure:

- Select Start > Settings > Add/Remove Programs.

- Double-click SIMATIC WinCC Windows Control Center.

- Click the button Do you want to remove or add parts of WinCC.

- In the Options section select the Basic Process Control option.

- Installation is usually made with WinCC or PCS 7 CD.

If these measures do not help, then maybe the following can:

• In AlarmLogging of WinCC insert three or four dummy messages without
process link and remap.

12.1.4 Problems when mapping data blocks with the same name

Entry ID: 769630 - Date: 03/15/1999

QUESTION:
Why do I get an error message when mapping from the S7 project into an OS? I
have a data block each in two different ASs. The data blocks have the same
symbolic name but different structures.

ANSWER:
The same structure variable is created for both blocks from the different ASs.
However, since the structures are different, this leads to an error message when
mapping. This behavior is a system property.

Reason:
In WinCC you must assign unique names that are derived from the engineering.
In the case of block types, it is presumed that block types with the same name are
identical in code, interface and attributes, because the block type name is used
for naming the associated WinCC structure type. Because the data of several S7
programs is operated and monitored by one OS, it is presumed that the associated
block types in the assigned programs are identical.
Global DBs are mapped in WinCC on a WinCC structure type with the name of
the global DB (either DB<Number> or symbolic name) and to exactly one
instance (e.g. S7 program (1)_DB1) of it.
It is quite usual to give different symbolic names in a project to data blocks with
different contents.
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12.1.5 Mapping archives with PCS 7 version 4.02

Entry ID: 901759 - Date: 06/29/1999

QUESTION:
Why are archives (AR_SEND) also mapped with PCS 7 V4.02?

ANSWER:
As described in the FAQ with Entry ID 766375 "Incorporating AR_SEND in PCS 7
version V4.02" and in the documentation, the archives with reference to the
AR_SEND (SFB37) block should no longer be transferred to WinCC. PCS 7
V4.01 was installed on your computer before you installed PCS 7 V4.02. In this
case it can happen that the archive is nevertheless transferred with V4.02.

If a previous version was installed on your computer before the installation of
PCS 7 V4.02, it is not sufficient to delete the relevant Registry entry. In this
case the Registry entry must be entered manually and set to the value "0". The
computer must then be restarted in order to activate the Registry changes. After
this process the archives are no longer created in the case of an AS-OS transfer.

Proceed as follows to change the Registry entries:

1. Start > Run, enter regedit

2. Search the key:
HKEY_CURRENT_USER\Software\SIEMENS\STEP7\2.0\Applications\AS-OS
Engineering\Settings

3. Enter a new value (right click\new\DWORD value)
"TransferArsend" ="0"

! Warning

Retain uppercase and lowercase as given.

4. Close the Registry editor and restart the computer.

Notice

Basically, no warranty can be given for direct changes in the registry database,
because this is entirely the responsibility of the user. In any case it is
recommended to make a backup of the registry before proceeding as described
below. Furthermore, these settings are computer-specific. This means that when
copying the project to another computer, the settings have to be made again.
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12.1.6 Length of mapped message texts

Entry ID: 906344 - Date: 06/30/1999

QUESTION:
In the transfer protocol when mapping I get the message "Warning: a message
was too long and was truncated for transfer" or "Warning: either shorten the text or
increase the text block length in WinCC". What should I do?

ANSWER:
In the Alarm Logging of WinCC you will find the user text blocks amongst the
message blocks. Double-click the text blocks to open a window in which you can
enter the text block length required.

Notice

In the "Area" text block you can transfer a maximum of 65 characters.



Configuring SIMATIC Connections

Process Control System PCS 7, Tips and Tricks
12-6 A5E00080064-01



Process Control System PCS 7, Tips and Tricks
A5E00080064-01 13-1

13 SCL-Language

13.1 Basics

13.1.1 Creating a block in SCL that supports HMI and messages

Entry ID: 1023091 - Date: 09/08/1999

QUESTION:
How can I create a block that supports HMI and messages?

ANSWER:
An example of this is attached in SCL source code. You must strictly follow the
procedure given below:

1. In the SLC compiler under the "Tools" menu call the Settings…  function.

2. Open the Create Block  tab and activate the option Take into account system
attribute 'S7_server' .

3. Compile the block and save it upon completion.

4. Mark the block in the container block of the SIMATIC Manager.

5. In the SIMATIC Manager under the "Edit" menu call the function Special
Object Properties ... > Message .

6. In the "Message Configuration" menu select the New Device  button and select
WinCC as indicating device and acknowledge with OK.

7. Mark the first message or "Sub_No_1".

8. In the "Text" tab enter $$AKZ$$ for the origin in the first text line "Text 1".

9. Exit the window with OK.

10. Only now insert the block in CFC.

Sample code for function block FB353 ("adder"):
BuBundMelde.pdf (5 KB)
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13.1.2 Calling twoAlarm_8P - SFB 35 blocks in a function block with
SCL

Entry ID: 1027414 - Date: 09/13/1999

QUESTION:
What should I watch out for if I want to call two Alarm_8P blocks in a function
block?

ANSWER:
If you want to call two Alarm_8P blocks in a function block under SCL, then
proceed as follows:

Call the Alarm_8P blocks in your function block as described in the example. You
can also download the associated source code (SCL_Code.pdf file). This SCL
source code contains an example for calling two Alarm_8P blocks. Proceed as
follows:

1. Switch the blocks as described in the example. Note also that you must set the
inputs EV_ID_MELD 1 + 2 to "external" (must be VAR_INPUT).

2. In the SCL editor under the menu item Tools > Settings you select the Create
Block tab. Here you must activate the option "Take into account system
attribute S7_Server".

3. Now you can compile the SCL code.

4. Select your newly created block in the block container of the SIMATIC
Manager. Via the menu items Edit > Special Object Properties open the
"Message" window.

5. Here in the "Configure Message" menu you must select the New Device
button and set WinCC as display device. Close the window with OK.

6. Now select the first message "Sub_No_1" and in the Text tab enter in the first
line "Text 1" $$AKZ$$ for the origin. If you have configured other messages,
they must also have $$AKZ$$ in their text line "Text1".

7. Now you can incorporate the blocks created into the CFC and configure
messages as usual.

Source code in SCL (German):

SCL_Code.pdf (4 KB)
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13.1.3 Reading the system time of the PLC, converting to a string or
integer value and mapping to WinCC

Entry ID: 1085941 - Date: 11/22/1999

QUESTION:
How can I read the system time of the PLC, convert it into a format that I can
transfer to WinCC and have it displayed there?

ANSWER:
The following blocks read the system time an convert the minutes, hours etc. into
the String data type or Int data type. You can then map the corresponding FB to
WinCC where you can access the variable.

! Warning

The year is specified as two digits, therefore the transition from 99 to 00 must be
ensured in further programming (transition from 1999 to 2000).

Proceed as follows:

1. In the source container generate a new STL source and open it.

2. Copy the source text (see below) either for conversion into String
(FUNCTION_STRING) or Integer (FUNCTION_INT) and match the FB
number.

3. Insert the SFC 1 (Read clock) in the CFC and delete it again (SFC is now in
the Off-line block container).

4. For conversion into String: insert the FC 16 (I_STRNG) in the CFC and delete
it again (the FC is now in the Off-line block container).

5. Compile the source.

6. Insert the FB in the CFC, compile and load the CFC. Map your project to
WinCC.

7. Switch the variable in WinCC to an I/O field, for example.

AWL block for the data type STRING (German comment). Example with absolute
local data programming. This is the optimum solution with regard to time and
memory:
FUNCTION_STRING1.pdf (4 KB)

AWL block for the data type STRING (German comment). This example works with
symbolic programming:
FUNC_STRING_SYMBOLIC.pdf (5 KB)

AWL block for the data type INT (German comment). Example with absolute local
data programming. This is the optimum solution with regard to time and memory:
FUNCTION_INT1.pdf (3 KB)

AWL block for the data type INT (German comment). This example works with
symbolic programming:
FUNC_INT_SYMBOLIC.pdf (3 KB)
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13.1.4 System attributes with string variables as IN_OUT parameters

Entry ID: 1965123 - Date: 03/13/2000

QUESTION:
Why can’t I assign any system attributes with string variables as IN_OUT
parameters in the SCL?

ANSWER:
You are using string variables as IN_OUT parameters in SCL. Now you want to
assign system attributes for them. When you start the program compiler, you get
the following error message:

The Help of the message that appears indicates that it is possible to declare
system attributes for in/out parameters. 

You must note, however, that the system attributes for in/out parameters can only
be assigned for elementary data types (REAL, BOOL etc.).
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13.1.5 Converting from the TIME to the REAL format

Entry ID: 1965158 - Date: 03/13/2000

QUESTION:
How can I convert in SCL from the TIME to the REAL format?

ANSWER:
Here is an example of how in SCL you can convert from the TIME to the REAL
format:

FUNCTION FC113:REAL

VAR_INPUT

TIME_INPUT: TIME;

END_VAR

BEGIN

FC113:=DINT_TO_REAL(TIME_TO_DINT(TIME_INPUT));

END_FUNCTION

13.1.6 SCL compiler reports "Invalid input, in/ out, output parameters"

Entry ID: 1965818 - Date: 03/13/2000

QUESTION:
The SCL compiler aborts with the following error message "Invalid input, in/ out,
output parameters", "Invalid assignment", "Incomplete assignment of input
parameters". What could be the cause of this?

ANSWER:
This error message of the compiler is output when the keywords are used
incorrectly in the program.

Example:
Name of an input variable = "OK". OK is a keyword (flag) that indicates whether the
assignments of a block have been processed without error. A list of all the
keywords is given in the manual "Programming SCL for S7-300/400 blocks",
6ES7811-1CA02-8AA0. The error message can also occur if a defective STL block
is imported and incorporated in CFC. You must then clear the cause of the error
directly in the STL source and reimport the block.
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13.1.7 PCS 7 V4.02 (SCL V4.01) error message: "Not enough main
memory available"

Entry ID: 1985425 - Date: 03/13/2000

QUESTION:
What is the cause of the error message "Not enough main memory available" from
the SCL compiler?

ANSWER:
This error occurs when compiling the CFC. The cause can be that a task FC needs
more local data than is available. This is an FC for a time interrupt OB in which all
the functions of the OB are called. This is too big in this case.

Remedy:
Split the program (OB) up into several run groups. Then a task FC is created for
each run group. See also FAQ with Entry ID 771569.

13.1.8 Sample program: constructing an edge trigger flag in SCL

Entry ID: 2211262 - Date: 04/20/2000

QUESTION:
How can you construct an edge trigger flag in SCL?

ANSWER:
The following SCL source implements the behavior of the "FP" and "FN"
command that is only available in STL. You should however note that this
sequence requires a longer runtime in SCL than the single command in STL: If you
have time-critical requirements to fulfill, it is recommended to resort to the STL
programming.

Please note that implementation of the RLO memory bit is not in the local data,
because it can have an undefined value with each new cycle.

Insert external source in the SIMATIC Manager:
Copy the Flanke_ok.exe file into a separate directory and then start it with a
double-click. Import the file into the source container in the SIMATIC Manager via
the menu Insert > External Source.

Flanke_ok.exe (30 KB)

Note

The sample program is freeware. Every user can use, copy or forward this
program FREE OF CHARGE. The authors and owners of this program take no
responsibility whatsoever for the functionality and compatibility of this software.
Use of the software is entirely at the users own risk. Since this software is free of
charge, there is no warranty, nor claim for error correction and hotline support.
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13.1.9 Determining the calling OB

Entry ID: 674623 - Date: 12/04/1998

QUESTION:
How can I determine the OB from which my function block was called?

ANSWER:
You can call the SFC6 (RD_SINFO) in your function block. The NUM components
of the TOP_SI structure contain the number of the OB from which the function
block was called. The enclosure contains a sample program.

SCL_GetOB_e.pdf (3 KB)

13.1.10 How can you access a bit of a variable in SCL?

Entry ID: 677106 - Date: 12/04/1998

QUESTION:
How can I access a specific bit of a variable in SCL code?

ANSWER:
You must create an AND or OR link between the variable and a constant.

1. Determining a bit in a variable:
Create an AND link between the variable and a constant in which only the bit
required is set. Compare the result for non-equality (<>) to 0.

2. Setting the bit of a variable:
Create an OR link between the variable and a constant in which only the bit
required is set.

3. Resetting the bit of a variable:
Create an AND link between the variable and a constant in which all the bits
except for the one required are set.

In the attached example bit 0 of the IN1 variable is written to the bit 0 variable,
and bit 1 of the OUT1 variable is set to the value of the bit 1 variable.

SCL_Bit_Access.pdf (3 KB)
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13.1.11 Converting the Integer format into S5Time

Entry ID: 740125 - Date: 02/03/1999

QUESTION:
How can I convert the Integer format into S5Time?

ANSWER:
Here is an example of how to convert the Integer format into S5Time:

FUNCTION FC1 : VOID

VAR_TEMP

test_i:int;

test_s5t:s5time;

END_VAR

BEGIN

test_s5t:=FC40(IN:=DINT_TO_TIME(INT_TO_DINT(test_i)));

END_FUNCTION

13.1.12 Converting WORD to REAL

Entry ID: 771453 - Date: 03/22/1999

QUESTION:
How can I convert WORD to REAL?

ANSWER:
The FUNCTION_BLOCK FB201 converts WORD to REAL. It converts the WORD
input "Input_W" into the REAL output "Output_R".

VAR_INPUT:
Input_W : WORD; END_VAR

VAR_OUTPUT:
Output_R : REAL; END_VAR

BEGIN:
Output_R :=
DINT_TO_REAL(DWORD_TO_DINT(WORD_TO_DWORD(Input_W)));
END_FUNCTION_BLOCK
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13.1.13 PCS 7 V4.02 - SCL new keywords

Entry ID: 771583 - Date: 03/22/1999

Problem:
In the IEC1131-3 standard, keywords were newly defined in version V4.02. These
are not to be used as variable names.

ANSWER:
The keywords are as follows:

AT
PROGRAM
END_PROGRAM

You should therefore check upon project migration from older PCS 7 versions
whether these new keywords are declared as variables in the self-created SCL
sources. If yes, you must rename these variables and recompile them. Otherwise
you will get error messages when compiling project changes under PCS 7 V4.02.

Examples of typical error messages:
"Identifier missing or invalid"
"Invalid statement"

13.1.14 Number of inputs/outputs on a block described in SCL

Entry ID: 833183 - Date: 04/28/1999

QUESTION:
How many inputs and outputs can I fit in a block described in SCL?
And is there a difference between the number of IN/OUT variables and string
variables?

ANSWER:
In the case of FBs you must not exceed the maximum length of the associated
instance DB (e.g. 16K for CPU416). The sum is made up of all the variables. In the
case of FCs you must not exceed the permissible length for the local stack. The
size of the local stack is given in the relevant technical data for each CPU.

• CPU414-2 DP: local data = 8 Kbytes

• CPU416-2 DP: local data = 16 Kbytes for order number 6ES7 416-2XK00-
0AB0

• CPU416-2 DP: local data = 16 Kbytes for order number 6ES7 416-2XL00-
0AB0

• There is no difference in the number of IN/OUT variables and string variables.
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13.1.15 Using ANY pointer with communication blocks

Entry ID: 903656 - Date: 06/29/1999

QUESTION:
How should the memory area (byte 6) of the ANY pointer (SD_1) be configured for
the AR_SEND block (SFB37)?

ANSWER:
In the general description of the ANY pointer the following is written in the
documentation:

For the memory area (byte 6) of the ANY pointer enter B#16#84 for data blocks
and in the same place B#16#85 for instance data blocks.

If you are using the ANY pointer in conjunction with communication blocks such
as AR_SEND, then there are restrictions. The AR_SEND does not distinguish
between data blocks and instance data blocks. For this reason you must always
enter B#16#84 for the AR_SEND for access to data blocks or instance blocks. The
setting B#16#85 for the ANY pointer (SD_1) is not permitted by the AR_SEND
block.

13.1.16 Calling FBs and FCs in SCL Code

Entry ID: 906647 - Date: 06/30/1999

QUESTION:
How are FBs and FCs called in SCL code?

ANSWER:
The following example shows how you call FBs and FCs in SCL code:

Example:
FUNCTION_BLOCK FB1
VAR_INPUT
IN1 : BYTE;
IN2 : WORD;
END_VAR
VAR_OUTPUT
OUT1 : WORD;
END_VAR
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BEGIN
// Statement part
;
END_FUNCTION_BLOCK

FUNCTION FC1 : INT
VAR_INPUT
IN1 : BYTE;
END_VAR
VAR_OUTPUT
OUT1 : ANY;
END_VAR

BEGIN
// Statement part
FC1 := 100;
END_FUNCTION

FUNCTION_BLOCK FB3

VAR
VAR_BYTE : BYTE;
VAR_WORD : WORD;
VAR_INT : INT;
VAR_ARRAY: ARRAY[1..10] OF BYTE;
SYMB_FB1 : FB1; //Or: SYMB_FB1 : <symbolic name of the FB1 from symbol
table>
END_VAR

BEGIN
SYMB_FB1(IN1:=VAR_BYTE, IN2:=VAR_WORD);
VAR_WORD := SYMB_FB1.OUT1;
VAR_INT := FC1(IN1:=VAR_BYTE, OUT1:=VAR_ARRAY); //Warning: with FC or
SFC all the parameters must be activated
END_FUNCTION_BLOCK
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14 BATCH flexible

14.1 Basics

14.1.1 Changing a recipe parameter during a BATCH run

Entry ID: 1013795 - Date: 08/24/1999

QUESTION:
How can I change recipe values during a Batch?

ANSWER:
In order to change recipe parameters during the Batch run you need the new
function "Operator Dialog" in conjunction with ’$’ variables.

Proceed as follows:

1. Define a new AF7OD type and enter a name and the number of parameters.

2. Define the required setpoint and actual values, and check the reference of the
setpoint value to the actual value ("Actual ref." column).
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3. Create a new AF/OD instance and select a unit and the AF/OD type that you
created before. If you use an OD, the field for the process variable name must
remain empty. If, on the other hand, you use an AF, then you must make a
valid entry.
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4. Open the parameter table and, if necessary, enter limit values and presettings.

5. Define the ’$’ variables in the header parameters of the new recipe.
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6. Insert an operator dialog in the recipe and select the associated setpoint
values for the ’$’ variables.
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7. After the recipe has been released for production, insert a new batch, select
the correct recipe and define the values of your ’$’ variables.

8. Start Batch Control and activate the batch.
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9. Now, when the batch reaches the operator dialog, you can change the actual
value. This is then transferred to the associated setpoint values by pressing the
Input button.
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After leaving the operator dialog with OK, the changed values overwrite all the
linked ’$’ variables.
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14.1.2 Changes in the Object Manager are not accepted (V4.02)

Entry ID: 1986746 - Date: 03/13/2000

QUESTION:
Why are changes in the BATCH flexible Object Manager (e.g. user rights) not
accepted?

ANSWER:
After installing BATCH flexible V4.02 you have made changes in the BOM (e.g.
changes in the rights of user groups). It might happen that these rights are not
accepted when you do a BOM restart (at least not for standard entries). You notice
this externally in that you have system initialization for a certain time each time you
restart the BOM. The cause of this is the following Registry entry:

"HKEY_LOCAL_MACHINE\SOFTWARE\SIEMENS\BATCH flexible\V
4.0\General\System Init"

This value must be 0, otherwise the default settings are entered each time in the
BF project database. Proceed as follows to change the relevant Registry entry:

1. Start menu > Run, enter regedit.

2. Find the code:
HKEY_LOCAL_MACHINE\SOFTWARE\SIEMENS\BATCH flexible\V
4.0\General\System Init

3. Set the value to 0 (Right-click/Change).

Notice

In general, no warranty can be given for direct changes in the registry database,
because this is entirely the responsibility of the user. In any case it is
recommended to make a backup of the registry before proceeding as described
below. Furthermore, these settings are computer-specific. This means that when
copying the project to another computer, the settings have to be made again.

14.1.3 Missing measured value display in the batch protocol

Entry ID: 2361787 - Date: 06/06/2000

QUESTION:
Why are no measured values displayed in the batch protocol?

ANSWER:
If the BATCH flexible client (BATCH flexible single station installation) is ahead of
the server by a few minutes, then BATCH flexible attempts to access an archive
area that does not yet exist. This is why time synchronization is absolutely
necessary for BATCHflexible in a WinCC client-server configuration.
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14.1.4 Empty BOM after starting the BOM via the desktop icon

Entry ID: 679193 - Date: 12/08/1998

QUESTION:
Why is the BOM (Batch Object Manager) empty when I start it via the desktop
icon?

ANSWER:
After starting the BOM via the desktop icon or via the Windows NT Start menu the
BOM is empty. All the fields are gray, the application window cannot be opened.
The current Windows NT user is not known in the BOM.

Possible causes:

• You have probably forgotten to set up the current Windows NT user in the
BOM the first time you called the BOM.

• The user logged into Windows NT is not yet set up in the BOM.

Solution:
In both cases you can open the BOM via WinCC runtime. A user must be set up
beforehand in WinCC and this user must be known in the BOM. If you open the
BOM normally via WinCC, you can set up new users (Windows NT user).

The following are already available by default in BATCH:

• Automation engineer

• Plant manager

• Operator

• Senior shift engineer

• Superuser

• Process engineer

14.1.5 Using Dollar variables

Entry ID: 679496 - Date: 12/09/1998

QUESTION:
How can I use dollar variables with BATCHflexible?

ANSWER:
$ variables (dollar variables) are used for subsequent adaptation of a recipe
parameter. By using dollar variables you can still influence the recipe parameters of
a batch.

$ variables are to be configured as follows:

1. Open the header parameter of the recipe.

2. Select the $ variables tab.

3. Enter an $ variable here.

4. Assign ID, type, value, unit and mandatory input. If the mandatory input field is
selected, then the operator is obliged to enter a value when planning a batch.
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! Warning

$ variables can subsequently only be assigned to recipe parameters that have the
same unit/ type.

5. Open an AF of the recipe.

6. Double-click the "$" to assign all those $ variables that have the same unit and
type to the AF parameter.

7. Store the recipe and release for production.

8. Plan the patch according to the recipe created.

Now the system prompts you to enter the values for the $ variables.

14.1.6 Configuration of the AF status word

Entry ID: 680601 - Date: 12/09/1998

QUESTION:
What is the configuration of the AF status word with BATCHflexible ?

ANSWER:
If you program your own automation functions without using SFC_CTRL, then you
must emulate the status word for the AF block. It has the following configuration:

 Bit No.  Meaning  Bit No.  Meaning

0 IDLE 16 QCMODINI

1 RUN 17 QCMOD

2 TERM 18 res

3 HELD 19 res

4 ABORT 20 T_OPRQG

5 res 21 res

6 res 22 res

7 res 23 res

8 res 24 res

9 res 25 res

10 res 26 EXEC_ERR

11 res 27 S_ERRG

12 res 28 LI_ERR

13 res 29 OP_ERR

14 res 30 QEXT_ERR

15 res 31 ERROR
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The BATCH-relevant statuses are bit-coded as follows:

Bit 0 IDLE

Bit 1 RUNNING

Bit 2 TERMINATED

Bit 3 HELD

Bit 4 ABORTED

Bit 5 READY

Bit 17 Automatic

Bit 31 ERROR

READY and ERROR can be used parallel to other bits.

Notice

AF must be set to Automatic (Bit 17 = 1).

A flow chart for a self-terminating and one for a non-self-terminating automation
function are in the current readme file of BATCHflexible.

14.1.7 Installing a BATCHflexible database on another computer

Entry ID: 680688 - Date: 03/14/2000

QUESTION:
How can I install a BATCHflexible database on another computer?

ANSWER:
BATCHflexible permits only one BATCH project on a computer. Sometimes,
however, it is necessary to install an existing project on a different computer.

Solution:

1. To be on the safe side, make a back-up copy of your project. Delete the
original BATCH database directory "Siemens\BATCHFLEXIBLE\BFdata".

2. Now copy the new database directory "BFdata" that you have copied
beforehand from the original computer into the folder
"Siemens\BATCHFLEXIBLE".

3. You might have to transfer the BATCH database file (see Note).

4. Open the BOM and remove all entries under "Applications". This is necessary
because these entries still have the name of the original computer. Then start
the following BATCHflexible applications from the path
"Siemens\BATCHFLEXIBLE" via the Explorer (BFCDV__X.exe,
BFCPL__X.exe, BFCST__X.exe, BFRECEDX.exe, Bfrecgnx.exe, in the case
of a multi-user project also BFBROKRX.exe). The applications are now
entered in the BOM with the correct computer name.
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Notice

The name of the BATCH database is defined upon installation of BATCHflexible
(the default name is "Project1.db"). When copying external BATCH databases you
must always use the database name that was defined by BATCH at installation.
You can determine this database name as follows:
Start\Settings\Control Panel\BATCH flexible\Project Configuration

14.1.8 Batch cannot be deleted

Entry ID: 680720 - Date: 12/08/1998

QUESTION:
Why can’t a specific batch be deleted?

ANSWER:
During start-up, batches that test individual automation functions (AFs) are usually
used. If you want to delete these subsequently, then these batches have to be
terminated in an inconvenient manner and exported. If you set up a user belonging
to the "Superuser" user group, then this superuser can easily delete batches at any
time. The "Superuser" group has rights that you cannot assign individually to any
other user via the Rights dialog.

14.1.9 Linear adaptation

Entry ID: 724540 - Date: 01/22/1999

QUESTION:
How do I use the "Linear adaptation" function?

ANSWER:
Recipes are generally created independently of a fixed quantity. All the parameters
refer to the standard batch of the recipe. The actual quantity will differ from this
however (restricted by the upper and lower limits).

Example:

Head parameter: Standard batch: 10

Min. quantity: 1

Max. quantity: 100

AF: AF parameter: Rated value_A: Value: 1

Adaptation: linear

Rated value_B: Value: 5

Adaptation: linear

Rated value_C: Value: 10

Adaptation: linear
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Batch_A: Quantity: 1 Rated value_A: 0.1

Rated value_B: 0.5

Rated value_C: 1

Batch_B: Quantity: 5 Rated value_A: 0.5

Rated value_B: 2.5

Rated value_C: 5

Batch_C: Quantity: 10 Rated value_A: 1

Rated value_B: 5

Rated value_C: 10

The rated values are calculated depending on the standard batch and the value of
the AF parameter, and are then written to the outputs of the AF block.
The value of the recipe parameter is derived from the following equation:

Rated value = Value * Quantity / Standard batch

14.1.10 Configuring steps with BATCHflexible

Entry ID: 765094 - Date: 03/01/1999

QUESTION:
What should I watch out for and do when working with BATCHflexible?

ANSWER:
Always read the readme file before installing BATCHflexible.
In the following the different steps required for configuring are described in brief:

• Configure batch blocks UNIT, AF, TRANS in the ES-CFC.

• Configure the AF function level (processing level) in the ES-SFC.

• Compile the CPU in the ES-CFC.

• Map project in the SIMATIC Manager.

• Export into *.bsf file in the ES-CFC.

• Start BOM.

• Create users, user groups with rights. You must create at least one user that is
call exactly the same as the user in WinNT. You must also create this user in
WinCC. You can individually assign the users a selection of all the functions
from all the editors.

• Read in configuration data.

• Check configuration data.

• Enter production data:
You must enter products and if necessary, create units (setpoint values). The
category of Secondary and Raw Materials is primarily of relevance for
superimposed product planning systems. The input of qualities is optional.

• Supplementing system data:
You must enter the setpoint and actual value designations, and units of the AF
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types. Under Measuring Points you can select WinCC archive variables that
can later be assigned to the recipe, and supplied with the configuring of a
batch. The requirement is that you start the BOM via WinCC.

• Configuring steps in the recipe editor:

1. Create new recipe.

2. Start recipe editor.

3. Create SFC structure

4. Assign AF and enter setpoint values, and if necessary, configure transitions.

5. Fill in recipe head.

6. Save recipe and release for production.

7. Exit recipe editor.

8. Entering qualities is optional. All other entries must be made:

- Product

- Quantity

- Standard batch: in the case of parameters with matching this is the
reference quantity

- Minimum batch: minimum product quantity

- Maximum batch: maximum product quantity.

- Unit: unit of the product.

In Device assignment you can define whether a device is occupied at the Start of
a batch and for the total runtime, or is only occupied when needed for the first
time in a batch. You must enter the required setpoint value in the column
designated with the value. If you want, under "Matching" you can configure scaling
of the parameter with reference to the standard quantity. By default there is linear
and quadratic matching available. Under "Operator Statement" you can enter
Notes for the operator as static text. This note text is displayed as you choose
either before or after the start or run of the AF with or without requirement to
acknowledge. $ variables are wildcards that you can configure instead of explicit
setpoint values. In such cases you use the actual values only when planning a
batch. Make sure here that the units of the $ variables and the AF setpoint values
that are to be replaced by the $ variables are the same.

• Configuring steps in batch planning:

1. Start batch planning.

2. Insert batch.

3. Fill in mask displayed.

4. Release batch.

5. Exit batch planning.

Automatic that the batch will be started as soon as all the devices concerned are
not occupied by other batches. There is no relation at start time. Furthermore,
you have the option of linking several batches (right-click, set concatenation).
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• Now go to WinCC (RUNTIME mode) and execute the following steps in this
order:

1. Start batch control from WinCC.

2. Open batch.

3. Start batch.

4. Monitor batch.

5. Exit batch control.

You must start batch control via the standard keyset of WinCC. This then displays
the batch status list. Double-clicking a batch opens the above Detail View with the
associated operating options. Several batches can run in parallel. Before starting
the batch or in the STOP status you can change the structure and parameters.
The difference between STOP and STOP IMMEDIATELY is as follows:

1. STOP: the batch is stopped, i.e. all active AFs are completed and then the
batch stops.

2. STOP IMMEDIATELY: the batch is stopped and all the active AFs are stopped,
i.e. the SFCs linked to the AFs are stopped.

Devices and automation functions can then only be started by a batch if not
occupied by another batch. Automation functions must also be in Automatic so that
the batch control can work (SFC in AUTO).

• Proceed as follows to print the recipes and batches:

1. Start BOM.

2. Print recipes and batches.

3. Exit BOM.

! Warning

You can reach step controllers from the STOP status by setting run marks. If you
do not remove the existing run marks, both these and the newly set run through
the recipe. You should therefore protect this function with appropriately high
authorization.

14.1.11 Deleting aborted batches

Entry ID: 769197 - Date: 03/16/1999

QUESTION:
How can I delete aborted batches?

ANSWER:
You must log on as super user to be able to delete aborted batches. The super
user has rights that cannot be assigned to any other user. These rights include the
authorization to delete aborted batches.
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14.1.12 Getting database into initial state

Entry ID: 769463 - Date: 03/16/1999

QUESTION:
How can I get my BATCHflexible database (V 4.01.1) back to its initial state?

ANSWER:

! Warning

If you reset your database to its original state, all the BATCHflexible configuring
data is lost.

Proceed as follows:

1. Delete the files "Bfini__x.log" and "<Projectname>.db" in the directory
"..\Siemens\BATCHflexible\Bfdata".

2. Copy "bfini__x.db" into the directory "..\Siemens\BATCHflexible\Bfdata" and
rename the copy "<Projectname>.db".

3. Start the BOM from the DeskTop. The database opens.

4. Start all the BATCHflexible applications from the Explorer. Now the
applications automatically enter themselves in "Bfini__x.log".

14.1.13 Release of batches

Entry ID: 769484 - Date: 03/15/1999

QUESTION:
Why are batches released in different ways in the Object Manager and Batch
Planning?

ANSWER:
First you must create a recipe in a batch in order to make it run. You can create
this batch in the Object Manager or in the "Batch Planning" option package. A
batch must be released before you can start it.

The release of a batch in the Object Manager and in Batch Planning is different.

• In the Object Manager the batch is released automatically when it is created.

• In Batch Planning a created batch must be released manually.

Background:

• In the BATCH Object Manager you cannot plan batches, but only create 1
batch at a time. Creating a batch includes automatic release. You need this
functionality if you have not procured the "Batch Planning" package.

• In Batch Planning you can plan batches. Once created you can
change/replan a batch until you explicitly make a manual release. An implicit
release would destroy the planning functionality.
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14.1.14 Necessity for creating names

Entry ID: 769687 - Date: 03/15/1999

QUESTION:
In the readme file for BATCHflexible version V4.02 it says that the three
hierarchical levels to be created must be name forming. But why is it no longer
necessary to have name forming for the new batch version?

ANSWER:
In configuring guidelines for version V4.02, which must be followed for an
automatic migration of V4.02 projects to version V5.0, it says that the first 3 levels
of the Technological Hierarchy must be name forming (’Name is component of the
system ID’).

When these guidelines were drawn up, it was necessary to have this restriction.
The further development of BATCH flexible V5.0 has shown that the restriction is
no longer absolutely necessary. This means that you can label the TH containers
as non-name-forming. If you deselect name forming, you must however ensure
that the TH container is unique. The uniqueness is no longer checked by the
system if name forming is deselected. This can lead to problems with
BATCHflexible.

14.1.15 Importing process values into the batch protocol

Entry ID: 770032 - Date: 03/16/1999

QUESTION:
How can you import process values into the batch protocol?

ANSWER:

1. Create an archive in Tag Logging along with associated variables. Make sure
that archiving is not done too often, otherwise the batch protocol will become
very large. The cyclic archive must be at least as big as required for processing
the batch.

2. In the BOM under System data > Measuring points select the relevant
archive and measuring point, and assign them to a device.

3. In the header parameter of the recipe insert the measuring point of the batch
data recording for which a protocol is to be made.
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14.1.16 BATCHflexible: time-controlled starting of batches

Entry ID: 794369 - Date: 03/22/1999

QUESTION:
Can I create batches with a planned start or end time, and automatic start mode?

ANSWER:
Yes, but with the PCS 7 versions <=4.02 you cannot define a start time yet. It
starts as soon as you answer "Yes" to the following question when starting the
batch controller:

"Should processing of batches be started in automatic mode?"

If you answer "No", all batches set to automatic mode wait until the menu item
"Start controller processing" has been set in the batch controller. They then start
immediately according to their sequence numbers or links. The time-controlled start
of batches is planned for future versions.

14.1.17 Batch-specific archiving of process data

Entry ID: 831535 - Date: 04/28/1999

QUESTION:
How can I achieve batch-specific archiving of process data?

ANSWER:
In PCS 7 version V5 it is planned that the system supports batch-specific archiving
of process data.

With the current PCS 7 version V4.02 you can use the workaround described
below.

In WinCC Tag Logging you already have the option of starting and stopping the
archiving of process variables based on an event. As "Start event" you use the
start bit in the status word of the AF block (QSTART). As "Stop event" you use the
terminated bit (QTERM).
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1. Open Tag Logging in WinCC.

2. Insert a process value archive.

3. Mark the process value you want to archive.

4. Right-click Properties.

5. The following dialog box opens:
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6. Set the Archiving type to Cyclic-selective.

7. Select the Events tab.
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8. In the "Events" dialog box enter the events at which archiving is to be
triggered.

Start Event

Here you select a function that gives the value TRUE or FALSE. The function
represents the status of the start bit (QSTART) on the AF block. If the value is
TRUE, archiving can start. Using "Select" you can select and enter actions from a
list.

Stop Event

Here you select a function that gives the value TRUE or FALSE. The function
represents the status of the terminated bit (QTERM) on the AF block. If the value is
TRUE, archiving is stopped. This function is dominant over that under "Start
Event". Using "Select" you can select and enter actions from a list.
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Dynamic

By Dynamic is meant the dynamic changing of times. This provides the option of
changing the archiving or collecting time when a specific event occurs (the function
entered gives the value TRUE).

14.1.18 Using self-defined parameter types

Entry ID: 857832 - Date: 07/30/1999

QUESTION:
Can I use self-defined parameter types?

ANSWER:
You are using the standard parameter types (floating-point number, contents, text)
that are already available by default in the system data. Now you also want to use
self-defined parameter types. Such parameter types are specially tailored to
systems. These systems can be, for example, motors or valves and their
addressable states. You can create and process the parameter types in the system
data:
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When you have set your own parameter types, you must assign them to the
relevant rated values (system data AF/OD types):
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In the system data "AF/OD Instances" you can define presettings for the individual
rated values. These are used in the recipe when the AF is subsequently installed:

In the recipe itself you can change the values of the recipe parameters:

Advantage of using your own parameter types:
The recipes are clearer. You can define logical names (e.g. "OPEN", "CLOSED")
for actuator states instead of working only with floating-point numbers. This makes
it easier for you to make a change or simply monitor a running batch.
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14.1.19 Printing to file from the Batch Object Manager

Entry ID: 897482 - Date: 06/28/1999

QUESTION:
What should I watch out for if I want to print to file from the Batch Object Manager?

ANSWER:
You want to print to file from the Batch Object Manager. If you wait until the box
opens in which you enter the file name, you can no longer operate WinCC and
Batch. The print job creates a second window, one for the file name and one for
aborting the process. Since the window for making the entries is always in the
center of the screen, the superimposed BOM (Batch Object Manager) can no
longer be used.

Remedy:
Reduce the size of all the batch applications from which you wish to print to under
half the size of the screen.

14.1.20 Batch Data Management generates message: "No connection to
WinCC alarm logging. Application is closing" for BATCH flexible
version 4.02 or higher

Entry ID: 904025 - Date: 06/29/1999

QUESTION:
Why does Batch Data Management generate the message "No connection to
WinCC alarm logging. Application is closing" upon terminating the WinCC RT?

ANSWER:
Upon terminating WinCC RT you get the following message:

Batch Data Management is started in conjunction with the Batch Control as a
background task and is terminated only under the following conditions:

• When no Batch Control is active

• When all terminated batches are complete

• When there are no more released charges are available.
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In version V4.02 and higher Batch Data Management not longer retrieves the
Batch Messages cyclically from the WinCC archive. This is for performance
reasons. Now Batch logs on with WinCC Runtime for receiving Batch Messages.
For this there must be the appropriate short-term archive available. In order for the
start message of a charge to be received as well, Batch Data Management must
take batches into account as soon as they are released. Without WinCC Runtime
Batch Data Management can no longer receive any messages and thus terminates
with the error message described.
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15 Windows NT Information

15.1 Basics

15.1.1 PCS 7 and Windows compatibility

Entry ID: 2334224 - Date: 06/27/2000

QUESTION:
How compatible are PCS 7 versions and the Windows NT 4.0 Service Packs?

ANSWER:
You must observe the following compatibility table when using Windows NT 4.0
and PCS 7:

 PCS 7 Version  Windows NT 4.0  Internet Explorer

+SP3 +SP4 +SP5 +SP6

V4.01 X - - - V3.02 *)

V4.02 X - - - V4.01 + SP1

V4.02/PrimergyServer - X - - V4.01 + SP1

V4.02/SP1 - - X - V5.0

V5.0/SP1 - - X - V5.0

*) included on the PCS 7 CD

PCS 7 does not work with Windows9x, Windows ME and Windows 2000.

15.1.2 Blue screen when booting Windows NT

Entry ID: 384261 - Date: 01/28/2000

QUESTION:
Computer with Windows NT doesn’t boot, but hangs with a blue screen. What
should be done?

ANSWER:
Remedy:

1. Check all the installed slot cards of the computer and the memory slots as to
whether they are correctly installed and that there are no contact problems.

2. Check whether the boot drive in the computer’s BIOS is correctly set (usually
drive C:). It is particularly recommended to check this setting after installing
SCSI devices.
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15.1.3 Settings for Dr. Watson on a WinCC or PCS 7 computer

Entry ID: 1765511 - Date: 01/12/2000

QUESTION:
What are the best settings to be made in Dr. Watson on a WinCC computer in
order to be able to receive the most useful information possible?

ANSWER:
Start the DRWTSN32.EXE program. This file is in the subprogram "..\System32" in
Windows NT. The configuration dialog for Dr. Watson opens. Make the following
settings in it:

You can install Dr. Watson as default debugger in your system.

1. Start the MS-DOS prompt.

2. Enter the instruction DRWTSN32.EXE -i

Dr. Watson enters itself as default debugger in the Windows registry under:

\\HKEY_LOCAL_MACHINE\Software\Microsoft\

Windows NT\CurrentVersion\AeDebug
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If there is a crash, you must wait until the OK and Cancel buttons are active in the
window that opens. You must acknowledge the dialog with OK. Then Dr. Watson
writes two files into the Win NT directory:

• USER.DMP and

• DRWTSN32.log

This files are important for the analysis of the crash causes. For detailed
information refer to the online Help for Dr. Watson.

15.1.4 Assignment of user rights under Windows NT

Entry ID: 2044843 - Date: 04/04/2000

QUESTION:
How do I assign user rights under Windows NT?

ANSWER:
If you want to assign user rights in a network domain, then you must get in touch
with your network administrator. If you want to assign local user rights on your
computer, then you can make the settings yourself.

Requirement:
You can only assign or set new users and user rights if you yourself have
Administrator rights. You need the relevant local "Administrator Login". Ask
your Administrator about this.

Under Windows NT there is the User Manager for the administration of user
accounts. The User Manager permits you to set and administer user accounts,
user groups and security regulations.



Windows NT Information

Process Control System PCS 7, Tips and Tricks
15-4 A5E00080064-01

Step 1: creating a new user account under Windows NT

1. Log on as Administrator.

2. Open the User Manager in the "Start" menu by clicking Programs >
Administration (General) > User Manager.

3. Click the User > New User menu.

4. Enter the relevant fields with the information required and set the options as
appropriate.
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Step 2: defining user rights for the new users

You define user rights in Windows NT by assembling the users in user groups or
assigning them to an existing user group. These user groups have different user
rights.

• Administrators: members can administer the computer without restriction. If
you want to install PCS 7, for example, you need to be a member of the
Administrators group.

• Power users: members can release printers and local directories. For the
work with PCS 7 you need to be at least member of the power user group.
You can also work as administrator. For security reasons it is better to log on
as power user for working under PCS 7.

Assigning a user to the "Power User" group

1. In the User Manager double-click the newly created user. The dialog box for
the relevant user opens.

2. In the opened dialog box click the Groups button. The Group Memberships
dialog box opens.
In the upper part of the dialog box you see the user name. In the Member of
field on the left you see the entries indicating the user groups of which the user
is a member. A newly created member is always member of the "Users" group.

3. From the Not member of field on the right you select the required
membership, in our example Power Users.
Alternatively, you select Administrators, if you want to assign administrator
rights to the user.

4. Click Add.

5. Close the dialog with OK. Close the dialog box for users.

Result:
You have created a new user. You have then assigned rights to the new user by
assigning the user a group membership.
Now close all applications and log on to your computer under the new user name
with the corresponding code word.
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15.2 Time Setting

15.2.1 Problems that arise when changing the system time

Entry ID: 2042303 - Date: 08/15/2000

QUESTION:
What should you watch out for when changing the system time? (Careful when
traveling across time zones)

ANSWER:
When changing the system time you should note that this might cause
considerable problems. Therefore always take appropriate safety precautions when
changing the time.

The effects that arise are not product-specific, but a characteristic of all systems
that archive using time stamps, control processes, sort or measure the time.
The problems increase with the size of the time period changed, the time during
which the system runs with the wrong time and the degree to which the time-
dependent functions are used.

The effects occur in particular when the clock of a system is set to a date in the
distant future, the system works a certain amount of time there and then the clock
is set back to the "current" time. Typical faults that occur under these
circumstances are, for example:

• Non-execution of processes up to the time to which the system was set in the
future.

• Current values are ignored.
Often databases are filled with values from the future. Current values thus
have a time stamp which for the database are way back in the past. The
current values are therefore either deleted or ignored.

• Creation of defective lists that use the time as sort criterion.

Example:

A PC system clock is set to a date that is three months ahead. The computer then
runs for several hours and is then set back to the "current" time.

The following effects might occur:

• The cyclically activated virus scanner might only be executed again after the
real time has passed the time to which the system clock has been set.

• During the time that the computer clock is set in the future the archiving
programs (e.g. Storage) delete or relocate all the values that appear to be
several months old.

• Values from the time period in the future are displayed as the latest entries in
lists and archives.

• In the case of full cyclic archives, the newly arrived data is recognized as "old"
values and deleted.
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• There are restrictions of NT system services such as directory replication
service, hard disk diagnostics, print job management, password expires,
summer time/winter time changeover etc.

Remedy:

Since changing the time can have numerous side effects which in turn influence
each other, it is not possible to make a general statement about the outcome for
the system. The safest way would be to set up the system anew.
In practice it can look like this:
Before changing the time, you create an image of your system and import it again
after making your tests.

15.2.2 Winter time/ summer time changeover when importing images

Entry ID: 2042075 - Date: 04/03/2000

QUESTION:
What should I watch out for with regard to the winter time/summer time changeover
when importing images?

ANSWER:
During the summer time (winter time) you have created a back-up file (Image) with
the complete image of your hard disk. When you import this image to a computer
whose system clock is set to a data with winter time (summer time), this might lead
to the system clock is set one hour back (forward) when the operating system
starts up.
The operating system obviously presumes that the computer has not operated for a
longer period of time and does the apparently overdue changeover of the PC real-
time clock.

! Warning

This behavior can lead to critical states of the system. There is a particularly high
risk if the computer concerned is used as time master.
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15.2.3 The time signal is not received correctly when using the DCF77
radio clock receiver

Entry ID: 1104199 - Date: 09/21/1999

QUESTION:
The LED flashes regularly every second. Why is the time signal nevertheless not
received?

ANSWER:
You have not installed the NT driver of the DCF 77 radio clock receiver properly.
You have correctly connected the radio clock to a COM interface. The LED flashes
regularly every second. Nevertheless the time signal is not received (in the event
display is the last event for DCF77 = DCF77 START/STOP time signal reception
too bad).

This might be due to a bad reception signal or due to the fact that the FIFO is
activated for the COM interface.

Remedy:

1. Press the Start button and select Settings.

2. Select Control Panel.

3. Double-click the Connections icon.

4. Select the COM interface to which the radio clock receiver is connected.

5. Click Settings and then Extended.

6. Remove the check mark from in front of the "FIFO activated" item.

7. Exit all menus with OK.

8. Restart the computer.
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15.3 Automatic Start-up

15.3.1 Automatic program start after computer start-up

Entry ID: 1995051 - Date: 03/23/2000

QUESTION:
How can I get a program to start automatically after computer start-up?

ANSWER:
In addition to the standard method in Windows of putting the program concerned in
the Autostart folder, you also have the option of entering the program permanently
in the Windows registry. Then it will always be executed regardless of the user
logged on.

The Registry entry concerned is as follows:
HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\
Run

Proceed as follows to add a program.

1. Start menu > Run, enter regedit.

2. Find the code:

HKEY_LOCAL_MACHINE\SOFTWARE\Microsoft\Windows\CurrentVersion\Run

3. Insert a new character string (right-click > new > character string)

4. Double-click the code just create and a window opens in which you must enter
the complete path of the application to be started, for example:
"C:\Programs\<<MyApplication.exe>>"

Notice

In general, no warranty can be given for direct changes in the registry database,
because this is entirely the responsibility of the user. In any case it is
recommended to make a backup of the registry before proceeding as described
below.
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15.3.2 Automatic restart of Windows NT

Entry ID: 1144448 - Date: 10/04/1999

QUESTION:
How can I trigger an automatic restart from "Exploring Windows NT" after a system
crash under Windows NT?

ANSWER:
You have a time-critical system, e.g. an Exchange Server. In the case of a system
crash, a blue screen is displayed showing the reason for the system crash and the
time it happened. The blue screen remains until the computer is restarted.

This situation is particularly critical with systems that have to be in operation round
the clock, as in your case. You can set NT so that a restart is triggered
automatically after a system crash. For this you must make the following Registry
entry:

1. Start menu > Run, enter regedit

2. Find the code:

HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\CrashControl\

3. Insert a new value (right click\new\DWORD-value)
AutoReboot ="1"

After this modification NT will execute a restart once the crash has been registered
in the protocol file.

Notice

Basically, no warranty can be given for direct changes in the registry database,
because this is entirely the responsibility of the user. In any case it is
recommended to make a backup of the registry before proceeding as described
below. Furthermore, these settings are computer-specific. This means that when
copying the project to another computer, the settings have to be made again.
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15.3.3 Auto Logon PCS7 V5.1 PCS7 Complete Package

Entry ID: 789370 - Date: 08/18/1999

QUESTION:
How can I start Windows and log on automatically without entering a password?

ANSWER:
Only if you have a complete package of PCS7, proceed as described below.
But if you have just the PCS7 software, please proceed as described in the FAQ
with

Entry ID 268796

Activating Autologon

1. Start the application "C:\Simatic.dsk\Autolog.exe"
The default setting in the "Windows NT Auto Logon Setter" is always "Set
Auto Logon". The default setting is independent of whether Auto Logon is
activated or deactivated. The changed setting is effective only after you have
restarted the computer.

2. Acknowledge the default setting with "OK".

3. Acknowledge the "Auto Logon enabled" message with "OK".

4. Restart the computer to make the setting effective.
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Deactivating Auto Logon:

1. Start the application "C:\Simatic.dsk\Autolog.exe".

2. Acknowledge the "Remove Auto Logon " setting with "OK".

3. Acknowledge the "Auto Logon disabled" message with "OK".

4. Restart the computer to make the changes effective.
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16 Support

16.1 Basics

16.1.1 Diagnosis data in the various LOG files as of V 3.x

Entry ID: 70612 - Date: 05/06/1997

QUESTION:
Are there any files with diagnostic data?

ANSWER:
As of Version 3.x the system creates files with diagnosis data in case of failures.
The system diagnosis administers the system messages and operating messages
of the WinCC applications and forwards them to the WinCC message system for
further processing.

The system messages are stored locally on the computer under the
path...\WINCC\DIAGNOSE in the CSV file format (comma separated value).

There are log books for the system messages:

1. Operating messages: WinCC_Op_xx.log

2. System messages during start-up: WinCC_SStart_xx.log

3. System messages during operation: WinCC_Sys_xx.log

4. License check: License.log

( xx == 01..99 )

The individual files of the log books are overwritten according to the cyclic buffer
principle, i.e. when the set number of files is reached, the oldest file in the log book
is overwritten. This guarantees that the log book only needs a fixed maximum of
storage space on the hard disk.

This is calculated as follows: number of files * size of the files
The size and number of the files can be set separately for each log book.

The settings are stored in the WINCC_LOG.INI configuration file in the WINCC\BIN
path.
The size of the log book files is set by default to 64 Kbytes.

An operating message is configured as follows:
Date, time, message number, computer, user, application, old value, new value,
variable status, operating reason

Variable status : 0 == rejected, 1 == accepted
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A system message is configured as follows:
Date, time, message number, class, computer, user, application, error text

Class : 1 == Information, 2 == Warning, 3 == Error

And some additional information on the entries:

 Component abbreviation:  Package:

WCCRT MCP runtime

PDLRT HMI runtime

TLGRT PDU runtime

ALGRT Message runtime

RPTRT Protocols

TXTRT Text library runtime

GSCRT Global scripts

SCRIPT Scripts

USERT Password monitor runtime

LBMRT Life beat monitoring (option package)

STRRT Storage (option package)

SAMRT Group display (option package)

16.1.2 LOG functions and on-line help for the S7 channel

Entry ID: 71580 - Date: 09/05/1997

QUESTION:
How can you diagnose connection faults in a S7 connection ?

ANSWER:

1. The WinCC-BIN directory includes the "S7CHN.TIS" file. In order to activate
the diagnosis function you must rename this file to "S7CHN.INI".

2. Now reboot WinCC (you do not have to restart the computer).

3. Activate WinCC-Project. At the latest at this point an additional file named
"S7CHN.LOG" should be created in the WinCC-BIN directory. You can view
this using a text editor. It contains information on the status of the connection
and any error codes.
If this file is not created, then very likely because the S7 communications driver
was not installed at the set-up of WinCC.

4. Now start the on-line help in the Control Center and look for the keyword
"S7..." in the Index. The entry "Error codes for connection faults” is displayed in
a selection list. Select it. The next page shows you the error codes and their
meanings which will help you to identify the fault.

5. If you find the fault, make sure to rename the "S7CHN.INI" file back to its
original name "S7CHN.TIS". Otherwise the logbook is permanently activated
which will affect system performance.
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16.1.3 File "Sql.log" fills the hard disk

Entry ID: 1957353 - Date: 03/09/2000

QUESTION:
The "Sql.log" file is so big that my hard disk is full and my computer stops. What
can I do about this?

ANSWER:
The "Sql.log" file logs each database movement. This means that the file continues
to increase in size until the hard disk of the computer is full and nothing more can
be written on it. The file is created when you select "Activate Tracing" in the Control
Panel.

Remedy:
Deactivate this option as follows:

1. Press the Start button and select Settings.

2. Select Control Panel.

3. Double-click the ODBC Data Sources icon.

4. In the "Tracing" tab there is a button marked "Stop Tracing Now". In the input
field under the button is the "Sql.log" file in which the database movements are
stored.

5. Click this button and the text then changes to "Start Tracing Now".
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6. Delete the "Sql.log" file.

16.1.4 Loading firmware after interruption of the loading procedure with
the CPs 343-1 xxx and 443-1 xxx

Entry ID: 770389 - Date: 03/17/1999

QUESTION:
How can I reload the firmware after the firmware loading procedure has been
interrupted (e.g. through power failure) and what should I watch out for?

ANSWER:
The firmware loading procedure can be interrupted, for example, by a power
failure or by a lost message. The communications processor can then no longer
be addressed by the NCM diagnostics. It might also happen that the LEDs no
longer light on the CP.

However, you can relaunch the firmware loading procedure. But you must make
sure here that the new functionality "Module replacement without PG" is
implemented on the communications processors. The system blocks are stored in
the CPU and this distributes them to the CPs. There, they are only stored in the
RAM. This means that when you restart firmware loading (after an interruption) in
these two operating modes, you must use a different MAC address in each case.
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Variations:

• If the SDBs are stored in the CP itself, you can trigger the loading procedure
by the firmware loader with the configured MAC address.

• If the SDBs are stored in the CPU, then the CP loses its MAC address after
the interruption. Then you must enter the emergency address for the firmware
loader. The loading procedure is then relaunched.
The emergency address is 00.00.AF.FE.00.00. But this is set by the firmware
loader independently after the relevant option is activated.

16.1.5 Removing configurations from AUTOSTART

Entry ID: 492345 - Date: 09/25/1998

QUESTION:
I call my configuration in AUTOSTART, the keyboard switchover is set in the
configuration. How can I delete the configuration from AUTOSTART?

ANSWER:
When you start up WINDOWS 95 press and hold the Shift key. This prevents any
of the applications from AUTOSTART being executed. Then you can remove the
configuration from AUTOSTART.

16.1.6 Installation of a CP5412-A2 communications processor under
WindowsNT 4.0

Entry ID: 771392 - Date: 03/22/1999

QUESTION:
What should I watch out for when installing a CP5412-A2 under WindowsNT?

ANSWER:

1. Before you insert the plug-in card for an ISA slot, you must first get an
overview of your computer’s free resources.
For this you call the WindowsNT diagnostics [Start > Programs >
Administration (General) > WindowsNT Diagnostics]. Compare the values here
for IRQ, I/O Port and Memory with the possible values for the CP5412-A2
(Installation Guide). Note the free areas of the system that the CP5412-A2 can
also use.
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2. On the card you now set the noted I/O area using the DIP switches (see table
in the CP’s Installation Guide). You can then insert the card.

3. The inserted card must be installed as PG/PC interface [Start > Settings >
Control Panel > Set PG/PC interface].
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4. Now enter the unoccupied values determined previously. Here you must match
the values entered for the I/O area with the values set on the card. Once you
have entered the values, you close the dialog boxes and choose the access
path {PCS 7 Standard: S7ONLINE (STEP7) > CP5412-A2(MPI)}. You then get
the following message:

5. Acknowledge with OK. If the reboot is successful, you can then communicate
via this access path.

6. If an error message is displayed during rebooting, or the operating system
issues any other warnings, you have several options for clearing the cause:
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You first do a cold restart of the computer.
Then you should check the entry of the CP5412-A2 card in the resources, i.e. the
corresponding set values are occupied by the CP5412-A2 (see first figure).

1. If the entry is not included, there must still be memory area and or address
conflicts. In this case you must now check in the BIOS whether the IRQ used
by the CP5412-A2 is actually released {when the computer starts, press F2 >
Advanced > PCI Configuration > ... Resource Exclusion}. In some BIOS
versions you have the option of reserving the IRQs for ISA slots. It is
recommended here.

2. These various settings should make it possible to receive the entry of the
CP5412-A2 in the resources (see first figure), because this is the basic
requirement for perfect functioning.

3. If the entries are included, you can test the access path [... PG/PC interface >
Interface used > Properties > Operating state]. Likewise, you must also
specify the MPI parameters of the computer here [... > MPI].

4. If there are still error functions despite occupying the resources through the
CP5412-A2, this can be remedied by deinstalling and reinstalling the CP5412-
A2 in the PG/PC interface.
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16.2 Bussystem Support

16.2.1 Bus Terminator for PROFIBUS

Entry ID: 187276 - Date: 07/28/1997

QUESTION:-
Is the Bus Terminator essential for PROFIBUS?

ANSWER:

PROFIBUS segments must be terminated at both ends with a terminating resistor.
The line terminator consists of a resistance array, which is integrated in the RS 485
repeater, the OLM (channel 2), the bus terminal and some bus connectors already.
If these components are used at the end of a segment, the terminating resistor
must be switched in. The line terminator shunts the bus cable with the
characteristic wave impedance to avoid line reflections. At the same time the
resistor assures a neutral signal level in the gap between two messages.

To enable the line terminator to become operational, it must be supplied with
voltage from the connected unit. Units that are not permanently in operation are
therefore unsuitable for the connection at the ends of segments.

In the case of the RS 485 repeater and the OLM (channel 2), the terminating
resistor is supplied via an integrated voltage supply of the unit.

Switching off the voltage supply of one of the two terminating resistors within a
segment by switching of the terminal device or repeater, or by removing the bus
connector, will not cause an error under normal conditions.

The immunity of the bus system against EMI is however reduced significantly, so
that this operating condition should be avoided.

We furthermore recommend that in environments with strong EMI, the terminating
resistor should be activated at both ends, even in the case of very short segments
(e.g. from OLM to terminal unit). In such cases the 830-1cable should not be used.

Further installation guidelines for PROFIBUS networks are contained in the Manual
for PROFIBUS Networks.

busabd.pdfbusabd.pdf (8410 Bytes)
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16.2.2 Bus connection with PROFIBUS PA

Entry ID: 187346 - Date: 01/12/1998

QUESTION:
How is the bus connected with PROFIBUS-PA?

ANSWER:
With C= 1uF and R = 100 Ohm in series between data lines A and B (pins 3 and
8).

16.2.3 Troubleshooting during data transfer via FDL connections

Entry ID: 187609 - Date: 07/14/2000

QUESTION:
What should I do if data transfer via FDL connections doesn’t take place?

ANSWER:
You can implement data transfer via FDL connections with all PROFIBUS CPs for
the SIMATIC S7. There can be several reasons for this data transfer not taking
place.

Possible causes:

• Connection configuration not loaded or cannot be started.

• The AG-SEND / AG-RECV blocks are not called or called with faults in the
user program.

• Your own PROFIBUS station is not in the network.

• The partner station cannot be reached or is not ready.

Information on troubleshooting is available via:

• NCM S7 PROFIBUS diagnostics.

• Status value of the blocks.

Fault locating procedure:

• Check that the connection configuration has been loaded.
You get this information most quickly in the NCM S7 PROFIBUS diagnostics
under Connections.
Under this diagnostics object are displayed the configured FDL connections
with their associated connection statuses.

• Also check under "Connections" whether or not data can be sent from your
own station.
If there are no send jobs visible, then the AG-SEND block call is defective.
If send jobs are running but defective, you have to evaluate the cause of the
fault. For this see the fault messages in the "Diagnostics Buffer" of the CP.
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16.2.4 Cable assignment for a "zero modem cable"

Entry ID: 2052628 - Date: 04/03/2000

QUESTION:
What does the cable assignment for a?

ANSWER:
You need an RS232 cable, a so-called "zero modem cable", to connect a PC/PG
(COM2) to the RS232 interface of a Windows CE device, for example. The
following figure shows the cable assignment for an RS232 cable of the type 6ES7
901-1BF00-0XA0, which is implemented as "zero modem cable".

Notice

Only if you use a cable of the type 6ES7 901-1BF00-0XA0 can you be sure that
the EMC requirements are met. If you use a different cable, there is no guarantee
for this and you do so at your own risk.

Note that you may only used shielded connector housings. The cable shield must
be connected on both sides over a wide area with the connector housing and
shielding line.

Nullmodem_Beleg_00_01_e.pdf (33 KB)

16.2.5 Loading firmware via SIMATIC NET CPs with NCM S7 PROFIBUS
V5.1

Entry ID: 2629830 - Date: 07/10/2000

QUESTION:
I am using NCM V5.1. Via which SIMATIC NET CPs can I load the firmware onto
PROFIBUS CPs in the S7?

ANSWER:
With NCM S7 PROFIBUS V5.1 you can load firmware onto PROFIBUS CPs in the
S7 via the following SIMATIC NET CPs:

• CP 5411

• CP 5511

• CP 5611

• CP 5613

• CP 5614

• CP 5412 A2

The interface parameterizations used CP5411(FWL), CP5511(FWL) and
CP5611(FWL) are already entered in the "Set PG/PC interface" tool after
installation of NCM S7 PROFIBUS.

If you want to load the firmware via a CP 5613/CP 5614 or a CP 5412 A2, please
proceed as follows:
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1. Install a SIMATIC NET product that supports the CP concerned (e.g. S7-5613
V2.1 from the SIMATIC NET CD May/2000)

2. Open the "Set PG/PC interface" program.

3. Copy the interface parameterization CP 5412A2(PROFIBUS) or CP
5613(PROFIBUS) or CP 5614(PROFIBUS)).

4. Designate the copy as follows: CP 5412A2(FWL) or CP 5613(FWL) or CP
5614(FWL).

5. Open the Properties of the entry and change the baud rate to 187.5 kbaud.

6. Change the profile to "Universal (DP/FMS)".

16.2.6 SIMATIC NET Firmware Loader in NCM S7 PROFIBUS

Entry ID: 583414 - Date: 10/14/1998

QUESTION:
How can I load the new firmware releases into the SIMATIC NET PROFIBUS-CPs
(SIMATIC S7 family) via PROFIBUS?

ANSWER:
Using the firmware loader in NCM S7 PROFIBUS you can load a "LOAD file" into a
SIMATIC NET CP via PROFIBUS with the CP5412 A2.
Loading firmware:
Start the program from the Windows 95 or Windows NT Start menu via the
function:
SIMATIC > NCM S7 PROFIBUS > Firmware loader.

Proceed as follows:

1. Select the firmware to be selected via the Search... button.

2. Select PROFIBUS direct as the interface via which you want to enter the
firmware.

3. Set a new PG / PC interface via the Change... button.
Select the CP5412A2(PROFIBUS) as "Module parameterization used
(interface parameterization)" > Copy... button.
As "New interface parameterization" you enter CP5412A2(FWL).

4. Follow the prompts in the dialog to prepare the operating status of the CP for
the loading process and to load the firmware.
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16.2.7 Using the "PING" command to find network users

Entry ID: 656932 - Date: 11/19/1998

QUESTION:
What does the "PING" command do?

ANSWER:
Using the "PING" command (ICMP ECHO Request/Reply) you can determine
whether a specific user is available on the network and ready for operation. The
PING command is therefore very useful when starting up network connections. You
can use it to attempt to send a specific message to the user concerned and wait a
specific time for the reply. If the PING call is successful, you can presume that the
physical connection and the TCP protocol stack are functioning correctly. In this
way you can exclude a large number of error sources.

Example:
You open a DOS window and want to reach the user concerned with the IP
address 192.111.0.55. For this you enter the following command at the DOS
prompt:

C:\>ping 192.111.0.55

You get the following response if the user is available for you. The times depend
on the characteristics and speed of your network and will not necessarily be the
same as in our example.

Pinging 192.111.0.55 with 32 bytes of data:

Reply from 192.111.0.55: bytes=32 time=234ms TTL=32
Reply from 192.111.0.55: bytes=32 time=1ms TTL=32
Reply from 192.111.0.55: bytes=32 time=1ms TTL=32
Reply from 192.111.0.55: bytes=32 time=1ms TTL=32

If the user concerned is not available, then you will get a response that looks
something like this:

Pinging 192.111.0.55 with 32 bytes of data:

Request timed out.
Request timed out.
Request timed out.
Request timed out.
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16.2.8 CP443-5 Extended overall reset via NCM S7 PROFIBUS
diagnostics

Entry ID: 686332 - Date: 12/21/1998

QUESTION:
Can I delete the CP443-5 Extended via NCM S7 PROFIBUS diagnostics?

ANSWER:
You can delete CP443-5 Extended via NCM S7 PROFIBUS diagnostics in the
"Operating status" tab using the supplementary button CP overall reset.

Reason:
As opposed to other CPs (e.g. 443-5 BASIC), with CP443-5 Extended the SDBs
are not loaded onto the CP.

Important:
For this process the S7-400 CPU must be in the STOP state.
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16.3 AS Support

16.3.1 Reloading the hardware configuration with changed bus
parameters via PROFIBUS

Entry ID: 1176690 - Date: 10/11/1999

QUESTIONS:
What should I watch out for when setting the bus parameters of the PROFIBUS
users?

ANSWER:
Perfect operation is only possible for you if the bus parameters are identical in all
the users connected to the PROFIBUS. If the you change the bus parameters of a
user, you must therefore reload the hardware configuration in all the modules
connected. This is only possible via PROFIBUS if you have just the module on the
network that is to be loaded in each case, otherwise bus errors occur (effect: for
example, CP342-5 boots continuously). One alternative is to reload the hardware
configuration via MPI.

16.3.2 Connection interruption when loading into the SIMATIC station

Entry ID: 897989 - Date: 06/28/1999

QUESTION:
When loading a SIMATIC station there is a connection interruption. What could be
the cause of this?

ANSWER:
If, when loading a SIMATIC station, there is a connection interruption, this could be
caused by an on-line command exceeding the timeout. In many cases you can
solve the problem by setting the timeout of the current protocol to a value greater
than 10 seconds in the "Set PC/PG interface" dialog in the Control Panel.

Proceed as follows:

1. Press the Start button and select Settings

2. Select Control Panel

3. Double-click Set PC/PG interface

4. Now press the Properties button

5. For TimeOut now select a time greater than 10 seconds

6. Press OK

7. Close the "Set PG/PC interface" dialog with OK

REASON:
Some SIMATIC NET CPs have a non-volatile memory to prevent loss of
parameterization data in the case of a power failure. The time to delete this
memory depends on the number of delete procedure performed to date. In the
case of "older" modules there can therefore be cases of the timeout being
exceeded in the transfer protocol between PC/PG and the SIMATIC station. These
are then reported as connection interruptions.
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16.4 OS Support

16.4.1 Link to WinCC not set up

Entry ID: 1790666 - Date: 01/25/2000

QUESTION:
SAPs (Service Access Point) and addresses are set correctly. Why then can’t I set
up the PROFIBUS link to WinCC?

ANSWER:
The most common reason is an incorrect setting of the PROFIBUS network
parameters. With PROFIBUS all users must have the same network
parameters. It is best to pick out one user, calculate the parameters and then
match the parameters of all the other users to them.

16.4.2 Diagnosis and system information with WinCC Scope

Entry ID: 850436 - Date: 07/21/1999

QUESTION:
Which tools does WinCC offer for diagnosis and system information?

ANSWER:
WinCC Scope is a possible tool for your system diagnosis which thus makes it
possible to check your system configuration, too.

Proceed as follows to implement WinCC Scope:

1. Install an Internet Explorer. You need the WINSOCK interface, so use the
TCP/IP protocol.

2. Configure the MS-Loopback as adapter (you will find the adapter under Start
> Settings > Control Panel > Network > Network Card > Add). In this way
the local computer can be addressed over a name (also local host).

3. Set up the network. Define the IP address and interface mask.

4. Start WinCC Scope with the CCDIAGAGENT.EXE file. You will find this in the
Explorer under "<DRIVE>:\SIEMENS\WINCC\WINCCSCOPE\BIN". This starts
the server. A small globe appears in the Icon Tray. Right click this globe to
configure the diagnostics agents.

5. Then start the diagnostics help via Start > Simatic > WinCC > Scope. The
start page of WinCC Scope opens.

6. Set the URL to http://Name if you want to work with the network and access
the WinCC computer from a remote computer. The name is the name of the
computer on which the WinCC application is running.
If you want to start WinCC Scope locally, select http://localhost with the
Internet Explorer or Netscape Navigator.
If you get the error message "DNS not available", you must make another
change in the Control Panel. Select Start > Settings > Control Panel >
Internet > Connection. In the "Proxy Server" field you must activate the item
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"Bypass the proxy server for local addresses (intranet)", if you have selected
the item "Set up connection via a proxy server".

WinCC Scope Home Page

You now see four links:
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• How to use the new Diagnosis Interface
You get information on how to use WinCC Scope and the requirements.

• More Information from the Internet
You get a page with more links to WinCC and Siemens Automation.

• http://localhost
Here you get your diagnosis information. If you cannot get a connection here,
select

• http://localhost 8000
The diagnosis agent now selects the port 8000. Its standard port address of 80
is then used for something else.

WinCC Diagnosis

1. WinCC Info
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You get information on your installed version of WinCC, the WinCC modules, a link
to the available diagnostic files (see below: System and Operating Messages),
settings of the Graphic Designer and available authorizations, network
authorizations, authorization information from the MCP Info File and the
authorization log file.

2. System Info

Here, under Hardware you get information on the BIOS, the network, the available
drives and the memory. Under Software you get information on your Windows
version, the installed software components, the known DLLs and OCXs and update
information. Under Event Logging you will find a list of the log files for the
applications, the protection and the system. Registry displays the registry
information.

3. A&D Software

Under A&D Software you get information on the database you’re using, on PCS 7
and WinCC Setup log file(s), for example the file C:\WINNT.400\CITAMIS.STR.
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4. Project Info

Under Control Center you will find the C:\WINNT.400\MCP.INI file and a list of the
opened projects. This is also displayed under User Administrator, Picture Statistics,
Storage and Graphics Designer. Here there is also information on the first project
in the list. With Database Query you can start DB queries in your database or
execute SQL statements. In this case you should be careful. Before starting, make
a back-up of your project. Performance Data and Script Queues give you
information on the project that is currently running in Runtime mode.

5. Internet

6. Here are the same links that you get under <More Information from the
Internet> above.

The License.log file

The License.log file is for checking the licenses. You evaluate these when WinCC
is running in Demo mode. Even if you think you have installed all the licenses
correctly. The file gives you information on failed authorizations. You also see
whether you are using a WinCC subcomponent or suboption for which you have no
license. In WinCC Scope only the available licenses are displayed.
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System messages and operating messages

Operator messages are configured as follows:
Date, time, message number, computer, user, application, old value, new value,
variable status, operating reason
Variable status: 0 == rejected, 1 == accepted

Configuration of a system message:
Date, time, message number, class, computer, user, application, error text
Class: 1 == Information, 2 == Warning, 3 == Error

WinCC Scope manages the system and operating messages from the WinCC
applications. They are forwarded to the message system of WinCC for further
evaluation.

The messages are stored on each computer locally as .csv files in the
...\WINCC\DIAGNOSIS directory. There are three different logbooks for this:

• Operating messages: WinCC_Op_xx.log

• System messages during start-up: WinCC_SStart_xx.log

• System messages during operation: WinCC_Sys_xx.log

• License checking: License.log

• (xx == 01..99)

The files with the system and operating messages are located in WinCC Info →
Diagnostic Files.

The files are described according to the cyclic buffer principle. Hence the files
occupy only a specific space (number of files * size of files) on the hard disk. You
can set the size and number of files individually for each logbook. This is done in
the WINCC_LOG.INI file in the ...\WINCC\BIN directory. The default size is 64
Kbytes.

16.4.3 Early recognition of resources bottlenecks with CCPerfMon
(WinCC V4.x)

Entry ID: 954032 - Date: 06/28/2000

QUESTION:
How can I recognize resource bottlenecks in advance from WinCC and react to
them accordingly?

ANSWER:
If a follow-up archive is incorrectly calculated or not exported in time, then it might
happen, for example, that the hard disk becomes full. The consequence is that
WinCC or Windows NT becomes inoperable at some time or other. Using the
"CCPerfMon.exe" file in the "..\Siemens\WinCC\bin" path you can recognize the
situation in advance and react appropriately.

The program CCPerfmon.exe (only for WinCC V4.x) generates internal variables
that are stored in the group @CCPerfMon in the WinCC variable list. Using these
variables it is possible, for example, to have the remaining free capacity of the hard
disk displayed in a WinCC image. In this way the user sees how much space is left
on the hard disk and can act before the hard disk gets full. This also gives you the



Support

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 16-23

option to react over a global action per Script and, for example, storing a message
or initializing other actions.

All variable names of this group start with @PerfMon@ followed by the meaning of
the resource (see Table 1). The text variable with the name
@CCPERFMON@LASTRUN displays the date and time at which the performance
data was last determined. There are also internal variables that are monitored by
CCPerfMon (see Table 2). The monitoring sequences run every 5 minutes.

Note

CCPerfMon only functions under Windows NT!

Procedure:

1. It is best to start CCPerfMon by including the program in the start-up list of the
computer. Enter the program with the option "/h" for "hidden". In this case the
CCPerfMon does not appear in the Windows task bar, but can only be seen in
the Windows NT Task Manager.
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2. Now configure an image in which you display the variables described below.

Monitored resources and their meanings
Table 1: Monitored Performance Counter etc. (only Windows NT)

 Variable  Meaning

@CCPERFMON@LASTRUN Date / Time

@CCPERFMON@CPU_USAGE_IDLE CPU Idle Time in %

@CCPERFMON@PAGING_FILE_USAGE Use of the export file in %

@CCPERFMON@FREE_MEMORY_IN_BYTES Free main memory

@CCPERFMON@FREE_MBYTES_x Free space on disk x (x= C..M as available)

Table 2: Monitored WinCC Variables

 Variable  Meaning

@TLGRT_SIZEOF_DATABASE_QUEUE WinCC queue length

@TLGRT_SIZEOF_NOTIFY_QUEUE WinCC queue length

@TLGRT_SIZEOF_DBASE_QUEUE WinCC queue length



Support

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 16-25

Explanation of the CCPerfMon dialog

You get this dialog when WinCC is in Runtime mode and CCPerfMon is started
manually. In this case CCPerfMon must not be started via the start-up list of the
computer. It is useful to employ the dialog if you only want to use CCPerfMon now
and again. Note, however, that the associated variables are created automatically
in any case.

Table 3: Operating and Display Elements of the Dialog

 Dialog field/
button

 Type  Description

Timer Cycle Output field Resource acquisition cycle

Last Run Output field Date / Time of last acquisition

Status of
connection to
WinCC

Output field Status of connection from CCPerfMon to WinCC. If "Connected and in
Run Time Mode" is not displayed, CCPerfMon is not running correctly.

Clear Statistics Button Delete statistical data of CCPerfMon

Clear Trace
Window

Button Delete the entry in the Trace window

Trace Level -- Button Increase Trace (diagnostics) level (more diagnostics outputs)

Trace Level Output field Display of the current Trace (diagnostics) level

Trace Level ++ Button Reduce Trace (diagnostics) level (less diagnostics outputs). Default
value is 10. Increase the value to about 20 for test purposes to have the
Trace outputs displayed also in "normal mode".

Trace Window Output field Window for diagnostics outputs. The latest information is always at the
top.
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! Warning

Only the values of the servers are displayed in the CCPerfMon variables. This is
why they are stored with "Project-wide Updating". If you change the setting of the
variables to "Local Computer Updating", then these variables are updated only on
the server, on the clients the "0" values remain. Therefore the clients cannot
overwrite the values.

Note

As of WinCC V5.0/SP1 these tasks are handled by the "System Info Channel".

16.4.4 Diagnosis of the connection between WinCC and the SPS

Entry ID: 264740 - Date: 11/220/2000

QUESTION:
Is there an option in WinCC of diagnosing my process connection?

ANSWER:
Yes you have various options:

1. Menu "Options > Status Connections "

This is basically the fastest way of getting an idea of the status of the connections.

 

The meanings of these displays is described in Entry ID !632781! on the Customer
Support pages
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2. WinCC V4.x

1. Right-click the profile of your connection.

2. Select the menu item System Parameters.

3. In the "System Parameter" window you can see the status of the connection
and any error that might have occurred.
If an error is displayed, double-click the error display to obtain instructions as
how to clear the error.

Note

If you get the message "No further information on this error available", you can
still get more information using the online Help for WinCC. Note the error number
and open "? > Index > SIMATIC S7 Protocol Suite > S7 channel
troubleshooting of connection failures > Error codes" under "Connection
errors" to see a list of individual errors.

! Warning
You should only use this option in the case of actual problems. It is not suitable
for constant monitoring of the connection status.
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3. WinCC V5

In WinCC V5 you have the "Channel Diagnosis" tool available for diagnosis. The
tool is located under "Start > Simatic > WinCC > Tools > ChannelDiagnosis".
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Glossary

A

Access

Chart elements or block I/Os can access addresses, charts, block I/Os, or run-time
groups. A distinction is made between read and write access.

Access Path

Setting in the ↑ setting the PG/PC interface tool. In the "access path" tab, you
assign a module parameter set to an access point. This means that the
applications that use this ↑ access point, access the module belonging to the
module parameter set.

Access Point

Setting in the ↑ setting the PG/PC interface tool. An access point establishes the
connection between an application, an interface parameter set, and a module

Acknowledge Tag

The "acknowledgment state" of a message is entered in the acknowledge tag. This
allows a central signaling unit to be activated using the acknowledge tag.

Acknowledgment (OS Message System)

A pending message can be confirmed in two ways:

Single acknowledgment: Messages that do not have the attribute "group
acknowledgment capability" must be confirmed individually.

Group acknowledgment: Using a group acknowledgment, all the individual
messages visible in a ↑ message window and that have the attribute "group
acknowledgment capability" are confirmed together.
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Acknowledgment Philosophy (OS Message System)

The acknowledgment philosophy is the way in which a message is displayed and
processed from "entering state" to "leading state". In the OS message system
(Alarm Logging), the following acknowledgment philosophies can be implemented:

• Single message not requiring acknowledgment

• Single message requiring acknowledgment of entering state

• Single message requiring acknowledgment of leaving state

• Initial value message with single acknowledgment

• New value message with single acknowledgment

• New value message with double acknowledgment

• Message without "leaving state" status not requiring acknowledgment

• Message without "leaving state" status requiring acknowledgment

Acoustic Indicator

Horn, bell, buzzer or similar as an acoustic indication that a new message has
arrived at the operator station (in run-time).

Action

(SFC) Actions allow the activation or deactivation of run-time groups and SFC
charts as well as modifications to blocks and shared resources by assignments to
their input parameters. The actions are formulated in the Properties dialog.

Address

An address identifies a specific address or address area, examples: Input I12.1;
memory word MW25; data block DB3. An address can be specified in either
absolute or symbolic form.

Address

An address is part of a STEP 7 instruction and tells the processor what it should
perform an operation on. It can be addressed in symbolic or absolute form. In SFC,
the address is part of an assignment (step) or condition (transition).

Addressing, Absolute

In absolute addressing, the address is the absolute memory address of the value
with which the instruction will be performed. Example: The address Q4.0 identifies
bit 0 in byte 4 of the process image output table (PIQ).
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Addressing, Symbolic

In symbolic addressing, the address to be processed is specified in a symbolic
form (instead of an absolute address). The assignment between the symbol and
address is made in the symbol table.

Alarm Logging

Editor for configuring the message system within the operator station and
application for displaying, archiving and handling messages.

Alarm Logging Wizard

Dialog-guided menu for creating default settings for the message system within the
operator station.

Alternative Sequence

(SFC) A structural element that consists of at least two sequence paths. Only the
path whose transition condition is satisfied first is processed by the PLC.

ANSI

American National Standardization Institute

ANSI-C

Part of the C programming language standardized by ↑ ANSI.

Archive

The operator station saves measured values and messages in archives so that the
data can be called up over a longer period of time.

Archive Log (OS Message System)

To log the messages, the OS message system provides the ↑ message sequence
report and the archive report. With the archive report, you can print out the status
changes of messages stored in an archive. In the run-time system of the OS for
example, the operator can set a filter for a message page (for example all alarms
since 12:00 o’clock) and then output the filtered messages to a printer by clicking
the appropriate button.

AS Interface

The actuator-sensor interface is a network system for binary actuators and sensors
at the lowest field level.
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Associated Value

Current process value that you attach to a message triggered on the SIMATIC
station (PLC). On the message page of the operator station, the message along
with the current measured value appears in a line (for example 5.5 bar pressure
too high).

Autosensing

With Fast Ethernet, ports of the DTEs are capable of both 10 Mbps and 100 Mbps.
When Autosensing is active, the maximum transmission rate of the DTE is
detected and set at the port.

B

Base Data

Base data includes the ↑ Split Screen Wizard and the ↑ Alarm Logging Wizard.

Basic Operation

Basic operations (BOPs) are objects in the system that provide simple functions
such as AND, OR etc. They are displayed as blocks in CFC.

BATCH Flexible

Software for automating recipe-controlled batch processes.

Block

Blocks are separate parts of a user program that are distinguished by their
function, their structure or purpose.

CFC operates with "off the peg" block types that can be inserted in a CFC chart.
When you insert the block, an instance of the block type is created. These block
instances and their graphic representation are blocks in the sense of CFC.

Block Attributes

See system attributes

Block Header

The upper part of a block in the display of the CFC chart containing, among other
things the name and the task assignment (run-time property).
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Block Input

Block I/O that can be interconnected with a block output and ↑ addresses of a
compatible data type or that can have values assigned to it.

Block Instance

A block instance is the implementation of a block type. A block type
inserted in a CFC chart becomes an instance. After it is inserted, the block instance
has run-time properties and a unique name within the chart.

Block Interface

Consists of the inputs and outputs of a block.

Block I/O

Block input or block output

Block Library

↑ Library

Block Output

Block I/O that can be connected to block inputs and ↑ addresses of a compatible
data type.

Block Type

The block type identifies the various implementations of blocks. Block types,
include for example data blocks (DB), function blocks (FD), functions (FC).

Block Type

Block types are ready-made program sections that can be inserted in a CFC chart
(for example controllers, multiplexes etc.). When a block type is inserted, a block
instance is created. You can create any number of block instances from a block
type.

The block type determines the characteristics (algorithm) for all implementations of
this type. The name of the block type is specified in the symbol table.

Branch&Merge

The division of a project into various subprojects (for example every PLC is a
subproject and the OS is a further subproject) so that several configuring engineers
can work on a project at the same time.



Glossary

Process Control System PCS 7, Tips and Tricks
Glossary-6 A5E00080064-01

Bus

A path for electrical systems allowing the exchange of data and control information
between various components of a computer architecture.

Bus System

Generic term for hardware components and the transmission specification for
↑ busses.

C

C Action

see ↑ scripts

Central Processing Unit (CPU)

The CPU is a central module in the programmable controller in which the user
program is stored and executed. It includes the operating system and the
communications interfaces.

CFC

Continuous Function Chart.

1. Continuous function chart (CFC chart) with the graphic interconnection of
technological functions (blocks).

2. A software package (CFC editor) for plant-oriented, graphic configuration of an
automation task. Using CFC, ready-made blocks are put together to form an
entire software structure (CFC chart).

Chart

Document in which continuous automation functions can be created with the CFC
configuration tool or sequential control systems with SFC.

Chart Element

(SFC) Chart elements are the basic elements (step, transition, text) and structure
elements (sequence, simultaneous sequence, alternative sequence, loop and
jump).

Chart Folder

Folder in the project structure; this contains the charts of a user program.
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Chart-in-Chart Technique

See ↑ nested chart

Chart I/O

You can provide a chart with I/Os to extend your options such as

• inserting the chart in a different chart (↑ nested chart) and interconnecting it
with other charts or blocks

• or to compile it as a ↑ block type.

Chart Overview

The overview of a CFC chart (partition) with its six sheets.

Chart Partition

Part of a CFC chart. A CFC chart can be divided into a maximum of 26 chart
partitions ( labeled: A to Z ) each with 6 sheets.

Chart Topology

(SFC) In the chart topology, the chart elements are represented according to fixed
syntactical rules (for example order, spacing, extent and arrangement of the
elements). The syntactical rules are kept to automatically when you create the
chart topology with the editor.

Cold Restart

During a cold restart on an S7-CPU, the organization block OB102 is executed (↑
Startup of an S7-CPU).

The following rules apply to the "Cold restart":

• Data blocks created by SFCs in the work memory are deleted, the other data
blocks have the default values from the load memory.

• The process image and all timers, counters, and memory bits are reset
regardless of whether they were set as retentive.

During a cold restart, the process image input table is read and the STEP 7 user
program is executed starting at the first instruction in OB1.

Commissioning

To support commissioning, the CFC/SFC editor has integrated test functions that
allow the sequence of events on the PLC to be monitored, influenced and if
necessary parameter settings changed.
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Compilation

Conversion of the graphic CFC to a user program
(SCL for S7 or C for M7).

Component View

Device-oriented view in the SIMATIC Manager. The project is displayed with its
components (station, module, program ...); alternative
to the ↑ plant view.

Connection Table

Table for defining communication connections between modules in a network.

Connector

(CFC) The connection point on the block with a reference to the I/O to which it is
connected. Connectors are used when no more connecting lines can be drawn on
a sheet because it is already full. The connectors allow complex CFC structures
including those extending to other sheets to be displayed completely.

Consistency Check

Checks the consistency of block types, shared addresses etc. of the chart folder.

Consistency Error

The output of an error message with detailed information following a ↑ consistency
check.

Continuous Archive

After the configured number of data records or after a configured time, the↑ archive
is overwritten cyclically beginning with the oldest data record.

Control and Monitoring Attributes

See system attributes

Control block for SFC

With the SFC control block (SFC_CTRL), you can query the status of an SFC chart
and influence its execution in CFC. The control block is inserted in the CFC chart,
interconnected, and assigned parameters. It has its own run-time properties and
can be modified (along with the SFC chart) in the run sequence. The control block
must always be installed immediately before an SFC chart in the run sequence.
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CP

Communications Processor - communications module for installation in computers
or programmable controllers.

CP 443-1

↑ CP for use in ↑ Industrial Ethernet

CP 443-5 Basic

↑ CP for use in ↑ PROFIBUS

CSV

CSV stands for "Comma Separated Value" and is an ASCII text format in which
tabular data are saved. CSV files used in the IEA must have the extension .IEA.

Cycle Time

The cycle time is the time required by the CPU for processing the user program
once.

D

Data Block (DB)

Data blocks are areas in the user program that contain user data. There are shared
data blocks that can be accessed by all logic blocks, and there are instance data
blocks that are associated with a particular function block call. In contrast to all
other types of blocks, they contain no logic instructions.

Data Type

A data type specifies how the value of a variable or constant is used at a block I/O.
"BOOL", for example, defines a binary variable; "INT" defines a 16-bit fixed-point
variable.

dBase-III

Format of the database program of the Borland company (American software
manufacturer).

DCF 77

Time transmitter in Frankfurt/Mainflingen. This provides the highly accurate official
time for Germany based on a cesium clock.
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Diagnostic Buffer

Battery backed memory area on the CPU in which all diagnostic events are entered
in the order in which they occurred.

DOCPRO

Program for creating project documentation.

Download-Relevant Change

A modification in a CFC/SFC chart is download-relevant when it causes a change
in the user program of the CPU (for example a change to an interconnection).
Modifications that are not download-relevant, for example, include CFC block
positions and comments.

DP

Distributed Peripheral I/Os - input/output modules used in a distributed
configuration and located away from the CPU. The programmable controller and
the distributed I/Os are connected via the ↑ PROFIBUS DP bus system.

DP Master

A master conforming with the PROFIBUS DP standard (EN 50170, previously
DIN E 19245, Part 3) is known as a DP master.

DP/PA Coupler

Connectivity module between ↑ PROFIBUS DP and ↑ PROFIBUS PA.
This module does not require any parameter assignment.

DP/PA Link

Hardware made up of an IM 157 interface module and several
↑ DP/PA couplers. The DP/PA link connects ↑ PROFIBUS DP with
↑ PROFIBUS PA and must be configured in hardware configuration.

DP Slave

A slave operated on PROFIBUS with the PROFIBUS DP protocol is known as a
DP slave.

Dynamic Display

Dynamic display means that the input or output values of a block in the CFC chart
or address values in the SFC chart can be updated with the values of the CPU in
the test mode.
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Dynamic Display Window

Window in CFC for monitoring selected block I/Os on CPUs.

Dynamic Wizard

Configuration dialogs for creating graphic objects, connections to graphic objects,
archives etc.

DynWizEdit

Editor for creating ↑ dynamic Wizards.

E

Edit Mode

(Alternative to the ↑ test mode)
In CFC, blocks can be inserted, copied, moved, deleted, renamed, have
parameters assigned, or be interconnected.
In SFC, the sequential control system is created in this mode. Chart elements can
be inserted, copied, moved, deleted, renamed, and assigned parameters.

EMC

Electromagnetic compatibility State in which electrical or electronic devices do not
interfere with each other.

EMSR Designation

Elektro-, Meß-, Steuerungs,- und Regelungstechnik designation. Standardized
designations for graphic symbols and identifiers in process control engineering.

Enable Attribute

The enable attribute is a run-time attribute. It activates or deactivates a run-time
group or an SFC chart. As long as it is deactivated, the group (or SFC chart) is not
executed regardless of any other conditions. The enable attribute can be set
dynamically. In this case, the output value of a CFC block or the assignment in an
SFC Action decides whether the group or SFC chart is activated or deactivated.

ET 200M

This is a modular I/O system for single-tier configuration with the degree of
protection IP 20. The ET 200M can be extended with the signal, function and
communication modules of the S7-300 programmable controller. Communication
between ET 200M and the PLC is on ↑ PROFIBUS DP.
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Ethernet

One of the earliest local area networks. Today, Ethernet is used on coaxial cable or
fiber-optic cable.

F

Faceplate

A software block written in Visual Basic or Visual C that allows a block instance to
be controlled and monitored during run-time on an operator station.

Fail-Safe Systems

Following the failure of a component, these systems change to a fail-safe state to
avoid injury to persons and damage to equipment or the environment.

FAQ

Frequently Asked Questions - information on several Internet pages with
Tips & Tricks for PCS 7 "http://www.ad.siemens.de/csinfo".

Fast Ethernet

Fast variant of ↑ Ethernet. Approximately 10 x faster data transmission.

Fault-Tolerant System

A PLC (S7 400H) in which all the essential components exist twice. If one of the
subsystems fails (for example a component failure) the other takes over
automation of the plant without any interruption.

FDL Connection

Fieldbus Data Link – Layer 2 of the ISO reference model in PROFIBUS; it consists
of Fieldbus Link Control (FCL) and Medium Access Control (MAC).

Function (FC)

According to IEC 1131-3, functions are logic blocks without memory. A function
allows parameters to be passed on in the user program. Functions are ideally
suited for programming commonly occurring complex functions, for example
calculations.
Note: As there is no memory available, the calculated values must be processed
immediately following the FC call. See also ↑ block type.
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Function Block (FB)

(FUNCTION BLOCK) According to IEC 1131-3 a function block is a logic block with
static data. An FB allows you to pass parameters in the user program. This means
that function blocks are suitable for programming complex functions that are
required frequently, for example controllers, operating mode selection. As function
blocks have a memory (instance data block) its parameters (for example outputs)
can be accessed at any time and any point in the user program. See also
↑ block type.

G

Global Script

Editor in the control center of the OS for creating ↑ actions, project functions and
standard functions.

GPS

Global Positioning System – satellite system for exact position detection on earth.
The individual GPS satellites orbit the earth at a height of approximately 20000 km
in different orbits. Each satellite has a highly accurate atomic clock.

Graphics Designer

Editor in the OS for creating plant pictures.

Group Display

Group displays are used for two purposes:

• Displaying of the status of a PCS 7 tag (for example an instance of a MOTOR
block) on a process picture on the OS.

• Implementing OR logic for all status information of all PCS 7 tags of a process
picture and displaying this information in a process picture of a higher
hierarchy level.

Group Message (OS Message System)

In the OS message system (Alarm Logging), there are two types of message:
group messages and ↑ single messages. Group messages are used to group
together several single messages. The events associated with the single
messages therefore only trigger the common group message. The triggering single
message is no longer recognizable. One group message can be set up per
message class and message type. In addition to this, group messages can also be
put together from any selection of single messages.
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H

Hardware Catalog

Catalog for selecting PCS 7 components within ↑ HW Config.

HART

Highway Adressable Remote Transducer - registered trademark of the "HART
Communication Foundation" (HCF). Standard protocol for transmission of
information between a field device and PLC.

Higher Level Designation (HID)

It is made up of the hierarchical path of the plant hierarchy.

HW Config

Hardware configuration - editor within the SIMATIC Managers for configuring
hardware and configuring networks.

I

IEA Editor

A separate application for creating and editing import/export files. When working
with the editor, the formats specified for the import/export files are supported.

IM

Interface Module

Import/Export Assistant (IEA)

Software component in PCS 7 for handling ↑ models and generating ↑ replicas of
the models.

Industrial Ethernet

↑ Bus system for industrial application based on ↑ Ethernet.

Initial Value Message (OS Message System)

On the OS, a distinction is made between an initial value message and a ↑ new
value message. Among a group of messages, an initial value message is the
message whose status changed first since the last acknowledgment.
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Interconnection

(CFC) Connection between an interface I/O and another element. The value of an
interconnected input is fetched from the other end of the interconnection during
runtime.

Interface

The interface consists of the inputs and outputs of a block (block interface) or a
chart (chart interface) that can be interconnected and assigned parameters.

Internal Block

A block within a ↑ multiple instance block.

Internet

Worldwide network of UNIX data networks; originating from the university
environment. Today, the largest data network worldwide. On the INTERNET, the ↑
TCP/IP protocol is used.

IP Address

Address of a node on the ↑ Internet or Industrial ↑ Ethernet

ISO

International Standards Organization

J

Jump

(SFC) A jump is a structured element in SFC with which the execution of the SFC
chart is continued at a different step within the same chart depending on a
transition condition.

L

Ladder Logic (LAD)

Graphic representation of the automation task with symbols from a circuit diagram
complying with DIN 19239.
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Library

A folder for objects that can be used more than once and that is not project-related.
Blocks are made available according to certain criteria (block families, alphabetical
arrangement etc.) in block libraries. Different block libraries are used depending on
the target system or particular situation.

Lifebeat Monitoring

Program belonging to the run-time system (operator station) for monitoring the
programmable controllers, ↑ OS servers and ↑ OS clients connected to an OS
server. The connected systems are visualized in a plant picture.

Local Data

Local data are the data assigned to a ↑ logic block that are listed in its declaration
section or its variable declaration.

Location Identifier

Based on a sequence of letters and numbers, the exact location of a tag within a
process plant is defined (in much the same way as a street in a street map). The
location identifier can be specified when working with the IEA.

Lock List (OS Message System)

The lock list displays all the locked messages in the system. It is structured like the
message window. Locked messages can be unlocked using a button in the toolbar.

Logic Block

A logic block in SIMATIC S7 is a block that contains part of the STEP 7 user
program. In contrast, data blocks contain only data.

The following logic blocks exist:

• ↑ Organization blocks (OB)

• ↑ Function blocks (FB)

• ↑ Functions (FC)

• System function blocks (SFB)

• System functions (SFC)

Logs

Apart from the ↑ sequential message log and the ↑ archive log, the configuring
engineer can specify a user log with static and dynamic contents in the control
center of the OS. During run-time, the log is output cyclically on a printer or as the
result of an event (for example clicking a button).
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Long-Term Archive (OS Message System)

In a long-term archive, the archive size is decided by the length of time for which
the messages are archived. A long-term archive can be set up as a first-in-first-out
archive or as a continuous archive. In a first-in-first-out archive, the oldest
messages are overwritten when the maximum number of archived messages is
reached. In a continuous archive, the messages continue to be written sequentially
until the maximum capacity of the storage medium is reached. The messages
stored in a long-term archive are displayed in a ↑ message window.

Loop

(SFC) Structure element consisting of a ↑ sequence (S sequence) and a return
branch that encloses the S sequence and contains exactly one transition.

LOOP-in-Alarm

Function in the run-time of the OS. After clicking the appropriate button within a
message line, the faceplate belonging to the loop is displayed.

M

Machine Code

The program that can run on a programmable controller. The machine code is
compiled by ↑ CFC and downloaded to the PLC.

Memory Reset

During a memory reset, the following memory is deleted on the CPU:

• work memory,

• write/read area of the load memory,

• system memory except for the MPI parameters and the diagnostic buffer.

Message Blocks (OS Message System)

Status changes of a message are displayed in run time in a message line. The
information to be displayed in the message line is specified using message blocks.
There are three different types block:

• System blocks (for example, date, time, period, comment, ...) allow predefined
and not freely usable information to be specified. With assistant blocks, the
value of the message block (for example, the time) is displayed in the message
line.

• New Sir text blocks allow you to assign up to ten different freely defined texts
to a message. With user text blocks, the content of the message block (the
user-defined text) is displayed in the message line.
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• Using process value blocks, you can display the values of variables in the message
line. You can also define the formatting used. With process value blocks, the content of
the message block (the variable value specified by the user) is displayed in the
message line.

Message Configuration

Creation of messages and their attributes and texts. Messages can be configured
within CFC/SFC.

Message Event (OS Message System)

Message events are the messages "entering state", "leaving state" and
"acknowledgment". All message events are stored in the message archive.

Message Frames (OS Message System)

Message frames originate either from the process more from the process control
monitoring. They are exchanged between the controller (or the monitoring
application) and the OS message system.

Message Line (OS Message System)

Each message is displayed in a ↑ message window in a separate message line.
The content of the message line depends on the ↑ message blocks to be
displayed. With ↑ system message blocks (for example, date, time), the value of
the message block for ↑ process and ↑ user text blocks displayed is the content of
the blocks (for example, the text you specified).

Messages

A message system is used for the chronological signaling and archiving of sporadic
events occurring in the process at a central location. The cause of a message can
be an event or a message frame.

In general, a distinction is made between operating messages, fault messages,
and system messages. Operating messages are used to indicate a status in the
process. Fault messages are used to indicate a problem in the process. System
messages are used to indicate error messages from other applications.

In the message system (Alarm Logging), messages that behave in a similar way
(acknowledgment philosophy, color scheme for message states) can be grouped
together in message classes and message types.

Message Sequence Report (OS Message System)

To log the messages, the OS message system provides the ↑ message sequence
report and the archive report. In the message sequence report, all status changes
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(entering data, leaving state, confirmed) of currently pending messages are printed
out as a single line. Message Class

The message class determines the property of the message. In SIMATIC PCS 7,
there are the message classes alarm, warning, tolerance, PLC and OS control
system message, process message, operator prompt and operating message.
Message classes differ from each other in terms of the acknowledgment
philosophy. Messages with the same acknowledgment philosophy can be put
together in one message class.

Message Status (OS Message System)

Message statuses are the possible statuses of a message: "entering state",
"leaving state", "confirmed".

Message Tag

With the bit message technique, the controller signals the occurrence of an event in
the process using the message tag. Several messages can be masked by a
message tag.

Message Technique (OS Message System)

The OS message system (Alarm Logging) supports several message techniques:
The bit message technique, the technique of chronological messages, and the
technique of analog alarms for limit value monitoring.

• With the bit message technique, the controller signals the occurrence of an
event in the process using the message tag. The time stamp (date and time) of
the message is assigned by Alarm Logging.

• With chronological messages, the controller sends a frame with the data on the
message when the event occurs. This is evaluated in Alarm Logging. The time
stamp (date and time) of the message is assigned by the controller.

• With analog alarms, the changes in an analog variable can be monitored for
upper and lower limit value violations.

Message Texts

These are configured within the blocks in ↑ CFC and transferred to the OS. When
a message is triggered, the message texts are output on the message pages.

Message Types (OS Message System)

Message types are subgroups of ↑ message classes and can differ from each
other in the color selected for the message status. You can create up to 16
message types in each message class on the OS.
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Message Window (OS Message System)

In run time, the status changes of messages are displayed in a message window.
The appearance and options for controlling the message window can be defined
freely in the Graphics Designer.

A message window contains all the messages still to be displayed in the form of a
table. Each message is displayed in its own line, the ↑ message line.

You can influence the content of the message window using definable filters.

Depending on the source of the messages displayed in the message window, a
distinction is made between three types of message window.

• Message lists are used to display currently pending messages.

• ↑ Short-term archive windows are used to display messages stored in a short-
term archive.

• ↑ Long-term archive windows are used to display messages stored in a long-
term archive.

Model

A model consists of hierarchy folders with CFC/SFC charts, pictures, reports, and
additional documents from which any number of ↑ replicas can be created.

Model Chart

↑ A CFC chart that exactly represents the model of a commonly occurring structure
within a plant configuration. The model chart of a motor controller, for example has
exactly the blocks with the corresponding interconnections that are required to
control a motor in this plant.
Using the ↑ IEA, the model charts become ↑ models.

Module

• System module
Module required to operate a system (for example programmable logic
controller). The system modules include, for example, a power supply, a
central processing unit (CPU) and also perhaps a communications module.

• I/O module
Module for acquiring or outputting process signals.

Module Driver

• Input driver
Input drivers adapt the process signals of an input module and provide the
signal in CFC for further use.

• Output driver
Output drivers adapt the value formed in CFC and transfer the value to an
output module.
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MPI Address

In an MPI network, each programmable module must have its own
MPI address assigned.

Multiple Instance Block

A block that consists of more than one internal block with a common ↑ interface
and common data storage (instance DB).

Multi-Point Interface (MPI)

Interface for linking up to 32 devices (PC, PG, PLC, AS).

Multi-User

Several configuring engineers working at the same time on one project.

N

Nested Chart

A CFC chart that is inserted in another CFC chart (nested or top chart). Nested
charts are not displayed in the SIMATIC Manager.

NetPro

Editor for graphic configuration of networks. NetPro is started within the SIMATIC
Manager or the hardware configuration ( ↑ HW Config).

Network Components

Within the ↑ NetPro, there is a catalog of network components. From this catalog,
you can take, for example single stations and interconnect them to form networks.

New Value Message (OS Message System)

On the OS, a distinction is made between a new value message and an ↑ initial
value message. Among a group of messages, new value messages are the
messages whose status has changed since the last acknowledgment.

O

Office / Works Management Level

Computer-supported enterprise-wide information system of a company.
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Online/Offline

In the SIMATIC Manager, objects of the programmable controller are displayed in
the online view and the objects of the ES in the offline view. Online, there is a data
connection between the PLC and the programming device/PC; offline there is no
connection.

Operating Message

Following a change made to a parameter on the operating station, the parameter,
the old value, the new value and if applicable the unit of the value is displayed in a
message page.

Operating Mode

1. CPU:

The following operating modes can be set with the mode selector on the CPU
module:

• RUN with access to the STEP 7 user program using, for example, the
programming device ("RUN-P"),

• RUN with access protection ("RUN"),

• STOP and

• memory reset ("MRES").

2. SFC:

The mode decides how an SFC chart is controlled.

• AUTO (process mode): Execution is controlled automatically, for example using
the control block.

• MANUAL (operator mode): Execution is controlled manually by an operator, for
example using IBS or SFV (SFC visualization in WinCC).

Operating Response

• Rejecting operating response
A command outside the permitted limits is rejected.

• Limiting operating response
A command outside the permitted limits is accepted but restricted to the
maximum permitted limit value.

Operating State

1. The SIMATIC S7 programmable logic controllers can adopt the following
operating states: STOP, STARTUP, RUN and HOLD.

2. (SFC) The sequential control system can adopt the operating states OFF,
ACTIVE and HOLD.
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Operating System

A collective term for all functions which, in conjunction with the hardware, control
and monitor the execution of the user programs, the distribution of the operational
equipment among the individual user programs, and the maintenance of the
operating mode (for example standard operating systems MS-WINDOWS, real-
time operating system M7 RMOS32).

Organization Block (OB)

In S7,organization blocks are the interface between the operating system of the
CPU and the user program. The order in which the user program is executed is
specified in the organization blocks. An organization block corresponds to a ↑ task.

OS

Operator station. A station for controlling and monitoring the process. In PCS 7, the
WinCC software system is used for the OS with which all the process monitoring
and control functions can be implemented.

Overflow Page

(CFC) An overflow page is created automatically in CFC when there are so many
sheet bar entries in a ↑ sheet that there is no longer enough space. An overflow
page consists only of the ↑ sheet bars with entries and contains no other objects.

P

Parameter

A parameter is

1. the value of a CFC block/chart I/O.

2. a variable of an S7 logic block (actual parameter, formal parameter)

PCS 7 Assistant

A multi-page dialog that supports the user when creating a new project in the
SIMATIC Manager.

PDM (SIMATIC PDM)

Process Data Manager – software for assigning parameters to DP field devices.
SIMATIC PDM is started in the SIMATIC Manager or in HW Config.
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PG/PC Interface

A configuration tool for installing/uninstalling communication modules,
adding/deleting interfaces and assigning parameters to communications modules
(for example bus profile, node number etc.).

Phase Offset

The phase offset moves the point at which the run-time group or SFC chart is
activated within the task by a defined value compared with the basic cycle. This
achieves a more uniform distribution of load on the CPU. See also ↑ scan rate.

Picture Block

see ↑ faceplate

Picture Hierarchy

The arrangement of the plant pictures on the OS. The pictures are structured at
different levels. Each level corresponds to a particular level of detail in the plant.
The deeper the level, the more detail is provided with the plant components. The
picture hierarchy is shown in the ↑ Picture Tree Manager.

Picture Tree Manager

This is used to manage a hierarchy of plants, units and pictures of the ↑ graphics
designer.

Piping and Instrumentation Flow Diagram

Here, the components required in a plant and their interconnections are specified.

Plant Hierarchy (PH)

Structure organized in the form of a hierarchy according to technological aspects.

Plant Picture

see Lifebeat Monitoring.

Plant View

View in the SIMATIC manager according to technological aspects ( plant, unit,
function ...); an alternative to the ↑ component view.
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PLC

The PLC or target system is the programmable controller or a component of the
programmable controller on which the user program runs. Target systems include
for example SIMATIC S7 and M7.

Priority Class

The ↑ organization blocks are assigned to a particular priority class. The priority
class then determines the order in which the organization blocks are called.

Process Control Point

The smallest unit in process control. This satisfies the processing functions of a
process variable, such as control, display, alarm etc. from the point of view of
process engineering.

Process Image

Reserved areas in the RAM of the CPU. The signal states of the input and output
modules are entered in this area.

Processing Phase

(SFC) A step is divided into three processing phases: Initialization, (cyclic)
execution, and termination. Each processing phase corresponds to an action with
statements.

Process Variable

A neural object in terms of resources. It is used to connect the PLC configuration
world (STEP 7, CFC ...) with the OS configuration world (WinCC). It contains
information about the location at which it exists at run-time (for example the
network address and the memory area on the PLC) as well as information about
specify OS-relevant properties.

PROFIBUS

PROcess Field Bus – a fieldbus complying with EN 50170 Vol. 2 PROFIBUS
(DIN 19245; bus system for industrial application based on PROFIBUS).

PROFIBUS DP

DP mode complying with DIN E 19245 Part 3; PROFIBUS DP is a serial bus for the
attachment of remote (distributed) peripheral I/Os developed by SIEMENS
specifically for the field area.
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PROFIBUS PA

The extension of ↑ PROFIBUS DP with optimized transmission for field devices (for
example for supplying power to field devices via the data line and for use in
hazardous areas) while retaining the communication functions of PROFIBUS DP.

Program

General term for S7 and M7 programs.

Programmable Controller (PLC)

A programmable logic controller is a programmable controller (PLC) in SIMATIC
S7, a complete device (PLC with integrated control unit)
SIMATIC C7 or a SIMATIC M7 automation system.

Programmable Logic Controller (PLC)

Programmable logic controllers (PLC) are electronic controllers whose function is
stored as a program on the controller. Programmable controller has the structure of
a computer; it consists of a CPU (central processing unit) with memory,
input/output modules, and an internal bus system. The peripherals and the
programming language are designed to meet the requirements of control
engineering.

Programming Device (PG)

Portable personal computer in a special compact design intended for use in
industry. A PG is fully equipped for programming SIMATIC programmable logic
controllers.

Project

A folder containing all the objects belonging to an automation solution regardless of
the number of stations, modules and how they are networked.

R

Reference Data

Reference data are data available to the user in addition to the graphic chart
display in the form of lists, for example the list of access to shared addresses.

Reorganization

During this reorganization, gaps in the PCS 7 project resulting from deleting are
eliminated; in other words the memory requirements of the project/library data is
reduced.
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This function optimizes data storage for the project or library in much the same way
as a defragmenter optimizes data storage on a hard disk.

Replica

When you import with the import/export assistant, replicas are created from the
models. Each line in an import file creates a replica in the destination project. A
replica differs from the model (or from a copy of the model) among other things
because instead of an assignment to an import file it has an assignment to a
model.

Report Designer

Editor in the control center on the OS for creating and editing logs.

Resources

Resources are sets of objects (FBs, FCs, DBs, OBs, bit memory, counters, timers
etc.) that can be accessed when configuring and assigning parameters in a
CFC/SFC chart.

Restart

When an S7 CPU starts up ( for example after changing the mode selector from
STOP to RUN or when the power supply is turned ON), before cyclic program
execution (OB1) is started either the organization block OB 100 ( warm restart) or
organization block OB 101 (hot restart, only on the S7-400) or OB102 (cold restart)
is executed (↑ Startup of an S7-CPU). In a warm restart the process image of the
inputs in read in and execution of the STEP 7 user program is continued at the
point at which it was last stopped (STOP, power down).

The "hot restart" is only possible when the CPU is battery-backed.

All data areas (timers, counters, memory bits, data blocks) and their contents are
retained.

Routing

Establishment of communications connections beyond the boundaries of subnets.

Runtime

Process control; the operator controls and monitors the process on the operator
station (OS).

Runtime Attribute

Each run-time group has run-time attributes that control how it is activated. The
group passes on these attributes to all the blocks it contains.
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Runtime Group

Run-time groups are used to structure or group tasks. The blocks are installed in
the run-time groups sequentially. Run-time groups activated or deactivated
separately. If a run-time group is deactivated, none of the blocks it contains will be
activated any longer.

Runtime Properties

The run-time properties of a block determine how the block is included in the
processing of the entire structure on the PLC. These properties are vital to the
performance
of the PLC in terms of reaction times, dead times, or the stability
of time-dependent structures, for example control loops.

S

S7 Program

A folder for the ↑ symbol table, the blocks, the source files, and the charts for
programmable S7 modules.

Scan Rate

The scan rate is a ↑ run-time attribute. It specifies whether a
↑ run-time group or a chart is executed every time a task is executed or only every
nth time. See also ↑ Phase offset.

SCL

High-level language complying with IEC 1131-3 and resembling Pascal for
programming complex tasks on a PLC, for example algorithms, data processing
tasks.

Script

A program written in ↑ ANSI-C for solving user tasks. Scripts run
cyclically/acyclically in the background of the OS run-time or following an event (for
example mouse click) on a picture object within a plant picture.

Sequence

(SFC) A structure element consisting of a series of steps and transitions
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Sequence Path

(SFC) A sequence is a series of chart elements (in the chart topology seen as a
vertical path). A simultaneous sequence or an alternative sequence consists of at
least two sequences arranged side-by-side and containing at least one element.

Sequential Archive

The ↑ archive is written sequentially until the configured size is reached or until the
storage medium is full (see also ↑ Continuous archive).

Sequential Control System

A sequential control system passes control from one step to the next step
dependent on conditions. In PCS 7, sequential control systems are implemented
with SFC charts.

Server Name

The server name is required often for addressing a computer (PC) in a network.
You will find the server name under "Start (Windows NT taskbar) > Settings >
Control Panel > Network > Computer Name".

SFC

An SFC chart represents a ↑ sequential control system that runs as an
independent controller in the programmable logic controller.

SFV

Visualization of the SFC chart in the run-time system of WinCC.

Shared Address

Shared addresses are objects that can be addressed by every logic block (FC, FB,
OB). These addresses are memory bits (M), inputs (I) , outputs (Q), timers (T),
counters (C) and elements of data blocks (DB). It is possible to access shared
addresses in absolute or symbolic form.

Shared Data Block

This is a block that can be accessed by all blocks in the program. Every CFC block
instance can read the shared data from such a block or can write data to the block.
Shared data blocks are created with the LAD or STL editor.
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Sheet

(CFC) Subdivision of a chart partition. A ↑ chart partition consists of 6 sheets. The
sheet is a working area (with sheet bars) on which blocks are positioned, assigned
parameters and interconnected.

Sheet Bar

(CFC) The margin at the right and left-hand edge of a sheet. The sheet bars
contain:

• The references to connected objects (block/chart interface, address, run-time
group) that are not located on the current sheet.

• the number of the connector reference when the connecting line cannot be
drawn to the sheet bar because the chart is full.

Short-Term Archive (OS Message System)

In a short-term archive, you specify the size of the archive by the number of
messages to be archived. A short-term archive can only be created as a first-in-
first-out archive. Once the maximum number of archived messages has been
reached, the oldest messages are overwritten. A maximum of 10000 status
changes of messages can be stored in a short-term archive. The messages stored
in a short-term archive are displayed in a ↑ message window.

SICLOCK

Master clock in Industrial Ethernet.

Sign of Life Monitoring

see ↑ Lifebeat Monitoring

SIMATIC Manager

Graphic user interface for the SIMATIC user under Windows NT. With the SIMATIC
Manager, for example, you create projects and access libraries.

SIMATIC Station

see ↑ Programmable logic controller (PLC)

Single Message (OS Message System)

In the OS message system (Alarm Logging), there are two types of message:
single messages and ↑ group messages. With single messages, each event is
assigned a message.
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Source File

Part of a program created with a graphic or textual editor and from which the
executable user program is produced following compilation.

Split Screen Wizard

Dialog-guided menu for creating basic data and settings within the operating
station.

Startup of an S7-CPU

The CPU distinguishes between the following startup types:↑ : cold restart, ↑ hot
restart or ↑ warm restart. This is selected using a software switch in the object
properties of the CPU (HW Config).

Statement List (STL)

Statement List is a textual programming language resembling machine code
(complying with IEC 1131–3).

Status Tag (OS Message System)

The status tag contains the "entered state/left state" status of the message type
and an ID for messages requiring acknowledgment.

Step

(SFC) The step is an element of a ↑ sequential control system and the control
instance for processing the assigned ↑ actions. Each step consists of the three
actions: Initialization, (cyclic) processing, and termination.

Step Control Mode

(SFC) Mode by which control passes from step to step:

• C (confirmation by operator)
The sequential control system runs controlled by the operator.

• T (transition only)
The sequential control system runs controlled by the process.

• T or C (transition or confirmation by operator)
The sequential control system runs process-controlled or controlled by the
operator.

• T and C (transition and confirmation by the operator)
The sequential control system runs process-controlled and controlled by the
operator.
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Step Types

(SFC) SFC recognizes different step types:

• Initial step

• Normal step

• Final step

Storage

An editor for exporting archives (process value archives, curve archives). Storage
is started and the settings are made in the control center of WinCC.

Structure

A structure is a structured ↑ data type made up of several elements. An element
can be an elementary or a structured data type.

Structure Element

(SFC) Structure elements consist of an arrangement of basic elements. These
include the following: "sequence", "simultaneous sequence", "alternative
sequence", "loop" and "jump".

Subnet

Self-contained part of a bus system.

Symbol

A symbol is a name selected by the user defined according to syntax rules. This
name can be used in programming or in operating control and monitoring once it
has been defined (for example, as a variable, a data type, a jump label, or a
block)..

Example: address: I5.0, data type: BOOL, symbol: Emer. Stop Switch.

Symbol Table

A table used to assign symbols (= name) to addresses for shared data and blocks.
Example: Symbol Address
Emer. stop I1.7,
Controller FB24

System Attributes

System attributes can be divided into two groups:

• Block attributes and
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• parameter attributes.

The attributes assigned additional properties to blocks and parameters of blocks (
for example automatic inclusion in certain processing levels, or making parameters
invisible etc.).

System Resources

When you download the user program to a PLC currently in the run mode, it is
important that the newly downloaded sections of program do not exceed the
system resources. Exceeding these resources would cause the PLC to change to
STOP. System resources include, for example, the local data, the load memory,
the work memory, the maximum number of blocks (for example, FB, DB,...), the
maximum number of communication blocks, the cycle time, etc.

T

Tag Browser

The tag browser integrated on the OS provides information on the existing tags and
allows interconnection to the OS objects (for example, I/O fields).

Tag List

List of all the measuring points in a plant section or a project. The list contains the
following information for each tag:

EMSR designation, type of tag, location, measuring range, unit, signal meaning,
comment

Tag Logging

An editor in the control center of the OS for creating and editing curves.

Task

Tasks are the interface between the operating system of the CPU and the user
program. The order in which the user program is executed is specified in the tasks.
A task corresponds to an organization block (OB) in S7 and a priority class in M7.

Task/OB

A task is the interface between the operating system of the M7 CPU and the user
program. The tasks are mapped on RMOS tasks (see ↑Task).
In S7, the tasks are implemented as ↑ Organization Blocks (OBs).
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TCP/IP

Transport Control Protocol / Internet Protocol – the standard for communication
between UNIX computers and on the ↑ Internet.

Teleservice

From a central point, it is possible to investigate errors and their causes directly on
the PLC or OS of the customer. The service center is linked by a modem and
special software ( for example Laplink or
PC-Anywhere) in the customer system.

Test Mode

(Alternative to the ↑ edit mode) mode in CFC/SFC for testing and optimizing the
user program running online on the CPU.

Textual Reference

A textual reference can be used to configure access to chart I/Os inside or outside
the current chart folder and even chart I/Os that do not yet exist. After merging the
2 charts, this connection can be closed. If the charts are separated, the
connections are opened, but are retained as textual references.

Time-of-Day Synchronization.

see ↑ Time Synchronization.

Time Synchronization

An editor in the control center of the OS. Time synchronization makes sure that
all the PLCs and operating stations of the bus operate with the same time of day (
time of day synchronization).

Top Chart

CFC chart that is not inserted in another chart and that
is displayed in the SIMATIC Manager (↑ nested charts).

Topology

Physical structure of a system.

Transfer

The "PLC-OS Engineering" transfer program transfers the PLC configuration data
for operating control and monitoring created on the PLC to the data management
of the operator station. The program is started in SIMATIC manager.
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Transition

(SFC) The transition is a basic element of SFC and contains the conditions under
which a sequential control system passes control from one step to the next.

Transition/Transition and Acknowledgment (T/T and C)

(SFC) Step control mode "T/T and C". The sequential control system runs process-
controlled at steps without the T/T and C flag (just as in the T mode) and operator
controlled at steps with the T/T and C flag (just as in the T and C mode).

U

Update Cycle

In the test mode, this specifies the intervals at which the watched values of the
block I/Os are updated.

User Administrator

Editor in the control center of the OS for creating and editing access permissions
for operator control and monitoring during Runtime.

User Block

A block written by the user in SCL or Statement List in which the user formulates
the required functions. A user block consists of the program source file and the
block type from which the instances are created in CFC.

User Object

An object on the operator station made up of different single object
(I/O boxes, bars, texts etc.) that is used to display and control several parameters
of a block instance.

User Program

The user program contains all the statements and declarations and the data
required for signal processing to control a plant or a process. The program is
assigned to a programmable module (for example, CPU, FM) and can be
structured in smaller units.

In S7, the user program on the ES consists of the symbol table, the source files,
the blocks and the charts.
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V

Value Identifier

Symbolic substitute (text) for defined values of block I/Os of the data types BOOL,
BYTE, INT, DINT, WORD and DWORD.

W

Warm Restart

When a CPU starts up, the organization blocks are executed as described in ↑
Startup (↑ Startup of an S7-CPU).

The following rules apply to the "warm restart" (assuming the CPU is battery-
backed):

• All data blocks and their contents are retained

• Retentive timers, counters, and memory bits are retained; non-retentive timers,
counters, and memory bits are reset.

During a warm restart, the process image input table is read and the STEP 7 user
program is executed starting at the first instruction in OB1. In PCS 7, this is the
only startup type permitted.



Process Control System PCS 7, Tips and Tricks
A5E00080064-01 Index-1

Index

3
3COM card..........................................5-4, 11-26

A
access path .........................................5-24, 16-9
acknowledgability of messages....................2-12
acquisition cycle .........................................11-44
actions don’t run .........................................11-75
adapt name system........................................6-2
adapting blocks ............................................3-12
AF status word ...........................................14-10
AG_RECV ....................................................10-3
AG_SEND ....................................................10-3
Alarm Logging Wizard ................................11-54
ALARM_8P............................................7-1, 7-15
Alarm_8P blocks in SCL...............................13-2
Alternative ..................................................11-99
ANY Pointer ...................................................7-8
ANY pointer in SCL ....................................13-10
archive window...........................................11-45
archives mapped..........................................12-4
archives matched .....................................11-164
archiving at system start...........................11-127
archiving in SIMATIC Manager.......................3-7
archiving lost values .................................11-130
archiving process data (Batch)...................14-18
archiving program...........................................3-7
ArchSRV.EXE ..........................................11-161
AS/OS transfer .............................................12-1
assignment of resources ..............................5-26
authorization...............................................11-22
authorization level ......................................11-81
authorization level (actions)......................11-152
authorization levels.....................................11-34
authorization log file ...................................16-20
Automatic login...........................................11-29
automatic logon........................................11-122
automatic restart ......................................11-123
Autonegotiation ...................................5-15, 5-20
Autosensing ........................................5-15, 5-20
AUTOSTART................................................16-5
Auxiliary values ............................................2-10

B
backup...................................................3-7, 3-11
back-up file...................................................15-7
bar diagram ..............................................11-104
batch controller...........................................14-18

Batch Data Management ........................... 14-25
Batch Object Manager ................................. 14-9
Batch Planning........................................... 14-16
batch protocol ............................................ 14-17
BATCHflexible Object Manager ................... 14-8
beep periodically.......................................... 11-2
bit access in SCL ......................................... 13-7
bit set/reset .............................................. 11-104
block called in SCL .................................... 13-10
block supports HMI ...................................... 13-1
blocks with same number .............................. 7-3
blue screen .................................................. 15-1
Boolean variables in scripts ....................... 11-78
BSEND/BRCV ............................................. 10-1
bus monitor .................................................... 1-2
bus parameters (PROFIBUS) .................... 16-16
Bus terminator ........................................... 16-10
button (multiple-line text)............................ 11-95

C
C variable define........................................ 11-82
calling OB for function block ........................ 13-7
Central changing block type ........................ 7-12
Change CPU assigment (TH) ........................ 6-1
change recipe values................................... 14-1
change the entries alarm origin...................... 6-3
change trend image ................................. 11-144
change variable type...................................... 7-2
characters permitted ...................................... 3-1
check system resources ................................ 7-1
chip card login.......................................... 11-153
chipcard ..................................................... 11-29
client switch ............................................... 11-40
client with 2 CP’s ..................................... 11-124
clients don’t start automatically .................. 11-32
clients timeout.......................................... 11-114
COM port ....................................................... 5-1
comment .................................................... 11-47
communications instances............................. 9-3
communications interface ........................ 11-116
communications resources ............................ 9-4
Compile all functions.................................. 11-74
compress ..................................................... 7-11
computer name................................. 2-6, 11-125
configuration dialog (status display)........... 11-96
configuration file........................................... 3-28
configure a status display .......................... 11-98
configuring steps  (Batch) .......................... 14-13
connection ID............................................... 10-3
connection interruption .............................. 16-16
Connection Status ................................... 11-114



Index

Process Control System PCS 7, Tips and Tricks
Index-2 A5E00080064-01

Control Center foreground ......................... 11-87
control messages....................................... 11-56
control system messages ............................ 2-12
coordination rules........................................... 7-3
copy AS ......................................................... 3-6
copy charts .................................................... 3-9
copy PCS 7 projects .................................... 3-10
copy WinCC projects ................................... 11-3
copying program ............................................ 6-5
Copying subsystem........................................ 6-5
Country Settings .......................................... 7-15
CP 1413 installation ..................................... 5-39
CP 5412 A2 installation................................ 5-40
CP overall reset ......................................... 16-15
CP1613............................................... 5-27, 5-29
CP5412-A2 .................................................. 16-5
CPU Data communication.............................. 1-3
create name in Batch ................................. 14-17
curve control problems............................. 11-128
curve window no value............................. 11-126
cycle overload................................................ 4-4
cyclic archiving......................................... 11-130
cyclic read requests ....................................... 9-1
cyclic read service.................................... 11-121

D
data block ............................................... 3-2, 7-8
data block mapping...................................... 12-3
data consistency .......................................... 10-2
data manager........................................... 11-115
Data medium full ...................................... 11-157
DCF 77 radio clock ...................................... 15-8
DCF 77 time signal ...................................... 11-1
DDE channel............................................ 11-212
DDE channel via network......................... 11-219
DDE channel with Excel........................... 11-205
Default Trigger change .............................. 11-86
deinstalling PCS 7.......................................... 1-7
delete Batch............................................... 14-12
delete batches ........................................... 14-15
delete data from database ........................... 11-6
delete the Runtime data............................... 11-5
Deleting subsystem........................................ 6-5
DELTA compiling ........................................... 7-2
detect name conflicts ..................................... 6-6
device master file ......................................... 5-41
diagnosing connection ............................... 16-26
diagnosis function ........................................ 16-2
diagnostic information .................................. 16-1
diagnostic via routing ................................. 5-127
diagnostics buffer........................................... 1-4
direct link.................................................... 11-97
DLL created ............................................... 11-77
dollar variables in BATCHflexible................. 14-9
DP slave failure.............................................. 7-1
DP/PA link......................................... 5-42, 5-113
Dr. Watson................................................... 15-2
dynamic connection ..................................... 10-3
Dynamic wizard (first/final page)(............... 11-89

E
edge trigger flag in SCL................................13-6
EMC ...............................................................1-2
EMF format.................................................11-99
error after compiling ...................................11-76
error message ............................................11-76
error message Tag Logging .....................11-139
error message with  loop display ................11-27
ET 200M with CPU-STOP ............................5-44
Ethernet OSM/V1 .........................................5-26
event display ............................................11-122
event log...................................................11-123
events.........................................................11-85
EventState................................................11-107
exchange data.............................11-205, 11-212

F
faceplates (bitmaps) .................................11-109
faceplates partially displayed......................11-33
faults diadnose ...............................................1-2
FDL connections (troubleshooting).............16-11
FM355 PID controller starting up..................5-93
FMS Broadcast.............................................5-39
FMS channel restrictions ................................5-5
FMS link .........................................................5-5
format statement ............................................7-9
full duplex .....................................................5-26
Full Duplex ...................................................5-19
full-duplex .....................................................5-15

G
generate a message...................................11-63
generate reference data .................................2-3
GetArchiveData ........................................11-125
GetTag .....................................................11-115
GetTagMultiWait.........................................11-84
GetTagWait ..............................................11-116
global operand..............................................7-11
Global Script...............................................11-74
Global Script object window .......................11-74
GPS satellite time.........................................11-2
Graphics Designer......................................11-20
group display ............................................11-109
group message................................11-43, 11-51
GSD Files .....................................................5-41

H
Half Duplex...................................................5-19
half-duplex....................................................5-15
hardcopy.....................................................11-28
Hardcopy (white background).....................11-86
hardcopy of picture subareas ...................11-160
hard-copy printout ......................................11-39
hardware catalog............................................3-4
Hardware information .................................16-20
High-availability S7.......................................5-28



Index

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 Index-3

Highest Station Address...............................5-12
HMI properties..............................................7-15
hooter .........................................................11-69
horn signal..................................................11-70

I
I/O access failure............................................3-3
image change.............................................11-38
image compositions..................................11-165
image file......................................................15-7
image not displayed ...................................11-87
image window...........................................11-103
images locally.............................................11-40
individual messages ...................................11-43
Industrial Ethernet CP ..................................5-13
Industrial Ethernet OSM...............................5-13
Industrial Twisted Pair ..................................5-13
Infotext .......................................................11-47
initial state (Batch database) ......................14-16
insert OS in project.....................................11-11
install BATCHflexible database ..................14-11
installation of PCS 7.......................................1-6
installed version of WinCC .........................16-20
installing a CP1413 ......................................5-20
instance data blocks number..........................7-6
Integer into S5Time......................................13-8
integer value as decimal value ...................11-98
intrinsically safe operating ..........................11-30
invalid parameter (SCL) ...............................13-5
ISO transport connection..............................5-14
ISO-on-TCP connection ...............................5-14
ITP port ........................................................5-13
ITP-Port........................................................5-27

K
key combination locked ............................11-122
keywords in SCL ..........................................13-9

L
Language for Display .....................................3-6
language ID................................................11-11
Language setting in the SIMATIC Manager ...8-1
language switching.....................................11-20
license error message..............................11-117
License.log file ...........................................16-21
licenses needed .......................................11-118
Lifebeat Monitoring...................................11-166
limited operating behavior ............................3-13
limits indirect ..............................................11-42
line layout printing ....................................11-147
line structur.....................................................5-6
Linear adaptation (Batch function) .............14-12
LINK modul ..................................................5-41
LINK modules...............................................5-41
link to group display......................................7-12
load CP firmware...............................16-4, 16-12
load operation interrupted ..........................5-121

local data requirement ................................... 2-2
locking the key combinations................... 11-113
log books ..................................................... 16-1
log file filled disk........................................... 16-3
log file size increases................................... 11-3
log on automatically ................................... 15-11
Loop in Alarm............................................. 11-52
LWL-Port ..................................................... 5-26

M
maintenance engineer ............................... 5-116
mapping....................................................... 12-2
mapping only the changes........................... 12-2
maximum length of code area...................... 7-17
maximum number alternative branches......... 9-4
maximum number of SFC plans .................... 9-2
measured values in batch protocol .............. 14-8
MESSAGE................................................... 7-18
message archives...................................... 11-46
Message attributes .................................... 11-50
message auxiliary value ................................ 7-6
message auxiliary values............................. 7-14
message block............................................. 7-12
message classes ........................................... 2-9
message classes in PCS 7 .......................... 2-11
Message Configuration.................................. 2-9
message export .............................. 11-47, 11-60
message get lost........................................ 11-52
message language .................................... 11-57
message list............................................... 11-46
message lock............................................. 11-42
message number ....................................... 11-59
Message overflow...................................... 11-62
message suppression.................................... 1-4
message text ............................................. 11-73
message text (language) ............................. 7-20
message texts................................................ 2-9
message texts sorted................................. 11-65
message variable types ............................. 11-50
message when logging on ......................... 11-45
message/error box..................................... 11-96
messages area specific ............................. 11-55
messages configuration................................. 7-9
messages displayed .................................. 11-42
messages import ....................................... 11-49
messages not displayed ................. 11-32, 11-62
messages print selectively....................... 11-152
messages text block length ......................... 12-5
messages under Excel .............................. 11-48
Min TSDR .................................................... 5-11
missing messages ..................................... 11-42
Model ............................................................. 8-1
module (central rack) ..................................... 2-7
module replacement without PG.................. 5-18
mouse click ignored ................................... 11-83
Moving subsystem ......................................... 6-5
MSG_CSF Block............................................ 7-2
Multi VGA card......................................... 11-181
multiclient projects redundant server ....... 11-160
multi-user configurations.......................... 11-113



Index

Process Control System PCS 7, Tips and Tricks
Index-4 A5E00080064-01

MultiUserProject (client)........................... 11-204

N
NCM diagnostics mask .............................. 5-128
NETPRO.................................................... 5-121
network gateways ...................................... 5-125
network settings....................................... 11-116
Not enough main memory............................ 13-6
Novell network ......................................... 11-225
number of screen....................................... 11-94
number ranges............................................... 2-1

O
Object Manager ......................................... 14-16
old values storing........................................... 7-6
on-site operation (VALVE) ........................... 7-15
OPC in WinCC............................................. 11-2
operating behavior ....................................... 3-13
operating message texts................................ 2-7
operating messages..................................... 2-12
Operations executed not correctly ............. 11-84
operator message create ........................... 11-90
operator messages with time stamp ............ 7-18
Optical Link Modules...................................... 5-6
optical switch module................................... 5-26
OS area ID................................................. 11-55
OS project isn’t displayed......................... 11-119
OSM_V2 ...................................................... 5-15

P
Package................................................... 11-160
page layout printing.................................. 11-147
parameter assignment

monitoring time ........................... 5-123, 5-124
partner server ............................................ 11-12
PDM (Industrial Ethernet) ............................ 5-43
performance.......................11-95, 11-97, 11-112
performance increasing ............................. 11-18
picture open ............................................. 11-108
picture windows ....................................... 11-105
PING command ......................................... 16-14
PLC fault asynchronous................................. 1-3
PLC fault synchronous................................... 1-3
print in Batch Object Manager ................... 14-25
print job delete ......................................... 11-151
Process devices - Network view ................ 5-113
Process devices - System view.................. 5-112
process messages ....................................... 2-11
process-controlled archiving .................... 11-128
PROFIBUS bus parameters........................... 5-6
Profibus bus terminator.............................. 16-10
PROFIBUS CPs......................................... 16-12
PROFIBUS network parameters ................ 16-17
PROFIBUS PA devices.................................. 5-1
PROFIBUS PA link .................................... 5-110
PROFIBUS-PA bus terminator................... 16-11
program start automatically.......................... 11-4

ProgramExecute.........................................11-85
project access ............................................11-41
project automatically start.............................11-4
project can’t open .......................................11-25
project duplicator ......................................11-155
Project Duplicator ............................. 3-27, 11-12
project functions .........................................11-85
project save as ...........................................11-15
project switcher ........................................11-202
Project Switcher ..........................11-161, 11-162
PT100 connection ......................................5-106

Q
Quit Runtime via Help system ....................11-36

R
rack failure......................................................3-3
Rack number ............................................11-116
raw data send...........................................11-185
read system time ..........................................13-3
Reattempt after error ................................11-159
recognize resource bottlenecks..................16-22
redundant communication ............................5-27
redundant connection...................................3-19
redundant optical ring.....................................5-7
Redundant OS..............................................3-16
redundant project .......................................11-12
redundant servers ....................................11-183
registry information.....................................16-20
rejection operating behavior .........................3-13
remove curve images ...............................11-130
reorganize ....................................................7-11
reorganize the data ........................................3-8
replace the CPU ...........................................5-17
Report dynamic section............................11-148
Reports multiple languages ......................11-148
request ID.....................................................10-1
ressourcen of in- and outputs .......................13-9
restart automatically ...................................15-10
Retry Limit ....................................................5-11
routing .............................................5-126, 5-127
routing entry point.......................................5-128
run properties (block) ...................................7-18
Runtime database ........................................11-5
runtime sequence.........................................7-19

S
S5-95F link ...................................................5-54
S7 connection (log files) ...............................16-2
scaling function fpr process value ............11-129
scaling of variables.....................................11-25
SCL compiler-list ............................................9-3
script maximum characters.........................11-80
Segment (ID) ............................................11-116
self-defined parameter types ......................14-22
SEND/RECEIVE...........................................5-14
sequence-of-events.......................11-64, 11-145



Index

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 Index-5

Sequence-of-events (page output) ...........11-146
server name ...................................................2-6
server not found .......................................11-117
Server not ready (Storage).......................11-155
server switching .......................................11-183
set date and time........................................11-92
Set PG/PC interface .......................................3-5
setup error......................................................1-6
Setup Runtime Error 5....................................1-6
SFC plan via button..................................11-106
SFC varaiables...............................................9-3
SFC visualization............................................9-1
SFC_CTRL.....................................................9-2
SFC_CTRL block ...........................................9-5
signal module ................................11-54, 11-165
signal module acknowledge .....................11-166
signal module connecting.........................11-176
signal sequence report (start/stop) ...........11-145
SIMATIC PDM............................................5-112
SIMBApro.....................................................5-82
SIMBAsys module........................................5-88
SIMOCODE starting up ................................5-76
SIMOVERT start up......................................5-45
Simplex ........................................................5-19
SIPART DR 19 starting up ...........................5-67
SIPART® DR 21...........................................5-59
SITRANS P start up ...................................5-110
Slot no ......................................................11-116
slot time..........................................................5-8
space required .........................................11-126
special character ............................................3-1
special OB......................................................7-1
specialist ....................................................5-116
Split Screen Wizard..................................11-180
standard PC ...................................................1-1
star structur ....................................................5-6
start up automatically ...................................15-9
Static connections ........................................10-3
static text of layout....................................11-147
Station address ........................................11-116
status displays............................................11-96
Storage in multistation systems................11-158
Storage installation...................................11-159
Storage multiple station system ...............11-157
Storage no initialized ................................11-158
Storage redundant servers.......................11-156
Storage settings .......................................11-155
Storage started on other computer...........11-158
Storage with drive a..................................11-155
string disassemble......................................11-78
string length....................................................7-5
string reassemble.......................................11-78
strings as message auxiliary value...............7-14
SUBNET blocks .............................................1-5
subsystems copy............................................6-2
symbol bars not changed ...........................11-94
system attribute S7_Server ..........................13-2
system attributes .................................3-13, 3-14
system attributes (string variables)...............13-4
system clock (PC) ........................................15-6
system configuration ..................................16-17

system data block ........................................ 5-18
system message........................................ 16-22
system messages ...................................... 11-56
system time change..................................... 15-6

T
Tag Logging buffer................................... 11-125
Tag Logging cyclic archives......................... 11-5
Tag Logging hysteresis function .............. 11-130
Tag Logging performance........................ 11-140
Tag Logging table OCX ........................... 11-125
Tag Logging timeout ................................ 11-131
Technological Hierarchy ................................ 6-4
text library ................................................ 11-111
Text Library................................................ 11-20
text library crashes................................... 11-110
text library with EXCEL ............................ 11-111
texts disappear .......................................... 11-11
time interrupt.................................................. 7-4
time jumps ................................................. 11-31
time responses by connections.................... 10-2
time signal ................................................... 15-8
time synchronization ........................... 5-29, 5-40
time synchronizing ..................................... 11-35
TIME to REAL format................................... 13-5
TIME_BEGIN ................................................. 7-4
TIME_END..................................................... 7-4
timeout (loading AS) .................................. 16-16
timeout for terminating ............................... 11-93
transfer dialog .............................................. 3-26
transparent objects .................................... 11-95
Transport Service Access Points ............... 5-127
Trend (image opening) ............................ 11-140
trend curves............................................. 11-132
trend display in faceplate ............ 11-133, 11-136
Trend image............................................. 11-125
Trend not displayed correctly................... 11-140
trend printouts.......................................... 11-148
trigger an action ......................................... 11-66
triggers an action ....................................... 11-60
TSAP ......................................................... 5-127

U
UDP connection........................................... 5-14
UNC name............................................... 11-159
Unknown Objects..................................... 11-108
update information ..................................... 16-20
updating variables...................................... 11-10
User Archiv (column/row)......................... 11-189
User Archiv (decimal places) ................... 11-197
User Archiv (float data type) .................... 11-197
User Archiv (Form View).......................... 11-185
User Archiv (reading/writing).................... 11-197
User Archive ............................................ 11-196
User Archive (date/time) .......................... 11-199
User Archive (export/import) .................... 11-190
user archive attach data records.............. 11-203
User Archive data .................................... 11-188



Index

Process Control System PCS 7, Tips and Tricks
Index-6 A5E00080064-01

User Archive dynamic Wizard.................. 11-195
user archive error codes .......................... 11-203
User Archive fields ................................... 11-198
User Archive format ................................. 11-196
User Archive toolbar ................... 11-190, 11-192
User Archive with API .............................. 11-202
User Archive with password..................... 11-202
User Archive with scripts.......................... 11-199
User Archive Wizard function................... 11-194
user object .................................. 11-107, 11-109
user rights .................................................... 15-3
user specific operating behavior .................. 3-13
UserArchive (German help) ..................... 11-184
UserArchive error messages ................... 11-189

V
value archives.......................................... 11-126
variable optimization ...................................... 9-1
variable requirements .............................. 11-114
variable trigger ........................................... 11-19
variables configuration ............................... 11-93
variables list .................................... 3-26, 11-117
video card ................................................ 11-167
Video option package .............................. 11-167

W
warning by compiling CFC............................7-13
WinCC link......................................................5-1
WinCC Project Duplicator.............................5-29
WinCC redundancy data ..........................11-182
WinCC Scope.............................................16-17
WinCC station and WinAC .......................11-225
window in foreground .................................11-79
Windows compatibility ..................................15-1
winter time/summer time ..............................15-7
WORD to REAL in SCL................................13-8
wunload ........................................................11-6

X
xdb file ..........................................................3-27

Z
zero modem cable......................................16-12
Zip project.....................................................3-11



Process Control System PCS 7, Tips and Tricks
A5E00080064-01 1

Entry IDs

Entry ID Date Page

1870314 02/17/2000 1-1

1017239 10/07/1999 1-2

376160 06/06/2000 1-2

39638 11/22/1999 1-3

673584 03/13/2000 1-3

735185 02/02/1999 1-4

836501 09/01/2000 1-5

1965150 03/13/2000 1-6

1658691 12/16/1999 1-6

1086918 01/28/2000 1-7

2772014 08/02/2000 2-1

2718726 08/14/2000 2-2

2727253 11/03/2000 2-6

264662 11/30/1998 2-7

2847377 08/14/2000 2-7

2862776 10/16/2000 2-9

2847472 08/14/2000 2-11

2123719 04/19/2000 3-1

2727413 07/26/2000 3-2

1032718 09/20/1999 3-3

1529424 06/05/2000 3-4

2043586 04/18/2000 3-5

501348 01/28/2000 3-6

1965493 03/13/2000 3-6

2741660 09/01/2000 3-7

2742424 08/01/2000 3-8

1922887 04/12/2000 3-9

2281913 05/22/2000 3-10

2768825 08/02/2000 3-11

2687195 07/21/2000 3-12

2687217 07/21/2000 3-13

2936808 01.09.2000 3-14

00003 07.08.2000 3-16



Entry IDs

Process Control System PCS 7, Tips and Tricks
2 A5E00080064-01

Entry ID Date Page

2855188 13.07.2000 3-19

2687356 07/21/2000 4-1

2699017 07/24/2000 4-2

2717635 07/24/2000 4-3

2847489 08/14/2000 4-4

2446042 10/17/2000 4-4

643369 11/09/1998 4-6

770478 03/24/2000 4-6

790821 04/09/1999 4-9

906270 06/30/1999 4-10

1945522 03/08/2000 4-11

738129 02/03/1999 4-12

747243 02/08/1999 4-12

747268 02/08/1999 4-12

747475 02/08/1999 4-13

1027086 06/27/2000 4-13

1435651 11/18/1999 4-14

2147032 04/27/2000 4-15

910273 07/01/1999 4-15

947094 07/07/1999 4-15

997694 08/11/1999 4-16

39675 05/15/1997 5-1

776180 03/24/1999 5-1

997755 08/11/1999 5-4

1936508 02/25/2000 5-5

2361825 06/06/2000 5-5

1995199 03/14/2000 5-6

1002445 06/05/2000 5-13

187029 03/17/1999 5-14

1936979 02/25/2000 5-15

1972934 03/13/2000 5-17

770487 03/17/1999 5-18

771582 03/22/1999 5-19

816064 04/26/1999 5-20

830817 04/26/1999 5-20

897664 06/29/1999 5-26

2361347 10/16/2000 5-27

2416068 11/03/2000 5-29

388442 07/24/1998 5-39

897564 06/29/1999 5-39



Entry IDs

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 3

Entry ID Date Page

372737 06/13/2000 5-40

674986 12/04/1998 5-40

2121195 04/20/2000 5-41

2253966 05/22/2000 5-43

39703 05/27/1997 5-44

624931 11/26/1998 5-45

630950 11/01/2001 5-54

667846 07/26/1999 5-59

668919 07/26/1999 5-67

675048 11/17/1999 5-76

726049 06/28/2000 5-82

747643 02/08/1999 5-93

766011 12/04/2000 5-106

766281 09/28/1999 5-110

1000471 08/20/1999 5-121

584459 04/10/2000 5-125

770706 03/17/1999 5-127

845349 09/20/1999 5-128

5827568 11/30/2000 6-1

2845898 08/14/2000 6-2

787149 08/10/1999 6-3

2874118 08/17/2000 6-4

2936844 09.05.2000 7-1

5127064 11/03/2000 7-1

1007262 11/02/1999 7-2

1023992 09/08/1999 7-3

1096269 09/20/1999 7-3

1155460 01/04/2000 7-4

1436308 11/18/1999 7-5

1578540 02/21/2000 7-6

1871311 03/23/2000 7-6

1885730 02/18/2000 7-8

1926599 04/03/2000 7-9

2098423 05/02/2000 7-11

2698524 07/24/2000 7-11

2771574 08/02/2000 7-12

325658 12/04/1998 7-12

391247 10/11/1999 7-13

674578 06/13/2000 7-14

674649 12/04/1998 7-14



Entry IDs

Process Control System PCS 7, Tips and Tricks
4 A5E00080064-01

Entry ID Date Page

762780 03/01/1999 7-15

766298 03/01/1999 7-15

770488 12/08/2000 7-15

771569 09/13/1999 7-17

822508 04/26/1999 7-18

865057 05/31/1999 7-18

905116 06/29/1999 7-19

982759 07/27/1999 7-20

00001 22.08.2000 8-1

364055 07/07/1998 9-1

1703113 12/23/1999 9-1

382741 07/20/1998 9-2

734508 02/02/1999 9-2

752341 02/08/1999 9-4

790830 12/04/2000 9-5

1152252 01/10/2000 10-1

415724 08/24/1998 10-2

676702 01/25/2000 10-3

1046241 09/20/1999 11-1

1069326 09/20/1999 11-2

1136345 09/21/1999 11-2

1320229 02/21/2000 11-2

1443781 11/22/1999 11-3

1936932 02/25/2000 11-3

1958892 03/09/2000 11-4

1995242 03/23/2000 11-4

218453 02/17/2000 11-5

2464133 06/20/2000 11-6

379351 07/20/1998 11-10

677622 12/04/1998 11-11

724240 01/22/1999 11-11

779613 04/06/1999 11-12

833225 06/29/1999 11-18

996777 11/21/2000 11-20

00010 12.07.2000 11-21

2887917 10/16/2000 11-22

1008166 08/23/1999 11-25

1014417 08/24/1999 11-25

1025091 04/19/2000 11-26

1548903 11/26/1999 11-27



Entry IDs

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 5

Entry ID Date Page

1712549 01/04/2000 11-28

1947167 03/06/2000 11-29

2553068 07/03/2000 11-30

384263 03/01/1999 11-31

674987 12/04/1998 11-32

708854 01/12/1999 11-32

740175 01/25/2000 11-33

771444 04/28/1999 11-34

775488 08/19/1999 11-35

786888 01/21/2000 11-36

831864 04/28/1999 11-38

840776 12/07/1999 11-39

978169 07/26/1999 11-40

982658 07/27/1999 11-40

986394 07/30/1999 11-41

189296 01/21/1998 11-42

1903489 02/18/2000 11-42

1957448 03/08/2000 11-42

2383298 06/13/2000 11-43

268814 03/08/2000 11-44

493560 01/04/2000 11-45

495670 11/22/1999 11-45

56549 10/25/1999 11-46

56558 08/02/2000 11-47

684800 12/10/1998 11-50

70682 04/26/1999 11-50

70691 12/05/1997 11-51

70700 05/15/1997 11-52

850372 05/17/1999 11-52

892149 06/28/1999 11-54

2770292 08/02/2000 11-55

2847488 08/14/2000 11-56

1008101 01/25/2000 11-57

1020608 08/27/1999 11-59

1025092 09/09/1999 11-60

1624059 12/14/1999 11-62

1965122 03/13/2000 11-62

382120 06/29/1999 11-63

384262 01/28/2000 11-64

680629 12/08/1998 11-65



Entry IDs

Process Control System PCS 7, Tips and Tricks
6 A5E00080064-01

Entry ID Date Page

773963 12/08/2000 11-66

775455 12/14/1999 11-69

979559 07/27/1999 11-70

996785 08/05/1999 11-73

1172924 10/11/1999 11-74

1321558 11/08/1999 11-74

1797191 01/25/2000 11-75

2013047 03/28/2000 11-76

2357302 07/03/2000 11-76

2687225 07/21/2000 11-77

2787299 08/04/2000 11-78

334112 05/28/1998 11-78

415808 04/25/2000 11-79

493535 09/28/1998 11-80

71069 12/21/1998 11-81

71096 07/26/1999 11-82

715336 01/18/1999 11-83

814450 06/23/1999 11-84

92301 09/25/1999 11-84

92310 10/25/1999 11-85

790445 04/09/1999 11-85

1005865 10/13/1999 11-86

1024702 09/09/1999 11-86

144152 10/13/1997 11-87

1903171 02/18/2000 11-87

1937166 04/03/2000 11-89

218555 01/27/1998 11-90

268841 03/02/1998 11-92

268850 09/25/1998 11-93

2717651 07/24/2000 11-93

70940 05/12/1997 11-94

70967 02/25/2000 11-94

70976 07/08/1997 11-95

70985 06/13/2000 11-95

715335 01/18/1999 11-96

803922 04/29/1999 11-96

92250 09/25/1996 11-97

92413 10/08/1999 11-98

2843157 08/14/2000 11-98

00011 12.07.2000 11-100



Entry IDs

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 7

Entry ID Date Page

1292350 11/08/1999 11-103

2012110 03/27/2000 11-104

2442720 06/14/2000 11-104

2511096 06/27/2000 11-105

364046 07/09/1998 11-106

372414 07/15/1998 11-107

673583 11/30/1998 11-107

678986 12/08/1998 11-108

837177 05/03/1999 11-108

865859 05/31/1999 11-109

996786 08/05/1999 11-109

268805 03/02/1998 11-110

492977 09/25/1998 11-111

56567 02/18/1997 11-111

2623090 07/07/2000 11-112

268823 03/02/1998 11-113

332356 09/21/1999 11-113

492745 09/25/1998 11-114

632781 11/02/1998 11-114

665138 11/18/1998 11-115

2839551 08/09/2000 11-116

1628028 12/14/1999 11-117

2290170 05/23/2000 11-117

2397327 12/04/2000 11-118

364054 07/07/1998 11-119

2000360 03/24/2000 11-121

1008102 04/05/2000 11-122

1118180 09/21/1999 11-122

1140065 10/04/1999 11-122

1144558 12/22/2000 11-123

1468062 11/22/1999 11-123

990306 11/21/2000 11-124

1117419 09/21/1999 11-125

1333228 11/08/1999 11-125

1442788 11/22/1999 11-125

144365 10/07/1999 11-126

144377 03/09/1998 11-126

218573 01/29/1998 11-127

2202297 06/05/2000 11-128

2515625 06/27/2000 11-128



Entry IDs

Process Control System PCS 7, Tips and Tricks
8 A5E00080064-01

Entry ID Date Page

71287 05/15/1997 11-129

867876 05/28/1999 11-130

949541 07/08/1999 11-130

972621 07/21/1999 11-131

1804857 01/25/2000 11-132

2539759 11/20/2000 11-133

264713 07/03/2000 11-136

264722 02/26/1998 11-139

264731 01/28/2000 11-140

376161 07/20/1998 11-140

727093 12/08/2000 11-140

982717 07/27/1999 11-144

218564 01/27/1998 11-145

268886 01/24/2000 11-145

416441 08/25/1998 11-147

492346 09/25/1998 11-147

492720 09/25/1998 11-148

71242 07/08/1997 11-148

2481909 09/18/2000 11-148

384265 04/05/2000 11-151

945132 07/08/1999 11-152

774907 03/22/1999 11-152

640671 03/15/1999 11-153

1139856 09/21/1999 11-155

1547983 11/26/1999 11-155

1623949 12/14/1999 11-155

1624279 12/14/1999 11-156

218471 02/12/1998 11-157

558326 09/29/1998 11-157

71106 07/08/1997 11-158

71196 02/21/2000 11-158

640438 11/03/1998 11-158

640636 11/03/1998 11-159

640707 11/03/1998 11-159

686331 12/10/1998 11-159

1156337 10/06/1999 11-160

1936507 02/25/2000 11-160

2044160 11/21/2000 11-161

2511949 06/21/2000 11-161

780432 04/06/1999 11-162



Entry IDs

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 9

Entry ID Date Page

884083 06/24/1999 11-164

1764224 01/12/2000 11-165

1965159 03/13/2000 11-165

384264 07/24/1998 11-166

632703 11/02/1998 11-166

632780 11/02/1998 11-167

724520 01/28/1999 11-167

776118 05/31/1999 11-176

781997 04/06/1999 11-180

831486 09/21/1999 11-181

977358 07/26/1999 11-182

977870 07/26/1999 11-183

978631 07/26/1999 11-183

762666 02/24/1999 11-184

763895 02/24/1999 11-185

803955 05/31/1999 11-185

762748 02/24/1999 11-189

748948 02/08/1999 11-189

730078 02/01/1999 11-190

729763 02/01/1999 11-190

725822 01/28/1999 11-194

71187 09/05/1997 11-195

71169 08/07/1997 11-196

537698 09/29/1998 11-197

537498 09/29/1998 11-197

537598 11/21/2000 11-197

506891 09/28/1998 11-198

492721 09/25/1998 11-199

2463816 06/20/2000 11-199

1935606 02/25/2000 11-202

1548250 11/26/1999 11-202

1584496 12/14/1999 11-203

1005800 08/20/1999 11-203

1321095 11/08/1999 11-204

761667 02/21/2000 11-205

765028 03/01/1999 11-212

765223 03/01/1999 11-219

325357 05/08/1998 11-225

646822 11/09/1998 11-225

673454 11/20/2000 12-1



Entry IDs

Process Control System PCS 7, Tips and Tricks
10 A5E00080064-01

Entry ID Date Page

1436300 11/18/1999 12-2

264617 06/28/1999 12-2

769630 03/15/1999 12-3

901759 06/29/1999 12-4

906344 06/30/1999 12-5

1023091 09/08/1999 13-1

1027414 09/13/1999 13-2

1085941 11/22/1999 13-3

1965123 03/13/2000 13-4

1965158 03/13/2000 13-5

1965818 03/13/2000 13-5

1985425 03/13/2000 13-6

2211262 04/20/2000 13-6

674623 12/04/1998 13-7

677106 12/04/1998 13-7

740125 02/03/1999 13-8

771453 03/22/1999 13-8

771583 03/22/1999 13-9

833183 04/28/1999 13-9

903656 06/29/1999 13-10

906647 06/30/1999 13-10

1013795 08/24/1999 14-1

1986746 03/13/2000 14-8

2361787 06/06/2000 14-8

679193 12/08/1998 14-9

679496 12/09/1998 14-9

680601 12/09/1998 14-10

680688 03/14/2000 14-11

680720 12/08/1998 14-12

724540 01/22/1999 14-12

765094 03/01/1999 14-13

769197 03/16/1999 14-15

769463 03/16/1999 14-16

769484 03/15/1999 14-16

769687 03/15/1999 14-17

770032 03/16/1999 14-17

794369 03/22/1999 14-18

831535 04/28/1999 14-18

857832 07/30/1999 14-22

897482 06/28/1999 14-25



Entry IDs

Process Control System PCS 7, Tips and Tricks
A5E00080064-01 11

Entry ID Date Page

904025 06/29/1999 14-25

2334224 06/27/2000 15-1

384261 01/28/2000 15-1

1765511 01/12/2000 15-2

2044843 04/04/2000 15-3

2042303 08/15/2000 15-6

2042075 04/03/2000 15-7

1104199 09/21/1999 15-8

1995051 03/23/2000 15-9

1144448 10/04/1999 15-10

789370 08/18/1999 15-11

70612 05/06/1997 16-1

71580 09/05/1997 16-2

1957353 03/09/2000 16-3

770389 03/17/1999 16-4

492345 09/25/1998 16-5

771392 03/22/1999 16-5

187276 07/28/1997 16-10

187346 01/12/1998 16-11

187609 07/14/2000 16-11

2052628 04/03/2000 16-12

2629830 07/10/2000 16-12

583414 10/14/1998 16-13

656932 11/19/1998 16-14

686332 12/21/1998 16-15

1176690 10/11/1999 16-16

897989 06/28/1999 16-16

1790666 01/25/2000 16-17

850436 07/21/1999 16-17

954032 06/28/2000 16-22

264740 11/220/2000 16-26



Entry IDs

Process Control System PCS 7, Tips and Tricks
12 A5E00080064-01


	Title
	Preface
	Overview

	Contents
	1 Basics
	1.1 Basics
	1.1.1  Implementing a Standard PCs with PCS 7 V4.02
	1.1.2  Diagnostics option in the case of problems connecting with DP
	1.1.3  EMC of S7 components
	1.1.4  Data communication cycle with S7-400
	1.1.5  WinCC messages: "PLC fault synchronous" and "PLC fault asynchronous"
	1.1.6  Message suppression of the PCS 7 blocks CTRL_PID / MEAS_MON for AH,WH,WL,AL
	1.1.7  Reduce runtime of error OBs (SUBNET block) in PCS 7 version V4.xx

	1.2 Installation
	1.2.1  Abort when installing PCS 7 V4.02
	1.2.2  When starting the PCS 7 Setup issue of error message "Setup Runtime Error 5; invalid procedure call"
	1.2.3  Deinstalling PCS 7


	2 Project planning
	2.1 Basics
	2.1.1  Free block numbers for user blocks
	2.1.2  Determining the current local data requirement in the CPU
	2.1.3  Relationship between computer name and database server name V4.0x
	2.1.4  Modules in the central rack

	2.2 Message Configuration
	2.2.1  Predefining operating message texts
	2.2.2  Message configuring in the EngineeringStation
	2.2.3  Message classes in PCS 7 and their acknowledgability


	3  Creating a Project
	3.1 Basics
	3.1.1  Illegal characters in PCS 7 V5.0 and V 4.x
	3.1.2  Creating global data blocks for the OS
	3.1.3  Determining defective station in the case of I/O access failure
	3.1.4  Configuring CPUs and CPs not listed in the HW Config
	3.1.5  Menu item "Set PG/PC interface" missing in the SIMATIC Manager
	3.1.6  Menu item  Language for Display  doesn t work in the SIMATIC Manager
	3.1.7  Error when copying an AS in the SIMATIC Manager

	3.2 Project Handling
	3.2.1  Back up project data
	3.2.2  Reorganization of the project
	3.2.3  Copying CFC plans into other Ass for PCS 7 versions earlier than V5.0
	3.2.4  Copying of PCS 7 projects
	3.2.5  Data backup of individual automation systems

	3.3 Blocks Handling
	3.3.1  Adapting blocks and libraries to the customer profile
	3.3.2  Changing the operating behavior of the PCS 7 with blocks from the standard library
	3.3.3  System attributes for blocks and parameters

	3.4 Redundancy
	3.4.1  Creating and Downloading a Redundant OS Within a Project in PCS 7 Versions Higher than 4.02
	3.4.2  Configuring a redundant connection in PCS 7 Versionen higher than 4.02


	4 Configuring Hardware
	4.1 Basics
	4.1.1  Station diagnostics of a SIMATIC Station
	4.1.2  Storing user program permanently on FEPROM memory card
	4.1.3  Moving DP slaves to a different master system
	4.1.4  Operating state "STOP" when cycle monitoring time is exceeded
	4.1.5  Quantified project scope of the communications instances for PCS 7 automation systems
	4.1.6  Modules missing the HW Config
	4.1.7  CPU diagnostics includes smudge characters instead of cleartext
	4.1.8  HW Config cannot be started after incorporating a GSD file (versions <4.02)
	4.1.9  STOP through the priority class run system

	4.2 Redundant AS
	4.2.1  Configuring redundant power supply modules in an S7-400
	4.2.2  Changing the rack number of sync modules
	4.2.3  Configuring the second CPU 417-4H
	4.2.4  No switching to Redundant mode with running PG function for test and start-up
	4.2.5  Prompt to make overall reset after power ON with no battery back-up

	4.3 Automation System
	4.3.1  Memory concept for the S7-400
	4.3.2  Higher memory requirement when the CPU is in RUN mode
	4.3.3  Memory requirement of the process image (code memory/ data memory)
	4.3.4  Using the 3rd and 4th interfaces of the CPU 417-4
	4.3.5  Maximum possible number of DP phases with S7 400
	4.3.6  Battery error with the S7-400: OB81 is not called


	5 Configuring Networks
	5.1 Basics
	5.1.1  Connection of PROFIBUS PA devices
	5.1.2  COM Port in PCS 7 can no longer be addressed
	5.1.3  Installing the 3COM card after PCS 7

	5.2 FMS
	5.2.1  Maximum message length with FMS link
	5.2.2  Restrictions of the FMS channel

	5.3 OML
	5.3.1  Configuring the PROFIBUS bus parameters with STEP7 using OLMs version V3

	5.4  CP Industrial Ethernet
	5.4.1  Connecting Industrial Ethernet communications processors with an Industrial Ethernet OSM/V1 (optical switch module)
	5.4.2  Possible block transfer sizes with SEND/RECEIVE
	5.4.3  Link between the OSM V2 and the Industrial Ethernet CPs 343-1 and 443-1
	5.4.4  Replacing S7-400 CPU keeping the CP data and subsequent loading of the CPU via Industrial Ethernet CP in PCS 7 version V4.xx
	5.4.5  Consistency system data block (SDB 1xxx Type 3118) with the CPs 443-1xxx and 343-1xxx for PCS 7 version V5.x
	5.4.6  Operating modes Simplex, Half Duplex and Full Duplex in the communications world and with SIMATIC NET
	5.4.7  Autosensing and autonegotiation in the Fast Ethernet technology
	5.4.8  Installation of the CP1413 under Windows NT
	5.4.9  Operating modes of the Industrial Ethernet OSM/V1
	5.4.10  Redundant communication with two CP1613s for PCS 7 version V5.x
	5.4.11  Time synchronization for PCS 7 V5.x via CP1613
	5.4.12  Installation/Configuration of the CP 1413

	5.5  CP Profibus
	5.5.1 FMS Broadcast support
	5.5.2  Time synchronization via PROFIBUS with CP5412 (A2) V4.X
	5.5.3  Installation/Configuration of the CP 5412 A2

	5.6 Field Devices
	5.6.1  Incorporating new LINK modules in PCS 7 V4.02
	5.6.2  Configuration of PA field devices with PDM via Industrial Ethernet
	5.6.3  Statuses of the outputs of the ET 200M with CPU STOP
	5.6.4  PCS 7/ AS SIMOVERT for PCS 7 version V4.02
	5.6.5  Linking an S5-95F to PCS 7 V4.0x
	5.6.6   Starting up SIPART DR 21 for PCS 7 version V4.0x
	5.6.7  Starting up SIPART DR 19 for PCS 7 version V4.0x
	5.6.8  Starting up SIMOCODE for PCS 7 version V4.0x
	5.6.9  Application of the simulation system SIMBApro in PCS 7
	5.6.10  PCS 7 and the controller module FM355-PID
	5.6.11  Connection of the PT100 to analog input module SM 331 AI 8x12BIT
	5.6.12  Connecting a SITRANS P (DS series) to PCS 7 via a PROFIBUS PA - communication

	5.7 Routing
	5.7.1  Loading a complete S7-400 station with Industrial Ethernet CPs in RUN state of all components concerned for PCS 7 version V5.x
	5.7.2  SIMATIC S7 modules that support routing for PCS 7 version V5.x
	5.7.3  With PG channel routing: CP cannot be reached via special diagnostics for PCS 7 version V5.x
	5.7.4  NCM diagnostics mask gives the wrong information on the gateways used for PCS 7 version V5.x


	6 Plant Hierarchy
	6.1 Basics
	6.1.1  Changing the CPU assignment in the Technological Hierarchy for moving CFC /SFC charts in PCS 7 V4.x and V5.x
	6.1.2  Copying folders in the technological hierarchy and changing the names of CFC charts in PCS 7 version V5.x
	6.1.3  Changing the entries in the alarm origin in PCS 7 version V4.01 or earlier

	6.2 Modifying Projects
	6.2.1  Modifying a project in the Technological Hierarchy


	7 CFC-Plans
	7.1 Basics
	7.1.1  Checking system resources before loading
	7.1.2  Creating the special OBs via a MSG_CSF block
	7.1.3  Delta compiling in the CFC is not possible when modifying the interface of a block in PCS 7 version V4.02
	7.1.4  Blocks with the same number in the CFC
	7.1.5  Error message: Coordination rules have been violated FBxxx
	7.1.6  Sample program: request fault for time interrupt, measuring the time-out
	7.1.7  Wrong string length when transferring to WinCC in PCS 7 version 4.02
	7.1.8  Numbers of the instance data blocks of the CFC
	7.1.9  Sample program: generating message in the AS with new and old values upon changing values
	7.1.10 Interconnect ANY Pointer to a complete data block in the CFC für PCS 7 Version 4.02 or higher
	7.1.11  Format adaptation for the process value output when configuring messages in the CFC
	7.1.12  Absolute addressing of global operands in the CFC or in the SFC
	7.1.13  "CPU memory insufficient" message when loading the AS
	7.1.14  Central changing of type of blocks CFC charts
	7.1.15  Linking PCS 7 message block with group display.
	7.1.16  Warning: "CHANGE the OBx: the FCy must be called." when compiling the CFC
	7.1.17  Linking string as message-accompanying value
	7.1.18  No more accompanying message values displayed in WinCC
	7.1.19  Valve block PCS 7 doesn t support on-site operation
	7.1.20  Message when inserting blocks in CFC plan
	7.1.21  Notes on using the ALARM_8P
	7.1.22  Error message: Maximum length of code area reached
	7.1.23  Generating a new time stamp despite identical operator messages
	7.1.24  Missing OBs in the run properties of a block
	7.1.25  OB number display in the block header
	7.1.26  Language of message texts in the CFC


	8 Import-Export-Assistant
	8.1 Basics
	8.1.1  Language Setting in the SIMATIC Manager


	9 SFC-Plans
	9.1 Basics
	9.1.1  Variable updating and archiving.
	9.1.2  Detail window of the SFC visualization cannot be operated in PCS 7 version 4.0x
	9.1.3  Interconnection of inputs on the SFC_CTRL block
	9.1.4  Maximum number of SFC plans in one S7 CPU with and without control blocks in PCS 7 version 4.0x
	9.1.5  Maximum number of transitions and alternative branches
	9.1.6  Using the SFC Control block


	10  Configuring SIMATIC Connections
	10.1 Basics
	10.1.1  Implementing the SFB 12 and SFB 13
	10.1.2  Different time response when setting up and clearing down connections
	10.1.3  Sample program: configuring the blocks AG_SEND/AG_RECV ( V4.02 )


	11  Operator Station
	11.1 Basics
	11.1.1  DCF 77 receiver for WinCC
	11.1.2  GPS receiver (2XV9450-1AR13) for WinCC
	11.1.3  OPC under WinCC V. 5
	11.1.4  Periodic beeping after starting WinCC
	11.1.5  Copying projects with WinCC V5.0
	11.1.6  Growing log file in the project path
	11.1.7  WinCC V5.0: starting the project automatically depending on the user logged in
	11.1.8  Automatic program start after computer start-up
	11.1.9  Removing Runtime data from the database in V 4.0 and higher
	11.1.10 Removing unnecessary data from WinCC databases with WUNLOAD.
	11.1.11  Variable updating with several clients
	11.1.12 Inserting separately generated OS into PCS 7 or S7 project
	11.1.13 English texts disappear when switching languages
	11.1.14 WinCC Redundancy Project Duplicator
	11.1.15 Increasing the performance by taking into account communication mechanisms with WinCC
	11.1.16 Language switching for East European languages
	11.1.17 Editor for the Dynamic Wizard
	11.1.18 Software installations and authorizations in the multi-user system
	11.1.19 Scaling variables with PCS 7
	11.1.20 WinCC client cannot open the project from the server
	11.1.21 Adapter for 3COM card interface with RJ45 with Primergy computers
	11.1.22 APDIAG message in loop display call of a faceplate
	11.1.23 Hardcopy printout doesn t work on some computers with a client- server configuration under PCS 7 V4.02.
	11.1.24 Automatic login of a defined user with chipcard reader
	11.1.25 Intrinsically safe operating unit for hazardous area Zone 1 and Zone 2
	11.1.26 Time jumps with defects in the DCF77
	11.1.27 Group display in the overview area of WinCC doesn t show anything
	11.1.28 Clients only start up slowly or not at all after server switchover
	11.1.29 PCS 7 faceplates are not correctly displayed in RT
	11.1.30 Criteria for the authorization levels in the User Administrator with PCS 7
	11.1.31 Time synchronizing for clients
	11.1.32 Unwanted quitting of WinCC Runtime via the Help system
	11.1.33 Closing images that the wizard has created upon image change
	11.1.34 Hard-copy printouts on color printers
	11.1.35 Switching the client when the server fails
	11.1.36 Saving process images locally on the client in the case of WinCC multistation systems
	11.1.37 Project access in WinCC Client-Server Environment

	11.2 Alarm Logging
	11.2.1  Messages missing from Alarm_8P
	11.2.2  Limit value message present although limits not exceeded
	11.2.3  Only 1000 messages visible in the archive window
	11.2.4  Deleting individual messages from a group message
	11.2.5  Changing the acquisition cycle of Alarm Logging (V4.01 / V 5.x)
	11.2.6  Messages are not displayed in the archive
	11.2.7  WinCC, generate message when logging on
	11.2.8  Differences between message processing in the message list and in the archives
	11.2.9  Exporting and importing message texts with Excel (WinCC V5 SP1)
	11.2.10 Message attributes with Import/Export files
	11.2.11 Function of the variable types in the individual messages
	11.2.12 Group message functionality
	11.2.13 Using any configuration function in conjunction with "Loop in Alarm"
	11.2.14 Messages: "Transfer buffer too small", "TagQueue overflow", "Messages are lost"
	11.2.15 Signal module without Split Screen Wizard with own message classes
	11.2.16 Area-specific messages
	11.2.17 Meaning of the group signal technology and system messages
	11.2.18 Texts in group messages also in other languages
	11.2.19 Determining the number of messages in WinCC
	11.2.20 Action call via Alarm Logging in PCS 7/WinCC
	11.2.21 Message: Message overflow detected
	11.2.22 Messages are not displayed in the faceplate.
	11.2.23 Creating a message upon connection failure
	11.2.24 Sequence-of-events log when deactivating WinCC
	11.2.25 Sorting of message texts between ES and OS (WinCC)
	11.2.26 Triggering an action by activating a message
	11.2.27 WinCC hooter when a message arrives
	11.2.28 Triggering of the horn with messages
	11.2.29 Text length of the  Origin  message text in Alarm Logging

	11.3  Global Script
	11.3.1  Menu item "Compile all functions " is not active in the Global Script
	11.3.2  The object window is no longer visible in the Global Script editor
	11.3.3  Global/local actions do not run in Runtime
	11.3.4  WinCC project or standard functions are not found.
	11.3.5  Error message in the diagnostics file: "Script: More than 5000 actions in work"
	11.3.6  Increased memory use when incorporating a DLL in WinCC scripts
	11.3.7  Querying Boolean variables in OS scripts (C actions)
	11.3.8  Disassembly and assembly of strings
	11.3.9  Fetching program windows to the foreground via an WinCC script
	11.3.10 Maximum number of characters in a C script
	11.3.11 Querying of authorization levels using C-Script
	11.3.12 Defining global C variable that is known to all functions
	11.3.13 "Button up" doesn t work after calling a standard function.
	11.3.14 GetTagMultiWait with "float" data type
	11.3.15 Operations with picture names
	11.3.16 ProgramExecute - program is not started
	11.3.17 Global Scripts: difference between project function and global event

	11.4  Graphics Designer
	11.4.1  Economic hard copy printout on color printers
	11.4.2  Changing the Default Trigger when configuring (V4.02 and higher)
	11.4.3  After selecting the variable browser, the Control Center is in the foreground
	11.4.4  Image blocks are no longer displayed after copying buttons.
	11.4.5  Display/ mask out first page/ final page of the Dynamic wizard
	11.4.6  Creating a user-specific operator input
	11.4.7  Setting date and time
	11.4.8  Increase timeout when starting up/terminating runtime.
	11.4.9  Changing variables configuration as of WinCC V5.0
	11.4.10 Limitation of number of screen windows in one image
	11.4.11 Symbol bars in the Graphics Designer can no longer be changed in size and location.
	11.4.12 Performance loss through transparent drawing
	11.4.13 Input of multiple-line text with one button
	11.4.14 Configuring status displays with configuration or dynamic dialog
	11.4.15 Inoperability of the system message/error box
	11.4.16 Optimized configuration through direct link
	11.4.17 Displaying the integer values from the SPS as decimal values in WinCC
	11.4.18 Configuring a status display
	11.4.19 Displaying Faceplates in a Process Picture
	11.4.20 Moving an image window only within the working area of the Split Screen Wizard
	11.4.21 Setting/Resetting bit via mouse click (toggle function)
	11.4.22 Flickering of bar display when updating
	11.4.23 Sample program: Open picture windows "@TOP01...@TOP16" in any position in the picture "@1001.pdl"
	11.4.24 Calling SFC plan via button
	11.4.25 Generate user object in the Graphics Designer
	11.4.26 Controlling status display with EventState variable
	11.4.27 Unknown Objects instead of Faceplates
	11.4.28 Opening a picture in the process window with LoopInAlarm
	11.4.29 PCS 7: group displays in a user object
	11.4.30 Display of bitmaps of the faceplates linked as icons

	11.5 Text Library
	11.5.1  Destroyed text library table
	11.5.2  Cannot open Text Library
	11.5.3  Import/export of EXCEL tables to and from the text library

	11.6  Projects management
	11.6.1  Improvement of performance through changing the variable scaling
	11.6.2  ODBC error when creating a multi-user configuration
	11.6.3  Locking key combinations is sometimes ineffective
	11.6.4  Sporadic problems when starting up clients
	11.6.5  Connection Status in the Control Center
	11.6.6  Using the GetTag and GetTagWait functions
	11.6.7  Checking network settings and the communications channel
	11.6.8  Error message "Cannot find server, start project locally?" when opening an OS from the SIMATIC Manager
	11.6.9  License error message "No License for PLS1"
	11.6.10 Licenses required for WinCC V5.0 / SP1 for server/client operation
	11.6.11 PCS 7 OS project cannot be created or is not displayed.

	11.7 Communication
	11.7.1  Cyclic reading service

	11.8 Configuring System
	11.8.1  Key combination CTRL+ESC doesn t remain locked after RESET
	11.8.2  Error in the event display: "S7OPCIAX"
	11.8.3  Automatic logon under Windows NT doesn t always work
	11.8.4  Automatic restart of Windows NT
	11.8.5  Switch off message from Windows NT event log
	11.8.6  Implementing the WinCC Client on a computer with more than one IP address (two network cards or RAS access) in WinCC V4.02

	11.9 Tag Logging
	11.9.1  Tag Logging and memory behavior
	11.9.2  Nothing is displayed in the table OCX
	11.9.3  Values from the Tag Logging Archive are not displayed.
	11.9.4  Tag Logging and Variable Names
	11.9.5  Space requirements for measured value archives
	11.9.6  Action for releasing the archiving
	11.9.7  Incompatibility of the curve control
	11.9.8  Telegram setup with process-controlled archiving
	11.9.9  Archiving converted process values in Tag Logging
	11.9.10 Sporadic failures when archiving
	11.9.11 Inhibiting the display of specific curves in the curve images
	11.9.12 Increasing timeout for starting and terminating Tag Logging
	11.9.13 Display of different trend curves in one image
	11.9.14 Incorporating curve display (trend) in faceplate (with PCS 7 V5.0)
	11.9.15 Incorporating curve display (trend) in faceplate (with PCS 7 V4.02)
	11.9.16 Error message: "TagLogging is being processed"
	11.9.17 Curve trend displayed only after start
	11.9.18 Display of curves in a client-server system with time synchronization with time delay
	11.9.19 Performance improvement of Tag Logging
	11.9.20 Changing the trend image of "Curves over measuring point"

	11.10 Report Designer
	11.10.1 Stop/ start signal sequence report as of V 4.0
	11.10.2 Sequence-of-events log procedure
	11.10.3 Combination line and page layout
	11.10.4 Using "&" in the static text of the report designer
	11.10.5 Multilingual reports
	11.10.6 Errors in printout of dynamic sections
	11.10.7 Trend printouts
	11.10.8 Deleting print jobs from WinCC Runtime
	11.10.9 Printing messages with PCS 7 V4.02

	11.11 User Administrator
	11.11.1 Executing actions depending on authorization level
	11.11.2 Logging on with the chip-card reader

	11.12 Storage
	11.12.1 Storage cannot be set on drive A:\
	11.12.2 Storage message: "Server not ready, manual exporting and creation of data media not possible"
	11.12.3 Storage settings with two redundant computers in the project duplicator
	11.12.4 Storage with redundant servers
	11.12.5 Message: "Data medium full. Please change."
	11.12.6 Setting up storage with Client-Server
	11.12.7 Storage cannot initialize the drive
	11.12.8 At start, Storage issues the message "... started on other computer"
	11.12.9 Implementation of Storage in the multistation system
	11.12.10 Storage installation requirements for client/server
	11.12.11 Meaning of the UNC name of storage drive
	11.12.12 Storage doesn t roll out any more

	11.13 Optional package
	11.13.1 Hardcopy picture subareas
	11.13.2 Redundant servers with multiclient projects
	11.13.3 "ArchSRV.exe" starts briefly with WinCC Runtime, but terminates immediately
	11.13.4 Configuring the clients with the tool "Project Switcher" after the project has been duplicated.
	11.13.5 Operation and behavior of the Project Switcher
	11.13.6 Procedure in the case of problems with redundancy
	11.13.7 Deleting image compositions created with Split Screen Manager
	11.13.8 Signal module, update time of the variables @Signal1..@Signal3
	11.13.9 Lifebeat Monitoring can t be opened
	11.13.10 Acknowledgment of signal module by client
	11.13.11 Integration of multiple video images in one process image
	11.13.12 Using the PCS 7 Video option package
	11.13.13 Connecting a signal module
	11.13.14 The Split Screen Wizard closes with an error message
	11.13.15 Special features with actions when using a Multi VGA card
	11.13.16 Comparison of exported data with WinCC redundancy
	11.13.17 Mutual recognition of redundant servers
	11.13.18 Recognizing the switch from one server to another

	11.14 User Archive
	11.14.1 German Online Help with UserArchive
	11.14.2 Configuring Form View of UserArchive (4.02)
	11.14.3 Raw data with BSEND/BRECEIVE
	11.14.4 Error messages when opening the UserArchive editor
	11.14.5 Edit column/row width in the User Archive Runtime
	11.14.6 User Archive Editor: Toolbar non-operable
	11.14.7 Exporting/importing the User Archive data records (version V4.02 and higher) in *.csv file
	11.14.8 Toolbar buttons of the User Archive outside the OCX
	11.14.9 Using the WinCC User Archive Wizard Scripts V4.02 and higher
	11.14.10 User Archive Wizard doesn t create a complete archive image
	11.14.11 Date format in conjunction with User Archive
	11.14.12 Reading and writing of data records too slow
	11.14.13 Float data type
	11.14.14 Number of decimal places with data type Double
	11.14.15 Defining fields with Wizard Script for User Archive
	11.14.16 Date/ time in user archive
	11.14.17 Sample program: grouping of repetitive functions on User Archives in one function.
	11.14.18 Requirement for using the User Archive and project switcher API on the client
	11.14.19 Password protection for User Archives in Client-Server mode
	11.14.20 Function extension of the control variables of the user archive to WinCC V5.0
	11.14.21 Error Codes of the User Archive Function "uaGetLastError
	11.14.22 Project cannot be opened on the client with a WinCC MultiUserProject (WinCC V4.02 and SP1)

	11.15 Transferring Data
	11.15.1 DDE channel to Excel locally on a computer
	11.15.2 Data exchange between WinCC computers via DDE
	11.15.3 DDE channel to Excel via the network
	11.15.4 Connection of third-party devices to SIMATIC PCS 7 via Novell.
	11.15.5 Connecting WinCC to WinAC


	12  Configuring SIMATIC Connections
	12.1 Basics
	12.1.1  AS/OS transfer of a self-written data block
	12.1.2  When mapping with overall reset, the mapper overwrites the manually set parameters of the messages.
	12.1.3  Configuration can no longer be mapped in PCS 7 version earlier 4.02
	12.1.4  Problems when mapping data blocks with the same name
	12.1.5  Mapping archives with PCS 7 version 4.02
	12.1.6  Length of mapped message texts


	13 SCL-Language
	13.1 Basics
	13.1.1  Creating a block in SCL that supports HMI and messages
	13.1.2  Calling twoAlarm_8P - SFB 35 blocks in a function block with SCL
	13.1.3  Reading the system time of the PLC, converting to a string or integer value and mapping to WinCC
	13.1.4  System attributes with string variables as IN_OUT parameters
	13.1.5  Converting from the TIME to the REAL format
	13.1.6  SCL compiler reports "Invalid input, in/ out, output parameters"
	13.1.7  PCS 7 V4.02 (SCL V4.01) error message: "Not enough main memory available"
	13.1.8  Sample program: constructing an edge trigger flag in SCL
	13.1.9  Determining the calling OB
	13.1.10 How can you access a bit of a variable in SCL?
	13.1.11 Converting the Integer format into S5Time
	13.1.12 Converting WORD to REAL
	13.1.13 PCS 7 V4.02 - SCL new keywords
	13.1.14 Number of inputs/outputs on a block described in SCL
	13.1.15 Using ANY pointer with communication blocks
	13.1.16 Calling FBs and FCs in SCL Code


	14 BATCH flexible
	14.1 Basics
	14.1.1  Changing a recipe parameter during a BATCH run
	14.1.2  Changes in the Object Manager are not accepted (V4.02)
	14.1.3  Missing measured value display in the batch protocol
	14.1.4  Empty BOM after starting the BOM via the desktop icon
	14.1.5  Using Dollar variables
	14.1.6  Configuration of the AF status word
	14.1.7  Installing a BATCHflexible database on another computer
	14.1.8  Batch cannot be deleted
	14.1.9  Linear adaptation
	14.1.10 Configuring steps with BATCHflexible
	14.1.11 Deleting aborted batches
	14.1.12 Getting database into initial state
	14.1.13 Release of batches
	14.1.14 Necessity for creating names
	14.1.15 Importing process values into the batch protocol
	14.1.16 BATCHflexible: time-controlled starting of batches
	14.1.17 Batch-specific archiving of process data
	14.1.18 Using self-defined parameter types
	14.1.19 Printing to file from the Batch Object Manager
	14.1.20 Batch Data Management generates message: "No connection to WinCC alarm logging. Application is closing" for BATCH flexible version 4.02 or higher


	15  Windows NT Information
	15.1 Basics
	15.1.1  PCS 7 and Windows compatibility
	15.1.2  Blue screen when booting Windows NT
	15.1.3  Settings for Dr. Watson on a WinCC or PCS 7 computer
	15.1.4  Assignment of user rights under Windows NT

	15.2 Time Setting
	15.2.1  Problems that arise when changing the system time
	15.2.2  Winter time/ summer time changeover when importing images
	15.2.3  The time signal is not received correctly when using the DCF77 radio clock receiver

	15.3 Automatic Start-up
	15.3.1  Automatic program start after computer start-up
	15.3.2  Automatic restart of Windows NT
	15.3.3  Auto Logon PCS7 V5.1 PCS7 Complete Package


	16 Support
	16.1 Basics
	16.1.1  Diagnosis data in the various LOG files as of V 3.x
	16.1.2  LOG functions and on-line help for the S7 channel
	16.1.3  File "Sql.log" fills the hard disk
	16.1.4  Loading firmware after interruption of the loading procedure with the CPs 343-1 xxx and 443-1 xxx
	16.1.5  Removing configurations from AUTOSTART
	16.1.6  Installation of a CP5412-A2 communications processor under WindowsNT 4.0

	16.2 Bussystem Support
	16.2.1  Bus Terminator for PROFIBUS
	16.2.2  Bus connection with PROFIBUS PA
	16.2.3  Troubleshooting during data transfer via FDL connections
	16.2.4  Cable assignment for a "zero modem cable"
	16.2.5  Loading firmware via SIMATIC NET CPs with NCM S7 PROFIBUS V5.1
	16.2.6  SIMATIC NET Firmware Loader in NCM S7 PROFIBUS
	16.2.7  Using the "PING" command to find network users
	16.2.8  CP443-5 Extended overall reset via NCM S7 PROFIBUS diagnostics

	16.3  AS Support
	16.3.1  Reloading the hardware configuration with changed bus parameters via PROFIBUS
	16.3.2  Connection interruption when loading into the SIMATIC station

	16.4  OS Support
	16.4.1  Link to WinCC not set up
	16.4.2  Diagnosis and system information with WinCC Scope
	16.4.3  Early recognition of resources bottlenecks with CCPerfMon (WinCC V4.x)
	16.4.4  Diagnosis of the connection between WinCC and the SPS


	Glossary
	Index
	3
	A
	C
	B
	E
	F
	D
	G
	H
	I
	M
	K
	L
	N
	Q O
	R
	P
	S
	T
	U
	W
	X V
	Z

	Entry IDs

